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CHAPTER 1

Introduction aux cours

1.1 Avant-propos

1.1.1 Préparation

En 2008, nous avons lancé Une rapide introduction aux SIG, une ressource complètement libre et ouverte pour les
personnes désirant apprendre à utiliser des SIG sans être surchargées par le jargon et la terminologie. Ce travail a
été sponsorisé par le gouvernement Sud-Africain et a été un succès phénoménal car des personnes de toute la terre
nous ont écrit pour nous décrire comment elles avaient utilisé ce travail pour réaliser des formations universitaires,
pour apprendre les SIG par eux-mêmes, etc. L’introduction rapide n’est pas un tutoriel de logiciel mais plutôt un
texte générique (bien que des exemples sous QGIS soient montrés) permettant de comprendre les SIG. Il existe
également le Manuel QGIS qui fournit un aperçu détaillé des fonctionnalités de l’application QGIS. Néanmoins,
il n’est pas structuré sous forme de tutoriel mais plus comme un guide de référence. A Linfiniti Consulting CC.,
nous organisons fréquement des formations et nous avons réalisé qu’il manquait une troisième ressource, une qui
permettrait de guider séquentiellement le lecteur à travers l’apprentissage des aspects clefs de QGIS sous forme
d’un échange formateur-élève. Nous avons alors produit ce document.

Ce manuel d’exercices est prévu pour permettre de conduire une formation de 5 jours sur QGIS, PostgreSQL
et PostGIS. La formation est structurée pour s’adapter aux utilisateurs novices, intermédiaires et avancés et elle
dispose de plusieurs exercices complets avec des réponses annotées tout au long du texte.

1.1.2 Licence

Le Manuel d’Exercices Libre Quantum GIS de Linfiniti Consulting CC est basé sur une version précédente de
Linfiniti et est diffusé sous licence Creative Commons Attribution 4.0 International. De permissions plus étendues
que celles définies par cette licence sont disponibles plus bas.

Nous avons publié ce manuel d’exercice QGIS sous une licence libre pour vous permettre de le copier, de le
modifier et de le redistribuer librement. Une copie complète de la licence est disponible à la fin de ce document.
En termes simples, les recommandations d’utilisation sont les suivantes:

• Vous ne pouvez pas déclarer que cette œuvre est la votre ou supprimer le texte sur les auteurs de cette
oeuvre.

• Vous ne pouvez pas redistribuer cette oeuvre sous des permissions plus restrictives que celles qui vous ont
été attribuées.

• Si vous ajoutez une portion significative à cette œuvre et que vous livrez votre contribution en retour au
projet (au moins un module complet), vous pouvez ajouter votre nom à la fin de la liste des auteurs de ce
document (qui apparaît en page de garde).
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• Si vous avez effectué des changements mineurs ou des corrections, vous pouvez vous ajouter à la liste des
contributeurs ci-dessous.

• Si vous traduisez le document en entier, vous pouvez ajouter votre nom à la liste des auteurs sous la forme
“Translated by Joe Bloggs”.

• Si vous financez un module ou une leçon, vous pouvez demander à l’auteur d’inclure une note au début de
chaque leçon financée, par exemple:

Note: Ce cours a été sponsorisé par MegaCorp.

• Si vous n’êtes pas certain de ce que vous pouvez faire sous cette licence, merci de nous contacter à l’adresse
office@linfiniti.com et nous vous donnerons des conseils sur l’acceptabilité de vos intentions.

• Si vous publiez cette œuvre sur un site de publication tel que http://lulu.com, nous vous demandons de
reverser les profits au projet QGIS.

• Vous ne pouvez pas commercialiser cette œuvre sans la permission expresse des auteurs. Pour être clair, par
commercialisation, nous entendons que vous ne pouvez pas la revendre pour le profit, pour créer un travail
dérivé commercial (ex: vendre le contenu pour l’inclure dans des articles de magazines). L’exception à
cette règle consiste à reverser tous les profits au projet QGIS. Vous pouvez (et nous vous encourageons à le
faire) utiliser cette œuvre comme un livre pour gérer votre formation même si cette formation est de nature
commerciale. En d’autres termes, vous pouvez vous rémunérer en réalisant une formation basée sur cette
œuvre mais vous ne pouvez pas réaliser de profits en vendant le livre en lui-même, de tels profits devant être
reversés au projet QGIS.

1.1.3 Sponsoriser des chapitres

Cette oeuvre ne prétend pas être une référence complète de toutes les choses que vous pouvez accomplir avec
QGIS et nous vous encourageons à ajouter de nouveaux éléments pour combler les vides. Linfiniti Consulting
CC. peut également créer du contenu pour vous sur la base d’un service commercial avec le fait que tout le travail
produit devriendra partie de l’oeuvre et sera publié sous la même licence.

1.1.4 Auteurs

• Rüdiger Thiede (rudi@linfiniti.com) - Rudi a rédigé les éléments sur QGIS et les parties sur PostGIS.

• Tim Sutton (tim@linfiniti.com) - Tim a supervisé et guidé le projet ainsi que co-produit les parties sur
PostgreSQL et PostGIS. Tim a également produit le thème sphinx personnalisé pour ce manuel.

• Horst Düster (horst.duester@kappasys.ch ) - Horst a co-produit les parties sur PostgreSQL et PostGIS.

• Marcelle Sutton (marcelle@linfiniti.com) - Marcelle a réalisé la relecture et donné des conseils éditoriaux
lors de la création de cette oeuvre.

1.1.5 Contributeurs individuels

Votre nom ici!

1.1.6 Sponsors

• Cape Peninsula University of Technology
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1.1.7 Données

Note: Les données d’exemple utilisées à travers ce manuel peuvent être téléchargées ici:
https://github.com/qgis/QGIS-Training-Data/archive/QGIS-Training-Data-v1.0.zip. Vous pouvez enregistrer les
fichiers dans un répertoire nommé exercise_data.

Les données d’exemple qui accompagnent cette ressource sont disponibles gratuitement et proviennent des sources
suivantes:

• Les jeux de données sur les rues proviennent d’OpenStreetMap (http://www.openstreetmap.org/).

• Les limites de propriétés (urbaines et rurales) et les surfaces en eaux proviennent de NGI
(http://www.ngi.gov.za/).

• Le MEN STRM provient de CGIAR-CGI (http://srtm.csi.cgiar.org/).

1.1.8 Fichiers sources et signalement de bugs

La source de ce document est disponible sur GitHub, dans le dépôt QGIS-Documentation. Consultez GitHub.com
pour les instructions d’utilisation du système de contrôle de versionnement git.

Malgré nos efforts, vous pourriez trouver certaines erreurs ou informations manquantes en suivant ce manuel.
Nous vous remercions de bien vouloir les signaler à https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Dernière version

Vous pouvez toujours obtenir la dernière version de ce document en vous rendant à la version en ligne qui fait
partie du site Web de la documentation de QGIS (http://docs.qgis.org).

Note: Des liens vers les versions en ligne et PDF de la Documentation et des Manuels de formations existent.

Tim Sutton, Mai 2012

1.2 Préparation des données d’exercice

Les données exemples fournies avec le manuel d’apprentissage concerne la ville de Swellendam et ses abords.
Swellendam est située à environ 2 heures à l’est de Cape Town dans l’ouest de l’Afrique du Sud. Les noms des
entités contenues dans le jeu de données sont en Anglais et en Afrikaans.

Tout le monde peut utiliser ce jeu de données sans aucune difficulté mais vous préférerez sans doute utiliser les
données de votre propre pays ou votre propre ville. Si vous choisissez cette voie, vos données propres seront
utilisées dans toutes les leçons du module 3 au module 7.2. D’autres modules utilisent des sources de données
plus complexes qui ne seront peut-être pas disponibles pour votre région.

Note: Ce processus est prévu pour les formateurs ou les utilisateurs plus expérimentés de QGIS qui souhaitent
créer des jeux de données locaux pour leur formation. Les jeux de données par défaut sont fournis avec le manuel
d’exercice mais vous pouvez suivre les instructions qui suivent si vous désirez les remplacer.

Note: Les données d’exemple utilisées à travers ce manuel peuvent être téléchargées ici:
https://github.com/qgis/QGIS-Training-Data/archive/QGIS-Training-Data-v1.0.zip. Vous pouvez enregistrer les
fichiers dans un répertoire nommé exercise_data.
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1.2.1 Try Yourself

Note: Ces instructions supposent que vous avez une bonne connaissance de QGIS et n’ont pas vocation à être
utilisées comme ressource pédagogique.

Si vous voulez remplacer le jeu de données par défaut avec le votre pour la formation, vous pouvez le faire
facilement avec les outils inclus dans QGIS. La région que vous choisissez devrait avoir un mélange correct entre
les zones urbaines et rurales, contenir des routes de différentes classes, des limites administratives (comme les
réserves naturelles ou les fermes) et des surfaces en eau telles que les ruisseaux et les rivières.

• Ouvrez un nouveau projet QGIS

• Dans la liste déroulante du menu Vecteur, sélectionnez OpenStreetMap → Télécharger des données. Vous
pouvez ensuite manuellement entrer les coordonnées de la région qui vous intéresse ou utiliser une couche
existante pour définir ces coordonnées.

• Choisissez un dossier pour sauvegarder le fichier .osm résultant et cliquez Ok:

• Vous pouvez ensuite ouvrir le fichier .osm à l’aide du bouton Ajouter une couche vecteur. Vous pourriez
avoir besoin d’afficher Tous les fichiers dans la fenêtre de l’explorateur. Vous pouvez également opter pour
un glisser-déposer du fichier dans la fenêtre de QGIS.
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• Dans la fenêtre qui s’ouvre, sélectionnez toutes les couches, à l’exception de other_relations et
multilinestrings:

Trois couches dont le nom répond aux conventions de nommage OSM vont être chargées dans

votre carte (vous pourriez avoir besoin de l’outil Zoom Tout pour voir les données vecteur).

Il nous faut extraire les données utiles de ces couches, les renommer et créer les shapefiles correspondants:

• Tout d’abord, faites un double-clic sur la couche multipolygons afin d’ouvrir la fenêtre Propriétés de
la couche

• Dans l’onglet Général, cliquez sur Constructeur de requête pour ouvrir la fenêtre Constructeur de requête.

Cette couche contient trois champs dont nous aurons besoin d’extraire les données qui vont nous servir tout au
long de ce manuel.

• building

1.2. Préparation des données d’exercice 5
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• natural (spécifiquement, l’eau)

• landuse

Vous pouvez interroger un échantillon des données de votre région pour vérifier les résultats retournés. Si vous
trouver que la couche “landuse” ne retourne aucun résultat alors vous pouvez facilement l’exclure.

Vous aurez besoin d’écrire la requête de filtrage pour chaque champ afin d’en extraire les données dont nous avons
besoin. En exemple, nous utiliserons le champ “building”, ici:

• Entrez l’expression suivante dans la zone de texte: building != "NULL" et cliquez sur Tester pour
voir combien d’entités la requête vous retourne en résultat. Si le nombre est trop petit, vous devriez regarder
la Table Attributaire de la couche pour voir quelles données OSM a récupérées dans votre région:

• Cliquez sur Ok et vous verrez que tous les objets de la couche qui ne sont pas building ont été supprimés de
la carte.

Nous avons maintenant besoin de sauvegarder ce résultat dans une couche shapefile que vous utiliserez tout au
long de ce cours:

• Clic droit sur la couche multipolygons et sélectionnez Sauvegarder sous

• Assurez-vous de choisir ESRI Shapefile comme type de fichier et sauvegardez le fichier dans votre
nouveau dossier exercise_data, à l’intérieur d’un autre dossier nommé epsg4326.

• Assurez-vous de ne pas sélectionner Pas de symbologie (la symbologie est une partie du cours que nous
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verrons plus loin).

• Vous pouvez aussi sélectionner Ajouter les fichiers sauvegardés à la carte.

Une fois que la couche buildings a été ajoutée à la carte, vous pouvez répéter la procédure avec les champs
natural et landuse, en utilisant les expressions suivantes:

Note: Assurez-vous de vider le filtre précédent (via la boite de dialogue Propriétés de la couche de la couche
multipolygons avant de créer le prochain filtre d’expression !

• natural: “natural = ‘water”’

• landuse: “landuse != ‘NULL”’

Chaque jeu de données résultant devrait être enregistré dans le répertoire “epsg4326” dans le nouveau répertoire
exercise_data (ex: “water”, “landuse”).

Vous devriez ensuite extraire et enregistrer les champs qui suivent des couches lines et points dans leurs
répertoires respectifs:

• lines: “highway != ‘NULL”’ en roads, et “waterway != ‘NULL”’ en rivers

• points: “place != ‘NULL”’ en places

Une fois que vous avez terminé l’extraction des données, vous pouvez supprimer les couches multipolygons, lines
et points.

Vous devriez avoir maintenant une carte qui ressemble à la suivante (la symbologie peut être modifiée):

L’important est de constater que vous avez 6 couches qui correspondent à celles présentées ci-dessus et que toutes
ces couches ont des données.

La dernière étape consiste à créer un fichier Spatialite à partir de la couche landuse qui sera utilisé durant la
formation:

• Clic droit sur la couche landuse et sélectionnez Sauvegarder sous

• Sélectionnez SpatialLite comme format et sauvegarder le fichier en le nommant landuse dans le répertoire
“epsg4326”.

• Cliquez sur OK.

• Supprimez le fichier landuse.shp et les fichiers qui lui sont reliés (s’ils sont créés).
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1.2.2 Try Yourself Créer des fichiers Tiff du MEN SRTM

Pour le module 6 (création de données vecteur) et le module 8 (Rasters), nous aurons besoin d’images raster (MEN
SRTM) qui couvre la région que vous avez retenue pour la formation.

Le CGIAR-CGI (http://srtm.csi.cgiar.org/) fournit des MNE SRTM que vous pouvez télécharger depuis
http://srtm.csi.cgiar.org/SELECTION/inputCoord.asp.

Vous aurez besoin d’images couvrant entièrement la région que vous avez choisie d’utiliser. Si vous con-
servez les mêmes données que le manuel d’exercices, vous pouvez utiliser l’emprise affichée dans l’image fig-
ure_set_osm_region au dessus, sinon vous devrez adapter votre emprise. Conservez le format GeoTiff. Une
fois le formulaire renseigné, cliquez sur le bouton Click here to Begin Search >> et téléchargez le/les fichier(s).

Une fois que vous avez téléchargé le/les fichier(s) requis, vous devriez les sauvegarder dans le répertoire
exercise_data sous raster/SRTM.

1.2.3 Try Yourself Créer des fichiers Image Tiff

Dans le module 6, la leçon 1.2 montre des images rapprochées de trois stades d’école que les étudiants doivent
numériser. Vous devrez reproduire ces images à l’aide de votre nouveau fichier Tiff du MEN SRTM. Il n’y a pas
d’obligation a utiliser des stades, n’importe quelle utilisation du terrain peut être utilisée (ex: bâtiments scolaires,
cours de récréation ou parkings voiture).

A titre de référence, voici les images du jeu de données d’exemple:
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1.2.4 Try Yourself Remplacement des variables

Une fois que vous avez créé votre jeu de données locales, la dernière étape consiste à remplacer les variables dans
le fichier conf.py de manière à ce que les noms appropriés apparaissent dans votre version localisée du Manuel
d’Exercice.

Les variables qui doivent être remplacées sont les suivantes:

• majorUrbanName: “Swellendam” par défaut. Remplacez cette valeur par le nom de la grande ville de
votre région.

• schoolAreaType1: “atheltics field” par défaut. Remplacez cette valeur avec le nom du type de la plus
grande surface scolaire de votre région.

• largeLandUseArea: “Bontebok National Park” par défaut. Remplacez cette valeur par le nom d’un
grand polygone d’utilisation du terrain de votre région.

• srtmFileName: srtm_41_19.tif par défaut. Remplacez cette valeur avec le nom de fichier de votre
fichier de MEN STRM.

• localCRS: WGS 84 / UTM 34S par défaut. Remplacez cette valeur avec le SCR correct de votre
région.
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CHAPTER 2

Module: L’Interface

2.1 Lesson: Une Brève Introduction

Bienvenue à notre cours ! Au cours des prochains jours, nous vous montrerons comment utiliser facilement et
efficacement QGIS. Si vous êtes nouveau dans les SIG, nous allons vous dire ce dont vous avez besoin pour
commencer. Si vous êtes un utilisateur expérimenté, vous verrez comment QGIS remplit toutes les fonctions que
vous attendez d’un programme de SIG, et bien plus encore !

Dans ce module, nous présentons le projet QGIS lui-même tout en expliquant l’interface utilisateur.

A la fin de cette section, vous serez capable d’identifier les éléments principaux de l’écran de QGIS, saurez ce que
fait chacun d’eux et pourrez charger une couche shapefile dans QGIS.

Warning: Ce cours comprend des instructions sur l’ajout, la suppression et la modification des jeux de
données SIG. Nous avons fourni des ensembles de données de formation à cet effet. Avant d’utiliser les
techniques décrites ici sur vos propres données, assurez vous toujours de disposer des sauvegardes appropriées
!

2.1.1 Comment utiliser ce tutoriel?

Chaque texte qui ressemble à cela fait référence à quelque chose sur l’écran sur lequel vous pouvez cliquer.

Les textes qui ressemblent → à → cela vous dirigent à travers les menus.

Ce type de texte fait référence à quelque chose que vous pouvez taper, comme une commande, un chemin,
ou un nom de fichier

2.1.2 Objectifs de cours à plusieurs niveaux

Ce cours a été réalisé pour différents niveaux de pratique SIG. Selon le niveau dans lequel vous vous situez, les
apports de ces cours seront différents. Chaque niveau contient des informations essentielles pour le suivant, il est
donc important de faire les exercices jusqu’à votre niveau, en commençant par le plus basique.

Basique

Dans cette catégorie, le cours suppose que vous avez peu ou pas d’expérience avec des connaissances SIG
théoriques ou le fonctionnement d’un programme de SIG.

Une formation théorique limitée sera fournie pour expliquer le but de l’action que vous effectuerez dans le pro-
gramme, mais l’accent est mis sur l’apprentissage par la pratique.

11



QGIS Training Manual, Version 2.18

Quand vous aurez fini le cours, vous aurez une meilleure idée des possibilités des SIG, et comment exploiter leur
pouvoir via QGIS.

Intermédiaire

Dans cette catégorie, le cours suppose que vous avez les connaissances et l’expérience d’une utilisation quotidi-
enne des SIG.

En suivant les instructions de niveau basique, vous serez replacé dans un contexte familier et vous pourrez prendre
conscience et apprendre ce qui diffère dans QGIS par rapport à un autre logiciel SIG auquel vous êtes habitué.
Vous apprendrez également comment utiliser les fonctions d’analyse dans QGIS.

Lorsque vous aurez terminé le cours, vous devriez être apte à utiliser toutes les fonctions habituelles qu’un logiciel
SIG propose pour un travail quotidien.

Avancé

Cette catégorie est destinée aux utilisateurs expérimentés avec les SIG et familiers des bases de données spatiales,
sachant utiliser des données provenant de serveurs distants, écrivant peut-être des scripts à des fins d’analyse, etc.

Suivre les instructions des deux autres niveaux vous familiarisera avec la méthode que l’interface de QGIS suit,
et vous assurera de connaître comment accéder aux fonctions de base dont vous aurez besoin. Vous apprendez
également comment utiliser le système d’extensions de QGIS, le système d’accès aux bases de données, et plus
encore.

A la fin du cours, avec ce niveau, vous maîtriserez QGIS pour une utilisation quotidienne même dans ses fonctions
avancées.

2.1.3 Pourquoi QGIS?

Comme l’information intègre de plus en plus la composante spatiale, il ne manque pas d’outils pour remplir
certaines ou toutes les fonctions SIG les plus courantes. Pourquoi devrait-on utiliser QGIS plutôt qu’un autre
logiciel SIG ?

Voici seulement quelques-unes des raisons:

• Gratuit. Installer et utiliser le logiciel QGIS vous coûtera un grand total de 0C. Aucun frais initial, aucun
frais récurent, rien.

• Libre. Si vous avez besoin de fonctionnalités supplémentaires dans QGIS, vous pouvez faire plus que juste
espérer qu’elles soient incluses dans la prochaine version. Vous pouvez parrainer le développement de la
fonctionnalité ou l’ajouter vous-même si vous êtes familier avec la programmation.

• Constamment en développement. Parce que chacun peut ajouter de nouvelles fonctionnalités et améliorer
les existantes, QGIS ne stagne jamais ! Le développement d’un nouvel outil peut arriver aussi rapidement
que votre besoin.

• Une aide et une documentation détaillées disponibles. Si vous êtes bloqué avec quoi que ce soit, vous
pouvez consulter la vaste documentation, les autres utilisateurs de QGIS ou même les développeurs.

• Multi-plateforme. QGIS peut être installé sur MacOS, Windows et Linux.

Maintenant que vous savez pourquoi vous voulez utiliser QGIS, nous allons vous montrer comment. La première
leçon va vous guider dans la création de votre première carte QGIS.
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2.2 Lesson: Ajout de votre première couche

Nous allons lancer l’application, et créer une carte de base à utiliser pour les exemples et les exercices.

Objectif de cette leçon: Démarrer avec une carte d’exemple.

Note: Avant de commencer cet exercice, QGIS doit être installé sur votre ordinateur. En outre, il vous faut
télécharger le fichier training_manual_exercise_data.zip depuis la zone de téléchargement des don-
nées de QGIS.

Lancez QGIS à partir de son raccourci sur le bureau, depuis le menu, etc., selon la façon dont vous avez configuré
son installation.

Note: Les captures d’écran de ce cours ont été prises dans QGIS 2.0 fonctionnant sur MacOS . Selon votre
configuration, les écrans que vous rencontrez peuvent être un peu différents. Cependant, tous les mêmes boutons
seront toujours disponibles, et les instructions sont valables pour n’importe quel OS . Vous aurez besoin de QGIS
2.0 (la dernière version au moment de l’écriture) pour suivre ce cours.

Commençons dès maintenant !

2.2.1 Follow Along: Préparer une carte

• Ouvrez QGIS. Vous aurez une carte vierge.

• Look for the Add Vector Layer button:

• Cliquez dessus pour ouvrir la fenêtre suivante:

• Cliquez sur le bouton Parcourir et naviguez jusqu’au fichier exercise_data/epsg4326/roads.shp
(dans votre répertoire de cours). Avec le fichier sélectionné, cliquez sur Ouvrir. Vous verrez la boîte de
dialogue d’origine, mais avec le chemin du fichier rempli. Cliquez sur Ouvrir. Les données que vous avez
spécifié vont maintenant charger.

Félicitations ! Vous avez désormais une carte de base. Il est maintenant temps de sauver votre travail.
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• Cliquez sur le bouton Sauvegarder sous :

• Sauvegarder la carte sous exercise_data/ et appellez-la basic_map.qgs.

Vérifiez vos résultats

2.2.2 In Conclusion

Vous avez appris à ajouter une couche et créer une carte basique!

2.2.3 What’s Next?

Vous êtes maintenant familier avec la fonction du bouton Ajouter une couche vectorielle, mais qu’en est-il de tous
les autres ? Avant de continuer avec des choses plus compliquées, jetons un coup d’œil à la présentation générale
de l’interface de QGIS. C’est le sujet de la prochaine leçon.

2.3 Lesson: Un Aperçu de l’Interface

Nous allons explorer l’interface utilisateur de QGIS afin que vous soyez familier avec les menus, les barres
d’outils, le canevas de carte et la liste des couches, ces éléments formant la structure de base de l’interface.

Le but de cette leçon: Comprendre les notions de base de l’interface de QGIS.

2.3.1 Try Yourself: Les Notions de Base

Les éléments identifiés sur la figure ci-dessous sont:

1. Légende / Panneau Explorateur

2. Barre d’outils
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3. Canevas de carte

4. Barre d’état

5. Barre d’outils latérale

La Liste de Couches

Dans la liste des couches, vous pouvez voir à tout moment toutes les couches qui sont disponibles dans le projet.

Dérouler les boutons à plusieurs options (en cliquant sur la petite flèche juste à côté du bouton) vous donnera les
différentes fonctions de ses options.

Cliquer sur la couche avec le bouton droit affichera un menu avec plein d’options. Durant ce cours, vous en
utiliserez certaines, alors restez attentifs !

Certaines versions de QGIS ont une boîte de contrôle Ordre des couches juste en dessous de la liste des couches.
Ne vous inquiétez pas si vous ne la voyez pas. Si elle est présente, assurez vous qu’elle est bien cochée.

Note: Une couche vecteur est un jeu de données, généralement d’un seul type d’objets, comme des routes, arbres,
etc. Une couche vectorielle peut contenir soit des points, soit des lignes ou des polygones.

Le panneau de recherche

Le panneau de recherche dans QGIS permet de naviguer simplement dans les données stockées sur votre ordi-
nateur. Vous pouvez accéder aux couches vecteurs (comme des fichiers Shape ou Mapinfo), bases de données
(comme PostGIS, Oracle, Spatialite ou MSSQL Spatial) et connexions WMS/MFS. Vous pouvez également voir
vos données GRASS.

Barres d’Outils

La grande majorité des outils peuvent être accessibles via les barres d’outils. Par exemple, la barre d’outils Fichier
vous permet de sauvegarder, charger, imprimer et créer un nouveau projet. Vous pouvez facilement personnaliser
votre interface pour ne voir que les outils les plus fréquemment utilisés, en ajoutant ou en retirant des barres
d’outils comme nécessaire via le menu Vue → Barres d’outils.

Même s’ils ne sont pas visibles dans la barre d’outils, tous vos outils restent accessibles via les menus. Par
exemple, si vous supprimez la barre d’outils Fichier (qui contient le bouton Sauvegarder), vous pouvez toujours
enregistrer votre carte via le menu Projet puis en cliquant sur Sauvegarder.

Le Canevas de Carte

C’est où la carte elle-même est affichée.

La Barre d’Etat

Vous affiche des informations sur la carte en cours. Permet également d’ajuster l’échelle de la carte et de voir les
coordonnées du curseur de souris sur la carte.
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2.3.2 Try Yourself 1

Essayez d’identifier les quatre éléments listés ci-dessus sur votre écran, sans vous référer au diagramme ci-dessus.
Voyez si vous pouvez retrouver leurs noms et fonctions. Vous vous familiarisez avec ces éléments au fur et à
mesure que vous les utiliserez.

Vérifiez vos résultats

2.3.3 Try Yourself 2

Essayez de retrouver chacun de ces outils dans votre interface. A quoi servent-ils?

1.

2.

3.

4.

5.

Note: Si un de ces outils n’est pas visible à l’écran, essayez d’activer certaines barres d’outils qui sont actuelle-
ment cachées. Gardez à l’esprit que s’il n’y a pas assez d’espace sur l’écran, une barre d’outils peut être raccourcie,
masquant certains de ses outils. Vous pouvez voir les outils cachés en cliquant sur le bouton double flèche à droite
de toute barre d’outils repliée. Vous pouvez voir une info-bulle avec le nom de n’importe quel outil en maintenant
votre souris sur l’outil pendant un certain temps.

Vérifiez vos résultats

2.3.4 What’s Next?

Maintenant que vous avez vu comment fonctionne l’interface de QGIS, vous pouvez utiliser les outils disponibles
et commencer à vous exercer sur votre carte! C’est l’objet de la prochaine leçon.
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CHAPTER 3

Module: Création d’une carte de base

Dans ce module, vous allez créer une carte de base qui servira plus tard de support aux démonstrations des
fonctionnalités de QGIS.

3.1 Lesson: Travailler avec des données vectorielles

Les données vectorielles sont sans doute le type le plus commun de données que vous trouverez dans l’utilisation
quotidienne des SIG. Elles décrivent des données géographiques en termes de points, qui peuvent être connecté à
des lignes et polygones. Chaque objet d’un jeu de données vectorielles est appelé une entité, et est associé à des
données qui décrivent cette entité.

L’objectif de cette leçon : Apprendre à reconnaître la structure des données vectorielles, et la façon de charger
des jeux de données vectorielles sur une carte.

3.1.1 Follow Along: Visualisation des attributs d’une couche

Il est important de comprendre que les données avec lesquelles vous êtes en train de travailler ne montrent pas
seulement où ces objets se trouvent dans l’espace, mais aussi vous informent sur ce que sont ces objets.

De l’exercice précédent, vous devriez avoir chargé la couche roads dans votre carte. Vous pouvez pour l’instant
seulement voir la position des routes.

Pour voir toutes les données qui vous sont disponibles, avec la couche roads sélectionnée dans la légende de la
carte :

• Cliquer sur ce bouton :

Cela vous montrera une table avec plus de données sur la couche roads. Ces données supplémentaires sont
appelées données attributaires. Les lignes que vous pouvez voir sur votre carte représentent où les routes vont ;
ce sont les données spatiales.

Ces définitions sont communément utilisées dans les SIG, c’est pourquoi il est essentiel de s’en souvenir !

• Vous pouvez maintenant fermer la table d’attributs.

Les données vectorielles représentent des entités sous forme de points, lignes et polygones sur un plan de coor-
données. Elles sont habituellement utilisées pour stocker des données discrètes, telles que des routes ou des pâtés
de maisons.
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3.1.2 Follow Along: Chargement des données vectorielles à partir de
shapefiles

Le shapefile est un format de fichier spécifique qui vous permet de stocker des données SIG dans un groupe associé
de fichiers. Chaque couche consiste en plusieurs fichiers avec le même nom, mais différents types de fichiers. Les
shapefiles sont faciles à échanger, et la plupart des logiciels SIG peuvent les lire.

Référez-vous à l’exercice d’introduction dans la section précédente pour les instructions sur comment ajouter des
couches vectorielles.

Chargez les jeux de données du répertoire epsg4326 dans votre carte en utilisant la même méthode:

• « lieux »

• « eau »

• « rivières »

• « bâtiments »

Vérifiez vos résultats

3.1.3 Follow Along: Chargement des données vectorielles à partir d’une
base de données

Les bases de données vous permettent de stocker un large volume de données associées dans un fichier. Vous
pouvez déjà être familier avec un Système de Gestion de Base de Données (SGBD), tel que Microsoft Access.
Les applications SIG peuvent aussi utiliser les bases de données. Les SGBD spécifiques aux SIG (comme PostGIS)
ont des fonctions supplémentaires, car ils ont besoin de gérer des données spatiales.

• Cliquez sur cet icône :

(Si vous êtes certain que vous ne pouvez pas du tout le voir, vérifiez que la barre d’outils Contrôle des couches est
activée.)

Cela va vous ouvrir une nouvelle boîte de dialogue. Dans cette boîte de dialogue :

• Cliquez sur le bouton Nouveau.

• Dans le même répertoire epsg4326 , vous devriez trouver le fichier landuse.sqlite. Sélectionnez-le
et cliquez Ouvrir.

Vous allez maintenant voir à nouveau la première boîte de dialogue. Notez que le menu déroulant de sélection au-
dessus des trois boutons indique à présent “landuse.sqlite@...”, suivi par le chemin du fichier de base de données
sur votre ordinateur.

• Cliquez sur le bouton Connecter. Vous devriez voir ceci dans la case précédemment vide :
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• Cliquez sur la couche landuse pour la sélectionner, puis cliquez sur Ajouter

Note: Souvenez-vous de souvent sauvegarder la carte ! Le fichier de la carte ne contient pas directement les
données, mais il se souvient quelles couches vous aviez chargé dans votre carte.

Vérifiez vos résultats

3.1.4 Follow Along: Réorganisation des calques

Les calques dans votre liste de calques sont dessinés sur la carte dans un certain ordre. Le calque en bas de la
liste est dessiné en premier, et le calque en haut est dessiné en dernier. En changeant leur ordre dans la liste, vous
pouvez changer l’ordre suivant lesquel ils sont dessinés.

Note: En fonction de la version de QGIS que vous utilisez, vous pouvez avoir une case à cocher Contrôle de
l’ordre de rendu des couches en dessous de votre liste de Couches. Celle-ci doit être cochée (activée) afin que le
déplacement des couches vers le bas et vers le haut dans la liste des Couches les déplacera vers le devant ou les
enverra vers l’arrière de la carte. Si votre version de QGIS n’a pas cette option, alors elle est activée par défaut et
vous n’avez pas besoin de vous en inquiétez.

L’ordre dans lequel les couches ont été chargées dans la carte n’est probablement pas logique à ce stade. Il est
possible que la couche des routes soit complètement cachée parce que les autres couches sont au-dessus d’elle.

Par exemple, cet ordre de couche. . .
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... résultera par une absence de visibilité pour les lieux et les routes car elles sont en dessous des aires urbaines.

Pour résoudre le problème :

• Cliquez et glissez sur la couche dans la légende de la carte.

• Réorganiser-les pour obtenir ça :

Vous verrez que la carte a maintenant visuellement plus de sens, avec les routes et les bâtiments qui apparaissent
au-dessus des régions d’utilisation du sol.

3.1.5 In Conclusion

Maintenant vous avez ajouté tous les calques dont vous aviez besoin à partir de plusieurs différentes sources.

3.1.6 What’s Next?

En utilisant la palette de couleur aléatoire automatiquement assignée lors du chargement des couches, votre carte
actuelle n’est sans doute pas facile à lire. Il est donc préférable d’assigner votre propre choix de couleurs et de
symboles aux couches. C’est ce que nous verrons dans la prochaine leçon.
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3.2 Lesson: Symbologie

La symbologie d’une couche correspond à son apparence visuelle sur la carte. La force de base des SIG par
rapport aux autres façons de représenter des données spatiales est qu’avec les SIG, il est possible d’avoir une
représentation visuelle des données avec lesquelles vous travaillez.

Ainsi, l’apparence visuelle de la carte (qui dépend de la symbologie individuelle des couches) est très impor-
tante. L’utilisateur final des cartes que vous produisez a besoin d’être capable de voir facilement ce que la carte
représente. Un aspect tout aussi important est le fait que vous devez être en mesure d’explorer les données avec
lesquelles vous travaillez, et une bonne symbologie aide beaucoup.

En d’autres mots, posséder sa propre symbologie n’est pas un luxe ou tout simplement quelque chose d’agréable
à avoir. En fait, c’est essentiel pour vous d’utiliser un SIG proprement et produire des cartes et informations que
les gens seront en mesure d’utiliser.

Objectif de cette leçon : Être capable de créer n’importe quelle symbologie souhaitée pour n’importe quelle
couche vectorielle.

3.2.1 Follow Along: Modication des couleurs

Pour changer la symbologie d’une couche, ouvrir la fenêtre Propriétés de la couche. Commençons par changer la
couleur de la couche landuse.

• Faites un clic-droit sur la couche landuse dans la zone de légende de la carte.

• Sélectionnez l’élément Propriétés dans le menu qui apparaît.

Note: Par défaut, vous pouvez aussi accéder aux propriétés de la couche en double-cliquant sur la couche dans la
légende.

Dans la fenêtre Propriétés :

• Sélectionnez l’onglet Style à l’extrême gauche :
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• Cliquez sur le bouton pour sélectionner la couleur à côté de l’étiquette Couleur.

Une boîte de dialogue de couleur standard va apparaître.

• Choisissez une couleur grise et cliquez sur OK.

• Cliquez encore sur OK dans la fenêtre Propriétés de couche, et vous verrez le changement de couleur être
appliqué à la couche.

3.2.2 Try Yourself

Changez la couleur de la couche water pour obtenir un bleu clair.

Vérifiez vos résultats

3.2.3 Follow Along: Modification de la structure des symboles

Ce sont de bonnes choses jusqu’à présent, mais il y a plus que juste sa couleur dans la symbologie d’une couche.
Par la suite, nous éliminerons les lignes entre les différentes zones d’utilisation du sol afin de rendre la carte
visuellement moins encombrée.
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• Ouvrez la fenêtre Propriétés de la couche pour la couche landuse.

Sous l’onglet Style, vous allez voir le même type de boîte de dialogue qu’avant. Cette fois, cependant, vous allez
faire plus que juste changer rapidement la couleur.

• Dans l’onglet Couches de Symbole, ouvrez le menu déroulant Remplissage (si nécessaire) et sélectionnez
l’option Remplissage Simple :

• Cliquez sur la liste déroulante Style de la bordure. A ce stade, vous devriez voir une courte ligne et les mots
Ligne continue.

• Changez cette option pour Pas de ligne.

• Cliquez sur OK.

Maintenant, la couche landuse n’aura plus de contours entre ses surfaces.

3.2.4 Try Yourself

• Changez encore la symbologie de la couche water afin d’obtenir une bordure bleue foncée.

• Changez la symbologie de la couche rivers en une représentation sensible des cours d’eau.

Vérifiez vos résultats
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3.2.5 Follow Along: Visibilité dépendante de l’échelle

Parfois, vous trouverez que la couche ne fonctionne pas pour une échelle donnée. Par exemple, un jeu de données
de tous les continents peut avoir peu de détails, et ne pas être très précis au niveau d’une rue. Quand cela se passe,
vous voulez être capable de cacher le jeu de données aux échelles inappropriées.

Dans notre cas, nous pouvons décider de cacher les bâtiments pour une vue à petite échelle. Cette carte, par
exemple ...

... n’est pas très utile. Les bâtiments sont difficiles à distinguer à cette échelle.

Pour autoriser le rendu selon l’échelle :

• Ouvrez la boîte de dialogue Propriétés de couche pour la couche buildings.

• Activez l’onglet Général.

• Activez le rendu selon l’échelle en cliquant sur la case à cocher intitulée Visibilité dépendante de l’échelle :
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• Changez la valeur Minimum à 1:10’000.

• Cliquez sur OK.

Testez les effets sur cela en zoomant et dézoomant sur votre carte, en notant quand la couche buildings disparaît
et réapparaît.

Note: Vous pouvez utiliser votre molette de souris pour zoomer par incrément. Une alternative est d’utiliser
l’outil de zoom pour zoomer sur une fenêtre.

3.2.6 Follow Along: Ajout de couches de symbole

Maintenant que vous savez comment changer une simple symbologie pour des couches, la prochaine étape est de
créer des symbologies plus complexes. QGIS vous permet de faire cela en utilisant les couches de symboles.

• Retournez au panneau des propriétés de symbole de couche landuse (en cliquant sur Remplissage simple
dans le panneau guilabel:Couches de symboles).

Dans cet exemple, le symbole courant n’a pas de bordure (c’est-à-dire que le style de bordure Pas de crayon est
utilisé).
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Sélectionnez le Remplissage dans le panneau Couches de symboles. Puis cliquez sur le bouton Ajouter une couche
de symbole :

• Cliquez dessus et la boîte de dialogue changera pour ressembler à quelque chose comme ça :
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(La couleur n’est peut-être pas la même sur votre ordinateur, mais de toutes manière elle va être changée)

Désormais, vous avez deux couches de symbole. La nouvelle étant de remplissage continu, elle masquera com-
plètement l’ancienne. De plus, elle possède un style de bordure Ligne continue, que nous ne voulons pas. Actuelle-
ment, ce type de symbole n’est clairement pas ce que l’on souhaite et doit être changé.

Note: Un point très important est de ne pas confondre une couche et une couche de symbole. Une couche est un
ensemble de vecteurs (ou une image raster) qui a été chargé dans la carte. Une couche de symbole est une partie
des symboles utilisés pour représentés la couche. Dans ce cours, nous ferons toujours la distinction et ce, pour
éviter toute confusion.

Avec la nouvelle couche Remplissage simple sélectionnée :

• Mettez le style de bordure à Pas de crayon, comme avant.

• Changez le style de remplissage avec quelque chose d’autre que Continu ou Pas de brosse. Par exemple :
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• Cliquez sur OK. Maintenant, vous pouvez voir vos résultats et les modifier si besoin.

Vous pouvez même ajouter plusieurs couches de symbole supplémentaires et ainsi créer un type de texture pour
votre couche.
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Joli ! Mais il y a trop de couleurs pour pouvoir l’utiliser dans une belle carte.

3.2.7 Try Yourself

• En vous souvenant de zoomer si nécessaire, créez, avec la méthode que nous venons de voir, une texture
simple et efficace pour la couche des bâtiments buildings.

Vérifiez vos résultats

3.2.8 Follow Along: Classement des niveaux de symbole

Quand des couches de symboles sont dessinées, elles sont, tout comme des couches, dessinées dans un certain
ordre. Dans certains cas, des résultats inattendus peuvent apparaître avec plusieurs couches de symboles.

• Ajoutez une couche de symbole supplémentaire à la couche roads (en utilisant la méthode apprise ci-dessus).

• Ajustez l’épaisseur du trait de la couche roads à 0.3 mm, avec une couleur blanche et une Ligne en tiret
dans la liste déroulante Style de crayon.

• Donnez à cette nouvelle couche de symbole une épaisseur de 1.3 mm et assurez vous que ce soit une Ligne
continue.

Ce qui devrait donner celà :
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Et ce n’est pas du tout ce que nous souhaitions !

Pour éviter que celà advienne, vous pouvez trier les niveaux de symboles et ainsi choisir dans quel ordre les
couches de symboles se dessinent.

To change the order of the symbol layers, select the Line layer in the Symbol layers panel, then click Advanced →
Symbol levels... in the bottom right-hand corner of the window. This will open a dialog like this:
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Cochez Activer les niveaux de symbole. Vous pouvez désormais ordonner vos niveaux de symbole en saisissant le
numéro de niveau correspondant, 0 étant la plus basse.

Dans notre cas, nous voulons inverser l’ordre, comme ceci :
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Les lignes pointillées blanches apparaîtront au dessus de l’épais trait noir.

• Cliquez deux fois sur OK pour retourner à la carte.

La carte doit maintenant ressembler à cela :
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Notez également que les croisements des routes sont désormais “fusionnés”, une route n’est pas dessinée au dessus
d’une autre.

Lorsque vous aurez fini, vous pouvez sauvegarder votre style de symbole lui-même pour l’appliquer à d’autres
couches plus tard. Pour ce faire, cliquez sur Enregistrer le style –> Fichier de style de couche QGIS en bas à droite
de la fenêtre Propriétés de la couche.

Sauvegardez votre style de symbole sous exercise_data/styles. Pour le charger quand vous le souhaitez,
appuyez simplement sur le bouton Charger le Style. Avant de changer un style, gardez bien à l’esprit qu’un style
non sauvegardé remplacé par un autre sera perdu.

3.2.9 Try Yourself

• Changez encore une fois l’apparence de la couche roads.

Les routes doivent être fines et gris moyen, avec un fin contour jaune pâle. Souvenez-vous que vous pouvez
changer le niveau des couches de symboles via le menu Avancé → Niveau de symboles.
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Vérifiez vos résultats

3.2.10 Try Yourself

Les niveaux de symbole fonctionnent également pour les couches classées (c’est-à-dire les couches ayant plusieurs
symboles). Puisque nous n’avons pas encore abordé la classification, vous allez travailler avec des données pré-
classées rudimentaires.

• Créez une nouvelle carte et ajoutez seulement le jeu de données roads.

• Appliquez le style advanced_levels_demo.qml qui vient de exercise_data/styles.

• Zoomez sur la zone Swellendam.

• Grâce aux couches de symboles, créez une carte où les intersections des routes semblent connectées les unes
avec les autres comme dans l’image suivante :
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Vérifiez vos résultats

3.2.11 Follow Along: Types de couches de symbole

En plus de définir les couleurs et des styles prédéfinis, vous pouvez également utiliser différents types de symboles.
Le seul type utilisé jusque là est le Remplissage simple. D’autres types plus avancés permettent de personnaliser
encore plus vos styles.

Chaque type de vecteur (point, ligne et polygone) a son propre set de types de couche de symbole. Premièrement,
nous allons voir les différents types possibles pour les points.

Types de couches de symbole de point

• Ouvrez votre projet basic_map.

• Changez les propriétés du symbole pour la couche places :
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• Vous pouvez accéder aux différents types de symboles en sélectionnant l’élément Marqueur simple dans le
panneau Symboles de couches et en cliquant ensuite sur le menu déroulant Type de symbole de couche:

• Étudiez les différentes options qui s’offrent à vous, et choisissez un symbole avec un style que vous pensez
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approprié.

• En cas de doute, utilisez un Symbole simple en rond avec un bord blanc et un remplissage vert pâle, avec
une taille de 3,00 et une Largeur de bordure externe de 0.5.

Types de couches de symbole de ligne

Pour voir les différentes options disponibles pour les données lignes :

• Changez le Type de symbole pour la couche des routes roads et choisissez le type situé tout en haut de la
liste déroulante Ligne de symboles :

• Sélectionnez la couche Symbole simple dans le panneau Couches de symbole. Changez les propriétés du
symbole pour que ça corresponde à cette boîte de dialogue :
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• Changez l’intervalle à 1,00 :
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• Ensure that the symbol levels are correct (via the Advanced → Symbol levels dialog we used earlier) before
applying the style.

Une fois appliqué, visualisez le résultat sur la carte. Comme vous pouvez l’observer, ces symboles suivent les
directions des routes mais ne les suivent pas parfaitement partout. Cet aspect peut être utile dans certains cas, dans
d’autres pas du tout. Si vous préfériez le style précédent, vous pouvez lui affecter de nouveau son style d’origine.

Types de couches de symbole de polygone

Pour voir les différentes options possibles pour les données polygones :

• Changez le type de couche de symbole pour la couche water, comme avant pour les autres couches.

• Étudiez ce que les différentes options de la liste peuvent faire.

• Choisissez l’une d’entre elles que vous trouvez adéquate.

• Si vous doutez, utilisez le Motif de point avec les options suivantes :
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• Ajoutez une nouvelle couche de symbole avec un Remplissage simple normal.

• Mettez-lui le même bleu clair avec une bordure bleu foncé.

• Déplacez-la sous la couche de symbole en motif de points à l’aide du bouton Descendre.
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Par conséquent, vous avez un symbole texturé pour la couche de l’eau, avec le bénéfice supplémentaire que vous
pouvez changer la taille, la forme et la distance des pointillés individuels qui composent la texture.

3.2.12 Follow Along: Créer un remplissage SVG personnalisé

Note: Pour faire cet exercice, vous aurez besoin d’installer le logiciel gratuit d’édition vectorielle Inkscape.

• Démarrez le programme Inkscape.

Vous verrez l’interface suivante:
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Vous pouvez la trouver familière si vous avez utilisé d’autres programmes d’édition d’image vectorielle, comme
Corel.

Premièrement, nous allons changer le canevas à une taille appropriée pour une petite texture.

• Cliquez sur l’élément du menu File → Document Properties. Cela vous ouvrira la boîte de dialogue Pro-
priétés du document .

• Changez les Unités en px.

• Changez la Largeur et la Hauteur à 100.

• Fermez la boîte de dialogue quand c’est fait.

• Cliquez sur l’élément du menu Vue → Zoom → Page pour voir la page sur laquelle vous êtes en train de
travailler.

• Sélectionnez l’outil Cercle.
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• Cliquez et faites glisser sur la page pour dessiner une ellipse. Pour que l’ellipse devienne un cercle, tenez
appuyé le bouton ctrl pendant que vous dessinez.

• Faites un clic droit sur le cercle que vous venez de créer et ouvrez Remplissage et Contour Vous pouvez
modifier son apparence, comme par exemple:

– Changez la couleur de Remplissage pour obtenir un bleu clair,

– Choisissez une couleur plus sombre pour le contour dans l’onglet Stroke paint,

– Et réduisez l’épaisseur de la bordure dans l’onglet Stroke style
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• Dessinez une ligne en utilisant l’outil Crayon:

– Cliquez une fois pour débuter la ligne. Maintenez la touche Ctrl pour limiter les angles à 15 degrés.

– Déplacez le pointeur horizontalement et placez le point avec un simple clic.

– Cliquez et accrochez-vous au sommet de la ligne et tracez une ligne verticale, terminée par un clic
simple.

– Maintenant, rassemblez les deux sommets terminaux.

– Modifiez la couleur et la largeur du symbôle de triangle pour correspondre au trait du cercle et
déplacez-le autour de manière à obtenir un symbole qui ressemble au suivant:
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• Si le symbole vous convient, sauvegardez-le en tant que landuse_symbol dans le répertoire de l’exercice,
sous le répertoire exercise_data/symbols, en tant que fichier SVG.

Dans QGIS :

• Ouvrez les Propriétés de la couche pour la couche landuse.

• Dans le panneau Style, modifiez la structure du symbole en sélectionnant Remplissage SVG dans :le
guilabel:Type de Couche de Symbole , comme indiqué ci-dessous.

• Cliquez sur le bouton de Navigation pour sélectionner votre image SVG. Elle est ajoutée à l’arbre des
symboles et vous pouvez maintenant personnaliser ces différentes caractéristiques (couleurs, angle, effets,
unités, etc.).
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Vous pouvez également mettre à jour les bordures de la couche svg (voir ci-dessous):
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Une fois que vous avez validé la boîte de dialogue, les entités de la couche landuse devraîent maintenant être
couverte par un ensemble de symbole, affichant une texture comme celle de la carte suivante. Si les textures ne
sont pas visibles, vous aurez sans doute besoin de zoomer dans le canevas de carte ou indiquer dans les propriétés
de la couche une plus grande Largeur de texture.
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3.2.13 In Conclusion

Changer la symbologie des différentes couches a transformé un empilement de vecteurs en une belle carte lisible.

3.2.14 Further Reading

Exemples de Belles Cartes

3.2.15 What’s Next?

Changer la symbologie pour une couche entière est utile, mais l’information contenue dans chaque couche n’est
pas disponible pour quelqu’un qui lit la carte. Comment se nomment les rues ? A quelles régions ces zones appar-
tiennent ? Quelles sont les surfaces des exploitations agricoles ? Toutes ces informations sont encore invisibles.
La prochaine leçon expliquera comment représenter ces données sur une carte.

Note: Avez-vous pensé à sauvegarder votre carte récemment ?
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CHAPTER 4

Module: Classer des données vectorielles

La classification des données vectorielles vous permet d’attribuer différents symboles aux entités (différents objets
dans la même couche), dépendamment de leurs attributs. Cela permet à quelqu’un qui utilise la carte de voir
facilement les attributs des différentes entités.

4.1 Lesson: Données Attributaires

Jusqu’à maintenant, aucune des modifications que nous avons apportées à la carte ont été influencées par les objets
qui sont représentés. En d’autres termes, toutes les zones d’occupation du sol se ressemblent, et toutes les routes
également. En regardant la carte, les observateurs ne savent rien à propos des routes qu’ils regardent ; seulement
qu’il y a une route d’une certaine forme à un certain endroit.

Mais toute la force des SIG est que tous ces objets visibles sur la carte ont également des attributs. Des cartes dans
un SIG ne sont pas uniquement des images. Elles ne représentent pas seulement des objets dans des endroits, mais
également des informations sur ces objets.

Objectif de cette leçon : Explorer les données attributaires d’un objet et comprendre pour quoi les différentes
données peuvent être utilisées.

4.1.1 Follow Along: Données Attributaires

Ouvrez la table attributaire de la couche places (référez-vous si nécessaire à la section “Travailler avec les Don-
nées Vecteurs”). Quel champ sera le plus utile à représenter sous forme d’étiquette, et pourquoi ?

Vérifiez vos résultats

4.1.2 In Conclusion

Vous savez maintenant comment utiliser la table d’attributs pour étudier les données que vous utilisez. Les jeux de
données seront seulement intéressants lorsqu’ils comporteront des attributs qui vous concerne. Si vous savez de
quels attributs vous avez besoin, vous pouvez savoir rapidement si vous serez capable d’utiliser un jeu de données
spécifiques ou si vous avez besoin d’un autre qui dispose des données nécessaires.

4.1.3 What’s Next?

Des différents attributs sont utiles à différentes fins. Certains d’entre eux peuvent être représentés directement
sous forme de texte dans la carte que voit l’utilisateur. Vous apprendrez comment faire cela dans la prochaine
leçon.
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4.2 Lesson: L’outil Étiquette

Des étiquettes peuvent être ajoutées à une carte pour afficher de l’information sur un objet. N’importe quelle
couche vecteur peut avoir des étiquettes qui lui sont associées. Le contenu de ces étiquettes repose sur les données
attributaires de la couche.

Note: La fenêtre Propriétés de la couche dispose d’un onglet Étiquettes qui offre maintenant les mêmes fonc-
tionnalités, mais pour cet exemple, nous utiliserons l’outil Étiquette accessible via une barre d’outils.

Le but de ce cours: Appliquer des étiquettes utiles, jolies et lisibles à une couche.

4.2.1 Follow Along: Utilisation d’étiquettes

Avant de pouvoir accéder à l’outil Étiquette, vous devez vous assurer de l’avoir activé.

• Allez au menu Vue → Barres d’outils.

• Assurez-vous que la case à côté du libellé Étiquette est cochée. Si elle ne l’est pas, Cliquez sur le libellé
Étiquette et ce sera activé.

• Cliquez sur la couche places dans la Liste de couches pour la mettre en surbrillance.

• Cliquez sur le bouton suivant:

Ceci vous ouvre la fenêtre Paramètres d’étiquetage de la couche.

• Cochez la case à côté de Étiqueter cette couche avec....

Il vous faudra choisir le champ de la table d’attributs qui sera utilisé pour les étiquettes. Dans le cours précédent,
vous avez décidé que le champ NAME était le plus approprié pour un tel objectif.

• Sélectionnez name dans la liste:
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• Cliquez sur OK.

La carte devrait maintenant afficher des étiquettes comme ceci:
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4.2.2 Follow Along: Modification des Options d’Étiquetage

Selon les styles que vous avez choisis pour votre carte dans les leçons précédentes, vous trouverez peut-être que
les étiquettes ne sont pas correctement formatés ou se chevauchent ou encore sont trop éloignés de leurs points de
référence.

• Ouvrez la fenêtre Paramètres d’étiquetage de la couche une nouvelle fois en cliquant sur le bouton comme
précédemment.

• Assurez-vous que Texte est sélectionné dans la liste d’options à gauche, puis mettez à jour les options de
formattage de texte pour les faire correspondre à celles montrées ci-dessous:
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Le problème de la police est résolu! Maintenant, examinons la question des étiquettes qui chevauchent les points,
mais avant cela, jetons un coup d’oeil à l’option Tampon.

• Ouvrez la fenêtre Paramètres d’étiquetage de la couche.

• Sélectionnez Tampon dans la liste d’options en partie gauche.

• Sélectionnez la case à cocher à côté de Affiche un tampon, puis choisissez les options qui correspondent aux
suivantes:
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• Cliquez sur Appliquer.

Vous constaterez que cela ajoute une bordure ou un tampon coloré autour des étiquettes des places, les rendant
plus faciles à repérer sur la carte:
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Maintenant, nous pouvons aborder le positionnement des étiquettes par rapport à leurs points de repères.

• Dans la fenêtre Paramètres d’étiquetage de la couche, allez à l’onglet Emplacement.

• Modifiez la valeur Distance à 2mm et assurez-vous que Autour du point est sélectionné:
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• Cliquez sur Appliquer.

Vous verrez que les étiquettes ne chevauchent plus désormais les points.

4.2.3 Follow Along: Utiliser des étiquettes à la place de symboles de
couche

Dans de nombreux cas, l’emplacement d’un point n’a pas besoin d’être très précis. Par exemple, la plupart des
points dans la couche places se réfère à des villes entières ou des banlieues, et le point spécifiquement associé à
de telles entités n’est pas si précis à une grande échelle. En fait, donner un point trop précis est souvent déroutant
pour quelqu’un qui lit une carte.

Par exemple: sur une carte du monde, le point indiquant l’Union Européenne peut être quelque part en Pologne,
par exemple. Pour quelqu’un qui lit la carte, voir un point marqué Union Européenne en Pologne peut sembler
vouloir dire que la capitale de l’Union Européenne est donc en Pologne.

Aussi, pour prévenir ce genre d’incompréhension, il est souvent utile de désactiver les symboles de points et les
remplacer complètement par les étiquettes.

Dans QGIS, vous pouvez faire ça en positionnant l’étiquette directement à la place du point auquel elle se réfère.

• Ouvrez la fenêtre Paramètres d’étiquetage de la couche de la couche places.

• Sélectionnez l’option Emplacement dans la liste d’options.
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• Cliquez sur le bouton Autour du point.

Ceci va révéler les options Quadrant que vous pourrez utiliser pour définir la position de l’étiquette par rapport
au marqueur de point. Dans le cas-ci, nous souhaitons centrer l’étiquette sur le point donc choisissez le centre du
quadrant:

• Cachez les symboles de point en éditant le style de couche comme d’habitude, et en mettant la hauteur et la
largeur du symbole d’ellipse à 0:
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• Cliquez sur OK et vous obtiendrez ce résultat:
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Si vous effectuiez un zoom arrière sur la carte, vous verriez que la plupart des étiquettes disparaissent à une
échelle plus grande afin d’éviter les chevauchements. Parfois, c’est ce qui est souhaité lorsqu’il s’agit de données
avec beaucoup de points, mais d’autres fois cette façon vous fera perdre des informations utiles. Il y a une autre
possibilité pour le traitement de cas comme celui-ci, que nous verrons dans un exercice plus tard dans cette leçon.

4.2.4 Try Yourself Personnaliser les étiquettes

• Revenez dans les préférences des étiquettes et des symboles pour mettre un symbole en point et un décalage
des étiquettes de 2.00mm. Vous pouvez ajuster le style du symbole en point ou les étiquettes à ce stade.

Vérifiez vos résultats

• Définissez l’échelle de carte à 1:100000. Vous pouvez le faire en le saisissant directement dans la case
Échelle de la Barre d’Etat.

• Modifiez vos étiquettes pour les rendre cohérentes avec cette échelle de lecture.

Vérifiez vos résultats
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4.2.5 Follow Along: Étiquetage de Lignes

Maintenant que vous comprenez le fonctionnement de l’étiquetage, il y a un nouveau problème. Points et poly-
gones sont faciles à étiqueter, mais qu’en est-il des lignes? Si vous les étiquetez de la même manière que les
points, vos résultats devraient ressembler à quelque chose comme ceci:

Nous allons reparamétrer les étiquettes de la couche roads afin qu’elles soient faciles à comprendre.

• Cachez la couche Places afin qu’elle ne vous perturbe pas.

• Activez les étiquettes de la couche streets comme avant.

• Mettez la Taille de police à 10 afin de voir le plus d’étiquettes.

• Zoomez sur l’étendue de la ville Swellendam.

• Dans la fenêtre Etiquette, allez à l’onglet Emplacement et choisissez les paramètres suivants.
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Vous verrez probablement que le style de texte a utilisé les valeurs par défaut et les étiquettes sont par conséquent
très difficiles à lire. Définissez le format de texte d’étiquette avec une Couleur gris foncé ou noir et un Tampon
jaune clair.

Selon l’échelle, la carte devrait ressembler à peu près à ceci:
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Vous verrez que certains noms de voies apparaissent plus d’une fois sans que ce ne soit toujours nécessaire. Pour
empêcher cela:

• Dans la fenêtre Paramètres d’étiquetage de la couche, choisissez l’option Rendu et sélectionnez Fusionner
les lignes connectées pour éviter la duplication d’étiquettes:
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• Cliquez sur OK.

Une autre fonction utile permet d’empêcher l’affichage des entités trop courtes pour être indiquées.

• Dans le même panneau Rendu, définissez à 5mm la valeur de Ne pas afficher d’étiquettes pour les entités
plus petites que et regardez le résultat lorsque vous cliquez sur Appliquer.

Essayez d’autres options Emplacement. Comme vu précédemment, l’option horizontal n’est pas approprié dans
ce cas-ci, alors essayons l’option Courbé à la place.

• Sélectionnez l’option Courbé du panneau Placement de la fenêtre Paramètres d’étiquetage de la couche.

Voici le résultat:
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Comme vous pouvez le constater, cela cache un grand nombre des étiquettes qui étaient précédemment visible
à cause de la difficulté de les faire suivre les lignes tordues des rues et être suffisamment lisibles. Vous pouvez
choisir d’utiliser une de ces options selon ce que vous pensez être le plus utile ou ce qui rend le mieux.

4.2.6 Follow Along: Valeurs définies par des données

• Désactivez l’étiquetage pour la couche Streets.

• Réactivez l’étiquetage pour la couche Places.

• Ouvrez la table d’attributs de la couche Places via le bouton .

Il contient un champ qui nous intéresse maintenant: place qui définit le type d’espace urbain de chaque entité.
Nous pouvons utiliser cette donnée pour influencer le style des étiquettes.

• Naviguez jusqu’au panneau Texte dans le panneau places Étiquette.

• Dans la liste déroulante Italique, sélectionnez Editer afin d’ouvrir la fenêtre Constructeur de chaine
d’expression:
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Dans la zone de texte, saisissez : "place" = ’town’ et cliquez deux fois sur Ok:
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Remarquez ces effets:
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4.2.7 Try Yourself Utiliser les Valeurs définies par des données

Note: Nous allons aller un peu plus loin ici pour vous présenter quelques paramètres avancés d’étiquetage. A ce
niveau avancé, nous assumons que vous avez suffisamment de connaissances sur le sujet pour comprendre ce qui
va suivre. Si ce n’est pas le cas, quittez cette section et revenez plus tard lorsque vous aurez étudiez les pré-requis.

• Ouvrez la table d’attributs de la couche Places.

• Enter edit mode by clicking this button:

• Ajoutez une nouvelle colonne:

• Configurez-le comme ceci:
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• Utilisez ceci pour définir des tailles de police personnalisées pour chaque différent type de place (c’est-à-
dire, pour chaque valeur clé du champ PLACE).

Vérifiez vos résultats

4.2.8 Possibilités Avancées de l’étiquetage

Nous ne pouvons couvrir toutes les options dans ce cours mais sachez que l’outil Etiquette offre beaucoup d’autres
fonctions utiles. Vous pouvez définir le rendu selon l’échelle, modifier les propriétés de redu des étiquettes d’une
couche et chaque option d’étiquette à l’aide des attributs de la couche. Vous pouvez même définir une rotation,
une position XY et d’autres propriétés de l’étiquette (si vous avez des champs attributaires qui s’y prêtent), puis
modifier ces propriétés à l’aide des outils adjacents à l’outil principal de la barre d’outils Etiquette:

(Ces outils seront actifs tant que les champs requis existent dans la table d’attributs et que vous êtes en mode
édition.)

N’hésitez pas à explorer les diverses possibilités offertes par le système d’étiquetage.

4.2.9 In Conclusion

Vous avez appris comment utiliser les attributs d’une couche pour créer des étiquettes dynamiques. Cela peut
rendre votre carte plus informative et plus élégante.
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4.2.10 What’s Next?

Maintenant que vous savez comment les attributs peuvent apporter une différence visuelle à votre carte, que diriez-
vous de les utiliser pour changer la symbologie des objets eux-mêmes ? C’est l’objet de la leçon suivante!

4.3 Lesson: Classification

Les étiquettes sont un bon moyen de communiquer de l’information, comme les noms des places, mais elles ne
peuvent pas être utilisées pour n’importe quoi. Par exemple, disons que quelqu’un veut savoir pour quoi chaque
domaine d’utilisation des terres est utilisé. En utilisant les étiquettes, vous obtiendrez ceci :

Cela rend les étiquettes de la carte difficiles à lire car trop nombreuses si vous avez de nombreuses utilisation du
territoires différentes à afficher.

Objectif de cette leçon : Apprendre comment classifier des données vectorielles efficacement.

4.3.1 Follow Along: Classification de données nominales

• Ouvrez la boîte de dialogue Propriétés de couche de la couche landuse.

• Rendez-vous à l’onglet Style.

• Cliquez sur le menu déroulant qui indique Symbole unique et changez-le en Categorisé:
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• Dans le nouvel onglet, changez la Colonne en landuse et la Palette de couleur en Verts.

• Cliquez sur le bouton étiqueté Classer :
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• Cliquez sur OK.

Vous verrez quelque chose comme ça :
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• Cliquez sur la flèche (ou le signe plus) à côté de landuse dans la Légende de la carte, vous verrez les
catégories expliquées :

Maintenant, nos polygones d’utilisation du territoire sont coloriés de manière appropriée et sont classifiés de
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manière à ce que les surfaces d’un même type de territoire soient de la même couleur. Vous pouvez supprimer la
bordure noire la couche landuse:

• Ouvrez les Propriétés de la couche, rendez-vous à l’onglet Style et sélectionnez Symbole.

• Changez le symbole en enlevant la bordure de la couche Remplissage simple et cliquez sur OK.

Vous verrez que les bordures des polygones d’utilisation du sol ont été supprimées, en laissant seulement nos
nouveaux remplissage de couleur pour chaque catégorisation.

• Si vous le désirez, vous pouvez changer le remplissage de couleur pour chaque zone d’occupation du sol en
double-cliquant le bloc de couleur correspondant.

Notez qu’il y a une catégorie qui est vide :
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Cette catégorie vide est utilisée pour colorer les objets qui n’ont pas de valeur d’occupation du sol définie ou
qui ont une valeur NULL. C’est important de garder cette catégorie vide afin que les zones qui ont une valeur
NULL soient toujours représentées sur la carte. Vous pouvez changer la couleur pour représenter de manière plus
évidente un blanc ou une valeur NULL.

Souvenez-vous de sauvegarder votre carte maintenant afin que vous ne perdiez pas toutes vos modifications dure-
ment gagnées !

4.3.2 Try Yourself Plus de classification

Si vous suivez seulement le niveau de base, utilisez les connaissances que vous avez acquises au-dessus de classer
la couche buildings. Configurez la catégorisation avec la colonne building et utilisez la palette de couleur Spectral.

Note: Rappelez-vous de zoomer sur une zone urbaine pour voir les résultats.

4.3.3 Follow Along: Classification de ratio

Il y a quatre types de classification : nominale, ordinale, d’intervalle et de ratio.
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Dans la classification nominale, les catégories dans lesquelles les objets sont classés sont basées sur des noms ;
elles n’ont pas d’ordre : noms de ville, codes de district, etc.

Dans la classification ordinale, les catégories sont organisées dans un certain ordre. Par exemple, les villes du
monde ont un rang en fonction de leur importance dans le commerce mondial, le voyage, la culture, etc.

Dans la classification d’intervalle, les nombres sont sur une échelle avec des valeurs positives, négatives et nulles.
Par exemple : hauteur au-dessus/au-dessous du niveau de la mer, température au-dessus/au-dessous de la congéla-
tion (0 degré Celsius), etc.

Dans la classification de ratio, les nombres sont sur une échelle avec uniquement des valeurs positives et nulles.
Par exemple : température au-dessus du zéro absolu (0 degré Kelvin), distance d’un point, le trafic moyen sur une
route donnée par mois, etc.

Dans l’exemple ci-dessus, nous utilisons la classification nominale pour attribuer chaque ferme la ville par laquelle
il est administré. Nous utiliserons maintenant une classification de ratio pour classer les fermes par zone.

• Sauvegardez votre symbologie de l’occupation du sol (si vous voulez la garder) en cliquant sur le bouton
Sauvegarder le style... dans la boîte de dialogue Style.

Nous allons reclasser la couche, donc les classes existantes seront perdues si elles n’ont pas été sauvegardées.

• Fermez la boîte de dialogue Style.

• Ouvrez la Table attributaire de la couche landuse.

Nous voulons classer les zones d’occupation du sol par taille, mais il y a un problème : elles n’ont pas de champ
de taille, nous allons donc en créer un.

• Entrez en mode d’édition en cliquant sur ce bouton :

• Ajoutez une nouvelle colonne avec ce bouton :

• Configurez la boîte de dialogue qui apparaît, comme ceci :
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• Cliquez sur OK.

Le nouveau champ sera ajouté (à l’extrême droite de la table ; vous devez la faire défiler horizontalement pour le
voir). Cependant, il n’est à ce moment pas rempli, il y a uniquement des valeurs NULL partout.

Pour résoudre ce problème, nous devrons calculer les aires.

• Ouvrez la calculatrice de champ :

Vous obtiendrez cette boîte de dialogue :
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• Changez les valeurs en haut de la boîte de dialogue pour qu’elle ressemble à cela :

• Dans la Liste des fonctions, sélectionnez Géométrie → $area:
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• Double-cliquez dessus pour qu’il apparaisse dans le champ Expression.

• Cliquez sur OK.

Votre champ AREA est maintenant rempli avec des valeurs (vous pouvez avoir besoin de cliquer sur l’en-tête de la
colonne pour actualiser les données). Sauvegardez les modifications et cliquez sur Ok.

Note: Ces aires sont en degrés. Plus tard, nous les calculerons en mètres carrés.

• Ouvrez l’onglet Style de la boîte de dialogue Propriétés de la couche.

• Changez le style de la classification de Catégorisé à Gradué.

• Changez la Column en AREA :

• Sous Palette de couleur, choisissez l’option Nouvelle palette de couleur... pour obtenir cette boîte de dia-
logue :
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• Choisissez Gradient (s’il n’est pas déjà sélectionné) et cliquez sur OK. Vous verrez ceci :
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Vous utiliserez ceci pour désigner la zone, avec des petites zones comme Couleur 1 et des grandes zones comme
Couleur 2.

• Choisissez les couleurs appropriées.

Dans cet exemple, le résultat doit ressembler à cela :

82 Chapter 4. Module: Classer des données vectorielles



QGIS Training Manual, Version 2.18

• Cliquez sur OK.

• Choisissez un nom approprié pour la nouvelle palette de couleur.

• Cliquez sur OK après avoir rempli le nom.

Vous aurez maintenant quelque chose comme ça :
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Laissez tout le reste tel quel.

• Cliquez sur Ok :
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4.3.4 Try Yourself Affiner la Classification

• Éliminez les lignes entres les classe.

• Modifiez les valeurs Mode et Classes jusqu’à obtention d’une classification qui ait du sens.

Vérifiez vos résultats

4.3.5 Follow Along: Classification basée sur des règles

Il est souvent utile de combiner plusieurs critères pour une classification, mais une classification normale ne prend
malheureusement d’un seul attribut en compte. C’est là que la classification basée sur de règles est très pratique.

• Ouvrez la boîte de dialogue Propriétés de couche de la couche landuse.

• Passez à l’onglet Style.

• Passez le style de la classification en Ensemble de règles. Vous obtiendrez ceci :
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• Cliquez le bouton Ajout règle : .

• Une nouvelle boîte de dialogue apparaît :

• Cliquez sur le bouton de points de suspension ... à côté de la zone de texte Filtre.

• Utilisez le constructeur de requête qui apparaît, entrez le critère "landuse" = ’residential’ ET
"name" != ’ |majorUrbanName| ’, cliquez sur Ok et choisissez un bleu-gris pâle pour celui-ci et
enlevez la bordure :
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• Ajoutez d’un nouveau critère "landuse" != ’residential’ AND "AREA" >= 0.00005 et
choisissez une couleur vert moyen.

• Ajoutez un autre nouveau critère "name" = ’ |majorUrbanName| ’ et attribuez-lui une couleur
gris-bleu plus sombre afin d’indiquer l’importance des villes dans la région.

• Cliquez et faites glissez ce critère en haut de la liste.

Ces filtres sont exclusifs, du fait qu’ils excluent collectivement certaines zones de la carte (c’est-à-dire celles qui
sont plus petites que 0.00005, ne sont ni résidentielles ni dans ‘Swellendam‘). Cela signifie que les polygones
exclus prennent par défaut le style de la catégorie des valeurs (pas de filtre).

Nous savons que les polygones exclus de notre carte ne peuvent pas être des zones résidentielles, donnez-leur
alors une couleur vert pâle correspondant à la catégorie par défaut.

Votre boîte de dialogue devrait maintenant ressembler à cela ;
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• Appliquez cette symbologie.

Votre carte ressemblera à quelque chose comme ça :
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Maintenant que vous avez une carte avec Swellendam, le quartier résidentiel le plus important et d’autres quartiers
non résidentiels colorés en fonction de leur taille.

4.3.6 In Conclusion

La symbologie nous permet de représenter les attributs d’une couche d’une façon facile à lire. Cela nous permet
aussi bien qu’au lecteur de carte de comprendre la signification de caractéristiques, en utilisant tout attribut per-
tinent que nous choisissons. En fonction des problèmes auxquels vous faites face, vous appliquerez différentes
techniques de classification pour les résoudre.

4.3.7 What’s Next?

Nous avons maintenant une carte de belle apparence, mais comment allons-nous sortir de QGIS dans un format
que nous pouvons imprimer, ou en faire une image ou un PDF ? C’est le sujet de la prochaine leçon !
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CHAPTER 5

Module: Création de Cartes

Dans ce module, vous allez apprendre à utiliser le composeur de carte de QGIS pour produire des cartes de qualité,
avec tous les éléments requis.

5.1 Lesson: Utiliser le composeur de cartes

Maintenant que vous avez une carte, vous devez être capable de l’imprimer ou de l’exporter dans un document.
En effet, un fichier de carte SIG n’est pas une image. Au contraire, il enregistre l’état du programme SIG, avec des
références à toutes les couches, leurs étiquettes, couleurs, etc. Donc pour quelqu’un qui n’a pas les données ou le
même programme de SIG (comme QGIS), le fichier de la carte sera inutile. Heureusement, QGIS peut exporter
son fichier de carte dans un format que n’importe quel ordinateur peut lire, de même que l’impression de la carte
si une imprimante est connectée. Autant l’exportation que l’impression sont traitées via le Composeur de cartes.

Objectif de cette leçon : Utiliser le composeur de carte QGIS pour créer une carte de base avec tous les paramètres
requis.

5.1.1 Follow Along: Le Gestionnaire de Composition

QGIS vous autorise à créer plusieurs cartes utilisant le même fichier de carte. Pour cette raison, il existe un outil
appelé le Gestionnaire de composition.

• Cliquez sur le menu Projet → Gestionnaire de composition pour ouvrir cet outil. Vous verrez une boîte de
dialogue Gestionnaire de composition vide apparaître.

• Cliquez sur le bouton Ajouter et donnez au nouveau composeur le nom de Swellendam.

• Cliquez sur OK.

• Cliquez sur le bouton Afficher.

(Vous pouvez également fermer la boîte de dialogue et accéder à un composer via le menu Fichier → Composeurs
d’impression, comme dans l’image ci-dessous.)
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Quelque soit la façon dont vous y accéder, vous verrez maintenant la fenêtre Composeur d’impression :
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5.1.2 Follow Along: Composition d’une carte de base

Dans cet exemple, la composition était déjà telle que nous la voulions. Assurez-vous de faire de même.

• Dans la fenêtre Composeur d’impression, vérifiez que les valeurs sous Composition → Papier et Qualité
sont fixées comme suit :

• Taille: A4 (210x297mm)

• Orientation: Paysage

• Qualité: 300dpi

Vous avez maintenant la mise en page que vous souhaitez, mais cette page est encore vierge. Il manque clairement
une carte. Ajoutons cela !

• Cliquez sur le bouton Ajouter une nouvelle carte :

Avec cet outil activé, vous pourrez placer une carte sur la page.

• Cliquez et faites glisser un bloc sur la page blanche :

La carte apparaîtra sur la page.

• Déplacez la carte en cliquant et en vous déplaçant autour:
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• Modifiez ses dimensions en cliquant et en déplaçant les boîtes dans les coins:

Note: Votre carte peut être très différente, bien sûr ! Cela dépend de comment est configuré votre propre projet.
Mais pas de panique ! Ces instructions sont générales, donc elles fonctionneront de la même manière, peu importe
à quoi ressemble la carte.

• N’oubliez pas de laisser des marges sur les bords, et un espace sur le dessus pour le titre.

• Zoomez et dézoomez sur la page (mais pas sur la carte !) en utilisant ces boutons :
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• Zoomez et déplacez la carte dans la fenêtre principale de QGIS. Vous pouvez aussi déplacer la carte en

utilisant l’outil Déplacer le contenu de l’objet :

Lorsque vous zoomez, la vue de la carte ne se rafraîchit pas. Ce comportement est présent pour éviter de redessiner
la carte lorsque vous zoomer sur la page où vous êtes mais il permet également de montrer que la page sera dans
une résolution non adaptée lors du zoom.

• Forcez la carte à se rafraîchir en cliquant sur ce bouton :

Rappelez-vous que la taille et la position que vous avez données à la carte n’ont pas besoin d’être définitives. Vous
pouvez toujours revenir et modifier la carte plus tard si vous n’êtes pas satisfait. Pour l’instant, il faut vous assurer
que vous avez sauvegardé votre travail dans cette carte. Étant donné qu’un Composeur dans QGIS est une partie
du fichier principal de la carte, vous devrez sauvegarder votre projet principal. Rendez-vous à la fenêtre principale
de QGIS (celle avec la Légende de la carte et tous les autres éléments familiers avec lesquels vous avez travaillé
plus tôt), et sauvegardez votre projet depuis là, comme d’habitude.

5.1.3 Follow Along: Ajout d’un Titre

Votre carte semble maintenant bien sur la page, mais vos lecteurs/utilisateurs ne savent pas encore ce qu’elle
dit. Ils ont besoin d’un peu de contexte, qui correspond à ce que vous ajoutez comme éléments cartographiques.
Ajoutons tout d’abord un titre.

• Cliquez sur ce bouton :

• Cliquez sur la page, au-dessus de la carte, et une étiquette apparaîtra en haut de la carte.

• Redimensionnez-la et place-la en haut au centre de la page. Elle peut être redimensionnée et déplacée de la
même façon que lorsque vous avez redimensionné et déplacé la carte.

Lorsque vous déplacez le titre, vous remarquerez que des lignes directrices apparaissent pour vous aider à posi-
tionner le titre au centre de la page.

Cependant, il existe également un outil pour aider à placer le titre à une position relative par rapport à la carte (et
non à la page) :

• Cliquez sur la carte pour la sélectionner.

• Appuyez sur shift sur votre clavier et cliquez sur l’étiquette afin que la carte et l’étiquette soient toutes
les deux sélectionnées.

• Cherchez le bouton Aligner et cliquez sur la flèche du menu déroulant à côté du bouton pour faire
apparaître les options de positionnement et cliquez sur Centrer :
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Pour être sûr que vous ne bougez pas accidentellement ces éléments maintenant que vous les avez alignés :

• Faites un clic-droit à la fois sur la carte et sur l’étiquette.

Une petite icône de cadenas apparaîtra dans le coin pour vous informer qu’un élément ne peut pas être déplacé en
ce moment. Cependant, vous pouvez toujours refaire un clic-droit sur un élément pour le déverrouiller.

L’étiquette est maintenant centrée par rapport à la carte, mais pas le contenu. Pour centrer le contenu de l’étiquette
:

• Sélectionnez l’étiquette en cliquant dessus.

• Cliquez sur l’onglet Propriétés de l’objet dans le panneau latéral de la fenêtre Composeur.

• Changez le texte de l’étiquette en “Swellendam” :

• Utilisez cette interface pour configurer les options de police et d’alignement :

• Choisissez une grande mais raisonnable police de caractère (l’exemple utilise la police par défaut avec une
taille de 36) et configurez l’Alignement Horizontal sur Centre.
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Vous pouvez également changer la couleur de la police de caractère, mais il est probablement préférable de la
laisser en noir, comme par défaut.

La configuration par défaut n’ajoute pas de cadre autour de la boîte de texte du titre. Cependant, si vous le
souhaitez, vous pouvez le faire :

• Dans l’onglet Propriétés de l’objet, faites défiler vers le bas jusqu’à ce que vous voyiez l’option Cadre.

• Cochez la case Cadre pour activer le cadre. Vous pouvez également changer la couleur et l’épaisseur du
cadre.

Dans cet exemple, nous n’activerons pas le cadre, ainsi voici notre page telle qu’actuellement :

5.1.4 Follow Along: Ajout d’une Légende

Le lecteur de la carte doit aussi maintenant pouvoir voir ce que les différentes choses sur la carte signifient. Dans
certains cas, comme avec les noms de lieux, c’est assez logique. Dans d’autres cas, c’est plus difficile de deviner,
comme avec la couleurs des fermes. Ajoutons une nouvelle légende.

• Cliquez sur ce bouton :

• Cliquez sur la page pour placer la légende, et déplacez-la où vous voulez :
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5.1.5 Follow Along: Personnaliser les éléments de légende

Pas tout dans la légende n’est nécessaire, alors enlevons quelques éléments non souhaités.

• Dans l’onglet Propriétés de l’élément, vous trouverez le panneau Élements de la légende.

• Sélectionnez l’entrée buildings.

• Supprimez-la de la légende en cliquant sur le bouton moins :

Vous pouvez aussi renommer les éléments.

• Sélectionnez une couche dans la même liste.

• Cliquez sur le bouton Édition :

• Renommez les couches en Places, Roads and Streets, Surafce Water, et Rivers.

• Paramétrer l’entrée landuse à Caché et cliquez sur la flèche du bas pour éditer chaque nom de catégorie
de la légende. Vous pouvez également ordonner les éléments:
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Comme la légende sera probablement élargie avec les nouveaux noms des couches, vous pouvez déplacer et
redimensionner la légende et/ou la carte. Voici le résultat :

5.1.6 Follow Along: Exporter votre carte

Note: Avez-vous pensé à souvent sauvegarder votre travail ?

La carte est finalement prête à être exportée ! Vous verrez les boutons d’export près du coin supérieur gauche de
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la fenêtre Composeur :

Le bouton sur la gauche est le bouton Imprimer, qui interagit avec une imprimante. Étant donné que les options
d’impression seront différentes selon le modèle d’imprimante avec lequel vous travaillez, le mieux est probable-
ment de consulter le manuel de l’imprimante ou un guide général sur l’impression pour plus d’informations à ce
sujet.

Les trois autres boutons vous permettent d’exporter la page de la carte dans un fichier. Il y a trois formats
d’exportation à choix :

• Exporter comme Image

• Exporter comme SVG

• Exporter comme PDF

Exporter comme une image vous donnera une sélection de différents formats courants d’image à choix. C’est
probablement l’option la plus simple, mais l’image ainsi créée est “morte” et difficile à modifier.

Les deux autres options sont plus courantes.

Si vous transmettez la carte à un cartographe (qui pourra vouloir l’éditer pour publication), c’est mieux de
l’exporter en SVG. SVG veut dire “Scalable Vector Graphic” - graphique vectoriel extensible, et peut être im-
porté dans des programmes tel que Inkscape ou autre programme d’édition d’images vectorielles.

Si vous devez envoyer la carte à un client, il est plus courant d’utiliser un PDF, car il est plus facile de configurer les
options d’impression pour un PDF. Certains cartographes peuvent aussi préférer un PDF, s’ils ont un programme
qui leur permet d’importer et de modifier ce format.

Pour nos fins, nous allons utiliser un PDF.

• Cliquez sur le bouton Exporter au format PDF :

• Choisissez comme d’habitude un emplacement de sauvegarde et un nom de fichier.

• Cliquez sur Sauvegarder.

5.1.7 In Conclusion

• Fermez la fenêtre Composeur.

• Sauvegardez votre carte.

• Trouvez votre PDF d’exportation en utilisant votre gestionnaire de fichiers du système d’exploitation.

• Ouvrez-le.

• Bravo !

Félicitations pour votre premier projet complet de carte QGIS !

5.1.8 What’s Next?

Sur la prochaine page, vous allez recevoir une mission à remplir. Cela vous permettra de pratiquer les techniques
que vous venez d’apprendre.

5.2 Tâche 1

Ouvrez votre projet de carte existant et révisez le complètement. Si vous observez de petites erreurs ou des
éléments que vous vouliez réparer auparavant, faites-le maintenant.
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Lors de la personnalisation de votre carte, posez-vous continuellement des questions. La carte est-elle facile à lire
et à comprendre pour quelqu’un qui n’est pas familier avec les données ? Si je voyais cette carte sur Internet, ou
sur une affiche ou dans un magazine, serait-elle capable de capturer mon attention ? Est-ce que je serais intéressé
à lire cette carte si elle n’était pas la mienne ?

Si vous suivez ce cours à un niveau Basique ou Intermédiaire, étudiez aussi les techniques dans les
sections plus avancées. Si vous voyez quelque chose que vous aimeriez faire dans votre carte, pourquoi ne pas
essayer de l’appliquer ?

Si vous suivez ce cours avec l’aide de quelqu’un, cette personne peut vous demander de soumettre une version
finale de votre carte, exportée au format PDF, pour l’évaluation. Si vous suivez ce cours en auto-apprentissage,
il est recommandé que vous évaluiez votre propre carte en utilisant les mêmes critères de sélection. Votre carte
sera évaluée sur l’apparence générale et la symbologie de la carte elle-même, aussi bien que sur l’apparence et
la disposition de la page et des éléments de la carte. Rappelez-vous que l’élément clé pour évaluer l’apparence
des cartes sera toujours la facilité d’utilisation. Une carte est faite pour être regardée et plus il est facile de la
comprendre d’un simple coup d’œil, mieux c’est.

Joyeuse personnalisation!

5.2.1 In Conclusion

Les quatre premiers modules vous ont appris à créer et mettre en forme une carte vecteur. Dans les quatre prochains
modules, vous apprendrez à utiliser QGIS pour une complète analyse en SIG. Il s’agira notamment de créer et
éditer des données vectorielles ; analyser des données vectorielles ; utiliser et analyser des données raster ; et
utiliser le SIG pour résoudre un problème de bout en bout, à l’aide de données raster et vecteur.
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CHAPTER 6

Module: Créer des données vectorielles

Créer des cartes à partir de données existantes n’est qu’un début. Dans ce module, vous apprendrez à modifier des
données vectorielles existantes et créer entièrement de nouveaux jeux de données.

6.1 Lesson: Création d’un Nouveau Jeu de Données Vectorielles

Les données que vous utilisez doivent venir de quelque part. Pour la plupart des applications, les données existent
déjà ; mais plus le projet est particulier et spécifique, moins il est probable que les données soient déjà disponibles.
Dans ce cas, vous devez créer vos propres données.

Objectif de cette leçon : Créer un nouveau jeu de données vectorielles.

6.1.1 Follow Along: La boîte de dialogue de création de couche

Avant que vous puissiez créer de nouvelles données vectorielles, vous avez besoin d’un jeu de données vectorielles
auquel les ajouter. Dans notre cas, vous commencerez par créer entièrement des nouvelles données, plutôt que de
modifier un jeu de données existant. Par conséquent, vous devrez définir votre propre nouvel ensemble de données
en premier.

Vous devrez ouvrir la boîte de dialogue Nouvelle couche vectorielle qui va vous permettre de définir une nouvelle
couche.

• Naviguez et cliquez sur l’entrée du menu Couche → Nouveau → Nouvelle couche vectorielle.

Vous obtiendrez la fenêtre suivante:
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C’est important de décider quelle sorte de jeu de données vous voulez à ce stade. Chaque différent type de couche
vectorielle est “construit différemment” dans le fond, alors une fois que vous avez créé la couche, vous ne pouvez
changer son type.

Pour le prochain exercice, nous allons créer de nouvelles entités qui représentent des aires. Pour de telles entités,
vous aurez besoin de créer un jeu de données polygones.

• Cliquez sur le bouton radio Polygone.
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Cela n’a pas d’impact sur le reste de la boîte de dialogue, mais cela produira le bon type de géométrie à utiliser
quand le jeu de données vectorielles sera créé.

Le prochain champ vous permet de spécifier le Système de Coordonnées de Référence, ou SCR. Un SCR définit
comme décrire un point sur la Terre en termes de coordonnées, et comme il y a plusieurs façons différentes de le
faire, il y a plusieurs SCR différents. Le SCR de ce projet est WGS84, il est donc déjà juste par défaut :

Il y a ensuite un ensemble de champs regroupés sous Nouvel attribut. Par défaut, une nouvelle couche a seulement
un attribut, le champ id (que vous devriez voir dans la Liste d’attribut) en-dessous. Cependant, pour que les
données que vous créez soient utilisables, vous devez maintenant spécifier quelque chose pour les entités que vous
créerez dans cette nouvelle couche. Pour nos buts actuels, il suffit d’ajouter un champ appelé nom.

• Reproduisez l’installation du haut, puis cliquez sur le bouton Ajouter à la liste d’attribut :

• Vérifiez que votre fenêtre ressemble maintenant à ceci:
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• Cliquez sur OK. Une fenêtre de sauvegarde va apparaître.

• Naviguez jusqu’au répertoire exercise_data.

• Sauvegardez votre nouvelle couche en tant que school_property.shp.

La nouvelle couche devrait apparaître dans votre Légende de carte.
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6.1.2 Follow Along: Sources de Données

Quand vous créez de nouvelles données, cela doit évidemment être sur des objets qui existent réellement sur le
terrain. Par conséquent, vous devrez obtenir vos informations à quelque part.

Il y a plusieurs façons différentes d’obtenir des données sur des objets. Par exemple, vous pouvez utiliser un
GPS pour prendre des points dans le monde réel, puis importer les données dans QGIS par la suite. Ou vous
pouvez lever des points à l’aide d’un théodolite, et entrer manuellement les coordonnées pour créer de nouvelles
fonctionnalités. Ou vous pouvez utiliser le processus de numérisation pour localiser des objets à partir de données
de télédétection, telles que l’imagerie par satellite ou la photographie aérienne.

Pour notre exemple, vous utiliserez l’approche de numérisation. Des échantillons de jeu de données raster sont
fournis, ainsi vous pourrez les importer si nécessaire.

• Cliquez sur le bouton Ajouter une couche raster :

• Naviguez jusqu’à exercise_data/raster/.

• Sélectionnez le fichier 3420C_2010_327_RGB_LATLNG.tif.

• Cliquez sur Ouvrir. Une image sera chargée dans votre carte.

• Trouvez la nouvelle image dans la Légende de la carte.

• Cliquez et glissez-la jusqu’en bas de la liste afin que vous puissiez encore voir vos autres couches.

• Trouvez et zoomez sur cette zone :

Note: Si votre symbologie de couche buildings recouvre une partie ou toute la couche raster, vous pouvez
temporairement désactiver la couche en la désélectionnant dans la Légende de la carte. Vous pouvez aussi vouloir
cacher la symbologie roads si vous la trouver distrayante.

Vous allez numériser ces trois champs :
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Afin de commencer la numérisation, vous devez entrer en mode d’édition. Les logiciels SIG nécessitent sou-
vent cela pour vous empêcher de modifier ou de supprimer accidentellement des données importantes. Le mode
d’édition est activé ou désactivé pour chaque couche individuellement.

Pour entrer en mode d’édition pour la couche school_property :

• Cliquez sur la couche dans la Légende de la carte pour la sélectionner. (Soyez vraiment sûr que la bonne
couche soit sélectionnée, autrement vous modifierez la mauvaise couche !)

• Cliquez sur le bouton Basculer en mode d’édition :

Si vous ne trouvez pas ce bouton, vérifiez que la barre d’outil Numérisation est activée. Il devrait y avoir une
coche à côté de l’entrée du menu Vue → Barre d’outils → Numérisation.

Dès que vous êtes en mode d’édition, vous verrez que les outils de numérisation sont maintenant activés :

Quatre autres boutons correspondant ne sont pas encore activés, mais ils le seront lorsque nous commencerons à
interagir avec nos nouvelles données :

De la gauche à la droite sur la barre d’outils, il y a :
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• Sauvegarder les modifications : sauvegarde les changements apportés à la couche.

• Ajouter une entité : commencer à numériser une nouvelle entité.

• Déplacer l’entité : déplacer une entité entière autour.

• Outil de noeud : déplacer seulement une partie de l’entité.

• Supprimer les entités sélectionnées : supprimer l’entité sélectionnée.

• Couper les entités : couper l’entité sélectionnée.

• Copier les entités : copier l’entité sélectionnée.

• Coller les entités : coller une entité coupée ou copiée dans la carte.

Vous voulez ajouter une nouvelle entité.

• Cliquez maintenant sur le bouton Ajouter une entité pour commencer à numériser nos domaines scolaires.

Vous remarquerez que votre curseur de souris est devenu une croix. Cela vous permet de placer plus précisément
les points que vous allez numériser. Souvenez-vous que même lorsque vous êtes en train d’utiliser l’outil de
numérisation, vous pouvez zoomer et dézoomer sur votre carte en faisant rouler la molette de la souris, et vous
pouvez vous déplacer autour en maintenant la molette de la souris enfoncée et en glissant sur la carte.

La première entité que vous allez numériser est le athletics field :

• Commencez à numériser en cliquant sur un point n’importe où le long du bord du champ.

• Placez plus de points en cliquant davantage le long du bord, jusqu’à ce que la forme que vous dessinez
recouvre complètement le champ.

• Après avoir placé votre dernier point, faites un clic droit pour finir de dessiner le polygone. Cela va finaliser
l’entité et vous ouvrir la boîte de dialogue Attributs.

• Entrer les valeurs comme ci-dessous :
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• Cliquez sur OK et vous avez créé une nouvelle entité !

Souvenez-vous, si vous avez fait une faute pendant la numérisation d’une entité, vous pouvez toujours la modifier
après que vous l’ayez créée. Si vous avez fait une faute, continuez à numériser jusqu’à ce que vous ayez créé
l’entité comme au-dessus. Puis :

• Sélectionnez l’entité avec l’outil Sélection d’entité :

Vous pouvez utiliser :

• l’outil Déplacer l’entité pour déplacer l’entité entière,

• l’outil Outil de noeud pour déplacer seulement un point où vous pouvez avoir mal cliqué,
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• Supprimer les entités sélectionnées pour se débarrasser entièrement de l’entité de sorte que vous puissiez
essayer à nouveau, et

• l’élément du menu Edition → Annuler ou le raccourci clavier ctrl + z pour annuler les fautes.

6.1.3 Try Yourself

• Numérisez l’école elle-même et le champ du haut. Utilisez cette image pour vous guider :

Souvenez-vous que chaque nouvelle entité a besoin d’une valeur unique !

Note: Quand vous avez fini d’ajouter des entités à une couche, rappelez-vous de sauvegarder vos modifications
et ensuite de quitter le mode d’édition.

Note: Vous pouvez définir le style du remplissage, la bordure et la mise en forme et le placement des étiquettes de
la school_property en utilisant les techniques enseignées dans les leçons précédentes. Dans notre exemple, nous
utiliserons une bordure en traitillé de couleur violet claire avec pas de remplissage.
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6.1.4 Try Yourself

• Créez une nouvelle entité ligne appelée routes.shp avec les attributs id et type. (Utilisez l’approche
ci-dessus pour vous guider.)

• Nous allons numériser deux routes qui ne sont pas encore marquées sur la couche des routes ; une est un
chemin, l’autre est une piste.

Notre chemin s’étend le long du bord sud de la banlieue de Railton, commençant et finissant aux routes balisées :

Notre piste est un peu plus loin au sud :
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Un à la fois, numérisez le chemin et la piste sur la couche routes. Essayez de suivre les routes le plus finement
possible, en utilisant des points (clic gauche) à chaque angles ou tournants.

En créant chaque route, donnez-leur une valeur d’attribut type de chemin ou piste.

Vous trouverez probablement que seuls les points sont marqués ; utilisez la boîte de dialogue Propriétés de la
couche pour ajouter une mise en forme à vos routes. Sentez-vous libre de donner des styles différents au chemin
et à la piste.

Sauvegardez vos modifications et quittez le mode Edition.

Vérifiez vos résultats

6.1.5 In Conclusion

Vous savez maintenant comment créer des entités ! Ce cours ne couvre pas l’ajout d’entités ponctuelles, car
ce n’est pas vraiment nécessaire une fois que vous avez travaillé avec des entités plus compliquées (lignes et
polygones). Cela fonctionne exactement de la même manière, hormis le fait que vous cliquez seulement une fois
où vous voulez que le point soit, lui donnez des attributs comme d’habitude, et ensuite l’entité est créée.

Savoir comment numériser est important car c’est une activité très courante dans les programmes SIG.

6.1.6 What’s Next?

Des entités dans une couche SIG ne sont pas seulement des images, mais des objets dans l’espace. Par exemple,
des polygones adjacents savent où ils sont par rapport aux uns et aux autres. Cela s’appelle la topologie. Dans la
prochaine leçon vous verrez un exemple de pourquoi cela peut être utile.

6.2 Lesson: Topologie des données

La topologie est un aspect utile des couches de données vectorielles, car il minimise les erreurs telles que les
chevauchements ou les lacunes.

6.2. Lesson: Topologie des données 113



QGIS Training Manual, Version 2.18

Par exemple : si deux entités partagent une bordure, et que vous modifiez la bordure avec la topologie, alors
vous n’aurez pas besoin de modifier d’abord une entité, puis l’autre, et soigneusement aligner les bordures afin
qu’elles correspondent l’une avec l’autre. Vous pouvez plutôt modifier leur bordure commune et les deux entités
changeront en même temps.

Objectif de cette leçon: Comprendre la topologie par les exemples.

6.2.1 Follow Along: Accrochage

Pour rendre les modifications topologiques plus faciles, il est préférable que vous activiez l’accrochage. Cela va
permettre à votre curseur de s’accrocher aux autres objets pendant que vous numérisez. Pour activer les options
d’accrochages :

• Rendez-vous à Préférences → Options d’accrochage.

• Configurez votre boîte de dialogue Options d’accrochage comme montré :

• Assurez-vous que la case dans la colonne Éviter intersections est cochée (mise comme vrai).

• Cliquez sur OK pour sauvegarder vos changements et quitter la boîte de dialogue.

• Entrez en mode d’édition avec la couche landuse sélectionnée.

• Vérifiez sous Vue → Barres d’outils pour être sûr que votre barre d’outil Numérisation avancée est activée.

• Zoomez jusqu’à cette zone (activez des couches et des étiquettes si nécessaire) :
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• Numérisez cette nouvelle zone (fictive) de Bontebok National Park :

• Quand vous y êtes invité, donnez-lui un OGC_FID de 999, mais sentez-vous libre de laisser les autres
valeurs inchangées.

Si vous êtes attentif durant la numérisation et permettez au curseur de s’accrocher aux sommets des fermes
voisines, vous remarquerez qu’il n’y aura pas d’écarts entre votre nouvelle ferme et les fermes existantes qui
lui sont adjacentes.

• Remarquez les outils annnuler/refaire dans la barre d’outils Numérisation avancée :

6.2. Lesson: Topologie des données 115



QGIS Training Manual, Version 2.18

6.2.2 Follow Along: Corriger les caractéristiques topologiques

La topologie des données peut parfois avoir besoin d’être mise à jour. Dans notre exemple, la couche landuse
possède des zones forestières complexes qui ont été récemment regroupées pour former une seule zone :

À la place de créer de nouveaux polygones pour unir des zones de forêts, nous allons utiliser l’Outil de noeud
pour modifier les polygones existants et les grouper.

• Entrez en mode d’édition, si ce dernier n’est pas déjà activé.

• Sélectionnez l’Outil de noeud.

• Choisissez une zone de forêt, sélectionnez un coin et déplacez-le vers un angle adjacent, de sorte que deux
sections de forêt se rencontrent :
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• Faites un glissé-déplacé des nœuds jusqu’à ce qu’ils se mettent en position.

Les bordures topologiquement correctes ressemblent à cela :
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Continuez à joindre quelques zones supplémentaires en utilisant l’Outil de noeud. Vous pouvez aussi utiliser
l’outil Ajouter une entité si cela est approprié. Si vous utilisez nos données d’exemple, vous devriez avoir une
zone forestière qui ressemble à quelque chose comme ça :

Ne vous inquiétez pas si vous avez regroupé plus, moins ou différentes zones de forêt.
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6.2.3 Follow Along: Outil: Simplifier l’Entité

Voici l’outil Simplifier l’entité :

• Cliquez dessus pour l’activer.

• Cliquez sur une des zones que vous avez regroupé en utilisant soit l’Outil noeud soit l’outil Ajouter une
entité. Vous verrez cette boîte de dialogue :

• Déplacez le curseur d’un côté à l’autre et regardez ce qu’il se passe :
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Cela vous permet de réduire le nombre de noeuds dans les entités complexes.

• Cliquez sur Ok

Constatez ce que l’outil fait à la topologie. Le polygone simplifié ne touche maintenant plus les polygones ad-
jacents comme il se doit. Cela montre que cet outil est mieux adapté à la généralisation des entités autonomes.
L’avantage est qu’il vous fournit une simple et intuitive interface pour la généralisation.

Avant de continuer, remettez le polygone dans son état d’origine en annulant le dernier changement.

6.2.4 Try Yourself Outil: Ajouter un anneau

Ceci est l’outil Ajouter un anneau :

Cela vous permet de faire un trou dans une entité, aussi longtemps que le trou est délimité sur tous les côtés par
l’entité. Par exemple, si vous numérisez les bordures extérieures de l’Afrique du Sud et que vous devez ajouter un
trou pour Lesotho, vous devez utiliser cet outil.

Si vous essayez cet outil, vous remarquerez que les options d’accrochage actuelles vous empêchent de créer un
anneau au milieu du polygone. Cela serait bien si la zone que vous souhaitez exclure soit liée aux limites du
polygones.

• Désactivez l’accrochage pour la couche d’occupation du sol via la boîte de dialogue que vous avez utilisé
plus tôt.
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• Maintenant, essayez d’utiliser l’outil Ajouter un Anneau pour créer un trou dans le milieu de Bontebok
National Park.

• Supprimez votre nouvelle entité en utilisant l’outil Effacer un anneau :

Note: Vous devez sélectionner un coin de l’anneau afin de le supprimer.

Vérifiez vos résultats

6.2.5 Try Yourself Outil: Ajouter une partie

Ceci est l’outil Ajouter une partie :

Cela vous permet de créer une partie supplémentaire de l’entité, pas directement connectée à l’entité principale.
Par exemple, si vous avez numérisé les frontières du territoire continental d’Afrique du Sud mais que vous n’avez
pas ajouté les Îles du Prince Édouard, vous utiliserez cet outil pour les créer.

• Pour utiliser cet outil, vous devez tout d’abord sélectionner le polygone auquel vous souhaitez ajouter la
partie en utilisant l’outil Sélection d’entité :

• Essayez maintenant d’utiliser l’outil Ajouter une partie pour ajouter une zone périphérique à la Bontebok
National Park.

• Supprimez votre nouvelle entité en utilisant l’outil Effacer une partie :

Note: Vous devez sélectionner un coin de la partie afin de la supprimer.

Vérifiez vos résultats

6.2.6 Follow Along: Outil: Remodeler les Entités

Ceci est l’outil Remodeler les entités :

Il peut ajouter une bosse à une entité existante. Avec cet outil sélectionné :

• Faites un clic gauche dans la Bontebok National Park pour commencer à dessiner un polygone.

• Dessinez un polygone avec trois coins, le dernier de ceux-là doit être à l’intérieur du polygone originale,
formant un rectangle avec une face ouverte.

• Faites un clic droit pour finir de marquer les points :
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Cela doit donner un résultat similaire à ça :

Vous pouvez aussi faire l’opposé :

• Cliquez à l’extérieur du polygone.

• Dessinez un rectangle dans le polygone.

• Faites un clic droit à l’extérieur du polygone à nouveau :
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Le résultat de ce qui précède :

6.2.7 Try Yourself Outil: Séparer les entités

L’outil Séparer les entités est similaire à la façon dont vous avez pris une partie de la ferme tout de suite, sauf qu’il
ne supprime pas une des deux parties. Au lieu de cela, il les conserve les deux.
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• Tout d’abord, ré-activez l’accrochage pour la couche landuse.

Nous utiliserons l’outil pour séparer un coin du Bontebok National Park.

• Sélectionnez l’outil Séparer les entités et cliquez sur un vecteur pour commencer à dessiner une ligne.
Cliquez sur le vecteur à l’opposé du coin que vous souhaitez séparer et faites un clic droit pour compléter la
ligne :

• À ce stade, il peut sembler que rien ne s’est passé. Mais souvenez-vous que votre symbologie pour la couche
landuse n’as pas de bordure, alors la nouvelle ligne de division ne sera pas affichée.

• Utilisez l’outil Sélection d’entité pour sélectionner le coin que vous venez de séparer ; la nouvelle entité
sera maintenant mise en surbrillance :
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6.2.8 Try Yourself Outil: Fusionner les Entités

Nous allons maintenant regrouper l’entité que vous venez de créer et le polygone original :

• Essayez les outils Fusionner les entités sélectionnées et Fusionner les attributs des entités sélectionnées.

• Remarquez les différences.

Vérifiez vos résultats

6.2.9 In Conclusion

L’édition topologique est un outil puissant qui vous permet de créer et de modifier des objets rapidement et
facilement, tout en veillant à ce qu’ils restent topologiquement corrects.

6.2.10 What’s Next?

Vous savez maintenant comment numériser la forme des objets facilement, mais ajouter les attributs est toujours
un peu casse-tête ! Nous allons ensuite vous montrer comment utiliser les formulaires ainsi que l’édition d’attribut
qui est plus simple et plus efficace.

6.3 Lesson: Formulaires

Quand vous ajoutez de nouvelles données via la numérisation, une boîte de dialogue vous est présentée pour
vous permettre de remplir les attributs pour cette fonction. Cependant, cette boîte de dialogue n’est, par défaut,
visuellement pas très agréable. Cela peut causer un problème d’utilisation, en particulier si vous avez de grands
jeux de données à créer, ou si vous voulez que d’autres personnes vous aident à numériser et qu’elles trouvent les
formulaires par défaut source de confusion.
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Heureusement, QGIS vous laisse créer vos propres boîtes de dialogue personnalisées pour une couche. Cette leçon
vous montre comment.

Objectifs de cette leçon : Créer un formulaire pour une couche.

6.3.1 Follow Along: Utilisation de la Conception de Formulaires avec QGIS

• Sélectionnez la couche roads dans la Légende de la carte.

• Entrez comme avant en Mode d’édition.

• Ouvrez sa Table attributaire.

• Faites un clic-droit sur une cellule dans la table. Un petit menu apparaîtra, avec la seule entrée Ouvrir
formulaire.

• Cliquez dessus pour voir le formulaire que QGIS génère pour cette couche.

Évidemment, il serait bien de pouvoir faire cela tout en regardant la carte, plutôt que d’avoir besoin de chercher
une rue spécifique dans la table d’attribut tout le temps.

• Sélectionnez la couche roads dans la Légende de la carte.

• En utilisant l’outil Identifier, cliquez sur une rue dans la carte.

• Le panneau Résultats identité s’ouvre et affiche un arbre montrant les valeurs des champs et d’autres infor-
mations générales sur l’entité cliquée.

• En bas du panneau, validez la case à cocher Ouverture auto. forme

• Cliquez maintenant sur une des rues de la carte. À coté du dialogue Résultats Identité vous verrez la forme
maintenant familière :
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• Chaque fois que vous cliquez sur une entité unique avec l’outil Identité, sa forme s’affiche à moins que
Ouverture auto. forme ne soit désactivée.

6.3.2 Try Yourself Utilisation du formulaire pour modifier des valeurs

Si vous êtes en mode d’édition, vous pouvez utiliser ce formulaire pour modifier les entités des attributs.

• Activez le mode d’édition (si ce n’est déjà fait).

• En utilisant l’outil Identifier, cliquez sur la rue principale qui traverse Swellendam :

• Modifiez sa valeur highway en secondary.

• Sauvegardez vos modifications.

• Sortez du mode d’édition.

• Ouvrez la Table attributaire et notez que la valeur a été mise à jour dans la table d’attribut et donc dans la
donnée source.

Note: Si vous utilisez le jeu de données par défaut, vous trouverez qu’il y a plus d’une route sur la carte nommée
Voortrek Street.

6.3.3 Follow Along: Configuration des types de champs du formulaire

C’est bien de modifier les choses en utilisant un formulaire, mais vous devez encore tout entrer à la main.
Heureusement, les formulaires ont différentes sortes de soi-disant outils qui vous permettent de modifier les don-
nées de différentes manières.

• Ouvrez la fenêtre Propriétés de la couche de la couche roads.
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• Basculez sur l’onglet Champs. Vous verrez ceci :

• Cliquez sur le bouton Édition de ligne sur la même ligne que guilabel:man_made et une nouvelle boîte de
dialogue s’ouvrira.

• Sélectionnez Case à cocher dans la liste des options :
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• Cliquez sur OK.

• Entrez en mode d’édition (si la couche roads n’est pas déjà en mode d’édition.

• Cliquez sur l’outil Identifier.

• Cliquez sur la même route principale que vous avez choisie plus tôt.

Vous verrez maintenant que l’attribut man_made a une case à cocher à côté de lui indiquant Vrai (coché) ou
Faux (non coché).

6.3.4 Try Yourself

Définissez un outil de formulaire plus approprié pour le champ highway.

Vérifiez vos résultats

6.3.5 Try Yourself Création d’un test de données

Vous pouvez également concevoir votre propre formulaire personnalisé en partant de zéro.

• Créez une couche de point simple nommée test-data avec deux attributs :

– Nom (texte)

– Âge (texte)
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• Capturez quelques points sur votre nouvelle couche en utilisant les outils de numérisation afin que vous
ayez un peu de données pour jouer avec. Il se peut qu’on vous présente le formulaire de capture d’attribut
généré par défaut par QGIS chaque fois que vous capturez un nouveau point.

Note: Vous pouvez devoir désactiver l’Accrochage s’il est encore activé des tâches précédentes.
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6.3.6 Follow Along: Création d’un Nouveau Formulaire

Nous voulons maintenant créer notre propre formulaire personnalisé pour la phase de capture des attributs de
données. Pour faire cela, vous devez avoir installé Qt4 Designer (uniquement nécessaire pour les personnes qui
créent les formulaires). Il devrait être fourni dans vos supports de cours, si vous utilisez Windows. Vous pouvez
devoir le chercher si vous utilisez un autre système d’exploitation. Sur Ubuntu, faites ce qu’il suit dans le terminal
:

Note: Au moment de l’écriture, Qt5 est la dernière version disponible. Cependant, ce processus requiert spé-
cialement Qt4 et n’est pas nécessairement compatible avec Qt5.

sudo apt-get install qt4-designer

... et il devrait s’installer automatiquement. Autrement, cherchez-le dans le Software Center.

• Démarrez Designer en ouvrant son entrée Menu démarrer in Windows (ou avec tout autre approche appro-
priée dans votre système d’exploitation).

• Dans la boîte de dialogue qui apparaît, créez une nouvelle boîte de dialogue :
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• Cherchez l’Outil boîte sur le côté gauche de votre écran (par défaut). Il contient un élément appelé Édition
de ligne.

• Cliquez sur cet élément et faites-le glisser dans votre formulaire. Cela crée une nouvelle Édition de ligne
dans le formulaire.

• Avec le nouvel élément d’édition de ligne sélectionné, vous verrez ses propriétés le long du côté de votre
écran (par défaut sur la droite) :
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• Configurez son nom à Nom.

• En utilisant la même approche, créez une nouvelle zone de sélection numérique et configurez son nom à
Âge.

• Ajoutez une Étiquette avec le texte Ajouter une nouvelle personne en caractères gras (regardez
dans les propriétés de l’objet pour découvrir comment configurer cela). Alternativement, vous pouvez
vouloir définir le titre de la même boîte de dialogue (plutôt qu’ajouter une étiquette).

• Cliquez n’importe où dans votre boîte de dialogue.

• Trouvez le bouton Poser verticalement (dans une barre d’outils le long du bord supérieur de l’écran, par
défaut). Cela pose votre boîte de dialogue automatiquement.

• Configurez la taille maximale de la boîte de dialogue (dans ses propriétés) à 200 (largeur) sur 100 (hauteur).

• Sauvegardez votre nouveau formulaire sous exercise_data/forms/add_people.ui.

• Une fois la sauvegarde faite, vous pouvez fermer le programme Qt4 Designer.

6.3.7 Follow Along: Associer un Formulaire à une Couche

• Retournez sur QGIS

• Double-cliquez sur la couche test-data dans la liste des couches pour accéder à ses propriétés.

• Cliquez sur l’onglet Champs dans la fenêtre Propriétés de la couche.

• Dans la liste déroulante Mise en page de l’éditeur d’attribut, sélectionnez Fournir un fichier-ui.

• Cliquez sur le bouton de points de suspension et choisissez le fichier add_people.ui que vous venez
juste de créer :
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• Cliquez sur OK dans la fenêtre Propriétés de la couche.

• Passez en mode Édition et numérisez un nouveau point.

• Lorsque vous faites cela, on vous présentera votre boîte de dialogue personnalisée (à la place de la boîte de
dialogue générique que QGIS crée habituellement).

• Si vous cliquez sur un des points en utilisant l’outil Identifier, vous pouvez maintenant faire apparaître le for-
mulaire en faisant un clic-droit sur la fenêtre des résultats d’identité et en choisissant Afficher le formulaire
de l’entité dans le menu contextuel.

• Si vous êtes en mode d’édition pour cette couche, ce menu contextuel montrera à la place Modifier le
formulaire de l’entité, et vous pouvez alors modifier les attributs dans le nouveau formulaire, même après
leur capture initiale.

6.3.8 In Conclusion

En utilisant des formulaires, vous vous facilitez la vie lorsque vous modifiez ou créez des données. En modi-
fiant des types d’outil ou en créant entièrement un nouveau formulaire à partir de rien, vous pouvez contrôler
l’expérience de quelqu’un qui numérise des nouvelles données pour cette couche, en minimisant les malentendus
et les erreurs inutiles.
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6.3.9 Further Reading

If you completed the advanced section above and have knowledge of Python, you may want to check out this blog
entry about creating custom feature forms with Python logic, which allows advanced functions including data
validation, autocompletion, etc.

6.3.10 What’s Next?

L’ouverture d’un formulaire pour l’identification d’une entité est une des actions standards que QGIS effectue.
Cependant, vous pouvez également le diriger pour effectuer des actions personnalisées que vous définissez. C’est
le sujet de la prochaine leçon.

6.4 Lesson: Actions

Maintenant que vous avez vu une action par défaut dans la leçon précédente, il est temps de définir vos propres
actions. Une action est quelque chose qui arrive quand vous cliquez sur une entité. Cela peut ajouter beaucoup
de fonctionnalités à votre carte, vous permettant de récupérer des informations supplémentaires sur un objet par
exemple. Attribuer des actions peut ajouter une nouvelle dimension à votre carte !

Objectif de cette leçon : Apprendre à ajouter des actions personnalisées.

6.4.1 Follow Along: Ouvrir une Image

Utilisez la couche school_property que vous avez créé précédemment. Le support de cours inclut des photos
de chacun des trois propriétés que vous avez numérisées. Ce qui nous allons ensuite faire, c’est associer chaque
propriété avec son image. Puis, nous créerons une action qui ouvrira l’image d’un bien en cliquant sur la propriété.

6.4.2 Follow Along: Ajouter un champ pour images

La couche school_property n’a encore aucun moyen d’associer une image avec une propriété. Nous allons d’abord
créer un champ à cet effet.

• Ouvrez la fenêtre Propriétés de la couche.

• Cliquez sur l’onglet Champs.

• Basculez en mode édition :
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• Ajoutez une nouvelle colonne :
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• Entrez les valeurs ci-dessous :
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• Après la création du champ, cliquez sur le bouton Édition de ligne à la suite du nouveau champ.

• Définissez-le en Nom de fichier :
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• Cliquez sur OK dans la boîte de dialogue Propriétés de la couche.

• Utilisez l’outil Identifier pour cliquer sur une des trois entités dans la couche school_property.

Puisque vous êtes toujours en mode d’édition, la boîte de dialogue devrait être activée et ressembler à cela :
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• Cliquez sur le bouton parcourir (le ... à côté du champ image).

• Sélectionnez le chemin pour votre image. Les images sont dans
exercise_data/school_property_photos/ et sont nommées de la même façon que les
entités auxquelles elles devraient être associées.

• Cliquez OK.

• Associez toutes les images avec les bonnes entités en utilisant cette méthode :

• Sauvegardez vos modifications et sortez du mode d’édition.

6.4.3 Follow Along: Création d’une Action

• Ouvrez le formulaire Actions pour la couche school_property.

• Dans l’onglet Propriétés de l’action, entrez les mots Afficher l’image dans le champ Nom
:
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Ce qui faut ensuite faire varie selon votre système d’exploitation, ainsi choisissez la ligne de conduite appropriée
à suivre :

Windows

• Cliquez sur le menu déroulant Type et choisissez Ouvrir.

Ubuntu Linux

• Sous Action, écrivez eog pour le Gnome Image Viewer, ou écrivez display pour utiliser ImageMagick.
Souvenez-vous de mettre un espace après la commande !

MacOS

• Cliquez sur le menu déroulant Type et choisissez Mac.

• Sous Action, écrivez ouvrir. Souvenez-vous de mettre un espace après la commande !
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Continuez à écrire la commande

Vous souhaitez ouvrir l’image, et QGIS connaît sont emplacement. Il ne reste plus qu’à renseigner le Action où
l’image est.

• Sélectionnez image dans la liste :

• Cliquez sur le bouton Insérer un champ. QGIS va ajouter la phrase [% "image" %] dans le champ
Action.

• Cliquez sur le bouton Ajouter l’action à la liste.

• Cliquez sur OK dans la boîte de dialogue Propriétés de la couche.

Nous allons maintenant tester la nouvelle Action :

• Cliquez sur la couche school_property dans la Légende de la carte afin qu’elle soit en surbrillance.

• Trouvez le bouton Exécuter l’action de l’entité (sur la même barre d’outils que le bouton Ouvrir la table
d’attribut) :

• Cliquez sur la flèche en bas à droite de ce bouton. Il y a jusqu’ici seulement une action définie pour cette
couche, qui est celle que vous venez de créer.

• Cliquez sur le bouton pour activer l’outil.

• En utilisant cet outil, cliquez sur une des trois propriétés de l’école.

• L’image pour cette propriété va maintenant s’ouvrir.

6.4.4 Follow Along: Recherche sur Internet

Disons que nous sommes en train d’examiner la carte et voulons en savoir plus à propos de la zone dans laquelle
une ferme se trouve. Supposez que vous ne savez rien de la zone en question et voulez trouver des informations
générales sur elle. Votre première impulsion, en considérant que vous êtes en train d’utiliser en ce moment-même
un ordinateur, serait probablement de googler le nom de la zone. Alors disons à QGIS de le faire automatiquement
pour nous !

• Ouvrez la table d’attribut pour la couche landuse.

Nous utiliserons le champ nom pour chacune de nos zones d’occupation du sol pour la recherche Google.

• Fermez la table d’attribut.

• Retournez à Actions dans Propriétés des couches.

• Dans le champ Propriétés de l’action → Nom, écrivez Recherche Google.
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Ce qui faut ensuite faire varie selon votre système d’exploitation, ainsi choisissez la ligne de conduite appropriée
à suivre :

Windows

• Sous Type, choisissez Ouvrir. Cela va dire à Windows d’ouvrir une adresse internet dans votre navigateur
par défaut, tel qu’Internet Explorer.

Ubuntu Linux

• Sous Action, écrivez xdg-open. Cela va dire à Ubuntu d’ouvrir une adresse internet dans votre navigateur
par défaut, tel que Chrome ou Firefox.

MacOS

• Sous Action, écrivez ouvrir. Cela va dire à MacOS d’ouvrir une adresse internet dans votre navigateur
par défaut, tel que Safari.

Continuez à écrire la commande

Quelle que soit la commande que vous avez utilisée en-dessus, vous devez dire quelle adresse internet ouvrir après.
Vous voulez visiter Google, et rechercher automatiquement une phrase.

Habituellement, lorsque vous utilisez Google, vous entrez votre expression de recherche dans la barre de recherche
Google. Mais dans ce que, vous voulez que votre ordinateur le fasse à votre place. La façon de dire à
Google de rechercher quelque chose (si vous ne voulez pas utiliser directement sa barre de recherche) est de
donner à votre navigateur internet l’adresse http://www.google.com/search?q=SEARCH_PHRASE, où
SEARCH_PHRASE est ce que vous voulez rechercher. Comme nous ne savons pas pour le moment quelle est
l’expression à rechercher, nous allons juste entrer la première partie (sans l’expression de recherche).

• Dans le champ Action, écrivez http://www.google.com/search?q=. Souvenez-vous d’ajouter un
espace après votre commande initiale avant d’écrire celle-là !

Vous voulez maintenant que QGIS dise au navigateur d’indiquer à Google de chercher la valeur du nom pour
chaque entité sur lesquelles vous pourriez cliquer.

• Sélectionnez le champ nom.

• Cliquez sur Insérer un champ :
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Cela va dire à QGIS d’ajouter la phrase suivante :

Cela signifie que QGIS va ouvrir le navigateur et lui envoyer l’adresse
http://www.google.com/search?q=[% "name" %]. Mais [% "name" %] dit à QGIS d’utiliser
les contenus du champ nom comme une expression de recherche.

Si, par exemple, la zone d’utilisation du sol sur laquelle vous cliquez est
nommée Marloth Nature Reserve, alors QGIS va envoyer au navigateur
kbd:http://www.google.com/search?q=Marloth%20Nature%20Reserve, ce qui va dire à votre navigateur de
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visiter Google, qui va à son tour faire une recherche sur “Marloth Nature Reserve”.

• Si vous ne l’avez pas encore fait, mettez en place tout ce qui a été expliqué ci-dessus.

• Cliquez sur le bouton Ajouter à la liste d’action. La nouvelle action apparaîtra dans la liste au-dessus.

• Cliquez sur OK dans la boîte de dialogue Propriétés de la couche.

Il est maintenant temps de tester la nouvelle action.

• Avec la couche landuse activée dans la Légende de la carte, cliquez sur le bouton Exécuter l’action de
l’entité.

• Cliquez sur une zone d’occupation du sol que vous pouvez voir sur la carte. Votre navigateur va maintenant
s’ouvrir, et va automatiquement démarrer une recherche Google pour la ville qui est enregistrée comme
valeur de nom pour cette zone.

Note: Si votre action ne fonctionne pas, vérifiez que tout a été correctement entré ; les fautes de frappe sont
communes avec ce genre de travail !

6.4.5 Follow Along: Ouvrir une page web directement dans QGIS

Ci-dessus, vous avez vu comment ouvrir une page web dans un navigateur externe. Il y a des lacunes dans
cette approche, ce qui ajoute une dépendance inconnue – l’utilisateur final aura-t-il le logiciel requis pour exécuter
l’action sur son système ? Comme vous l’avez vu, ils n’ont même pas nécessairement la même sorte de commande
de base pour le même type d’actions, si vous ne savez pas quel système d’exploitation ils utiliseront. Avec certaines
versions d’OS, les commandes ci-dessus pour ouvrir le navigateur pourraient ne pas fonctionner du tout. Cela
pourrait être un problème insurmontable.

Cependant, QGIS se trouve au sommet de la libraire Qt4 incroyablement puissante et polyvalente. De plus, les
actions de QGIS peuvent être arbitraires, sous forme de jetons (c’est-à-dire en utilisant l’information variable
basée sur le contenu d’un attribut champ) des commandes Pythons !

Vous allez maintenant voir comment utiliser une action python pour montrer un page web. L’idée générale est la
même que pour ouvrir un site dans un navigateur externe, mais cela ne requière par de navigateur sur le système
de l’utilisateur car elle utilise la classe Qt4 QWebView (qui est un widget html de base de webkit) pour afficher le
contenu dans une fenêtre pop-up.

À la place de Google, utilisons cette fois-ci Wikipedia. Ainsi, l’URL dont vous avez besoin ressemblera à ça :

http://wikipedia.org/wiki/SEARCH_PHRASE

Créer l’action associée à la couche:

• Ouvrez la boîte de dialogue Propriétés de la couche et rendez-vous sur l’onglet Actions.

• Paramétrez une nouvelle action en utilisant les propriétés suivantes:

– Type: Python

– Name: Wikipedia

– Action (all on one line): from PyQt4.QtCore import QUrl; from
PyQt4.QtWebKit import QWebView; myWV = QWebView(None);
myWV.load(QUrl(’http://wikipedia.org/wiki/[% "name" %]’));
myWV.show()
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Il y a quelques choses qui se passent par ici :

• Tout le code python est sur une seule ligne avec des points virgules séparant les commandes (à la place de
nouvelles lignes, la manière habituelle de séparer des commandes python).

• [% "name" %] sera remplacé par la valeur de l’attribut réel lorsque l’action est invoquée (comme avant).

• Le code crée simplement une nouvelle instance QWebView, définit son URL, et ensuite appelle show() à
ce sujet pour le rendre visible comme une fenêtre sur le bureau de l’utilisateur.

Notez que c’est un exemple un peu farfelu. Python fonctionne avec une indentation qui a un sens, par conséquent
si l’on sépare les choses par des points-virgules ce n’est pas la meilleure manière de faire. Ainsi, dans la vraie
vie, il est plus fréquent d’importer les éléments d’un module en Python, puis d’appeler une fonction avec comme
paramètre un attribut de champ.

Vous pouvez également utiliser la méthode pour afficher une image sans nécessiter que l’utilisateur ait une vision-
neuse d’image particulière sur son système.

• Essayez d’utiliser les méthodes décrites ci-dessus pour charger une page Wikipedia en utilisant l’action
Wikipedia que vous venez de créer.

6.4. Lesson: Actions 147



QGIS Training Manual, Version 2.18

6.4.6 In Conclusion

Les actions vous permettent d’ajouter à vos cartes de nouvelles fonctionnalités, utiles pour l’utilisateur final
qui verra les mêmes cartes que dans QGIS. Grâce à l’utilisation de commandes shell pour tous les systèmes
d’exploitation, tout comme des instructions en Python, il n’y a pas de limite aux fonctions que vous pouvez
incorporer.

6.4.7 What’s Next?

Maintenant que vous avez fait toutes sortes de créations de données vectorielles, vous apprendrez à analyser ces
données pour résoudre des problèmes. Ceci est le sujet du prochain module.
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Module: Analyse vectorielle

Maintenant que vous avez modifié quelques entités, vous souhaitez sûrement savoir ce que l’on peut faire d’autre
avec elles. Avoir des entités avec des attributs, c’est bien, mais une fois finie, la carte ne vous apprendra rien de
plus qu’une carte non-SIG.

Le principal avantage d’un SIG est qu’un SIG peut répondre à des questions.

Pour les trois prochains modules, nous nous efforcerons de répondre à une question de recherche en utilisant des
fonctions SIG. Par exemple, vous êtes un agent immobilier recherchant une propriété résidentielle dans Swellen-
dam pour des clients ayant comme critères :

1. La propriété doit être dans Swellendam.

2. Elle doit être à une distance correcte en voiture (disons 1km) d’une école.

3. Sa taille doit être supérieure à 100 m².

4. Être située à moins de 50 m de la route principale.

5. Être située à moins de 500 m d’un restaurant.

Dans les prochains modules, nous allons exploiter la puissance des outils d’analyses SIG pour localiser les terrains
adaptés pour ce nouveau quartier résidentiel.

7.1 Lesson: Reprojeter et transformer des données

Parlons de nouveau des Systèmes de Coordonnées de Référence (SCR). Nous en avons touché quelques mots
auparavant, mais nous n’avons pas discuté de ce que cela signifie en pratique.

Le but de cette leçon : Reprojeter et transformer des jeux des données.

7.1.1 Follow Along: Projections

Le SCR that all the data as well as the map itself are in right now is called WGS84. C’est un Système de
Coordonnées Géodésique (SCG) très fréquent pour représenter de la donnée. Mais comme nous allons le voir, il
y a un problème.

• Sauvegardez votre carte actuelle.

• Puis ouvrez la carte du monde située dans le répertoire exercise_data/world/world.qgs.

• Zoomer sur l’Afrique du Sud en utilisant l’outil Zoom +.

• Définissez une échelle dans le champ Echelle, laquelle se situe dans la Barre d’état le long du bas de l’écran.
Une fois au dessus de l’Afrique du Sud, renseignez sa valeur à 1:5000000 (un cinq millionième).

• Déplacez vous sur la carte tout en gardant un oeil sur le champ Echelle.
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Avez-vous vu le changement d’échelle ? C’est parce que vous vous éloignez du point sur lequel vous avez zoomé
à 1:5000000, ce dernier était au centre de votre écran. Tout autour de ce point, l’échelle est différente.

Pour comprendre pourquoi, pensez au globe terrestre. Il y a des lignes imaginaires s’étendant du Nord au Sud. Ce
sont les lignes de longitude qui sont éloignées à l’équateur, mais qui se rejoignent aux pôles.

Dans un SCG, vous travaillez sur cette sphère, mais votre écran lui reste plat. Lorsque vous représentez une sphère
sur une surface plane, de la distorsion apparaît, comme ce qu’il arriverait si vous coupiez une balle de tennis et que
vous tentiez de l’aplatir. Sur une carte, cela signifierait que les lignes de longitude resteraient parallèles, même
aux pôles (où elles sont supposées se rencontrer). Ce qui signifie qu’au fur et à mesure que vous vous éloignez de
l’équateur, l’échelle des objets sera de plus en plus grande. Dans notre cas, cela signifie qu’il n’y a pas d’échelle
constante sur notre carte !

Pour résoudre ce problème, utilisons à la place un Système de Coordonnées Projeté (SCP). Un SCP “projette” ou
convertit la donnée de manière à prendre en compte les changements d’échelle et de les corriger. Par conséquent,
pour garder une échelle constante, nous devrons reprojeter nos données et utiliser un SCP.

7.1.2 Follow Along: La reprojection ‘à la volée’

QGIS vous permet de reprojeter la donnée ‘à la volée’. Ce qui signifie que même si la donnée elle-même est dans
un SCR différent, QGIS peut la projeter comme si elle était dans un SCR de votre choix.

• Pour activer la projection ‘à la volée’, cliquez sur le bouton Statut de la projection dans la Barre d’état le
long du bas de la fenêtre QGIS :

• Dans la boîte de dialogue qui apparaît, cochez la case à côté de Activer la projection ‘à la volée’.

• Saisissez le mot global dans le champ Filtre. Un SCR (NSIDC EASE-Grid Global) doit apparaître dans
la liste des SCR mondiaux.

• Cliquez sur NSIDC EASE-Grid Global pour le sélectionner, puis cliquez sur OK.

• Remarquez comment la forme de l’Afrique du Sud change. Toutes les projections fonctionnent en modifiant
la forme apparente des objets sur Terre.

• Zoomez de nouveau à l’échelle de 1:5000000, comme avant.

• Déplacez vous sur la carte.

• Notez que l’échelle reste fixe !

La reprojection ‘à la volée’ est également utilisée pour visualiser des jeux de données ayant des SCR différents.

• Une nouvelle fois, désactivatez la reprojection ‘à la volée’ :

– Cliquez sur le bouton Statut de la projection.

– Décochez la case Activer la projection ‘à la volée’.

– Cliquez sur OK.

• Dans QGIS 2.0, la reprojection ‘ à la volée’ est activée automatiquement lorsque des couches avec différents
SCR sont chargées dans la carte. Pour comprendre ce que signifie reprojection à la volée, désactivez ce
réglage automatique:

– Allez dans le menu Préférences → Options...

– Dans le panneau de gauche, sélectionnez SCR.

– Décochez Activer automatiquement la projection à la volée si les couches ont des SCR différents.

– Cliquez sur OK.
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• Ajoutez une autre couche vecteur à votre carte ayant seulement des données en Afrique du Sud. Vous la
trouverez dans le répertoire exercise_data/world/RSA.shp.

Que remarquez-vous ?

La couche n’est pas visible ! Mais c’est facile à corriger, non ?

• Un clic droit sur la couche RSA dans la Liste des couches.

• Sélectionnez Zoomer sur la couche.

Nous voyons désormais l’Afrique du Sud... mais où est passé le reste du monde ?

Nous pouvons zoomer sur chacune des deux couches, mais nous ne pouvons pas les voir les deux en même temps.
C’est à cause de leur Système de Coordonnées de Référence différent. Le jeu de données continents est en degrés,
mais celui du RSA est en mètres. Donc, prenons un point dans la ville du Cap dans le jeu de données du RSA, il
est situé à une distance d’à peu près 4 100 000 mètres par rapport à l’équateur. Mais dans celui des continents,
le même point a une distance de 33.9 degrés par rapport à l’équateur.

C’est la même distance - mais QGIS ne le sait pas. Vous ne lui avez pas dit de reprojeter la donnée. Pour l’instant,
notre version de l’Afrique du Sud de la couche RSA affiche une distance correcte de 4 100 000 mètres par
rapport à l’équateur. Mais dans le jeu de données continents, la ville du Cap est à seulement 33.9 mètres de
l’équateur ! Vous comprenez pourquoi il y a un problème.

QGIS ne sait pas où la ville du Cap est supposée être - ce sont les données qui vont lui dire. Si les données disent
à QGIS que la ville du Cap est à 34 mètres de distance de l’équateur et que l’Afrique du Sud mesure seulement
12 mètres du Nord au Sud, c’est ce que QGIS dessinera.

Pour corriger :

• Cliquez sur le bouton Statut de la projection et réactivez Activer automatiquement la projection à la volée
si les couches ont des SCR différents. comme auparavant.

• Zoomer sur l’emprise du jeu de données RSA.

Désormais, parce qu’ils sont projetées dans le même SCR, les deux jeux de données correspondent parfaitement :

Lors de la combinaison de données de différentes sources, il est important de se rappeler qu’elles ne sont peut-être
pas dans le même SCR. La reprojection ‘à la volée’ vous aide à les afficher ensemble.
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Avant de continuer, vous souhaitez certainement avoir la reprojection ‘à la volée’ s’activant automatiquement dès
que vous ouvrirez des jeux de données dont le SCR est différent :

• De nouveau dans le menu Préférences → Options..., sélectionnez SCR.

• Activez Activer automatiquement la projection à la volée si les couches ont des SCR différents.

7.1.3 Follow Along: Enregistrer un jeu de données dans un autre SCR

Vous souvenez-vous lorsque nous avons calculé les surfaces des bâtiments dans la leçon sur la Classification ?
Vous avez fait en sorte de classer les bâtiments en fonction de leur surface au sol.

• Ouvrez votre carte habituelle de nouveau (contenant les données de Swellendam).

• Ouvrez la table attributaire pour la couche buildings.

• Défilez vers la droite jusqu’à voir le champ AREA.

Vous remarquerez que les aires sont très petites ; probablement zéro. Ceci s’explique du fait que les aires soient
données en degrés - les données ne sont pas dans un Système de Coordonnées Projetées. Dans le but de calculer
les surfaces des terrains en mètres carrés, les données doivent également être en mètres carrés. Nous avons donc
besoin de les reprojeter.

Avoir juste une reprojection ‘à la volée’ n’aidera pas. ‘A la volée’ est explicite - ça ne change pas les données, les
couches sont juste reprojetées telles qu’elles apparaissent sur la carte. Pour vraiment reprojeter la donnée, vous
devez l’exporter dans un nouveau fichier en utilisant une nouvelle projection.

• Un clic droit sur la couche buildings dans la Liste des couches.

• Sélectionnez Sauvegardez sous... dans le menu qui est apparaît. Il vous sera présenté le dialogue Enregistrer
la couche vectorielle sous....

• Cliquez sur le bouton Parcourir à côté du champ Sauvegarder sous.

• Navigez dans le répertoire exercise_data/ et indiquez le nom de la nouvelle couche comme
buildings_reprojected.shp.

• Laissez le Codage tel quel.

• Changez la valeur de la liste déroulante SCR en SCR de la sélection.

• Cliquez sur le bouton Parcourir sous la liste déroulante.

• Le Sélectionneur de système de coordonnées de référence apparaîtra.

• Dans son champ Filtre, recherchez 34S.

• Choisissez WGS 84 / UTM zone 34S dans la liste.

• Laissez la valeur pour Exporter la symbologie.

Le dialogue Enregistrer la couche vectorielle sous... ressemble désormais à :
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• Cliquez sur OK.

• Créez une nouvelle carte et chargez la couche reprojetée que vous venez juste de créer.

Reportez-vous à la leçon sur la Classification pour voir comment les surfaces ont été calculées.

• Mettez à jour (ou ajoutez) le champ AREA en exécutant la même expression qu’avant :
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Un champ AREA sera ajouté avec la surface de chaque bâtiment en mètres carrés.

• Pour calculer les surfaces dans une autre unité de mesure, en hectares par exemple, utilisez le champ AREA
pour créer une deuxième colonne :
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Observez les nouvelles valeurs dans votre table attributaire. C’est beaucoup plus utile, car les gens mesurent les
bâtiments en mètres et pas en degrés. C’est pour cette raison qu’il est intéressant de reprojeter vos données, si
nécessaire, avant de calculer des surfaces, des distances, et toute autre valeur dépendante des propriétés spatiales
de la couche.

7.1.4 Follow Along: Créez votre propre projection

Il existe beaucoup plus de projections que celles incluses dans QGIS par défaut. Vous pouvez également créer vos
propres projections.

• Débutez une nouvelle carte.

• Chargez le jeu de données world/oceans.shp.

• Allez dans Préférences → Projection personnalisée... et vous devriez voir ce dialogue :
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• Cliquez sur le bouton Ajouter un nouveau SCR pour créer une nouvelle projection.

Une projection intéressante à utiliser est nommée Van der Grinten I.

• Entrez son nom dans le champ Nom.

Cette projection représente la Terre dans un champ circulaire plutôt que rectangulaire, comme la plupart des autres
projections.

• Pour ses paramètres, utilisez la phrase suivante :

+proj=vandg +lon_0=0 +x_0=0 +y_0=0 +R_A +a=6371000 +b=6371000 +units=m
+no_defs
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• Cliquez sur OK.

• Activez la projection ‘à la volée’.

• Choisissez votre projection nouvellement définie (faites une recherche sur son nom dans le champ Filtre).

• En appliquant la projection, voici ce à quoi doit ressembler la carte :
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7.1.5 In Conclusion

Différentes projections sont utiles à différentes fins. En choisissant une projection correcte, vous vous assurez que
les entités de votre carte seront représentées de manière précise.

7.1.6 Further Reading

Les éléments pour la section Avancée de ce cours ont été tirés de cet article.

Des informations complémentaires sur les Systèmes de Coordonnées de Référence sont disponibles ici.

7.1.7 What’s Next?

Dans la prochaine leçon, vous allez apprendre comment analyser des données vectorielles en utilisant les différents
outils de QGIS.

7.2 Lesson: Analyse Vectorielle

Les données vectorielles peuvent aussi être analysées pour révéler comment les différentes entités interagissent
entre elles dans l’espace. Il existe beaucoup de fonctions liées à l’analyse dans les SIG, ainsi nous n’allons pas
toutes les explorer. Nous allons plutôt poser une question et essayer de la résoudre en utilisant les outils que QGIS
prévoit.

Objectif de cette leçon : Poser une question et la résoudre en utilisant les outils d’analyse.
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7.2.1 Le processus SIG

Avant de commencer, il serait utile de donner un bref aperçu d’un processus qui peut être utilisé pour résoudre les
problèmes en SIG. Les étapes à suivre à ce sujet sont :

1. Énoncer le problème

2. Obtenir les données

3. Analyser le problème

4. Présenter les résultats

7.2.2 Le problème

Nous allons commencer le processus en décidant d’un problème à résoudre. Par exemple, vous êtes un agent
immobilier et vous recherchez une propriété résidentielle à Swellendam pour des clients dont les critères sont les
suivants:

1. Elle doit être en Swellendam.

2. Elle doit être à une distance raisonnable en voiture (disons 1km) d’une école

3. Elle doit avoir une taille de plus de 100m²

4. A moins de 50m d’une route principale

5. A moins de 500m d’un restaurant.

7.2.3 Les données

Pour répondre à ces questions, nous aurons besoin des données suivantes:

1. Les propriétés résidentielles (constructions) dans le périmètre,

2. Les routes dans et autour de la ville,

3. La localisation des écoles et des restaurants,

4. La taille des constructions.

Toutes ces données sont disponibles via OSM et vous pourriez trouver que le jeu de données que vous utilisez
depuis le début de ce manuel peut aussi l’être pour cette leçon. Toutefois, afin de nous assurer que nous avons
toutes les données requises, nous allons re-télécharger les données depuis OSM à l’aide de l’outil de télécharge-
ment de données OSM intégré à QGIS.

Note: Bien que les données OSM en téléchargement ont des champs cohérentes, la couverture et le détail varie.
Si vous trouvez que votre région choisie ne contient pas d’informations sur les restaurants, par exemple, vous
devriez peut-être choisir une région différente.

7.2.4 Follow Along: Démarrer un Projet

• Démarrez un nouveau projet QGIS.

• Utilisez l’outil de téléchargement de données disponible dans le menu Vecteur –> OpenStreetMap pour
télécharger les données de la région que vous avez retenue.

• Sauvegardez les données sous osm_data.osm dans votre dossier exercise_data.
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• Notez que le format osm est un type de données vectorielles. Ajoutez ces données comme une couche
vectorielle comme habituellement Couche → Ajouter une couche vecteur..., naviguez jusqu’au nouveau
fichier osm_data.osm que vous venez juste de télécharger. Vous pourriez avoir besoin de sélectionner
Afficher tous les fichiers comme format de fichier.

• Sélectionnez osm_data.osm et cliquez sur Ouvrir

• Dans la fenêtre qui s’ouvre, sélectionnez toutes les couches, à l’exception de other_relations et
multilinestrings:

Les données OSM seront importées en couches séparées dans votre carte.

Les données que vous venez de télécharger de l’OSM sont dans un système de coordonnées géographiques,
WGS84, qui utilise des coordonnées latitudinales et longitudinales, comme vous l’avez vu dans la leçon précé-
dente. Vous avez également appris que pour calculer des distances en mètres, nous devons travailler avec un
système de coordonnées projeté. Commencez par changer le système de coordonnées de votre projet en un SCR
adéquat pour vos données, dans le cas de Swellendam, WGS 84 / UTM zone 34S :

• Ouvrez la boîte de dialogue Propriétés du projet, sélectionnez SCR et déroulez la liste pour trouver
WGS 84 / UTM zone 34S.

• Cliquez sur OK.

Nous devons maintenant extraire l’information dont nous avons besoin pour le jeu de données OSM. Nous avons
besoin des couches représentant toutes les maisons, les écoles, les restaurants et les routes de la région. Cette
information se trouve dans la couche multipolygons et peut être extraite en utilisant les informations dans sa Table
des attributs. Nous commencerons avec la couche schools :

• Faites un clic droit sur la couche multipolygons dans le Panneau Couches et ouvrez les Propriétés de la
couche.

• Rendez-vous sur l’onglet Général.

• Sous Sous-ensemble de la couche cliquez sur le bouton [Constructeur de requêtes] pour ouvrir la boîte de
dialogue Constructeur de requêtes.

• Dans Champs à gauche dans cette boîte de dialogue descendez jusqu’à ce que vous voyiez le champ
amenity.

• Cliquez dessus une fois.

• Cliquez sur le bouton Tout en-dessous de la liste Valeurs:
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Maintenant, nous devons dire à QGIS de ne nous montrer que les polygones dont la valeur amenity est égale à
school.

• Double-cliquez sur le mot amenity dans la liste Champs.

• Regardez ce qu’il se passe dans le champ Expression spécifique de filtre du prestataire ci-dessous.

Le mot "amenity" a apparu. Pour construire le reste de la commande :

• Cliquez sur le bouton = (sous Opérateurs).

• Double-cliquez sur la valeur school dans la liste Valeurs.

• Cliquez sur OK deux fois.

Cela va filtrer la couche OSM multipolygons pour montrer seulement les écoles dans votre région. Vous
pouvez maintenant soit :

• Renommez la couche OSM filtrée en schools et réimportez la couche multipolygons depuis
osm_data.osm, OU

• Duppliquez la couche filtrée, renommez la copie, effacez le Constructeur de requête et créez votre
nouvelle requête dans le Constructeur de requêtes.
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7.2.5 Try Yourself Extraire les couches demandées OSM

En utilisant la technique ci-dessus, utilisez l’outil Constructeur de requêtes pour extraire les données
restantes pour créer les couches suivantes :

• roads (de la couche OSM lines)

• restaurants (de la couche OSM multipolygons)

• houses (de la couche OSM multipolygons)

Vous pouvez réutiliser la couche roads.shp que vous avez créée dans les leçons précédentes.

Vérifiez vos résultats

• Sauvegardez votre carte sous analysis.qgs, dans exercise_data (cette carte sera utilisée dans de
prochains modules).

• Dans votre gestionnaire de fichier de votre système d’exploitation, créez un nouveau dossier sous exer-
cise_data et appelez-le residential_development. C’est ici que vous sauvegardez les jeux de don-
nées qui seront les résultats des fonctions d’analyse.

7.2.6 Try Yourself Trouver des routes principales

Quelques-unes des routes dans le jeu de données OSM sont listées comme unclassified, tracks, path et
footway. Nous voulons les exclure de notre jeu de données des routes.

• Ouvrez le Constructeur de requête pour la couche roads, cliquez sur Effacer et construisez la
requête suivante :

"highway" != ’NULL’ AND "highway" != ’unclassified’ AND "highway" !=
’track’ AND "highway" != ’path’ AND "highway" != ’footway’

Vous pouvez soit utiliser l’approche ci-dessus, où vous double-cliquez sur les valeurs et cliquez sur les boutons,
ou vous pouvez copier et coller la commande ci-dessus.

Cela doit immédiatement réduire le nombre de routes sur votre carte :
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7.2.7 Try Yourself Convertir le SCR des couches

Parce que nous allons mesurer des distances dans nos couches, nous devons changer le SCR des couches. Pour
faire cela, nous devons sélectionner chaque couche l’une après l’autre, sauvegardez la couche dans un nouveau
shapefile avec notre nouvelle projection, puis importer cette nouvelle couche dans notre carte.

Note: Dans cet exemple, nous utilisons le SCR WGS 84 / UTM zone 34S, mais vous pouvez utiliser un SCR
UTM qui est plus approprié pour votre région.

• Faites un clic droit sur la couche roads dans l’onglet Couches.

• Cliquez sur Sauvegarder sous...

• Dans la boîte de dialogue Sauvegarder le vecteur sous, choisissez les paramètres suivants et
cliquez sur Ok (en étant sûr d’avoir sélectionné Ajouter les fichiers sauvegardés à la
carte) :
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Une nouvelle couche shapefile sera créée et ajoutée à la carte.

Note: Si vous n’avez pas coché Activer la projection ‘à la volée’ ou les paramètres Activer automatiquement la
projection à la volée si les couches ont des SCR différents (voir leçon précédente), vous ne pourrez pas voir les
nouvelles couches que vous venez d’ajouter à la carte. Dans ce cas, vous pouvez focaliser la carte sur une des
couches en faisant un clic droit sur une couche et en cliquant sur Zoomer sur la couche, ou juste en activant pour
une des couches les options mentionnées ‘à la volée’.

• Supprimez l’ancienne couche roads.

164 Chapter 7. Module: Analyse vectorielle



QGIS Training Manual, Version 2.18

Répétez ce processus pour chaque couche, en créant un nouveau shapefile et une couche avec “_34S” appondu au
nom originale et enlevez chacune des anciennes couches.

Une fois que vous avez terminé ce processus pour chaque couche, faites un clic droit sur une couche et cliquez sur
Zoom sur la couche pour focaliser la carte sur la zone d’intérêt.

Maintenant que nous avons converti les données OSM en une projection UTM, nous pouvons commencer nos
calculs.

7.2.8 Follow Along: Analyse du problème : Distances des écoles aux routes

QGIS vous permet de calculer des distances depuis tout objet vecteur.

• Soyez sûr que seules les couches roads_34S et houses_34S sont visibles, pour simplifier la carte pendant
que vous travaillez.

• Click on the Vector → Geoprocessing Tools → Fixed distance buffer tool:

Une nouvelle fenêtre s’ouvre.

• Configurez-la comme ceci :

The Distance is in meters because our input dataset is in a Projected Coordinate System that uses meter as its basic
measurement unit. This is why we needed to use projected data.

• Sauvegardez la couche résultante sous exercise_data/residential_development/ comme
roads_buffer_50m.shp.

• Cliquez sur OK et il créera une zone tampon.

• Lorsqu’on vous demande s’il faut “ajouter la nouvelle couche à la Légende”, cliquez sur Oui (La “Légende”
indique la Liste des couches).

• Close the Fixed distance buffer dialog.
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Maintenant, votre carte devrait ressembler à peu près à ceci:

Si votre nouvelle couche est tout en haut de la Légende de la carte, elle obscurcira probablement une
grande partie de votre carte, mais cela nous donne toutes les zones de région qui sont à 50m d’une route.

Cependant, vous remarquerez qu’il y a des zones distinctes à l’intérieur de notre tampon, qui correspondent à
toutes les routes individuelles. Pour se débarrasser de ce problème, enlevez la couche et recréez le tampon en
utilisant les paramètres indiqués ici :
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• Note that we’re now checking the Dissolve result box.

• Sauvegardez la sortie sous le même nom qu’avant (cliquez sur Oui lorsqu’on vous demande votre permission
pour écraser l’ancien fichier).

• Click OK and close the Fixed distance buffer dialog again.

Une fois que vous avez ajouté la couche à la Légende de la carte, ça ressemblera à cela :
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Il n’y a maintenant plus de subdivisions inutiles.

7.2.9 Try Yourself Distance depuis les écoles

• Utilisez la même approche qu’en haut et créez un tampon pour vos écoles.

Il doit être de 1 km de rayon, et sauvegardé dans le répertoire commun sous schools_buffer_1km.shp.

Vérifiez vos résultats

7.2.10 Follow Along: Chevauchement des zones

Maintenant que nous avons des zones où les routes sont à 50 mètres de distance et où il y a une école à moins
d‘1 km (à vol d’oiseau, pas par la route). Mais évidemment, nous ne voulons que les zones où ces deux critères
sont respectés. Pour faire cela, nous devrons utiliser l’outil Intersection. Cherchez-le sous Vecteur → Outils de
géotraitement → Intersection. Configurez-le comme suit :
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Les deux couches source sont les deux tampons ; l’emplacement de la sauvegarde est comme d’habitude ; et le
nom du fichier est road_school_buffers_intersect.shp. Une fois que c’est configuré comme ceci,
cliquez sur OK et ajoutez la couche à la Légende de la carte quand demandé.

Dans l’image ci-dessous, les zones bleues nous montrent où les deux critères de distance sont satisfaits en même
temps !
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Vous pouvez enlever les deux couches de tampon et garder seulement celle qui montre où elles se croisent, étant
donné que c’est ce que nous voulons vraiment savoir en premier lieu :

7.2.11 Follow Along: Sélection des bâtiments

Vous avez maintenant la région que les bâtiments doivent partiellement recouvrir. Ensuite, vous voulez sélection-
ner les bâtiments dans la zone.
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• Cliquez sur l’entrée du menu Vecteur → Outils de recherche → Sélection par localisation. Une fenêtre
apparaîtra.

• Configurez-la comme ceci :

• Cliquez sur OK puis sur Fermer.

• Vous trouverez sans doute que peu de choses semblent avoir changé. Si oui, déplacez la couche
school_roads_intersect tout en haut de la légende de la carte, puis faites un zoom avant :
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Les bâtiments en surbrillance jaune sont ceux qui remplissent nos critères et sont sélectionnés, alors que les
bâtiments en vert sont ceux qui ne le sont pas. Nous pouvons maintenant sauvegarder les bâtiments sélectionnés
dans une nouvelle couche.

• Faites un clic droit sur la couche houses_34S dans la Légende de la carte.

• Sélectionnez Sauvegarder la sélection sous....

• Configurez la boîte de dialogue comme ceci :
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• Le nom du fichier est well_located_houses.shp.

• Cliquez sur OK.

Vous avez désormais la sélection dans une couche séparée et pouvez enlever la couche houses_34S.
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7.2.12 Try Yourself Filtrer davantage nos bâtiments

Nous avons maintenant une couche qui nous montre tous les bâtiments à 1km d’une école et à 50m d’une route.
Nous devons maintenant réduire la sélection pour ne montrer que les bâtiments qui sont à 500m d’un restaurant.

En utilisant les processus décrits ci-dessus, créez une nouvelle couche nommée houses_restaurants_500m
qui filtre davantage votre couche well_located_houses pour ne montrer que les bâtiments qui sont à 500m
d’un restaurant.

Vérifiez vos résultats

7.2.13 Follow Along: Sélection des bâtiments de la bonne taille

Pour voir quels bâtiments sont de la bonne taille (plus de 100 mètres carrés), nous devons d’abord calculer leur
taille.

• Ouvrez la table attributaire de la couche houses_restaurants_500m.

• Entrez en mode d’édition et ouvrez la calculatrice de champ.

• Configurez-la comme ceci :
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• Si vous ne trouvez pas AREA dans la liste, essayez donc de créer un nouveau champ comme vous l’avez fait
dans la précédente leçon de ce module.

• Cliquez sur OK.

• Défilez vers la droite de la table attributaire ; votre champ AREA a maintenant des aires en mètres pour tous
les bâtiments dans votre couche houses_restaurants_500m.

• Cliquez à nouveau sur le bouton du mode d’édition pour finir l’édition, et sauvegardez vos modifications
quand on vous le demande.

• Construisez une requête comme précédemment dans cette leçon :

• Cliquez sur OK. Votre carte devrait maintenant ne vous montrer que ces bâtiments qui remplissent nos
critères de départ et qui ont une taille de plus de 100m carrés.

7.2.14 Try Yourself

• Sauvegardez votre solution dans une nouvelle couche, en utilisant l’approche que vous avez apprise ci-
dessus pour le faire. Le fichier devrait être sauvé sous le répertoire courant, avec le nom solution.shp.
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7.2.15 In Conclusion

En utilisant l’approche de résolution de problèmes SIG ainsi que les outils QGIS d’analyse vectorielle, vous avez
été capable de résoudre rapidement et facilement un problème avec de multiples critères.

7.2.16 What’s Next?

Dans la prochaine leçon, nous verrons comment calculer la plus petite distance par la route d’un point à un autre.

7.3 Lesson: Analyse de réseau

Calculer la plus petite distance entre deux points est une utilisation communément citée pour les SIG. QGIS est
livré avec cet outil, mais il n’est pas visible par défaut. Dans cette courte leçon, nous allons voir ce dont vous avez
besoin pour commencer.

Objectif de cette leçon : Activer, configurer et utiliser l’extension Graphes routiers.

7.3.1 Follow Along: Activer l’Outil

QGIS a beaucoup d’extensions qui complètent ses fonctions de base. Beaucoup de ces extensions sont si utiles
qu’elles sont livrées avec QGIS. Elles sont cependant toujours cachées par défaut. Donc pour pouvoir les utiliser,
vous devez d’abord les activer.

Pour activer l’extension Graphes routiers :

• Ouvrez le Gestionnaire d’extensions en cliquant sur l’élément du menu de la fenêtre principale Extensions
→ Installer/Gérer les extensions.... Une boîte de dialogue apparaît.

• Sélectionnez l’extension comme ceci :

• Cliquez sur Fermer dans la boîte de dialogue Gestionnaire d’extensions.
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Note: Si vous ne voyez pas l’extension dans votre interface, allez dans Vue → Panneaux et assurez-vous que Plus
court chemin a été coché.

Ce panneau apparaîtra dans votre interface :

7.3.2 Follow Along: Configurer l’Outil

Pour disposer d’une couche sur laquelle calculer, enregistrer d’abord votre carte. Si vous ne l’avez pas déjà
fait, enregistrer votre couche roads_34S dans un fichier Shape en faisant un clic-droit sur la couche et en
sélectionnant Enregistrer sous.... Créez une nouvelle carte et charger cette couche à l’intérieur.

Tant qu’autant de configurations différentes sont possibles pour l’analyse des réseaux, l’extension ne propose rien
avant que vous l’ayez configuré. Cela signifie qu’il ne se passera rien du tout si vous ne la configurez pas d’abord.

• Cliquez sur l’élément du menu Vecteur → Graphes routiers → paramètres. Une boîte de dialogue apparaî-
tra.

• Vérifiez que la configuration est comme suit (utilisez les paramètres par défaut à moins que quelque chose
d’autre soit spécifié) :
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• Unité de temps : heure

• Unité de distance : kilomètre

• Couche : roads_34S

• Champ de vitesse : Toujours utiliser par défaut / km/h
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• Direction : Direction à deux voies

• Vitesse : 60

7.3.3 Follow Along: Utiliser l’Outil

Trouvez deux points, sur les routes, sur votre carte. Ils n’ont pas besoin d’avoir de signification, mais ils devraient
être connectés par des routes et séparés par une distance raisonnable :
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• Dans le panneau extension, cliquez sur le bouton Créer un Point à côté du champ Départ :
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• Cliquez sur votre point de départ.

• Utilisez le bouton Créer un Point à côté du champ Stop et capturez le point d’arrivée que vous avez choisi.

• Cliquez sur le bouton Calculer pour voir la solution :
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7.3.4 Follow Along: Utilisation de critères

Note: Section développée par Linfiniti et S Motala (Cape Peninsula University of Technology)

• Ajoutez votre couche restaurants_34S à la carte (extrayez-la de votre carte analyis au besoin).

• Ouvrez la table attributaire pour la couche roads_34S et entrez en mode d’édition.

• Ajoutez une nouvelle colonne avec le nom SPEED, et donnez-lui le type Nombre entier avec une taille de
3.

• Dans la fenêtre principale, activez l’outil Sélectionner des entités avec un rectangle :
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• Sélectionnez les routes principales dans les régions urbaines - mais pas résidentielles :

(Pour sélectionner plus qu’une seule route, maintenez le bouton ctrl enfoncé et dessinez une boîte sur toutes les
routes que vous souhaitez inclure dans la sélection.)

• Dans la table attributaire, sélectionnez Montrer les entités sélectionnées.
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• Fixez la valeur SPEED pour toutes les rues sélectionnées à 60 :

Dans ce contexte, selon signifie que vous configurez la limite de vitesse sur ces routes à 60 km/h.

• Sélectionnez les autoroutes ou routes principales à l’extérieur des zones urbaines :
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• Fixez la valeur SPEED pour toutes les rues sélectionnées à 120.

• Fermez la table attributaire, sauvegardez vos modifications, et quittez le mode d’édition.

• Vérifiez les Vecteur → Graphes routiers → Paramètres des graphes routiers pour être sûr qu’ils sont con-
figurés comme expliqués précédemment dans cette leçon, mais avec une valeur Vitesse fixée grâce au champ
SPEED que vous venez de créer.

• Dans le panneau Plus court chemin, cliquez sur le bouton Point de départ.

• Fixez le point de départ sur une route mineure d’un côté de Swellendam et le point d’arrivée sur une route
principale de l’autre côté de la ville :
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• Dans la liste déroulante Critère dans le panneau Plus court chemin, sélectionnez Longueur.

• Cliquez sur Calculer. La route sera calculée pour la plus petite distance :

Notez la valeur de la Longueur et du Temps dans le panneau Plus court chemin.

• Fixez le Critère à Temps.

• Cliquez à nouveau sur Calculer. La route sera calculée pour le temps le plus court :
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Vous pouvez basculer entre ces critères, recalculez à chaque fois, et notez les changements dans la Longueur et le
Temps. Souvenez-vous que l’hypothèse faite pour arriver à l’heure pour parcourir un itinéraire ne tient pas compte
de l’accélération, et suppose que vous roulerez à la vitesse maximale à tout moment. Dans une situation réelle,
vous pouvez vouloir couper des routes en plus petites sections et noter la vitesse moyenne ou attendue dans chaque
section, plutôt que la limitation de vitesse.

Si vous observez une erreur indiquant qu’il manque un chemin lorsque vous cliquez sur Calculer, assurez-vous que
les routes que vous avez numérisées se rencontrent bien. Si elles ne se touchent pas, modifiez-les en redessinant
leur géométrie ou paramétrez la tolérance topologique dans les paramètres de l’extension. Si elles passent l’une
sur l’autre sans s’intersecter, utilisez l’outil Séparer les entités pour “séparer” les routes à leurs intersections.

Souvenez-vous que l’outil Séparer les entités ne fonctionne qu’en mode d’édition sur les entités sélectionnées !

Vous pourriez aussi cosntater que la route la plus courte et aussi la plus rapide si cette erreur est renvoyée.

7.3.5 In Conclusion

Vous savez maintenant comment utiliser l’extension Graphes routiers pour résoudre des problèmes de plus court
chemin.

7.3.6 What’s Next?

Vous verrez ensuite comment exécuter des algorithmes de statistiques spatiales sur des jeux de données vecto-
rielles.

7.4 Lesson: Statistiques Spatiales

Note: Leçon développée par Linfiniti et S Motala (Cape Peninsula University of Technology)
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Les statistiques spatiales vous permettent d’analyser et de comprendre ce qu’il se passe dans un jeu de données
vectorielles. QGIS comprend plusieurs outils standards pour l’analyse statistique qui s’avèrent utiles à cet égard.

L’objectif de cette leçon: Apprendre à utiliser les outils de statistiques spatiales dans QGIS.

7.4.1 Follow Along: Créer un jeu de données test

Afin de disposer d’un jeu de données de type point à utiliser, nous allons créer un jeu de points au hasard.

Pour ce faire, vous aurez besoin d’un jeu de données de type polygone qui définira l’étendue de la zone dans
laquelle vous voulez créer les points.

Nous allons utiliser l’emprise couverte par les rues.

• Créer une nouvelle carte vide

• Ajoutez votre couche roads_34S, ainsi que le raster srtm_41_19.tif (données d’élévation) trouvé
sous exercise_data/raster/SRTM/.

Note: Vous pourriez trouver que votre couche SRTM MNE a un SCR différent que celui de la couche des routes.
Si c’est le cas, vous pouvez reprojeter soit les routes soit la couche MNE en utilisant les techniques apprises plus
tôt dans ce module.

• Utilisez l’outil Enveloppe(s) Convexe(s) (disponible dans Vecteur → Outils de géotraitement) pour générer
une zone englobant toutes les routes:
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• Enregistrez le fichier de sortie sous roads_hull.shp dans le dossier
exercise_data/spatial_statistics/.

• Cochez l’option Ajouter le résultat au canevas afin d’avoir la couche dans la légende de carte (Panneau
Couche)

Création de points aléatoires

• Créer des points aléatoires dans cette zone à l’aide de l’outil Vecteur → Outils de recherche → Points
aléatoires:
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• Enregistrez le fichier de sortie sous random_points.shp dans le dossier
exercise_data/spatial_statistics/.

• Cochez l’option Ajouter le résultat au canevas afin d’avoir la couche dans la légende de carte (Panneau
Couche)
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Échantillonage des données

• Pour créer un simple jeu de données depuis le raster, vous devrez utiliser l’extension Point sampling tool.

• Si nécessaire, consultez auparavant le module sur les extensions.

• Search for the phrase point sampling in the Plugin → Manage and Install Plugins... and you will find
the plugin.

• Une fois activé dans le Gestionnaire d’extensions, vous verrez apparaître l’outil sous Extension → Analyses
→ Point sampling tool:
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• Sélectionnez la couche random_points qui contiendra l’échantillon de points et le raster SRTM comme
bande depuis laquelle les données seront extraites.

• Soyez sûr que “Ajouter la couche créée à la table des matières” est coché.

• Enregistrez le fichier de sortie sous random_samples.shp dans le dossier
exercise_data/spatial_statistics/.

Maintenant vous pouvez vérifier que les données du fichier raster dans la table d’attributs de la couche ran-
dom_samples, elles seront affichées dans la colonne nommée srtm_41_19.tif.

Voici un exemple de représentation de la couche:
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Les points sont classifiés par leur valeur, les points sombres sont à basse altitude.

Vous allez utiliser cette couche d’échantillon pour le reste des exercices statistiques.

7.4.2 Follow Along: Statistiques Basiques

Maintenant, récupérez les statistiques basiques de cette couche.

• Cliquez sur l’entrée du menu Vecteur → Outils d’analyse → Statistiques basiques.

• Dans la fenêtre qui apparaît, indiquez la couche random_samples comme couche en entrée.

• Assurez-vous que Champ cible contienne srtm_41_19.tif, il s’agit du champ sur lequel seront cal-
culées les statistiques.

• Cliquez sur OK. Vous obtiendrez des résultats comme ceci:
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Note: Vous pouvez copier et coller les résultats dans un tableur. La donnée utilise le séparateur deux-points (:).
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• Une fois fait, fermez la fenêtre de l’extension.

Pour comprendre les statistiques ci-dessus, référez-vous à la liste de définition:

Moyenne La valeur moyenne est simplement la somme des valeurs divisée par le nombre de valeurs.

Écart-type La déviation standard. Donne une indication sur la manière dont les valeurs sont regroupées autour
de la moyenne. Plus la déviation est faible, plus les valeurs tendent à se situer à la moyenne.

Somme Toutes les valeurs ajoutées ensemble.

Min La valeur minimale.

Max La valeur maximale.

N Le nombre de données/valeurs.

CV La covariance spatiale du jeu de données.

Nombre de valeurs uniques Le nombre de valeurs uniques dans l’ensemble du jeu de données. S’il y a 90
valeurs uniques dans un jeu de données ayant N=100, alors les 10 valeurs restantes sont identiques à une ou
plusieurs d’entre elles.

Portée La différence entre les valeurs minimale et maximale.

Médiane Si vous ordonnez les valeurs de la plus petite à la plus grande, la valeur du milieu (ou la moyenne des
deux valeurs du milieu si N est un nombre pair) est la médiane des valeurs.

7.4.3 Follow Along: Calculer une Matrice des Distances

• Créez une nouvelle couche de point dans la même projection que les autres jeux de données (WGS 84 /
UTM 34S).

• Passez en mode Édition et numérisez trois points quelque part au milieu des autres points.

• Utilisez la même méthode de génération de points aléatoires que précédemment mais indiquer seulement
trois points.

• Sauvegardez votre nouvelle couche sous distance_points.shp.

Pour générer une matrice des distances utilisant ces points:

• Ouvrez l’outil Vecteur → Outils d’analyse → Matrice des distances.

• Sélectionnez la couche distance_points comme couche d’entrée et la couche random_samples comme
couche cible.

• Définissez-le comme ceci:
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• Sauvegardez le résultat sous distance_matrix.csv.

• Cliquez sur OK pour générer la matrice des distances.

• Ouvrez-le dans un tableur pour voir les résultats. Voici un exemple:
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7.4.4 Follow Along: Analyse du Plus Proche Voisin

Pour faire une analyse du plus proche voisin:

• Cliquez sur l’entrée du menu Vecteur → Outils d’analyse → Analyse du plus proche voisin.

• Dans la fenêtre qui apparaît, sélectionnez la couche random_samples et cliquez sur OK.

• Les résultats apparaîtront dans la boîte de dialogue de la fenêtre, comme sur l’exemple:

Note: Vous pouvez copier et coller les résultats dans un tableur. La donnée utilise le séparateur deux-points (:).
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7.4.5 Follow Along: Coordonnées Moyennes

Pour obtenir les coordonnées moyennes d’un jeu de données:

• Cliquez sur l’entrée du menu Vecteur → Outils d’analyse → Cordonnée(s) moyenne(s)

• Dans la fenêtre qui apparaît, indiquez la couche random_samples comme couche en entrée, mais laissez
inchangées les autres options.

• Indiquez la couche de sortie: mean_coords.shp.

• Cliquez sur OK.

• Ajoutez la couche à la Légende de la carte quand demandé.

Comparons cela aux coordonnées centrales du polygone qui a été utilisé pour créer les données aléatoires.

• Cliquez sur l’élément du menu Vecteur → Outils de géométrie → Centroïdes de polygones

• Dans la fenêtre qui apparaît, indiquez la couche roads_hull comme couche en entrée.

• Sauvegardez le résultat sous center_point.

• Ajoutez-le dans la Légende de la carte lorsque demandé.

Comme vous pouvez le voir dans l’exemple ci-dessous, les coordonnées moyennes et le centroïde de la zone
d’étude (en orange) ne coïncident pas nécessairement:

7.4.6 Follow Along: Histogrammes d’image

L’histogramme d’un jeu de données montre la distribution des valeurs. Le moyen le plus simple de l’afficher
dans QGIS est d’utiliser l’historgramme d’image disponible dans la boîte de dialogue Propriétés de la couche de
n’importe quelle couche d’image.

• Dans votre Légende de la carte, faites un clic-droit sur la couche SRTM MNE.

• Sélectionnez Propriétés.

• Choisissez l’onglet Histogramme. Vous devrez cliquer sur le bouton Calculer l’histogramme pour générer
le graphique. Un graphe décrivant la fréquence des valeurs de l’image sera alors affiché.
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• Vous pouvez l’exporter en tant qu’image:

• Sélectionnez l’onglet Métadonnées, vous pouvez voir plus d’informations détaillées dans la boîte Pro-
priétés.

La valeur moyenne est 332.8 et la valeur maximale vaut 1699 ! Mais ces valeurs ne s’affichent pas dans
l’histogramme. Pourquoi ? C’est parce qu’il y a tellement peu de pixels qui disposent de cette valeur comparée
à la valeur moyenne. C’est également pour cela que l’histogramme est aussi étendu même s’il n’y a pas de ligne
rouge indiquant la fréquence des valeurs plus importantes que 250.

Par conséquent, gardez en tête qu’un histogramme vous montre la distribution des valeurs, et toutes les valeurs ne
sont pas forcément visibles sur le graphe.

• (Vous pouvez maintenant fermer la fenêtre Propriétés de la couche.)

7.4.7 Follow Along: Interpolation Spatiale

Disons que vous disposez d’un échantillon de points dont vous souhaitez extrapoler les données. Par exemple,
vous avez accès au jeu de données random_samples que nous avons créé auparavant et vous voulez vous faire une
idée de l’aspect du terrain.

Pour démarrer, lancez l’outil Grille (Interpolation) en cliquant dans l’entrée de menu Raster → Analyse → Grille
(Interpolation) .
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• Dans le champ Fichier source, sélectionnez random_samples.

• Cochez la case Champ Z, et sélectionnez le champ srtm_41_19.

• Mettez l’emplacement du Fichier de sortie à exercise_data/spatial_statistics/interpolation.tif.

• Cochez la case Algorithme et sélectionnez Distance inverse à une puissance.

• Mettez la Puissance à 5.0 et le Lissage à 2.0. Laissez les autres valeurs comme elles sont.

• Cochez la case Charger dans la carte une fois terminé et cliquez sur OK.

• Quand c’est fait, cliquez sur OK dans la boîte de dialogue qui dit kbd:Processus terminé, cliquez sur OK
dans la boîte de dialogue montrant des informations de retour (si elle a apparu), et cliquez sur Fermer dans
la boîte de dialogue Grille (Interpolation).

Voici une comparaison entre le jeu de données originel (gauche) et celui construit à partir de nos points (droite).
Les votres peuvent sembler différents étant donné la nature aléatoire de l’emplacement des points.

Comme vous pouvez le constater, 100 points ne suffisent pas à créer un terrain détaillé. Cela donne une idée
globale mais qui peut être mal interprétée. Par exemple, dans l’image ci-dessus, il n’est pas clair qu’il y ait une
montagne qui traverse le terrain, de l’est vers l’ouest. Au contraire, l’image semble afficher une vallée avec des
pics vers l’ouest. Une simple inspection visuelle nous permet de dire que le jeu de données n’est pas représentatif
du terrain.

7.4.8 Try Yourself

• Utilisez les processus montrés ci-dessus pour créer un nouveau jeu de 1000 points aléatoires.

• Utilisez ces points pour échantilloner le MEN originel.

• Utilisez l’outil Grille (Interpolation) sur ce nouveau jeu de données comme ci-dessus.

• Paramétrez le nom du fichier de sortie à interpolation_1000.tif, les paramètres Puissance and
Lissage respectivement à 5.0 et 2.0.

Les résultats (dépendamment de la position de vos points aléatoires) ressembleront plus ou moins à cela :
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La frontière montre la couche roads_hull (qui représente la frontière du jeu de points aléatoires) qui explique le
manque soudain de détail passé la bordure. C’est une représentation plus fidèle du terrain, dû à la plus grande
densité de points d’échantillon.

Voici un exemple d’à quoi cela ressemble avec 10 000 points aléatoires :

Note: Il n’est pas recommandé de lancer ce traitement avec 10 000 points d’échantillon si vous ne travaillez pas
avec une station de travail puissante car la taille du jeu de données implique beaucoup de temps de calcul.
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7.4.9 Follow Along: Outils complémentaires d’analyse spatiale

Le logiciel SEXTANTE a été ajouté en tant que fonction de coeur de QGIS depuis la version 2.0. A lo’rigine, il
était disponible en tant que projet séparé accessible depuis une extension. Vous pouvez le trouver dans le nouveau
menu de QGIS Traitements où vous pourrez trouver une riche boîte à outils d’analyse spatiale de nombreuses
extension, le tout à partir d’une seule interface.

• Activez cet ensemble d’outils en activant l’entrée du menu Traitements → Boîte à outils. La boîte à outils
ressemble à ce qui suit:

Vous la trouverez probablement intégrée à la fenêtre QGIS à droite de la carte. Les outils listés ici sont des liens
vers les outils réels. Quelques-uns sont les algorithmes internes de SEXTANTE et les autres sont des liens vers
des outils issus d’applications externes comme GRASS, SAGA et Orfeo. Ces applications externes sont installées
avec QGIS et vous pouvez les utiliser directement. Si vous avez besoin de modifier la configuration des outils
Traitements, par exemple, pour mettre à jour vers une nouvelle version, vous pouvez accéder aux paramètres
depuis Traitements → Options et configuration.

7.4.10 Follow Along: Analyse du motif de point

Pour obtenir une indication simple de la distribution spatiale des points du jeu de données random_samples, nous
pouvons utilise l’outil de SAGA Analyse du motif spatial de points via la Boîte à outils de traitements que vous
venez d’ouvrir.

• Dans la Boîte à outils Traitements, cherchez l’outil Analyse spatiale du motif de points.

• Double-cliquez dessus pour ouvrir sa boîte de dialogue.
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Installation de SAGA

Note: Si SAGA n’est pas installé sur votre système, la boîte de dialogue de l’extension vous informera que la
dépendance est manquante. Si ce n’est pas le cas, vous pouvez ignorer ces étapes.

Sur Windows

Inclus dans votre matériel de cours, vous trouverez le programme d’installation de SAGA pour Windows.

• Démarrez le programme et suivez ses instructions pour installer SAGA sur votre système Windows. Prenez
note de chemin où vous l’installer !

Une fois que vous avez installé SAGA, vous devrez configurer SEXTANTE pour trouver le chemin sous lequel il
a été installé.

• Cliquez sur le menu Analyse → Options et configuration de SAGA.

• Dans la boîte de dialogue qui apparaît, étendez l’élément SAGA et cherchez Répertoire SAGA. Sa valeur est
vide.

• Dans cet espace, insérez le chemin d’où vous avez installé SAGA.

sur Ubuntu:

• Cherchez la chaîne de caractères SAGA GIS dans le Software Center ou saisissez la commande sudo
apt-get install saga-gis dans votre terminal (vous aurez peut-être besoin d’ajouter le dépôt
SAGA à vos sources de binaires).

• QGIS trouvera automatiquement SAGA, bien que vous puissiez devoir redémarrer QGIS si ça ne fonctionne
pas tout de suite.

Sur Mac

Les utilisateurs de Homebrew peuvent installer SAGA avec cette commande:

• brew install saga-core

Si vous n’utilisez pas Homebrew, veuillez suivre les instructions ici:

http://sourceforge.net/apps/trac/saga-gis/wiki/Compiling%20SAGA%20on%20Mac%20OS%20X

Après l’installation

Maintenant que vous avez installé et configuré SAGA, ses fonctions deviendront accessible pour vous.

Utilisation de SAGA

• Ouvrez la boîte de dialogue SAGA.

• SAGA produit trois sorties, et demandera donc trois chemins de sortie.

• Sauvegardez ces trois sorties sous exercise_data/spatial_statistics/, en utilisant tous les
noms de fichiers que vous trouvez appropriés.
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Le rendu ressemblera à cela (la symbologie a été changée pour cet exemple) :
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Le point rouge indique la moyenne, le cercle large indique la distance standard qui donne une indication sur la
distribution des points par rapport à la moyenne. Le rectangle indique l’emprise la plus petite contenant tous les
points.

7.4.11 Follow Along: Analyse de la distance minimale

Souvent, la sortie d’un algorithme ne sera pas un shapefile, mais plutôt une table résumant les propriétés statis-
tiques d’un jeu de données. L’un d’eux est l’outil Analyse de la distance minimale.

• Trouvez cet outil dans la Boîte à outils Traitements sous Analyse de la distance minimale.

Il n’y a pas d’autres entrées que le jeu de données de points à analyser.

• Choisissez le jeu de données random_points.

• Cliquez sur OK. À la fin, une table DBF apparaîtra dans la Légende de la carte.

• Sélectionnez-la puis ouvrez sa table attributaire. Bien que les chiffres peuvent varier, vos résultats seront
dans ce format :
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7.4.12 In Conclusion

QGIS permet de nombreuses possibilités pour l’analyse des propriétés statistiques spatiales des jeu de données.

7.4.13 What’s Next?

Maintenant que nous avons couvert l’analyse vectorielle, pourquoi ne pas voir ce qu’il peut être fait avec des
rasters ? C’est ce que nous ferons dans le prochain module !
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Module: Rasters

Nous avons précédemment utilisé des rasters pour la digitalisation, mais les données raster peuvent aussi être
utilisées directement. Dans ce module, vous verrez comme cela est fait dans QGIS.

8.1 Lesson: Les données raster

Les données raster sont un peu différentes des données vectorielles. Les données vectorielles possèdent des
caractéristiques distinctes construites sur des sommets, et peut-être connectées avec des lignes et/ou des aires. Les
données raster, cependant, sont comme des images. Bien qu’ils puissent présenter différentes propriétés d’objets
dans le monde réel, ces objets n’existent pas comme des objets distincts ; au contraire, ils sont représentés en
utilisant des pixels de différentes valeurs de couleurs différentes.

Lors de ce module, vous allez utiliser des données raster pour compléter votre analyse SIG existante.

Objectif de cette leçon :* Apprendre à travailler avec des données raster dans l’environnement QGIS.

8.1.1 Follow Along: Chargement de Données Raster

• Ouvrez votre carte analysis.qgs (que vous devriez avoir créée et sauvegardé durant le module précé-
dent).

• Désactivez toutes les couches exceptées les couches solution et important_roads.

• Cliquez sur le bouton Charger une couche raster :

La boîte de dialogue Charger une couche raster va s’ouvrir. Les données pour ce projets sont dans
exercise_data/raster.

• Soit vous les chargez toutes séparément, ou vous maintenez la touche ctrl appuyée et cliquez sur les
quatre d’entre elles, l’une après l’autre, puis ouvrez-les en même temps

La première chose que vous remarquerez est que rien ne semble se passer dans votre carte. Les raster ne se
chargent-ils pas ? Et bien, ils sont là dans la Légende de carte, donc évidemment qu’ils sont chargés. Le problème
est qu’ils ne sont pas dans la même projection. Heureusement, nous avons déjà vu que faire dans cette situation.

• Select Project → Project Properties in the menu:

• Sélectionnez SCR dans le menu :

• Activez la reprojection “à la volée”.

• Réglez-la à la même projection que le reste de vos données (WGS 84 / UTM zone 33S).

• Click [OK].
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Les rasters doivent s’adapter parfaitement :

Nous y voilà - quatre photographies aériennes couvrant notre région d’études.

8.1.2 Follow Along: Créer un Raster Virtuel

Maintenant, comme vous pouvez le voir à partir de cela, votre couche de solution réside dans les quatre photogra-
phies. Ce qui signifie que vous allez devoir travailler avec ces quatre rasters tout le temps. Ce n’est pas idéal ; il
serait préférable d’avoir un fichier pour une image (composite), non ?

Heureusement, QGIS vous permet de faire exactement ça, et sans avoir besoin de créer réellement un nouveau
fichier raster, ce qui pourrait prendre beaucoup d’espace. Au lieu de cela, vous pouvez créer un Raster Virtuel.
Celui-là est aussi souvent appelé un Catalogue, ce qui explique sa fonction. Ce n’est pas vraiment un nouveau
raster. Au contraire, c’est une façon d’organiser vos raster existants dans un catalogue : un fichier pour un accès
facile.

Pour faire un catalogue :

• Cliquez sur l’élément du menu Raster → Divers → Construire un Raster Virtuel (Catalogue).

• Dans la boîte de dialogue qui apparaît, cochez la case à côté de Utiliser les rasters visibles comme entrée.

• Entrez exercise_data/residential_development comme emplacement de sortie.

• Entrez aerial_photos.vrt comme nom de fichier.
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• Cochez la case Charger dans la carte une fois terminé.

Remarquez le champ de texte en-dessous. Ce que la boîte de dialogue est en train de faire, c’est d’écrire ce texte
pour vous. C’est une longue commande que QGIS est en train d’exécuter.

Note: Gardez à l’esprit que le texte de la commande est modifiable, de sorte que vous pouvez personnaliser
la commande. Cherchez en ligne pour la commande initiale (dans ce cas, gdalbuildvrt) de l’aide sur la
syntaxe.

• Cliquez sur OK pour exécuter la commande.

Cela peut prendre un certain temps. Quand c’est fait, il vous le dira avec une boîte de message.

• Cliquez sur OK pour fermer le message.
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• Cliquez sur Fermer sur la boîte de dialogue Construire un Raster Virtuel (Catalogue). (Ne cliquez pas
encore sur OK, autrement la commande va de nouveau être exécutée.)

• Vous pouvez maintenant enlever les quatre raster originaux de la Légende de la carte.

• Si nécessaire, cliquez et faites glisser la couche du nouveau catalogue raster aerial_photos en bas de la
Légende de la carte pour que les autres couches actives deviennent visibles.

8.1.3 Transformation de données Raster

Les méthodes ci-dessus vous permettent de fusionner les jeux de données en utilisant un catalogue, et de les
reprojeter “à la volée”. Cependant, si vous configurez les données que vous allez utiliser pendant un certain
temps, il peut être plus efficace de créer de nouveaux rasters qui sont déjà fusionnés et reprojetés. Cela améliore
les performances tout en utilisant les rasters dans une carte, mais cela peut prendre un certain temps à d’abord
mettre en place.

Reprojection de rasters

• Cliquez sur l’élément du menu Raster → Projections → Projection).

Notez que cet outil dispose d’une option pratique de lot pour reprojeter le contenu de tous les répertoires. Vous
pouvez aussi reprojeter des rasters virtuels (catalogues), aussi bien qu’activer un mode de traitement multithreaded.
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Fusion de rasters

• Cliquez sur l’élément du menu Raster → Divers → Fusionner.

Vous pouvez choisir de traiter des répertoires entiers à la place de simples fichiers, vous donnant une capacité de
traitement par lots intégrés très utile. Vous pouvez aussi spécifier un raster virtuel comme fichier d’entrée, et tous
les rasters dont il est composé seront traités.

Vous pouvez également ajouter vos propres options en ligne de commande en utilisant la case à cocher et liste
Création d’Options. Cela s’applique uniquement si vous avez connaissance du fonctionnement de la librairie
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GDAL.
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8.1.4 In Conclusion

Dans QGIS, il est facile d’inclure des données raster dans vos projets existants.

8.1.5 What’s Next?

Ensuite, nous utiliserons les données raster qui ne sont pas de l’imagerie aérienne, et verrons comment la symbol-
isation est ainsi utile dans le cas des rasters.

8.2 Lesson: Modification de la symbologie des Raster

Toutes les données raster ne sont pas des photographies aériennes. Il y a beaucoup d’autres formes de données
raster et dans beaucoup de ces cas, il est essentiel de symboliser les données proprement, de sorte qu’elles devi-
ennent bien visibles et utiles.

Objectif de cette leçon : Changer la symbologie d’une couche raster.

8.2.1 Try Yourself

• Démarrez avec la carte actuelle que vous devriez avoir créée lors du précédent exercice : analysis.qgs.

• Utilisez le bouton Ajouter une couche raster pour charger le nouveau jeu de données raster.

• Chargez le jeu de données srtm_41_19.tif, trouvé sous le répertoire
exercise_data/raster/SRTM/.

• Une fois qu’il apparaît dans la Légende de la carte, renommez-le DEM.

• Zoomez sur l’étendue de cette couche en faisant un clic droit dessus dans la Légende de la carte et en
sélectionnant Zoomer sur la couche.

Ce jeu de données est un Modèle Numérique d’Élévation (MNE). C’est une carte de l’élévation (altitude) du
terrain, qui nous permet par exemple de voir où les montagnes et vallées sont.

Une fois qu’il est chargé, vous remarquerez que c’est une représentation de base étirée en niveaux de gris du DEM.
On peut le voir ici avec les couches vectorielles au-dessus :
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QGIS a automatiquement appliqué un étirement à l’image à des fins de visualisation et nous allons en apprendre
davantage sur la façon dont cela fonctionne avant de continuer.

8.2.2 Follow Along: Modification du style d’une couche Raster

• Ouvrez la boîte de dialogue Propriétés de la couche pour la couche SRTM en faisant un clic-droit sur la
couche dans la Légende de la carte et en sélectionnant l’option Propriétés.

• Basculez sur l’onglet Style.
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Il y a des paramètres que QGIS applique pour nous par défaut. C’est juste une manière de regarder un MNE, alors
explorons les autres.

• Changez le Type de rendu en Pseudo-couleurs à bande unique, et utilisez les options présentées par défaut.

• Cliquez sur le bouton Classer pour générer une nouvelle classification de couleurs, et cliquez sur OK pour
appliquer cette classification au MNE.
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Vous verrez le raster qui ressemble à ceci :
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C’est une façon intéressante de voir le MNE, mais peut-être que nous ne voulons pas le symboliser en utilisant ces
couleurs.

• Ouvrez à nouveau la boîte de dialogue Propriétés de couche.

• Revenez à un Type de rendu en Bande grise unique.

• Cliquez sur OK pour appliquer ces paramètres au raster.

Vous allez maintenant voir un rectangle entièrement gris, qui n’est pas très utile.
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C’est parce que nous avons perdu les paramètres par défaut qui “étirent” les valeurs de couleur pour leur montrer
le contraste.

Disons à QGIS d’à nouveau “étirer” les valeurs de couleurs basées sur la plage de données dans le MNE. Cela
fera utiliser à QGIS toutes les couleurs disponibles (dans Échelle de gris, ce sont le noir, le blanc et et toutes les
nuances de gris entre les deux).

• Spécifiez les valeurs Min et Max comme montré ci-dessous.

• Mettez la valeur Amélioration de contraste à Étirer jusqu’à MinMax :
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Mais quelles sont les valeurs minimales et maximales qui doivent être utilisées pour l’étirement ? Celles qui sont
actuellement sous les valeurs Min et Max sont les mêmes valeurs qui nous ont juste donné un rectangle gris avant.
Au lieu de cela, nous devrions utiliser les valeurs minimales et maximales qui sont actuellement pour l’image, non
? Heureusement, vous pouvez déterminer ces valeurs facilement en chargeant les valeurs minimales et maximales
du raster.

• Sous Charger les valeurs min / max, sélectionnez l’option Min / Max.

• Cliquez sur le bouton Charger :

Notez comme le Personnalisation des valeurs min / max a changé pour refléter les valeurs actuelles de notre MNE.
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• Cliquez sur OK pour appliquer ces paramètres à l’image.

Vous verrez maintenant que les valeurs du raster sont à nouveau affichées correctement, avec les couleurs plus
foncées représentant les vallées et celles plus claires, les montagnes :
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Mais n’y a-t-il pas une façon meilleure ou plus simple ?

Oui, il y a. Maintenant que vous comprenez ce qui doit être fait, vous serez content d’apprendre qu’il y a un outil
pour faire tout cela facilement.

• Enlevez le MNE actuel de la Légende de la carte.

• Chargez à nouveau le raster, renommez-le MNE comme avant. C’est à nouveau un rectangle gris...

• Activez l’outil dont vous aurez besoin en activant Vue → Barre d’outils → Raster. Ces icônes apparaîtront
dans l’interface :

Le troisième bouton depuis la gauche Histogramme de l’emprise locale étirera automatiquement les valeurs mini-
males et maximales pour vous donner le meilleur contraste dans la région sur laquelle vous zoomez. Cela est utile
pour les grands jeux de données. Le bouton sur la gauche Coupe étendue cumulative locale ... étirera les valeurs
minimales et maximales à des valeurs constantes à travers l’ensemble de l’image.

• Cliquez sur le quatrième bouton depuis la gauche (Étendre l’histogramme à tout le jeu de données). Vous
verrez que les données sont maintenant correctement représentées, comme avant.

Vous pouvez essayer les autres boutons de cette barre d’outils et voir comment ils altèrent l’étirement de l’image
lorsque vous zoomez sur des régions ou que vous dézoomez complètement.
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8.2.3 In Conclusion

Ce ne sont que les fonctions de base pour vous aider à démarrer avec la symbologie raster. QGIS vous offre
également de nombreuses autres options, comme pour symboliser une couche à l’aide des écarts-types, ou pour
représenter différentes bandes avec différentes couleurs dans une image multispectrale.

8.2.4 Références

Le jeu de données SRTM a été obtenu depuis http://srtm.csi.cgiar.org/

8.2.5 What’s Next?

Maintenant que nous pouvons voir nos données correctement affichées, étudions comment nous pouvons davan-
tage les analyser.

8.3 Lesson: Analyse de terrain

Certains types de raster vous permettent de gagner plus de perspicacité dans le terrain que ce qu’ils représentent.
Les Modèles Numériques d’Élévation (MNE) sont particulièrement utiles dans ce sens. Dans cette leçon, vous
utiliserez les outils d’analyse de terrain pour en savoir plus sur la zone d’étude pour le développement résidentiel
proposé plus tôt.

Objectif de cette leçon : Utiliser les outils d’analyse de terrain pour avoir plus d’information sur le terrain.

8.3.1 Follow Along: Calcul d’un Ombrage

Le DEM que vous avez en ce moment sur votre carte doit vous montrer l’élévation du terrain, mais il peut parfois
sembler un peu abstrait. Il contient toute l’information 3D sur le terrain dont vous avez besoin, mais il ne ressemble
pas à un objet 3D. Pour obtenir un meilleur aspect du terrain, il est possible de calculer un ombrage, qui est un
raster qui cartographie le terrain en utilisant la lumière et l’ombre pour créer une image 3D.

Pour travailler avec des DEM, vous devez utiliser l’outil d’analyse QGIS tout-en-un MNE (Modèles de terrain).

• Cliquez sur l’élément du menu Raster → Analyse → MNE (Modèles de terrain).

• Dans la boîte de dialogue qui apparaît, assurez-vous que le Fichier source est la couche MNE.

• Mettez comme Fichier de sortie hillshade.tif dans le répertoire
exercise_data/residential_development.

• Vérifiez également que l’option Mode a sélectionné Hillshade.

• Cochez la case à côté de Charger dans la carte une fois terminé.

• Vous pouvez laisser toutes les autres options inchangées.

• Cliquez sur OK pour générer l’ombrage.

• Lorsque l’on vous dit que le processus est achevé, cliquer sur OK dans le message pour le fermer.

• Cliquez sur Fermer sur la boîte de dialogue principale MNE (Modèles de terrain).

Vous aurez maintenant une nouvelle couche appelée hillshade qui ressemble à cela :
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Le résultat semble sympathique et en 3D. Mais pouvons-nous l’améliorer ? L’ombrage semble un peut en
plâtre. Pouvons-nous le combiner avec nos autres rasters plus colorés ? C’est effectivement possible en utilisant
l’ombrage en tant que couverture.

8.3.2 Follow Along: Utilisation d’un ombrage comme une couverture

Un ombrage peut fournir des informations très utiles sur la lumière du soleil à un moment donné de la journée.
Mais il peut aussi être utilisé à des fins esthétiques, pour donner à la carte une meilleure apparence. La clé pour
cela est de configurer l’ombrage pour qu’il soit presque complètement transparent.

• Changez la symbologie du DEM d’origine pour utiliser le schéma Pseudo-couleur comme dans l’exercice
précédent.

• Cachez toutes les couches, exceptées les couches DEM et hillshade.

• Cliquez et faites glisser le DEM pour être sous la couche hillshade dans la Légende de la carte.

• Configurez la couche hillshade comme transparente en ouvrant ses Propriétés de la couche et rendez-vous
à l’onglet Transparence.

• Configurez la Transparence globale à 50% :

• Cliquez sur OK dans la boîte de dialogue Propriétés de la couche. Vous recevrez un résultat comme ça :
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• Désactivez la couche hillshade puis réactivez-la dans la Légende de la carte pour voir la différence que cela
fait.

En utilisant un ombrage de cette façon, il est possible d’améliorer la topographie du paysage. Si l’effet ne vous
semble pas suffisamment fort, vous pouvez changer la transparence de la couche hillshade ; mais bien sûr que
plus l’ombrage devient brillant, plus les couleurs derrière lui seront sombres. Vous devrez trouver un équilibre qui
fonctionne pour vous.

N’oubliez pas de sauvegarder votre carte quand vous avez terminé.

Note: Pour les deux prochains exercices, utilisez une nouvelle carte. Chargez le jeu de données
raster DEM dans la carte (exercise_data/raster/SRTM/srtm_41_19.tif). C’est pour simpli-
fier les choses pendant que vous travaillez avec les outils d’analyse raster. Sauvegardez la carte comme
exercise_data/raster_analysis.qgs.

8.3.3 Follow Along: Calcul d’une Pente

Une autre chose utile à savoir à propos du terrain est comment est sa pente. Si, par exemple, vous voulez construire
des maisons ici, alors vous avez besoin d’un terrain relativement plat.

Pour faire cela, vous devez utiliser le mode Pente de l’outil MNE (Modèles de terrain) .

• Ouvrez l’outil comme avant.

• Sélectionnez l’option ModePente :
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• Définissez l’emplacement de la sauvegarde à to exercise_data/residential_development/slope.tif

• Cochez la case à coche Charger dans la carte....

• Cliquez sur OK et fermez les boîtes de dialogue lorsque le processus est terminé, et cliquez sur Fermer pour
fermer la boîte de dialogue. Vous verrez un nouveau raster chargé dans votre carte.

• Avec le nouveau raster sélectionné dans la Légende de la carte, cliquez sur le bouton Étendre l’histogramme
à tout le jeu de données. Vous verrez maintenant la pente du terrain, les pixels noirs représentant un terrain
plat et les pixels blancs un terrain pentu :

8.3.4 Try Yourself Calcul de l’aspect

L’aspect du terrain fait référence à la direction à laquelle il fait face. Comme cette étude prend place dans
l’hémisphère sud, les propriétés devraient idéalement être construites sur une pente orientée au Nord afin qu’elles
puissent rester dans la lumière du soleil.

• Utilisez le mode Aspect de l’outil MNE (Modèles de terrain) pour calculer l’aspect du terrain.
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Vérifiez vos résultats

8.3.5 Follow Along: Utilisation de la Calculatrice Raster

Rappelez-vous le problème de l’agent immobilier que nous nous sommes posés dans la leçon Analyse Vectorielle.
Imaginons que les acheteurs souhaitent maintenant acheter un immeuble et construire un plus petit cottage sur la
propriété. Dans l’Hémisphère Sud, nous savons qu’une parcelle idéale pour le développement a besoin d’avoir
des zones orientées vers le Nord, et avec une pente de moins de cinq degrés. Mais si la pente est inférieure à 2
degrés, alors l’aspect ne fonctionnera pas.

Heureusement, vous avez déjà des rasters qui vous montrent la pente aussi bien que l’aspect, mais vous n’avez
aucune façon de savoir où les deux conditions sont immédiatement satisfaites. Comment cette analyse peut-elle
être faite ?

La réponse réside dans la Calculatrice Raster.

• Cliquez sur Raster > Calculatrice raster... pour enclencher cet outil.

• Pour faire usage du jeu de données aspect, double-cliquez sur l’élément aspect@1 dans la liste Bandes
raster sur la gauche. Il apparaîtra dans le champ de texte Expression de la calculatrice raster ci-dessous.

Le Nord est à 0 (zéro) degrés, donc pour le terrain à face nord, son aspect doit être plus grand que 270 degrés et
plus petit que 90 degrés.

• Dans le champ Expression de la calculatrice raster, entrez cette expression :

aspect@1 <= 90 OR aspect@1 >= 270

• Mettez le fichier de sortie comme aspect_north.tif dans le répertoire
exercise_data/residential_development/.

• Assurez-vous que la case Ajouter le résultat au projet est cochée.

• Cliquez sur OK pour démarrer le processus.
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Votre résultat doit être cela :
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8.3.6 Try Yourself

Maintenant que vous avez fait l’aspect, créez deux nouvelles analyses séparées pour la couche MNE.

• La première identifiera toutes les zones où la pente est plus petite ou égale à 2 degrés.

• La seconde est similaire, mais la pente devra être plus petite ou égale à 5 degrés.

• Sauvegardez-les sous exercise_data/residential_development/ comme
slope_lte2.tif et slope_lte5.tif.

Vérifiez vos résultats

8.3.7 Follow Along: Combinaison des résultats de l’analyse raster

Vous avez maintenant trois nouvelles analyses raster sur la couche MNE :

• guilabel:aspect_north : le terrain face au nord

• slope_lte2 : la pente inférieure ou égale à 2 degrés

• slope_lte5 : la pente inférieure ou égale à 5 degrés

Là où les conditions de ces couches se rencontrent, elles sont égales à 1. Ailleurs, elles sont égales à 0. Cependant,
si vous multipliez un de ces rasters par un autre, vous obtiendrez les zones où les deux sont égales à 1.

Les conditions à remplir sont : égal ou inférieur à 5 degrés de pente, le terrain doit être orienté au Nord ; mais égal
ou inférieur à 2 degrés de pente, la direction vers laquelle le terrain est orienté n’a pas d’importance.
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Cependant, vous devez trouver des zones où la pente est égale ou inférieure à 5 degrés ET le terrain orienté au
Nord, OU la pente est égale ou inférieure à 2 degrés. Un tel terrain serait approprié pour le développement.

Pour calculer les zones qui satisfont ces critères :

• Ouvrez à nouveau votre Calculatrice raster

• Utilisez la liste Bandes de raster, les boutons Opérateurs, et votre clavier pour construire cette expression
dans la zone de texte Expression de la calculatrice raster :

( aspect_north@1 = 1 AND slope_lte5@1 = 1 ) OR slope_lte2@1 = 1

• Sauvegardez la sortie sous exercise_data/residential_development/ comme
all_conditions.tif.

• Cliquez sur OK dans la Calculatrice raster. Vos résultats :

8.3.8 Follow Along: Simplification du Raster

Comme vous pouvez le voir dans l’image du bas, l’analyse combinée nous a laissé avec beaucoup de très petites
zones où les conditions sont remplies. Mais elles ne sont pas très utiles pour nos analyses, puisqu’elles sont trop
petites pour y construire quelque chose. Éliminons toutes ces toutes petites zones inutiles.

• Ouvrez l’outil Tamiser (Raster → Analyse → Tamiser).

• Mettez comme Fichier source all_conditions, et comme Fichier de sortie
all_conditions_sieve.tif (sous exercise_data/residential_development/).

• Mettez pour les deux valeurs Seuil and Connexions de pixel à 8, puis exécuter l’outil.
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Une fois le processus exécuté, la nouvelle couche sera chargée dans le canevas. Mais quand vous essayez d’utiliser
l’outil histogramme complet pour visualiser les données, voici ce qui se passe :
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Que se passe-t-il ? La réponse réside dans les fichiers de métadonnées du nouveau raster.

• Regardez les métadonnées sous l’onglet Métadonnées de la boîte de dialogue Propriétés de la couche.
Regardez dans la section en bas Propriétés.
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Alors que ce raster, comme celui duquel il est dérivé, devrait seulement présenter les valeurs 1 et 0, il possède
comme valeur STATISTICS_MINIMUM un très grand nombre négatif. Une enquête sur les données montre
que ce nombre agit comme une valeur nulle. Comme nous recherchons seulement les zones qui n’ont pas été
éliminées, mettons ces valeurs nulles à zéro.

• Ouvrez à nouveau la Calculatrice raster, et construisez cette expression :

(all_conditions_sieve@1 <= 0) = 0

Cela maintiendra toutes les valeurs zéro existantes, tout en définissant les nombres négatifs à zéro ; ce qui
éliminera toutes les zones avec une valeur 1 intacte.

• Sauvegardez la sortie sous exercise_data/residential_development/ comme
all_conditions_simple.tif.

Votre sortie ressemble à cela :
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C’est ce qui était attendu : une version simplifiée des résultats précédents. Souvenez-vous que si les résultats que
vous obtenez à partir d’un outil ne sont pas ceux que vous attendiez, visualiser les métadonnées (et les attributs
vectoriels, si applicable) peut s’avérer essentiel pour résoudre le problème.

8.3.9 In Conclusion

Vous avez vu comment tirer toutes les sortes de produits d’analyse d’un MNE. Cela inclut l’ombrage, la pente
et les calculs d’aspect. Vous avez également vu comment utiliser la calculatrice raster pour analyser plus loin et
combiner les résultats.

8.3.10 What’s Next?

Maintenant que vous avez deux analyse : l’analyse vectorielle qui vous montre les parcelles susceptibles de
convenir, et l’analyse raster qui vont montre le terrain susceptibles de convenir. Comment peut-on les combiner
pour arriver à un résultat final pour ce problème ? C’est le sujet de la prochaine leçon, qui commence dans le
module suivant.
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CHAPTER 9

Module: Compléter l’analyse

Vous avez maintenant deux moitiés de l’analyse: une partie vecteur et une partie raster. Dans ce module, vous
verrez comment combiner les deux. Vous conclurez l’analyse et présenterez les résultats définitifs.

9.1 Lesson: Conversion Raster vers Vecteur

La conversion entre les formats raster et vecteur vous permet d’utiliser des données raster et vectorielles lors de
la résolution d’un problème de SIG, aussi bien que l’utilisation des différentes méthodes d’analyse propres à ces
deux formes de données géographiques. Cela augmente la flexibilité que vous avez lors de l’examen des sources
de données et méthodes de traitement pour résoudre un problème de SIG.

Pour combiner une analyse raster et vectorielle, vous devez convertir un type de données à l’autre. Convertissons
le résultat raster de la précédente leçon en un vecteur.

Objectif de cette leçon : Obtenir le résultat rater dans un vecteur qui peut être utilisé pour compléter l’analyse.

9.1.1 Follow Along: L’outil Polygoniser

Débutez avec la carte du dernier module, raster_analysis.qgs. Ici, vous devriez avoir le
all_conditions_simple.tif calculé durant les derniers exercices.

• Cliquez sur Raster → Conversion → Polygoniser (Raster à Vecteur). La boîte de dialogue de l’outil appa-
raîtra.

• Configurez-la comme ceci :
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• Changez le nom du champ (décrivant les valeurs du raster) en suitable.

• Sauvegardez le shapefile sous exercise_data/residential_development en tant que
all_terrain.shp.

Vous avez désormais un fichier vectoriel qui contient toutes les valeurs du raster, mais les seules zones qui vous
intéressent sont celles qui sont appropriées, c’est-à-dire les polygones pour lesquels la valeur suitable est 1.
Vous pouvez changer le style de cette couche si vous voulez en avoir une meilleure visualisation.

9.1.2 Try Yourself

Reportez-vous au module sur l’analyse vectorielle.

• Créez un nouveau fichier vectoriel qui contient seulement les polygones pour lesquels suitable a une
valeur de 1.

• Sauvegardez le nouveau fichier sous exercise_data/residential_development/ en tant que
suitable_terrain.shp.

Vérifiez vos résultats

9.1.3 Follow Along: L’outil Rastériser

Bien que cela ne soit pas nécessaire pour notre problème actuel, il est utile de connaître la conversion inverse de
celle effectuée ci-dessus. Convertissez en raster le fichier vectoriel suitable_terrain.shp que vous venez
juste de créer à l’étape précédente.

• Cliquez sur Raster → Conversion → Rastériser (Vecteur à Raster) pour démarrer cet outil, puis configurez-
le comme dans la capture d’écran ci-dessous :
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• Le Fichier source est all_terrain ;

• Le Fichier de sortie... est exercise_data/residential_development/raster_conversion.tif
;

• La Largeur et la Hauteur sont 837 et 661, respectivement.

Note: La taille de l’image de sortie est spécifiée ici pour être la même que dans le raster d’origine qui a été
vectorisé. Pour voir les dimensions d’une image, ouvrez ses métadonnées (onglet Métadonnées dans les Propriétés
de la couche).

• Cliquez sur OK dans la boîte de dialogue pour commencer le processus de conversion.

• Quand le processus est terminé, jugez son résultat en comparant le nouveau raster avec le raster original. Ils
devraient correspondre parfaitement, pixel sur pixel.

9.1.4 In Conclusion

La conversion entre les formats raster et vecteur vous permet d’accroître l’applicabilité des données, et ne doit pas
conduire à la dégradation des données.

9.1.5 What’s Next?

Maintenant que nous avons les résultats de l’analyse de terrain disponible dans un format vectoriel, ils peuvent
être utilisés pour résoudre le problème de quels bâtiments nous devons prendre en compte pour le développement
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résidentiel.

9.2 Lesson: Combiner les analyses

Utiliser les résultats vectorisés de l’analyse raster vous permettra de sélectionner seulement ces bâtiments sur un
terrain approprié.

Objectif de cette leçon : Utiliser les résultats de la vectorisation du terrain pour sélectionner des parcelles appro-
priées.

9.2.1 Try Yourself

• Sauvegardez votre carte (sous raster_analysis.qgs).

• Ouvrez la carte que vous avez créé plus tôt pendant l’analyse vectorielle (vous devriez avoir sauvegardé le
fichier sous analysis.qgs).

• Dans la Légende de la carte, activez ces couches :

– ombrage,

– solution (ou buildings_over_100)

• En plus de ces couches, qui devraient déjà être chargée dans la carte dans laquelle vous avez travaillé avant,
ajoutez également le jeu de données suitable_terrain.shp.

• S’il vous manque des couches, vous pouvez les trouver dans
exercise_data/residential_development/

• Use the Intersect tool (Vector → Geoprocessing Tools) to create a new vector layer called
new_solution.shp which contains only those buildings which intersect the suitable_terrain
layer.

Vous devriez maintenant avoir une couche qui montre certains bâtiments comme votre solution, par exemple :

Note: Si vous trouvez que l’outil Intersection ne produit pas de résultat, vérifiez les paramètres du SCR pour
chacune de vos couches. Le SCR doit être le même pour les deux couches que vous êtes en train de comparer. Vous
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pouvez devoir reprojeter une couche en sauvegardant la couche sous un nouveau shapefile avec le SCR requis.
Dans notre exemple, la couche suitable_terrain a été reprojetée en WGS 84 / UTM 34S et nommée
suitable_terrain_34S.

9.2.2 Try Yourself Contrôler les résultats

Regardez chacun des bâtiments de votre couche new_solution. Comparez-les avec la couche suitable_terrain en
changeant la symbologie pour la couche new_solution afin qu’elle n’ait que des bordures. Que remarquez-vous à
propos de certains de ces bâtiments ? Sont-ils tous appropriés juste parce qu’ils croisent la couche suitable_terrain
? Pourquoi ou pourquoi pas ? Lesquels allez-vous estimer comme non appropriés ?

Vérifiez vos résultats

9.2.3 Try Yourself Affiner l’analyse

Vous pouvez voir dans les résultats que certains bâtiments qui ont été inclus ne sont pas vraiment appropriés, nous
pouvons donc affiner l’analyse.

Nous voulons être sûr que notre analyse renvoie seulement les bâtiments qui tombent entièrement dans la couche
suitable_terrain. Comment pourriez-vous atteindre cet objectif ? Utilisez un ou plusieurs outils d’Analyse
Vectorielle et souvenez-vous que nos bâtiments ont tous une taille de plus de 100m carré.

Vérifiez vos résultats

9.2.4 In Conclusion

Vous avez maintenant répondu à la question originale de recherche, et pouvez donner une opinion (avec raisons,
soutenu par l’analyse) pour une recommandation concernant la propriété à développer.

9.2.5 What’s Next?

Vous présenterez ensuite ces résultats dans le cadre de votre deuxième travail.

9.3 Mission

En utilisant le composeur de carte, créez une nouvelle carte qui représente les résultats de votre analyse. N’oubliez
pas d’inclure ces couches :

• places (avec étiquettes)

• hillshade,

• solution (ou nouvelle_solution),

• roads et

• au choix photos_aeriennes ou MNE.

Rédigez un court paragraphe en guise d’accompagnement. Incluez dans ce texte les critères qui ont été utilisés
dans la considération d’une maison pour l’achat et le développement ultérieur, aussi bien que l’explication de vos
recommandations pour lesquelles les bâtiments sont appropriées.
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9.4 Lesson: Exercice Supplémentaire

Dans cette leçon, vous serez guidé à travers une analyse complète de SIG dans QGIS.

Note: Leçon développée par Linfiniti et S Motala (Cape Peninsula University of Technology)

9.4.1 Énoncé du problème

Vous êtes chargé de repérer les zones intérieures et alentours de la Péninsule du Cap qui correspondent à un habitat
convenable pour des végétaux fynbos rares. L’étendue de votre zone de recherche dans la Péninsule du Cap est :
au sud de Melkbosstrand, à l’ouest de Strand. Les botanistes vous ont fourni les préférences suivantes présentées
par les espèces en question :

• Elles poussent sur des pentes de la face est.

• Elles poussent sur les pentes avec un gradient compris entre 15% et 60%.

• Elles poussent dans des zones qui ont un total de précipitations annuelles de > 1200 mm.

• On n’en trouve pas à moins de 250 m d’habitations humaines.

• Les aires de végétation dans lesquelles elles se reproduisent doivent avoir une surface d’au moins 6000m2.

En tant que bénévole de Cap Nature, vous avez accepté de chercher la plante sur la partie de territoire conforme
aux conditions la plus proche de votre maison. Utilisez vos compétences en SIG pour déterminer où vous devriez
aller chercher.

9.4.2 Aperçu de la solution

In order to solve this problem, you will have to download data from
https://www.dropbox.com/s/q5evvkizuunrcs0/more_analysis.zip?dl=0 and place it under
exercise_data/more_analysis folder. You will use it to find the candidate area that is closest to
your house. If you don’t live in Cape Town (where this problem is based) you can choose any house in the Cape
Town region. The solution will involve:

• analyser le MNE pour trouver les pentes face à l’Est et les pentes avec les bons gradients ;

• analyser le raster des précipitations pour trouver les zones avec la bonne moyenne de précipitations ;

• analyser la couche vectorielle de zonage pour trouver des zones qui sont éloignées des habitations humaines
et qui ont la bonne taille.

9.4.3 Configuration de la carte

• Cliquez sur le bouton “Statut du SCR” dans le coin en bas à droite de l’écran. Sous l’onglet SCR de l’écran
qui apparaît, vous verrez la boîte Liste des Systèmes de Coordonnées de Référence.

• Dans cette boîte, naviguez jusqu’à Système de coordonnées projeté → Transverse Universelle de Mercator
(UTM).

• Sélectionnez l’entrée WGS 84 / UTM zone 33S (avec le code EPSG 32733).

• Cliquez sur OK. La carte est maintenant dans le système de coordonnées de référence UTM33S.

• Sauvegardez la carte en cliquant sur le bouton de la barre d’outils Sauvegarder le projet sous, ou utilisez le
menu Fichier → Sauvegarder le projet sous....

• Sauvegardez la carte dans un dossier appelé Rasterprac que vous devez créer quelque part sur votre
ordinateur. Vous sauvegarderez ainsi toutes les couches que vous créerez dans ce dossier.
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9.4.4 Chargement de données dans la carte

Pour traiter les données, vous devrez charger les couches nécessaires (noms des rues, zones, précipitations, MNE)
dans le canevas de la carte.

Pour les vecteurs...

• Cliquez sur le bouton Ajouter une couche vecteur, ou utilisez l’élément du menu Couche → Ajouter une
couche vecteur....

• Dans la boîte de dialogue qui apparaît, assurez-vous que le bouton radio Fichier est sélectionné.

• Cliquez sur le bouton Parcourir.

• Dans la boîte de dialogue qui apparaît, ouvrez le dossier exercise_data/more_analysis/streets.

• Sélectionnez le fichier Street_Names_UTM33S.shp.

• Cliquer sur Ouvrir.

La boîte de dialogue se ferme et montre la boîte de dialogue originale, avec chemin du fichier spécifié dans le
champ de texte à côté du bouton Parcourir. Cela vous permet d’être sûr que le bon fichier est sélectionné. C’est
aussi possible d’entrer le chemin du fichier dans ce champ à la main, si vous souhaitez le faire.

• Cliquez sur Ouvrir. La couche vecteur est chargée dans votre carte. Une couleur lui est attribuée automa-
tiquement; elle sera modifiée plus tard.

• Renommer la couche en Streets.

• Faites un clic-droit sur la Légende de la carte (par défaut, le volet le long du côté gauche de l’écran).

• Cliquez sur Renommer dans la boîte de dialogue qui apparaît et renommez-la, en pressant la touche Entrée
quand c’est fait.

• Répétez le processus d’ajout de vecteur, mais cette fois sélectionnez le fichier Gener-
alised_Zoning_Dissolve_UTM33S.shp dans le répertoire Zonage.

• Renommez-le en Zonage.

Pour les rasters...

• Cliquez sur le bouton Ajouter une couche raster, ou utilisez l’élément du menu Ajouter une couche raster....

• Naviguez jusqu’au fichier approprié. sélectionnez-le, et cliquez sur Ouvrir.

• Faites ceci pour chacun des deux fichiers rasters. Les fichiers que vous voulez sont DEM/reproject/DEM et
Rainfall/reprojected/rainfall.tif.

• Renommez le raster précipitation en Rainfall (avec une lettre majuscule au début). Au début, lorsque
vous les chargez, les images seront des rectangles gris. Ne vous inquiétez pas, cela sera changé plus tard.

• Sauvegardez la carte.

Afin de bien voir ce qu’il se passe, la symbologie des couches doit être changée.

9.4.5 Changement de la symbologie des couches vectorielles

• Dans la Légende de la carte, faites un clic-droit sur la couche Streets.

• Sélectionnez les Propriétés du menu qui apparaît.

• Basculez sur l’onglet Style dans la boîte de dialogue qui apparaît.

• Cliquez sur le bouton étiqueté Changer, avec un carré montrant la couleur actuelle de la couche Streets.

• Sélectionnez une nouvelle couleur dans la boîte de dialogue qui apparaît.
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• Cliquez sur OK.

• Cliquez encore sur OK dans la boîte de dialogue Propriétés de la couche. Cela changera la couleur de la
couche Streets.

• Suivez un processus similaire pour la couche Zonage et choisissez une couleur appropriée pour elle.

9.4.6 Changement de la symbologie des couches raster

La symbologie des couches raster est quelque peu différente.

• Ouvrez la boîte de dialogue Propriétés pour le raster Rainfall.

• Basculez sur l’onglet Style. Vous noterez que cette boîte de dialogue de style est très différente de la version
utilisée pour les couches vectorielles.

• Assurez-vous que le bouton Utiliser l’écart-type est sélectionné.

• Changez la valeur dans la boîte associée à 2.00 (la valeur devrait être à 0.00 par défaut).

• Sous l’en-tête Amélioration de contraste, changez la valeur de Courent de la liste déroulante en Étirer
jusqu’au MinMax.

• Cliquez sur OK. Le raster “Rainfall”, si visible, devrait changer de couleurs, vous permettant de voir dif-
férentes valeurs de brillance pour chaque pixel.

• Répétez ce processus pour le MNE, mais configurez l’écart type avec un étirement de 4.00.

9.4.7 Changement de l’ordre des couches

• Dans la Légende de la carte, cliquez et faites glissez les couches en haut et en bas pour changer l’ordre dans
lequel elles apparaissent dans la carte.

• Les nouvelles versions de QGIS peuvent avoir une case à cocher Contrôle de l’ordre de rendu des couches
sous la Légende de la carte. Assurez-vous qu’elle soit cochée.

Maintenant que toutes les données sont chargées et proprement visibles, l’analyse peut commencer. il est
préférable que l’opération de découpage soit faite en premier. Ainsi, de la puissance de traitement ne sera pas
gaspillée pour le calcul des valeurs dans les zones qui ne seront de toute façon par utilisées.

9.4.8 Trouver les bons districts

• Chargez la couche vecteur admin_boundaries/Western_Cape_UTM33S.shp dans votre carte.

• Renommez-la en Districts.

• Faites un clic-droit sur la couche Districts dans la Légende de la carte.

• Dans le menu qui apparaît, sélectionnez l’élément du menu Requête.... La boîte de dialogue Constructeur
de requêtes apparaît.

Vous allez maintenant construire une requête pour sélectionner la liste suivante de districts :

• Bellville,

• Cape,

• Goodwood,

• Kuils River,

• Mitchells Plain,

• Simons Town, et

• Wynberg.
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• Dans la liste Champs, double-cliquez sur le champ NAME_2. Il apparaît dans le champ de texte Clause SQL
WHERE ci-dessous.

• Cliquez sur le bouton = ; un signe = est ajouté à la requête SQL.

• Cliquez sur le bouton Toutes en-dessous de la liste (toujours vide) Valeurs. Après un court délai, la liste
Valeurs sera remplie avec les valeurs du champ sélectionné (NAME_2).

• Double-cliquez sur la valeur Bellville dans la liste Valeurs. Comme avant, elle va être ajoutée à la requête
SQL.

Afin de sélectionner plus qu’un district, vous devrez utiliser l’opérateur booléen OU.

• Cliquez sur le bouton OU et il sera ajouté à la requête SQL.

• En utilisant un processus similaire à celui d’en haut, ajoutez ce qui suit à la requête SQL existante :

"NAME_2" = ’Cape’

• Ajoutez un autre opérateur OU, puis faites-vous un chemin à travers la liste des districs ci-dessus d’une
manière similaire.

• La requête finale devrait être :

"NAME_2" = ’Bellville’ OR "NAME_2" = ’Cape’ OR "NAME_2" = ’Goodwood’ OR
"NAME_2" = ’Kuils River’ OR "NAME_2" = ’Mitchells Plain’ OR "NAME_2" =
’Simons Town’ OR "NAME_2" = ’Wynberg’

• Cliquez sur OK. Les districts indiqués dans votre carte sont maintenant limité à ceux de la liste ci-dessus.

9.4.9 Couper les rasters

Maintenant que vous avez une aire d’intérêt, vous pouvez couper les rasters de cette aire.

• Assurez-vous que les seules couches visibles soient le MNE, Rainfall et Districts.

• Districts doit être au sommet de celles qui sont visibles.

• Ouvrez la boîte de dialogue de coupage en sélectionnant l’élément de menu Raster → Extraction → Dé-
couper.

• Dans la liste déroulante Fichier source (raster), sélectionnez la couche MNE.

• Spécifiez un emplacement de sortie dans le champ de texte Fichier de sortie en cliquant sur le bouton
Sélectionner....

• Naviguez jusqu’au dossier Rasterprac.

• Entrez un nom de fichier.

• Sauvegardez le fichier. Laissez la case à cocher Pas de données de valeurs non cochée.

• Utilisez le mode de découpe Apreçu en vous assurant que le bon bouton radio est sélectionné.

• Cliquez et faites glissez une zone dans le canevas, ainsi la zone qui inclut les districts est sélectionnée.

• Cochez la case Charger dans la carte une fois terminé.

• Cliquez sur OK.

• Après l’opération de découpage terminée, NE FERMEZ PAS la boîte de dialogue Découper. (Le faire vous
ferait perdre la zone découpée que vous venez de définir.)

• Sélectionnez le raster Rainfall dans la liste déroulante Fichier source (raster) et choisissez un nom différent
de fichier de sortie.

• Ne changez pas les autres options. N’altérez pas la zone de découpage existante que vous avez dessiné
précédemment. Laissez tout pareil et cliquez sur OK.

• Après la seconde opération de découpage terminée, vous pouvez fermer la boîte de dialogue Découper.
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• Sauvegardez la carte.

9.4.10 Nettoyer la carte.

• Supprimez les couches originales Rainfall et DEM de la Légende de la carte :

• Faites un clic-droit sur ces couches et sélectionnez Supprimer.

– Cela ne va pas supprimer les données de votre périphérique de stockage, cela va seulement l’ôter de
votre carte.

• Désactivez les étiquettes de la couche Streets :

– Cliquez sur le bouton Étiquetage.

– Décochez la case Étiqueter cette couche avec.

– Cliquez sur OK.

• Montrer à nouveau toute la couche Streets :

– Faites un clic-droit sur la couche dans la Légende de la carte.

– Sélectionner Requête.

• Dans la boîte de dialogue Requête qui apparaît, cliquez sur le bouton Effacer, puis cliquez sur OK.

• Attendez que les données chargent. Toutes les rues seront maintenant visibles.

• Changez la symbologie raster comme avant (voir Changement de la symbologie des couches rasters).

• Sauvegardez la carte.

• Vous pouvez maintenant cacher les couches vecteurs en désélectionnant la case à côté d’elles dans la Lé-
gende de la carte. Cela permettra un rendu de la carte plus rapide et vous fera gagner du temps.

Afin de créer l’ombrage, vous devrez utiliser une extension qui a été créée pour cette fonction.

9.4.11 Activation de l’extension Analyse Raster de Terrain

Cette extension est incluse par défaut dans QGIS 1.8. Toutefois, elle pourrait ne pas être immédiatement visible.
Pour vérifier si c’est accessible sur votre système :

• Click on the menu item Plugins → Manage Plugins....

• Assurez-vous que la case à côté de Extension d’Analyse Raster de Terrain est sélectionnée.

• Cliquez sur OK.

Vous avez maintenant accès à cette extension via l’élément de menu Raster → Analyse de Terrain.

Souvenez-vous que des extensions peuvent parfois dépendre de certains modules Python installés sur votre sys-
tème. Si une extension refuse de fonctionner et se plaint de dépendances manquantes, veuillez demander de l’aide
à votre tuteur ou maître de conférences.

9.4.12 Créer l’ombrage

• Dans la Légende de la carte, assurez-vous que le MNE est la couche active (c’est-à-dire qu’elle est en
surbrillance car on a cliqué dessus).

• Cliquez sur l’élément du menu Raster → Analyse de Terrain → Ombrage pour ouvrir la boîte de dialogue
Ombrage.

• Spécifiez un emplacement approprié pour la couche de sortie et appelez-la Hillshade.

• Cochez la case Ajouter le résultat au projet.
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• Cliquez sur OK.

• Attendez que le processus se termine.

La nouvelle couche hillshade est apparue dans votre Légende de la carte.

• Faites un clic-droit sur la couche hillshade dans votre Légende de la carte et faites apparaître la boîte de
dialogue Propriétés.

• Cliquez sur l’onglet Transparence et configurez la barre coulissante de transparence à 80%.

• Cliquez sur OK .

• Notez l’effet quand l’ombrage transparent est superposé au MNE coupé.

9.4.13 Pente

• Cliquez sur l’élément du menu Raster → Analyse de Terrain.

• Sélectionnez le type d’analyse Pente, avec le MNE coupé comme couche source.

• Spécifiez un nom de fichier et un emplacement appropriés à des fins de sortie.

• Cochez la case Ajouter le résultat au projet.

• Cliquez sur OK.

L’image de la pente a été calculée et ajoutée à la carte. Cependant, c’est comme d’habitude juste un rectangle gris.
Pour voir correctement ce qui se passe, changez la symbologie comme suit.

• Ouvrez la boîte de dialogue Propriétés de la couche (comme d’habitude, via le menu du clic-droit sur la
couche).

• Cliquez sur l’onglet Style.

• Où il est dit Échelle de gris (dans le menu déroulant Couleur de la carte), changez le en Pseudocouleur.

• Assurez-vous que le bouton radio Utiliser l’écart-type est sélectionné.

9.4.14 Aspect

• Utilisez la même approche que pour calculer la pente, mais sélectionnez Aspect dans la boîte de dialogue
initiale.

Souvenez-vous de sauvegarder périodiquement la carte.

9.4.15 Reclassement des rasters

• Cliquez sur l’élément du menu Raster → Calculatrice Raster.

• Spécifiez votre dossier Rasterprac comme emplacement pour la couche de sortie.

• Assurez-vous que la case Ajouter le résultat au projet est cochée.

Dans la liste Bandes Raster sur la gauche, vous verrez toutes les couches rasters dans votre Légende de la carte.
Si votre couche Pente est appelée slope, elle sera listée en tant que slope@1.

La pente doit être entre 15 et 60 degrés. Tout ce qui est inférieur à 15 ou plus grand que 60 doit donc être exclu.

• En utilisant les éléments de la liste et les boutons dans l’interface, construisez l’expression suivante :

((slope@1 < 15) OR (slope@1 > 60)) = 0

• Configurez le champ Couche de sortie avec un emplacement approprié et un nom de fichier.

• Cliquez sur OK.
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Trouvez maintenant l’aspect correct (face est : entre 45 et 135 degrés) en utilisant la même approche.

• Construisez l’expression suivante :

((aspect@1 < 45) OR (aspect@1 > 135)) = 0

• Trouvez les précipitations correctes (plus grande que 1200mm) de la même façon. Construisez l’expression
suivante :

(rainfall@1 < 1200) = 0

Ayant reclassés tous les rasters, vous les verrez maintenant affichés sous forme de rectangles gris dans votre carte
(en admettant qu’ils ont été ajoutés correctement à la carte). Pour afficher correctement les données raster avec
seulement deux classes (1 et 0, signifiant vrai ou faux), vous devrez changer leur symbologie.

9.4.16 Configuration du style pour les couches reclassées

• Ouvrez l’onglet Style dans la boîte de dialogue Propriétés de la couche comme d’habitude.

• Sous l’en-tête Charger des valeurs min / max à partir d’une bande, sélectionnez le bouton radio Actuel (plus
lent).

• Cliquez sur le bouton Charger.

Les champs Personnaliser les valeurs min / max doivent maintenant être remplis avec respectivement 0 and 1. (Si
ce n’est pas le cas, alors il y a une erreur avec votre reclassification des données, et vous aurez besoin de revenir
sur cette partie.)

• Sous Amélioration de contraste, configurez la liste déroulante Actuel en Étirer jusqu’au MinMax.

• Cliquez sur OK.

• Faites ceci pour les trois rasters reclassifiés, et souvenez-vous de sauvegarder votre travail !

Le seul critère qui reste est que l’aire doit être éloignée de 250m des zones urbaines. Nous satisferons cette
exigence en s’assurant que les domaines que nous calculons sont situés à 250m ou plus d’un bord d’une zone
rurale. Par conséquent, nous devons premièrement trouver toutes les zones rurales.

9.4.17 Trouver les zones rurales

• Cachez toutes les couches dans la Légende de la carte.

• Affichez la couche vecteur Zonage.

• Faites un clic-droit dessus et faites apparaître la boîte de dialogue Requête.

• Construisez la requête suivante :

"Gen_Zoning" = ’Rural’

Voyez les instructions précédentes pour construire la requête Streets si vous êtes coincés.

• Quand vous avez fini, fermez la boîte de dialogue Requête.

Vous devriez voir une collection de polygones de la couche Zonage. Vous aurez besoin de les sauvegarder dans
un nouveau fichier de couche.

• Dans le menu du clic-droit de Zonage, sélectionnez Sauvegarder sous....

• Sauvegardez votre couche sous le dossier Zoning.

• Nommez le fichier de sortie rural.shp.

• Cliquez sur OK.

• Ajoutez la couche à votre carte.

• Cliquez sur l’élément du menu Vecteur → Outils de géotraitement → Décomposer.

246 Chapter 9. Module: Compléter l’analyse



QGIS Training Manual, Version 2.18

• Sélectionnez la couche rural en couche d’entrée et laissez décochée la case Utiliser seulement les entités
sélectionnées

• Sous Champ de catégorie, sélectionnez — Tout décomposer —.

• Sauvegardez votre couche sous le dossier Zoning.

• Cliquez sur OK. Une boîte de dialogue apparaîtra vous demandant si vous souhaitez ajouter la nouvelle
couche à la TDM (“Table des matières”, faisant référence à la Légende de la carte).

• Cliquez sur Oui.

• Fermez la boîte de dialogue Décomposer.

• Effacez les couches rural et Zoning.

• Sauvegardez la carte.

Vous devez maintenant exclure les zones qui sont à moins de 250m du bord d’une zone rurale. Faites ceci en
créant un tampon négatif, comme expliqué ci-dessous.

9.4.18 Création d’un tampon négatif

• Cliquez sur l’élément de menu Vecteur → Outils de géotraitement → Tampon(s).

• Dans la boîte de dialogue qui apparaît, sélectionnez la couche rural_dissolve comme votre couche vecteur
source (Utiliser uniquement les valeurs sélectionnées ne doit pas être coché).

• Sélectionnez le bouton Distance du tampon et entrez la valeur -250 dans le champ associé ; la valeur
négative signifie que le tampon doit être un tampon interne.

• Cochez la case Union des résultats du tampon.

• Mettez le fichier de sortie dans le même dossier que les autres fichiers vecteurs ruraux

• Nommez le fichier de sortie rural_buffer.shp.

• Cliquez sur Sauvegarder.

• Cliquez sur OK et attendez que le processus soit terminé.

• Sélectionnez Oui dans la boîte de dialogue qui apparaît.

• Fermez la boîte de dialogue Tampon.

• Supprimez la couche rural_dissolve.

• Sauvegardez la carte.

Afin d’intégrer les zones rurales dans la même analyse avec les trois rasters existants, il sera nécessaire
d’également les rasteriser. Mais pour que les rasters soient compatibles pour l’analyse, ils devront être de la
même taille. Par conséquent, avant que vous puissiez les rasteriser, vous devrez découper le vecteur de la même
surface que les trois rasters. Un vecteur peut seulement être découpé par un autre vecteur, donc vous devrez
d’abord créer une boîte englobante en forme de polygone de la même taille que les rasters.

9.4.19 Création d’une zone de délimitation vectorielle

• Click on the menu item Layer → New → New Shapefile Layer....

• Sous l’en-tête Type, sélectionnez le bouton Polygone.

• Cliquez sur Spécifiez le SCR et choisissez le système de coordonnées de référence WGS 84 / UTM zone
33S : EPSG:32733.

• Cliquez sur OK.

• Cliquez aussi sur OK dans la boîte de dialogue Nouvelle couche vecteur.

• Sauvegardez le vecteur dans le dossier Zoning.
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• Nommez le fichier de sortie bbox.shp.

• Cachez toutes les couches exceptée la nouvelle couche bbox et un des rasters reclassés.

• Assurez-vous que la couche bbox est en surbrillance dans la Légende de la carte.

• Naviguez jusqu’à l’élément du menu Vue > Barre d’outils et assurez-vous que la Numérisation est sélec-
tionnée. Vous devriez alors voir une icône de barre d’outils avec un crayon ou koki dessus. Il s’agit du
bouton Basculer en mode édition.

• Cliquez sur le bouton Basculer en mode édition pour entrer en mode d’édition. Cela vous permet de modifier
une couche vecteur.

• Cliquez sur le bouton Ajouter une entité, qui devrait être près du bouton Basculer en mode édition. Il peut
être caché derrière un bouton à double flèches ; si c’est le cas, cliquez sur les double flèches pour montrer
les boutons cachés de la barre d’outils Numérisation.

• Avec l’outil Ajouter une entité sélectionné, faites un clic-gauche sur les coins du raster. Vous devrez peut-
être zoomer avec la molette de la souris afin de vous assurer que c’est fait de manière exacte. Pour vous
déplacer sur la carte dans ce mode, cliquez et faites glisser la carte avec le bouton du milieu de la souris ou
la molette de la souris.

• Pour le quatrième et dernier point, faites un clic-droit pour finaliser la forme.

• Entrez un nombre arbitraire pour l’ID de la forme.

• Cliquez sur OK.

• Cliquez sur le bouton Sauvegardez les modifications.

• Cliquez sur le bouton Basculer en mode édition pour arrêter votre session d’édition.

• Sauvegardez la carte.

Maintenant que vous avez une boîte englobante, vous pouvez l’utiliser pour couper la couche tampon rural.

9.4.20 Découpage d’une couche vectorielle

• Assurez-vous que seules les couches bbox and rural_buffer sont visibles, avec celui-ci sur le dessus.

• Cliquez sur l’élément du menu Vecteur > Outils de géotraitement > Découper.

• Dans la boîte de dialogue qui apparaît, configurez la couche vecteur source avec rural_buffer et la couche
de découpage avec bbox, avec les deux cases Utiliser uniquement les entités sélectionnées décochées.

• Mettez le fichier de sortie sous le dossier Zoning.

• Nommez le fichier de sortie rural_clipped.

• Cliquez sur OK.

• Quand on vous demande d’ajouter la couche à la Légende de la carte, cliquez sur Oui.

• Fermez la boîte de dialogue.

• Comparez les trois vecteurs et regardez les résultats pour vous-même.

• Effacer les couches bbox et rural_buffer, puis sauvegardez votre carte.

Elle est maintenant prête à être numérisée.

9.4.21 Numérisation d’une couche vectorielle

Vous devrez spécifier une taille de pixel pour un nouveau raster que vous créez, donc vous devrez d’abord connaître
la taille d’un de vos rasters existants.

• Ouvrez la boîte de dialogue Propriétés d’un des trois rasters existants.

• Basculez sur l’onglet Métadonnées.
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• Prenez note des valeurs X et Y sous l’en-tête Dimensions dans la table des Métadonnées.

• Fermez la boîte de dialogue Propriétés.

• Cliquez sur l’élément du menu Raster → Conversion → Numériser. Vous pouvez recevoir un avertissement
à propos d’un jeu de données non supporté. Cliquez sur suivant et ignorez-le.

• Sélectionnez rural_clipped comme votre couche source.

• Définissez un emplacement pour le fichier de sortie dans le dossier Zoning.

• Nommez le fichier de sortie rural_raster.tif.

• Cochez la case Nouvelle taille et entrez les valeurs X et Y que vous avez noté plus tôt.

• Cochez la case Chargez dans la carte.

• Cliquez sur l’icône en forme de crayon à côté du champ de texte qui montre la commande qui sera exécutée.
A la fin du texte, ajoutez un espace, puis écrivez -burn 1. Cela indique à la fonction de Pixellisation de
“brûler” le vecteur existant dans la noucelle trame

• Cliquez sur OK.

• Le nouveau raster devrait apparaître dans votre carte une fois qu’il a été calculé.

• Le nouveau raster ressemblera à un rectangle gris – vous pouvez changer le style d’affichage comme vous
l’avez fait pour les rasters reclassifiés.

• Sauvegardez votre carte.

Maintenant que vous avez chacun des quatre critères dans des rasters séparés, vous devez les combiner pour voir
quelle zones satisfont tous les critères. Pour ceci, les rasters devront être multipliés avec chacun des autres rasters.
Lorsque l’on fait cela, tous les pixels qui se chevauchent avec une valeur de 1 conserveront la valeur 1, mais si
un pixel a la valeur de 0 dans n’importe lequel des quatre rasters, alors il affichera 0 dans le résultat. De cette
façon-là, le résultat contiendra seulement des zones se chevauchant.

9.4.22 Combiner des rasters

• Cliquez sur l’élément du menu Raster → Calculatrice Raster.

• Construisez l’expression suivante (avec les noms appropriés pour vos couches, selon comment vous les avez
appelées) :

[Rural raster] * [Reclassified aspect] * [Reclassified slope] *
[Reclassified rainfall]

• Définissez l’emplacement de sortie avec le dossier Rasterprac.

• Nommez le raster de sorite cross_product.tif.

• Assurez-vous que la case Ajouter le résultat au projet est cochée.

• Cliquez sur OK.

• Changez la symbologie du nouveau raster de la même façon que vous avez configuré les styles pour les
autres rasters reclassés. Le nouveau raster affiche désormais correctement les zones pour lesquelles tous les
critères sont satisfaits.

Pour obtenir le résultat final, vous devez sélectionner les aires qui sont plus grandes que 6000m^2. Cependant,
le calcul de ces zones est seulement possible pour une couche vectorielle, donc vous devrez vectoriser le raster.

9.4.23 Vectoriser le raster

• Cliquez sur l’élément du menu Raster → Conversion → Polygoniser.

• Sélectionnez le raster cross_product.

• Définissez l’emplacement de sortie à Rasterprac.
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• Nommez le fichier candidate_areas.shp.

• Assurez-vous que Charger dans la carte une fois terminé est coché.

• Cliquez sur OK.

• Fermez la boîte de dialogue quand le processus est terminé.

Toutes les aires du raster ont été vectorisées, donc vous devez sélectionner seulement les aires qui ont une valeur
de 1.

• Ouvrez la boîte de dialogue Requête pour le nouveau vecteur.

• Construisez cette requête :

"DN" = 1

• Cliquez sur OK.

• Créez un nouveau fichier vecteur à partir des résultats en sauvegardant le vecteur candidate_areas après que
la requête soit terminée (et seules les aires avec une valeur de 1 sont visibles). Utilisez pour cela la fonction
Sauvegarder sous... dans le menu du clic-droit de la couche.

• Sauvegardez le fichier dans le dossier Rasterprac.

• Nommez le fichier candidate_areas_only.shp.

• Sauvegardez votre carte.

9.4.24 Calcul de l’aire pour chaque polygone

• Ouvrez le menu du clic-droit de la nouvelle couche vectorielle.

• Sélectionnez Ouvrir la table attributaire.

• Cliquez sur le bouton Basculer en mode édition le long du bas de la table, ou appuyez sur Ctrl+E.

• Cliquez sur le bouton Ouvrir la calculatrice de champ le long en bas de la table, ou appuyez sur Ctrl+I.

• Sous l’en-tête Nouveau champ dans la boîte de dialogue qui apparaît, entrez le nom du champ area. Le
type de fichier de sortie devrait être un entier, et la longueur du champ devrait être de 10.

• Dans l’Expression de la calculatrice de champ, tapez :

$area

Cela signifie que la calculatrice de champ calculera l’aire de chaque polygone dans la couche vectorielle et
remplira ensuite une nouvelle colonne d’entiers (appelée area) avec la valeur calculée.

• Cliquez sur OK.

• Faites la même chose pour un autre nouveau champ nommé id. Dans l’Expression de la calculatrice de
champ, tapez :

$id

Cela garantit que chaque polygone a un identifiant unique à des fins d’identification.

• Cliquez encore sur Basculer en mode édition, et sauvegardez vos modifications si vous êtes invités à le faire.

9.4.25 Sélection des aires d’une taille donnée

Maintenant que les aires sont connues :

• Construisez une requête (comme d’habitude) pour sélectionner uniquement les polygones plus grands que
6000m^2. La requête est :
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"area" > 6000

• Sauvegardez la sélection comme une nouvelle couche vectorielle appelée solution.shp.

Vous avez maintenant vos aires de solution, parmi lesquelles vous sélectionnerez la plus proche de votre maison.

9.4.26 Numériser votre maison

• Créez une nouvelle couche vectorielle comme avant, mais cette fois, sélectionnez un Point comme valeur
Type.

• Assurez-vous que c’est le bon SCR !

• Nommez la nouvelle couche house.shp.

• Terminez la création de la nouvelle couche.

• Entrez en mode d’édition (alors que la nouvelle couche est sélectionnée).

• Cliquez sur le point où votre maison ou autre lieu de résidence actuel se trouve, en utilisant les rues comme
une aide. Vous pourriez devoir ouvrir d’autres couches pour vous aider à trouver votre maison. Si vous
ne vivez pas dans les environs, cliquez simplement quelque part entre les rues où une maison pourrait en
théorie être.

• Entrez un nombre arbitraire pour l’ID de la forme.

• Cliquez sur OK.

• Sauvegardez vos modifications et quittez le mode d’édition.

• Sauvegardez la carte.

Vous devrez trouver les centroïdes (“centres de gravité”) pour les polygones de l’aire de solution afin de décider
lequel est le plus proche de votre maison.

9.4.27 Calculer des centroïdes de polygones

• Cliquez sur l’élément du menu Vecteur → Outils de géométrie → Centroïdes de polygones

• Spécifiez la couche source comme solution.shp.

• Définissez l’emplacement de sortie à Rasterprac.

• Appelez le fichier de destination solution_centroids.shp.

• Cliquez sur OK et ajoutez le résultat à la Table des matières (Légende de la carte), puis fermez la boîte de
dialogue.

• Faites glisser la nouvelle couche jusqu’au sommet de l’ordre des couches de sorte que vous puissiez la voir.

9.4.28 Calculer quel centroïde est le plus près de votre maison

• Click on the menu item Vector → Analysis Tools → Distance matrix.

• La couche source devrait être votre maison, et la couche cible solution_centroids. Toutes les deux devraient
utiliser le champ id comme leur champ d’identifiant unique.

• Le type de matrice en sortie devrait être linéaire.

• Définissez un emplacement et un nom appropriés de sortie.

• Cliquez sur OK.

• Ouvrez le fichier dans un éditeur de texte (ou importez-le dans un tableur). Notez quel identifiant cible est
associé avec la Distance la plus courte. Il peut y en avoir plus d’un à la même distance.
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• Construisez une requête dans QGIS pour sélectionner seulement les aires de solution les plus proche de
votre maison (sélectionnez-les en utilisant le champ id).

C’est la réponse finale à la question de recherche.

Pour votre soumission, incluez la couche d’ombrage semi-transparent au-dessus d’un raster attrayant de votre
choix (comme par exemple le MNE ou le raster pente). Incluez également le polygone de la zone(s) de solution la
plus proche, aussi bien que votre maison. Suivez toutes les meilleures pratiques de la cartographie pour la création
de votre carte de sortie.
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CHAPTER 10

Module: Extensions

Les extensions vous permettent d’étendre les fonctionnalités offertes par QGIS. Dans ce module, nous vous mon-
trerons comment activer et utiliser les extensions.

10.1 Lesson: Installation et gestions des extensions

Pour débuter l’utilisation des extensions, vous devez savoir comment les télécharger, les installer et les activer.
Pour ce faire, vous allez apprendre à utiliser le Plugin Installer et le Plugin Manager.

Le but de cette leçon : Comprendre le système des extensions de QGIS.

10.1.1 Follow Along: Gestion des extensions

• Pour ouvrir le Gestionnaire d’extensions, cliquez dans le menu Extension → Installer/Gérer les extensions.

• Dans la fenêtre qui s’ouvre, trouvez l’extension Processing :

• Cliquez dans la case à côté de cette extension et décochez-la pour la désinstaller.
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• Cliquez sur Fermer.

• Regardez le menu, vous remarquerez que le menu Traitements a désormais disparu. Ceci signifie que de
nombreuses fonctions de traitement utilisées auparavant ont disparu ! C’est parce qu’elles font partie de
l’extension Processing, qui a besoin d’être activé pour pouvoir les utiliser.

• De nouveau, ouvrez le Gestionnaire d’extensions et réactivez l’extension Processing en cliquant dans la
case à côté puis cliquez sur Fermer.

• Le menu Processing devrait de nouveau être disponible.

10.1.2 Follow Along: Installation de nouvelles extensions

La liste des extensions que vous pouvez activer et désactiver puise dans les extensions que vous avez déjà installé.

• Pour installer de nouvelles extensions, sélectionnez l’onglet Non installées dans la fenêtre du Gestionnaire
d’extensions. Les extensions disponibles pour l’installation seront listées ici. La liste pourra varier suivant
votre configuration système existente.

• Vous pouvez trouver des informations concernant chaque extension en le sélectionnant dans la liste affichée
des extensions.
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• Une extension peut être installée en cliquant sur le bouton Installer l’extension en dessous du panneau
d’information de l’extension.

10.1.3 Follow Along: Configuration de dépôts supplémentaires
d’extensions

Les extensions sont disponibles dépendant de quels dépôts d’extensions à utiliser sont configurés.

Les extensions QGIS sont stockées sur internet dans des dépôts. Par défaut, seul le dépôt officiel est actif, signifiant
que vous avez seulement accès aux extensions officielles. Ce sont généralement les premières extensions que vous
souhaitez, car elles ont été testées soigneusement et sont souvent inclues par défaut dans QGIS.

Cependant, il est possible d’essayer plus d’extensions que celles par défaut. Premièrement, configurez les dépôts
supplémentaires. Pour ce faire :

• Placez vous sur l’onglet Paramètres dans la fenêtre Gestionnaire d’extensions :
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• Cliquez sur Ajouter... pour trouver et ajouter un nouveau dépôt.

• Fournissez un nom et une URL pour le nouveau dépôt que vous souhaitez configurer et assurez vous que la
case Activé est cochée.

• Vous devriez voir maintenant le nouveau dépôt listé dans la liste des dépôts d’extension configurés :
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• Vous pouvez également sélectionner l’option pour afficher les extensions expérimentales en cochant la case
Afficher les extensions expérimentales.

• Si vous revenez sur l’onglet Non installées, vous verrez que des extensions supplémentaires sont disponibles
à l’installation.

• Pour installer une extension, cliquez simplement dessus dans la liste puis cliquez sur le bouton Installer
l’extension.

10.1.4 In Conclusion

Installer des extensions dans QGIS est simple et efficace !

10.1.5 What’s Next?

Nous allons ensuite vous présenter quelques extensions utiles comme exemples.

10.2 Lesson: Des extensions utiles de QGIS

Maintenant que vous pouvez installer, activer et désactiver des extensions, regardons comment, dans la pratique,
elles peuvent vous aider au travers de quelques exemples d’extensions utiles.

Le but de cette leçon : Vous familiariser avec l’interface des extensions et vous faire prendre connaissance de
certain les extensions utiles.

10.2.1 Follow Along: L’extension d’analyse raster de terrain

• Commencez une nouvelle carte avec seulement de chargé le jeu de données raster srtm_41_19.tif (regarder
dans exercise_data/raster/SRTM).
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From the lesson on raster analysis, you’re already familiar with raster analysis functions. You used GDAL tools
(accessible via Raster → Analysis) for this. However, you should also know about the Raster Terrain Analysis
plugin. This ships standard with newer versions of QGIS, and so you don’t need to install it separately.

• Ouvrez le Gestionnaire d’extensions et vérifiez que l’extension d’Analyse Raster de Terrain est activée :

• Ouvrez le menu Raster. Vous devriez voir un sous-menu Analyse de terrain.

• Cliquez sur Analyse de terrain → Relief et saisissez les options suivantes :

• Sauvegardez le nouveau fichier sous exercise_data/plugins/relief.tif (créez un nouveau
dossier si nécessaire).
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• Laissez comme tel le Format en sortie et le Facteur Z.

• Assurez-vous que la case Ajouter un résultat au projet est cochée.

• Cliquez sur le bouton Création automatique. La liste en dessous sera remplie :

Ce sont les couleurs que l’extension utilisera pour créer le relief.

• Si vous le souhaitez, vous pouvez changer ces couleurs en double-cliquant sur la barre colorée de chaque
ligne. Par exemple :

• Cliquez sur OK et le relief sera créé :
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Ceci permet d’obtenir un effet similaire à celui utilisé lorsque vous avez placé l’ombrage semi-transparent au-
dessus d’une autre couche raster. L’avantage de cette extension est qu’elle crée cet effet en utilisant seulement une
seule couche.

10.2.2 Follow Along: L’extension OpenLayers

• Commencez une nouvelle carte et ajoutez la couche roads.shp.

• Zoomez sur la zone de Swellendam.

• En utilisant le Gestionnaire d’extensions, trouvez une nouvelle extension en saisissant le mot OpenLayers
dans le champ Rechercher.

• Sélectionnez l’extension OpenLayers dans la liste filtrée:
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• Cliquez sur le bouton Installer l’extension pour l’installer.

• Une fois fait, fermez le Gestionnaire d’extensions.

Avant de l’utiliser, assurez-vous que votre carte et votre extension sont correctement configurés :

• Ouvrez les paramètres de l’extension en cliquant sur Web → Extension OpenLayers → Aperçu OpenLayers.

• tilisez le panneau pour choisir le type de carte souhaité. Dans cet exemple, nous utiliserons le type de carte
“Google Hybrid”, mais vous pouvez en choisir un autre si vous le souhaitez.

• Ouvrez la fenêtre des Propriétés du projet en sélectionnant dans le menu Projet –> Propriétés du projet.

• Activez la projection “à la volée” et utilisez la projection WGS 84 / Pseudo Mercator :
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• Now use the plugin to give you a Google map of the area. You can click on Web → OpenLayers Plugin →
Add Google Hybrid Layer to add it:

Ceci chargera une nouvelle image raster depuis Google que vous pouvez utiliser en toile de fond, ou pour vous
aider à trouver où vous vous situez sur la carte. Nous avons ici cette couche avec en superposition, notre couche
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vecteur des routes :

Note: Vous devrez peut-être glisser votre couche de routes au-dessus de la couche Google pour la rendre visible
par-dessus la couche de fond. Il sera peut-être nécessaire de faire un zoom sur la couche de routes pour recentrer
la carte.

10.2.3 Follow Along: L’extension GeoSearch

• Commencez une nouvelle carte sans jeux de données.

• Ouvrez le Gestionnaire d’extensions et filtrez pour chercher l’extension GeoSearch et cliquez sur Installer
l’extension pour l’installer.
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• Fermez le Gestionnaire d’extensions.

• You can now use the GeoSearch plugin to search for placenames. Click on Plugins → GeoSearch Plugin
→ GeoSearch to open the GeoSearch dialog.

• Faites une recherche pour Swellendam dans la fenêtre de GeoSearch pour la localiser sur votre carte :
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10.2.4 In Conclusion

Il existe de nombreuses extensions disponibles pour QGIS. En utilisant les outils intégrés pour l’installation et la
gestion de ces extensions, vous pouvez trouver de nouvelles extensions et en faire une utilisation optimale.

10.2.5 What’s Next?

Nous allons ensuite voir comment utiliser en temps réel des couches qui sont hébergées sur des serveurs distants.
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CHAPTER 11

Module: Ressources en ligne

Lorsque l’on considère les sources de données pour une carte, il n’y a pas besoin de se restreindre aux données
que vous avez sauvegardées sur votre ordinateur avec lequel vous travaillez. Il y a des sources de données en ligne
depuis lesquelles vous pouvez charger des données et ce tant que vous êtes connecté à Internet.

Dans ce module, nous aborderons deux sortes de services SIG basés sur le web : Web Mapping Services (WMS)
et Web Feature Services (WFS).

11.1 Lesson: Web Mapping Services

Un Web Mapping Service (WMS, qui signifie Service de cartographie web en anglais) est un service hébergé sur
un serveur distant. Semblable à un site web, vous pouvez y accéder tant que vous avez une connexion au serveur.
En utilisant QIGS, vous pouvez charger un répertoire WMS directement dans votre carte existante.

Vous devez vous souvenir de la leçon sur les extensions qu’il est possible de charger une nouvelle image raster
depuis Google, par exemple. Cependant, il s’agit d’une transaction ponctuelle : une fois que vous avez téléchargé
l’image, elle ne change pas. Un WMS est différent dans le fait que c’est un service en direct qui actualisera
automatiquement sa vue si vous déplacez ou zoomez sur la carte.

Objectif de cette leçon : Utiliser un WMS et comprendre ses limites.

11.1.1 Follow Along: Chargement d’une Couche WMS

Pour cet exercice, vous pouvez soit utiliser la carte de base que vous avez réalisée au début du cours, ou alors
tout simplement ouvrir une nouvelle carte et y charger quelques couches existantes. Pour cet exemple, nous avons
utilisé une nouvelle carte et chargé les couches originales places et landuse et modifié leur symbologie :
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• Chargez ces couches dans une nouvelle carte, ou utilisez votre carte d’origine avec seulement ces couches
visibles.

• Avant de commencer à ajouter la couche WMS, désactivez tout d’abord la projection “à la volée”. Cela peut
conduire à une mauvaise superposition des couches, mais ne vous inquiétez pas : nous corrigerons cela plus
tard.

• Pour ajouter des couches WMS, cliquez sur la bouton Ajouter une couche WMS :

Souvenez-vous de comment vous avez connecté une base de données SpatiaLite au début du cours. Les couches
landuse, places, et water sont dans cette base de données. Pour utiliser ces couches, vous deviez tout d’abord vous
connecter à la base de données. L’utilisation d’un WMS est semblable, à l’exception du fait que les couches sont
sur un serveur distant.

• Pour créer une nouvelle connexion à un WMS, cliquez sur le bouton Nouveau.

Vous aurez besoin d’une adresse WMS pour continuer. Il y a plusieurs serveurs WMS libres disponibles sur
internet. Un de ceux-là est terrestris, qui utilise le jeu de données d’OpenStreetMap.

• Pour utiliser ce WMS, configurez-le dans votre boîte de dialogue actuelle, comme ceci :
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• La valeur du champ Nom doit être terrestris.

• La valeur du champ URL doit être http://ows.terrestris.de/osm/service.

• Cliquez sur OK. Vous devriez voir le nouveau serveur WMS listé :
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• Cliquez sur Connecter. Dans la liste d’en-dessous, vous devriez maintenant voir ces nouvelles entrées
chargées :
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Il y a toutes les couches hébergées par ce serveur WMS.

• Cliquez une fois sur la couche OSM-WMS. Cela affichera son Système de Coordonnées de Références :

Comme nous n’utilisons par le WGS 84 pour notre carte, regardons tous les SCR que nous avons à choix.

• Cliquez sur le bouton Changer. Vous verrez une boîte de dialogue Sélectionneur de système de coordonnées
de référence standard.

• Nous voulons un SCR projeté, donc choisissons WGS 84 / Pseudo Mercator.
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• Cliquez sur OK.

• Cliquez sur Ajouter et la nouvelle couche apparaîtra dans votre carte en tant que OSM-WMS.

• Dans la Légende de la carte, cliquez dessus et faites-la glisser en bas de la liste.

Vous remarquerez que vos couches ne sont pas localisées de manière correcte. Cela est dû au fait que la projection
“à la volée” est désactivée. Activons-la à nouveau, mais en utilisant la même projection que la couche OSM-WMS,
qui est la WGS 84 / Pseudo Mercator.

• Activez la projection “à la volée”.

• Dans l’onglet SCR (boîte de dialogue Propriétés du projet), entrez la valeur pseudo dans le champ Filtre :
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• Choisissez WGS 84 / Pseudo Mercator dans la liste.

• Cliquez sur OK.

• Faites maintenant un clic-droit sur une de vos propres couches dans la Légende de la carte et cliquez sur
Zoomer sur la couche. Vous devriez voir la zone Swellendam :

11.1. Lesson: Web Mapping Services 273



QGIS Training Manual, Version 2.18

Remarquez comme les rues de la couches WMS et vos propres rues se superposent. C’est bon signe !

La nature et les limtes du WMS

Vous devriez maintenant avoir remarqué que cette couche WMS contient actuellement beaucoup d’entités. Il y a
les rues, rivières, réserves naturelles, et caetera. Qui plus est, même si elle ressemble à quelque chose composé de
vecteurs, elle semble être un raster, mais vous ne pouvez pas changer sa symbologie. Pourquoi donc ?

C’est comme cela que fonctionne un WMS : c’est une carte, semblable à une carte normale en papier, que vous
recevez comme une image. Ce qui se passe habituellement est que vous avez des couches vectorielles, que QGIS
affiche comme une carte. Mais en utilisant un WMS, ces couches vectorielles sont sur un serveur WMS, qui les
affiche comme une carte et vous envoie cette carte en tant qu’image. QGIS peut afficher cette image, mais ne peut
pas changer sa symbologie, car tout est géré sur le serveur.

Cela a plusieurs avantages, parce que vous n’avez pas besoin de vous inquiétez de la symbologie. Cela est déjà
réglé, et devrait être agréable à voir sur les WMS conçus avec compétence.

D’un autre côté, vous ne pouvez pas changer la symbologie si vous ne l’aimez pas, et si des choses sont modifiées
sur le serveur WMS, alors elles changeront également dans votre carte. C’est pourquoi vous voudrez parfois
utiliser un Web Feature Service (WFS) à la place, qui vous donne des couches vectorielles séparément, et pas dans
le cadre d’une carte de style WMS.

Mais cela sera abordé dans la prochaine leçon. Premièrement, ajoutons une autre couche WMS depuis le serveur
WMS terrestris.

11.1.2 Try Yourself

• Cachez la couche OSM-WSM dans la Légende de la carte.

• Ajoutez le serveur WMS “ZAF CGS 1M Bedrock Lithostratigraphy” à l’URL :
http://196.33.85.22/cgi-bin/ZAF_CGS_Bedrock_Geology/wms

• Chargez la couche BEDROCKGEOLOGY dans votre carte (utilisez comme avant le bouton Ajouter une
couche WMS). Souvenez-vous de vérifier qu’elle a la même projection WGS 84 / World Mercator que le
reste de votre carte !
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• Vous pouvez vouloir définir son Encodage en JPEG et son option Échelle de taille à 200 sur 200, de sorte
qu’il se charge plus vite :

Vérifiez vos résultats

11.1.3 Try Yourself

• Cachez toutes les autres couches pour éviter de les afficher inutilement dans le fond.

• Ajoutez le serveur WMS “OGC” à cet URL : http://ogc.gbif.org:80/wms

• Ajoutez la couche bluemarble.

Vérifiez vos résultats

11.1.4 Try Yourself

Une partie de la difficulté à utiliser le WMS est de trouver un bon serveur (libre).

• Trouvez un nouveau WMS sur directory.spatineo.com (ou ailleurs en ligne). Il ne doit pas avoir de frais
connexes ou de restrictions, et doit couvrir la zone d’étude Swellendam.

Souvenez-vous que tout ce dont vous avez besoin pour utiliser un WMS est seulement son URL (et de
préférence une sorte de description).

Vérifiez vos résultats

11.1.5 In Conclusion

En utilisant un WMS, vous pouvez ajouter des cartes inactives comme toile de fond pour vos données de carte
existantes.
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11.1.6 Further Reading

• Spatineo Directory

• Geopole.org

• Liste des serveurs WMS d’OpenStreetMap.org

11.1.7 What’s Next?

Maintenant que vous avez ajouté une carte inactive comme toile de fond, vous serez content d’apprendre qu’il est
également possible d’ajouter des données (comme les autres couches vectorielles que vous avez ajoutées avant).
Un ajout de données depuis les serveurs distants est possible en utilisant un Web Feature Service (WFS). C’est le
sujet de la prochaine leçon.

11.2 Lesson: Web Feature Services

Un Web Feature Service (WFS) fournit à ses utilisateurs des données SIG dans des formats qui peuvent être
directement chargés dans QGIS. À la différence d’un WMS, qui vous fournit seulement une carte que vous ne
pouvez pas modifier, un WFS vous donne accès aux entités elles-mêmes.

Objectif de cette leçon : Utiliser un WFS et comprendre en quoi il est différent d’un WMS.

11.2.1 Follow Along: Chargement d’une couche WFS

• Ouvrez une nouvelle carte. C’est à des fins de démo et ça ne sera pas sauvegardé.

• Assurez-vous que la reprojection “à la volée” est désactivée.

• Cliquez sur le bouton Ajouter une nouvelle couche WFS :

• Cliquez sur le bouton Nouveau.

• Dans la boîte de dialogue qui apparaît, entrez le Nom nsidc.org et l’URL
http://nsidc.org/cgi-bin/atlas_south?version=1.1.0.
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• Cliquez sur OK, et la nouvelle connexion apparaîtra dans votre Serveur de connexions.

• Cliquez sur Connecter. Une liste de couches disponibles apparaîtra.

• Trouvez la couche south_poles_wfs.

• Cliquez sur la couche pour la sélectionner :
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• Cliquez sur Ajouter.

Cela peut prendre un certain temps pour charger la couche. Quand elle est chargée, elle apparaîtra dans la
carte. Ici, elle contient les contours de l’Antarctique (disponible sur le même serveur, et sous le nom de antarc-
tica_country_border) :

Qu’est-ce que que cela change par rapport à avoir une couche WMS ? Cela deviendra évidement quand vous
verrez les attributs des couches.
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• Ouvrez la table attributaire de la couche south_poles_wfs. Vous devriez voir cela :

Comme les points ont des attributs, nous sommes capable de les étiqueter, tout comme de changer leur symbologie.
Voici un exemple :

• Ajoutez des étiquettes à votre couche pour profiter des données attributaires dans cette couche.

Différences avec des couches WMS

Un service de WFS retourne la couche en elle-même et pas uniquement une carte rendue avec. Cela vous donne
un accès direct à la donnée et signifie que vous pouvez changer sa symbologie et lancer des fonctions d’analyse
dessus. Néanmoins, cela se fait en transmettant beaucoup plus de données. Cela se révélera particulièrement
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inadapté si les couches que vous chargez ont des formes complexes, un grand nombre d’attributs ou de nom-
breuses entités ou encore si vous chargez un grand nombre de couches. Les couches WFS prennent un temps non
négligeable à se charger à cause de tout cela.

11.2.2 Follow Along: Interroger une couche WFS

Bien que cela soit possible d’interroger une couche WFS après l’avoir chargée, c’est souvent plus efficace de
l’interroger avant de la charger. De cette façon vous n’interrogez que les entités que vous souhaitez, ce qui signifie
que vous utilisez moins de bande passante.

Par exemple, sur le serveur WFS que nous avons récemment utilisé, il y a une couche appelée countries (ex-
cluding Antarctica). Supposons que nous voulons savoir où se trouve l’Afrique du Sud par rapport à la couche
south_poles_wfs (et peut-être aussi la couche antarctica_country_border) qui a déjà été chargée.

Il y a deux manières de le faire. Vous pouvez charger la couche countries ... entièrement, et faire une requête
comme d’habitude une fois la couche chargée. Cependant, la transmission des données pour tous les pays mon-
diaux et n’utiliser uniquement que les données pour l’Afrique du Sud semble être un peu du gaspillage de bande
passante. En fonction de votre connexion, ce jeu de données peut prendre plusieurs minutes à se charger.

La manière alternative est de faire une requête pour filter avant même de charger la couche du serveur.

• Dans la fenêtre Ajouter une couche WFS ..., connectez-vous au serveur que vous avez utilisé précédemment
et vous devriez voir la liste des couches disponibles.

• Double-cliquez à côté de la couche countries ... dans le champ Filter, ou cliquez sur Construire une requête
:

• Dans la fenêtre qui s’ouvre, saisissez la requête "Countryeng" = ’South Africa’:
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• Elle apparaîtra dans le champ Filter :
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• Cliquez sur Ajouter avec la couche countries de sélectionnée comme ci-dessus. Seul le pays avec la valeur
du champ Countryeng définie comme South Africa se chargera depuis cette couche :

Vous n’avez pas à le faire, mais si vous avez testé les deux méthodes, vous remarquerez que cette dernière est
beaucoup plus rapide que le chargement complet des pays avant de les filtrer !

Notes sur la disponibilité des WFS

Il est rare de trouver un WFS hébergeant les entités dont vous avez besoin, surtout si votre besoin est très spé-
cifique. La raison pour laquelle un WFS est relativement rare est à cause des grandes quantités de données qui
doivent être transmises pour décrire toute une entité. Il n’est donc pas très rentable d’héberger un WFS plutôt
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qu’un WMS, qui ne transmet que des images.

Le type le plus commun de WFS que vous rencontrerez sera probablement sur un réseau local ou même sur votre
propre ordinateur, plutôt que sur internet.

11.2.3 In Conclusion

Les couches WFS sont préférables aux couches WMS si vous avez besoin d’un accès direct aux attributs et aux
géométries de ces couches. Cependant, en considérant le volume de données qui ont besoin d’être téléchargées
(ce qui mène à des problèmes de rapidité et aussi au manque de serveurs WFS publics facilement accessibles) ce
n’est pas toujours possible d’utiliser un WFS à la place d’un WMS.

11.2.4 What’s Next?

Next, you’ll see how to use QGIS Server to provide OGC services.
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CHAPTER 12

Module: QGIS Server

Ce module est une contribution de Tudor Bărăscu.

In this module, we’ll cover how to install and use QGIS Server.

For an introduction to what QGIS Server is (see the label_qgisserver section)

12.1 Lesson: Installer QGIS Server

The goal for this lesson: To learn how to install QGIS Server on Debian Stretch. With negligible variations
(prepending sudo to all admin commands) you can also follow it for any Debian based distribution like Ubuntu
and its derivatives.

12.1.1 Follow Along: Install from packages

In this lesson we’re going to do only the install from packages as shown here .

First add the QGIS repository by creating the /etc/apt/sources.list.d/debian-qgis.list file with
the following content:

# latest stable
deb http://qgis.org/debian stretch main
deb-src http://qgis.org/debian stretch main

After you add the qgis.org repository public key to your apt keyring (follow the above link on how to do it) you can
run the apt-get update command to refresh the packages list and apt-get dist-upgrade to upgrade
the packages.

Note: Currently Debian stable has LTR qgis packages in the source jessie-backports, so the above steps
are not necessary. Just add the jessie-backports repository and install with the -t jessie-backports
option.

Install QGIS Server with:

apt-get install qgis-server python-qgis

Note: adding -y at the end of the apt-get command will run it straight away, without requiring confirmation.

QGIS Server should be used in production without QGIS Desktop (with the accompagning X Server) installed on
the same machine.

285

http://qgis.org/en/site/forusers/alldownloads.html#linux


QGIS Training Manual, Version 2.18

12.1.2 Follow Along: QGIS Server Executable

The QGIS Server executable is qgis_mapserv.fcgi. You can check where it has been in-
stalled by running find / -name ’qgis_mapserv.fcgi’ which should output something like
/usr/lib/cgi-bin/qgis_mapserv.fcgi.

Optionally, if you want to do a command line test at this time you can run the
/usr/lib/cgi-bin/qgis_mapserv.fcgi command which should output something like:

QFSFileEngine::open: No file name specified
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment variable.
Content-Length: 206
Content-Type: text/xml; charset=utf-8

<ServiceExceptionReport version="1.3.0" xmlns="http://www.opengis.net/ogc">
<ServiceException code="Service configuration error">Service unknown or unsupported</ServiceException>

</ServiceExceptionReport>

This is a good thing, it tells you we’re on the right track as the server is saying that we haven’t asked for a supported
service. We’ll see later on how to make WMS requests.

12.1.3 Follow Along: HTTP Server Configuration

In order to access on the installed QGIS server from an Internet Browser we need to use an HTTP server.

In this lesson we’re going to use the Apache HTTP server, colloquially called Apache.

First we need to install Apache by running the following command in a terminal: apt-get install
apache2 libapache2-mod-fcgid.

In the /etc/apache2/sites-available directory let’s create a file called qgis.demo.conf, with this
content:

<VirtualHost *:80>
ServerAdmin webmaster@localhost
ServerName qgis.demo

DocumentRoot /var/www/html

# Apache logs (different than QGIS Server log)
ErrorLog ${APACHE_LOG_DIR}/qgis.demo.error.log
CustomLog ${APACHE_LOG_DIR}/qgis.demo.access.log combined

# Longer timeout for WPS... default = 40
FcgidIOTimeout 120

FcgidInitialEnv LC_ALL "en_US.UTF-8"
FcgidInitialEnv PYTHONIOENCODING UTF-8
FcgidInitialEnv LANG "en_US.UTF-8"

# QGIS log (different from apache logs) see http://docs.qgis.org/testing/en/docs/user_manual/working_with_ogc/ogc_server_support.html#qgis-server-logging
FcgidInitialEnv QGIS_SERVER_LOG_FILE /var/log/qgis/qgisserver.log
FcgidInitialEnv QGIS_SERVER_LOG_LEVEL 0

FcgidInitialEnv QGIS_DEBUG 1

# default QGIS project
SetEnv QGIS_PROJECT_FILE /home/qgis/projects/world.qgs
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# QGIS_AUTH_DB_DIR_PATH must lead to a directory writeable by the Server’s FCGI process user
FcgidInitialEnv QGIS_AUTH_DB_DIR_PATH "/home/qgis/qgisserverdb/"
FcgidInitialEnv QGIS_AUTH_PASSWORD_FILE "/home/qgis/qgisserverdb/qgis-auth.db"

# See http://docs.qgis.org/testing/en/docs/user_manual/working_with_vector/supported_data.html#pg-service-file
SetEnv PGSERVICEFILE /home/qgis/.pg_service.conf
FcgidInitialEnv PGPASSFILE "/home/qgis/.pgpass"

# Tell QGIS Server instances to use a specific display number
FcgidInitialEnv DISPLAY ":99"

# if qgis-server is installed from packages in debian based distros this is usually /usr/lib/cgi-bin/
# run "locate qgis_mapserv.fcgi" if you don’t know where qgis_mapserv.fcgi is
ScriptAlias /cgi-bin/ /usr/lib/cgi-bin/
<Directory "/usr/lib/cgi-bin/">
AllowOverride None
Options +ExecCGI -MultiViews -SymLinksIfOwnerMatch
Order allow,deny
Allow from all
Require all granted

</Directory>

<IfModule mod_fcgid.c>
FcgidMaxRequestLen 26214400
FcgidConnectTimeout 60
</IfModule>

</VirtualHost>

You can do the above in a linux Desktop system by pasting and saving the above configuration after doing sudo
nano /etc/apache2/sites-available/qgis.demo.conf.

Note: See some of the configuration options are explained in the Server server_env_variables section.

Let’s now create the directories that will store the QGIS Server logs and the authentication database:

sudo mkdir /var/log/qgis/
sudo chown www-data:www-data /var/log/qgis

mkdir /home/qgis/qgisserverdb
sudo chown www-data:www-data /home/qgis/qgisserverdb

Note: www-data is the Apache user on Debian based systems and we need Apache to have access to those
locations or files. The chown www-data... commands changes the owner of the respective directories and
files to www-data.

We can now enable the virtual host, enable the fcgid mod if it’s not already enabled and restart the apache2
service:

sudo a2enmod fcgid
sudo a2ensite qgis.demo
sudo service apache2 restart

Note: If you installed QGIS Server without running an X Server (included in Linux Desktop) and if you also
want to use the GetPrint command then you should install a fake X Server and tell QGIS Server to use it. You
can do that by running the following commands.

Install xvfb:
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sudo apt-get install xvfb

Créer le fichier de service:

sudo sh -c \
"echo \
’[Unit]
Description=X Virtual Frame Buffer Service
After=network.target

[Service]
ExecStart=/usr/bin/Xvfb :99 -screen 0 1024x768x24 -ac +extension GLX +render -noreset

[Install]
WantedBy=multi-user.target’ \
> /etc/systemd/system/xvfb.service"

Enable, start and check the status of the xvfb.service:

sudo systemctl enable xvfb.service
sudo systemctl start xvfb.service
sudo systemctl status xvfb.service

In the above configuration file there’s a FcgidInitialEnv DISPLAY ":99" that tells QGIS Server in-
stances to use display no. 99. If you’re running the Server in Desktop then there’s no need to install xvfb and you
should simply comment with # this specific setting in the configuration file. More info at http://www.itopen.it/qgis-
server-setup-notes/.

Now that Apache knows that he should answer requests to http://qgis.demo we also need to setup the client system
so that it knows who qgis.demo is. We do that by adding 127.0.0.1 qgis.demo in the hosts file. We can
do it with sudo sh -c "echo ’127.0.0.1 qgis.demo’ >> /etc/hosts". Replace 127.0.0.1
with the IP of your server.

Note: Remember that both the myhost.conf and /etc/hosts files should be configured for our setup to
work. You can also test the access to your QGIS Server from other clients on the network (e.g. Windows or Macos
machines) by going to their /etc/hosts file and point the myhost name to whatever IP the server machine
has on the network. You can be sure that that specific IP is not 127.0.0.1 as that’s the local IP, only accessible
from the local machine. On *nix machines the hosts file is located in /etc, while on Windows it’s under the
C:\Windows\System32\drivers\etc directory. Under Windows you need to start your text editor with
administrator privileges before opening the hosts file.

We can test one of the installed qgis servers with a http request from command line with curl
http://qgis.demo/cgi-bin/qgis_mapserv.fcgi which should output:

<ServiceExceptionReport version="1.3.0" xmlns="http://www.opengis.net/ogc">
<ServiceException code="Service configuration error">Service unknown or unsupported</ServiceException>
</ServiceExceptionReport>

Note: curl can be installed with sudo apt-get install curl.

Apache is now configured.

12.1.4 Follow Along: Create another virtual host

Let’s create another Apache virtual host pointing to QGIS Server. You can choose whatever name you like
(coco.bango, super.duper.training, example.com, etc.) but for simplicity sake we’re going to
use myhost.
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• Let’s set up the myhost name to point to the localhost IP by adding 127.0.0.1 x to the /etc/hosts
with the following command: sudo sh -c "echo ’127.0.0.1 myhost’ >> /etc/hosts"
or by manually editing the file with sudo gedit /etc/hosts.

• We can check that myhost points to the localhost by running in the terminal the ping myhost command
which should output:

qgis@qgis:~$ ping myhost
PING myhost (127.0.0.1) 56(84) bytes of data.
64 bytes from localhost (127.0.0.1): icmp_seq=1 ttl=64 time=0.024 ms
64 bytes from localhost (127.0.0.1): icmp_seq=2 ttl=64 time=0.029 ms
..

• Let’s try if we can access QGIS Server from the myhost site by doing: curl
http://myhost/cgi-bin/qgis_mapserv.fcgi or by accessing the url from your Debian
box browser. You will probably get:

<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>
<h1>Not Found</h1>
<p>The requested URL /cgi-bin/qgis_mapserv.fcgi was not found on this server.</p>
<hr>
<address>Apache/2.4.25 (Debian) Server at myhost Port 80</address>
</body></html>

• Apache doesn’t know that he’s supposed to answer requests pointing to the server named myhost.
In order to setup the virtual host the simplest way would be to make a myhost.conf file in the
/etc/apache/sites-available directory that has the same content as file:qgis.demo.conf except
for the ServerName line that should be ServerName myhost. You could also change where the logs
go as otherwise the logs for the two virtual hosts would be shared but this is optional.

• Let’s now enable the virtual host with sudo apt-get a2ensite myhost.conf and then reload the
Apache service with sudo systemctl reload apache2.

• If you try again to access the http://myhost/cgi-bin/qgis_mapserv.fcgi url you’ll notice everything is working
now!

12.1.5 In Conclusion

You learned how to install different QGIS Server versions from packages, how to configure Apache with QGIS
Server, on Debian based Linux distros.

12.1.6 What’s Next?

Now that you’ve installed QGIS Server and it’s accesible through the HTTP protocol, we need to learn how to
access some of the services it can offer. The topic of the next lesson is to learn how to access QGIS Server WMS
services.

12.2 Lesson: Serving WMS

Let’s download the demo data and unzip the files in the qgis-server-tutorial-data subdirectory to any
directory. We recommend that you simply create a /home/qgis/projects directory and put your files there
in order to avoid possible permissions problems.

The demo data contains a QGIS project named world.qgs that is already prepared to be served with QGIS
Server. If you want to use your own project or you want to learn how a project is prepared see the Creatingwms-
fromproject section.
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Note: This module presents the URLs so that the audience can easily distinguish the parameters and parameters
values. While the normal format is:

...&field1=value1&field2=value2&field3=value3

this tutorial uses:

&field1=value1
&field2=value2
&field3=value3

Pasting them into Mozilla Firefox works properly but other web browsers like Chrome may add unwanted spaces
between the field:parameter pairs. So, if you encounter this issue you can either use Firefox or modify the
URLs so that they’re in one line format.

Let’s make a WMS GetCapabilities request in the web browser or with curl:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs

In the Apache config from the previous lesson the QGIS_PROJECT_FILE variable sets the default project to
/home/qgis/projects/world.qgs. However, in the above request we made use of the map parameter to
be explicit and to show it can be used to point at any project. If you delete the map parameter from the above
request QGIS Server will output the same response.

By pointing any WMS client to the GetCapabilities URL, the client gets in response an XML document
with metadata of the Web Map Server’s information, e.g. what layers does it serve, the geographical coverage, in
what format, what version of WMS etc.

As QGIS is also a ogc-wms you can create a new WMS server connection with the help of the above GetCapabil-
ities url. See the Lesson: Web Mapping Services or the ogc-wms-servers section on how to do it.

By adding the countries WMS layer to your QGIS project you should get an image like the one below:

Note: QGIS Server serves layers that are defined in the world.qgs project. By opening the project with QGIS
you can see there are multiple styles for the countries layer. QGIS Server is also aware of this and you can choose
the style you want in your request. The classified_by_population style was chosen in the above image.

12.2.1 Logging

When you’re setting up a server, the logs are always important as they show you what’s going on. We have setup
in the *.conf file the following logs:

• QGIS Server log at /logs/qgisserver.log

• qgisplatform.demo Apache access log at qgisplatform.demo.access.log

• qgisplatform.demo Apache error log at qgisplatform.demo.error.log

The log files are simply text files so you can use a text editor to check them out. You can also use the tail
command in a terminal: sudo tail -f /logs/qgisserver.log.

This will continuously output in the terminal what’s written in that log file. You can also have three terminals
opened for each of the log files like so:

When you use QGIS Desktop to consume the QGIS Server WMS services you will see all the requests QGIS
sends to the Server in the access log, the errors of QGIS Server in the QGIS Server log etc.

Note:
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Figure 12.1: QGIS Desktop consuming the QGIS Server countries layer WMS service
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Figure 12.2: Using the tail command to visualise QGIS Server logs output
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• If you look at the logs in the following sections you should get a better understanding on what’s happening.

• By restarting Apache while looking in the QGIS Server log you can find some extra pointers on how things
work.

12.2.2 GetMap requests

In order to display the countries layer, QGIS Desktop, like any other WMS client, is using GetMap requests.

Une simple requête ressemble à:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries
&FORMAT=image/jpg

Avec la requête précédente, vous obtiendrez le résultat suivant :

Figure: simple GetMap request to QGIS Server

12.2.3 Try Yourself Change the Image and Layers parameters

Based on the request above, let’s replace the countries layer with another.

In order to see what other layers are available you could open up the world.qgs project in QGIS and look at its
contents. Keep in mind though that the WMS clients don’t have access to the QGIS project, they just look at the
capabilities document contents.

Also, there’s a configuration option so that some of the layers existing in the QGIS project are ignored by QGIS
when serving the WMS service.

So, you could look at the layer list when you point QGIS Desktop to the GetCapabilities URL or you could
try yourself finding other layer names in the GetCapabilities XML response.

One of the layer names that you could find and works is countries_shapeburst. You may find others but
keep in mind some may not be visible at such a small scale so you could get a blank image as response.

You can also play around with others parameters from above, like changing the returned image type to
image/png.

12.2.4 Follow Along: Use Filter, Opacities and Filter parameters

Let’s do another request that adds another layer, some of the extra-getmap-parameters, FILTER and OPACI-
TIES, but also uses the standard STYLES parameter.

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
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Figure 12.3: Qgis Server response after a simple GetMap request
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&WIDTH=665
&HEIGHT=551
&FORMAT=image/jpg
&LAYERS=countries,countries_shapeburst
&STYLES=classified_by_name,default
&OPACITIES=255,30
&FILTER=countries:"name" IN ( ’Germany’ , ’Italy’ )

Avec la requête précédente, vous obtiendrez le résultat suivant :

Figure 12.4: Response to a GetMap request with FILTER and OPACITIES parameters

As you can see from the above image, among other things, we told QGIS Server to render only Germany and
Italy from the countries layer.

12.2.5 Follow Along: Use Redlining

Let’s do another GetMap request that makes use of the qgisserver-redlining feature and of the SELECTION
parameter detailed in the extra-getmap-parameters section:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
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&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries,countries_shapeburst
&FORMAT=image/jpg
&HIGHLIGHT_GEOM=POLYGON((590000 6900000, 590000 7363000, 2500000 7363000, 2500000 6900000, 590000 6900000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name><FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter name="stroke">%233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=QGIS Tutorial
&HIGHLIGHT_LABELSIZE=30
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=3
&SELECTION=countries:171,6

Pasting the above request in your web browser should output the following image:

Figure 12.5: Response to a request with the REDLINING feature and SELECTION parameter

You can see from the above image that the countries with the 171 and 65 ids were highlighted in yellow (Romania
and France) by using the SELECTION parameter and we used the REDLINING feature to overlay a rectangle
with the QGIS Tutorial label.
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12.2.6 GetPrint requests

One very nice feature of QGIS Server is that it makes use of the QGIS Desktop print composers. You can learn
about it in the server_getprint section.

If you open the world.qgs project with QGIS Desktop you will find a print composer named Population
distribution. A simplified GetPrint request that exemplifies this amazing feature is:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?map=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0&
REQUEST=GetPrint
&FORMAT=pdf
&TRANSPARENT=true
&SRS=EPSG:3857
&DPI=300
&TEMPLATE=Population distribution
&map0:extent=-432786,4372992,3358959,7513746
&LAYERS=countries

Figure 12.6: Shows the pdf resulted from the above GetPrint request

Naturally, it’s hard to write your GetMap, GetPrint etc. requests.

QGIS Web Client or QWC is a Web client project that can work alongside QGIS Server so that you can publish
your projects on the Web or help you create QGIS Server requests for a better understanding about the possibilities.

You can install it like this:

• As user qgis go to the home directory with cd /home/qgis.

• Download the QWC project from here and unzip it.
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• Make a symbolic link to the /var/www/html directory as it’s the DocumentRoot
that we’ve setup in the virtual host configuration. If you unzipped the archive under
/home/qgis/Downloads/QGIS-Web-Client-master we can do that with sudo ln -s
/home/qgis/Downloads/QGIS-Web-Client-master /var/www/html/.

• Access http://qgisplatform.demo/QGIS-Web-Client-master/site/qgiswebclient.html?map=/home/qgis/projects/world.qgs
from your Web browser.

Now you should be able to see the Map as in the following figure:

Figure 12.7: QGIS Web Client consuming the world.qgs project

If you click the Print button in QWC you can interactively create GetPrint requests. You can also click the ?
icon in the QWC to access the available help so that you can better discover the QWC possibilities.

12.2.7 In Conclusion

You learned how use QGIS Server to provide WMS Services.
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12.2.8 What’s Next?

Next, you’ll see how to use QGIS as a frontend for the famous GRASS GIS.
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CHAPTER 13

Module: GRASS

GRASS (Geographic Resources Analysis Support System) est un logiciel libre de SIG bien connu qui dispose
d’une large gamme de fonctions SIG. Il a été publié pour la première fois en 1984 et il a subit de nombreuses
améliorations au fil du temps. QGIS vous permet d’utiliser les performants outils SIG de GRASS directement.

13.1 Lesson: Configuration de GRASS

Utiliser GRASS dans QGIS nécessite de voir l’interface légèrement différemment. Souvenez-vous que vous ne
travaillez pas directement dans QGIS, mais dans GRASS via QGIS.

Le but de cette leçon : commencer un projet GRASS dans QGIS.

13.1.1 Follow Along: Démarrer un nouveau projet GRASS

Pour lancer GRASS depuis QGIS, vous avez besoin de l’activer comme pour n’importe quelle autre extension.
Premièrement, ouvrez un nouveau projet QGIS.

• Dans le Gestionnaire d’extension, activez GRASS dans la liste :
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La barre d’outils de GRASS fera son apparition :

Avant d’utiliser GRASS, vous avez besoin de créer un jeu de donnée. GRASS travaille constamment avec un
environnement de base des données, ce qui signifie que vous avez besoin d’importer toutes les données que vous
souhaitez utiliser dans une base de données GRASS.

• Cliquez sur le bouton Nouveau jeu de donnée :

Vous verrez une fenêtre expliquant la structure d’un jeu de donnée GRASS.

• Créez un nouveau dossier nommé grass_db dans exercise_data.

• Définissez le dossier qui sera utilisé par GRASS pour y placer sa base de donnée :
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• Cliquez sur Suivant

GRASS a besoin d’une “localisation”, qui définira l’étendue géographique maximale sur laquelle vous allez tra-
vailler.

• Nommez la nouvelle localisation Afrique_du_Sud :
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• Cliquez sur Suivant

• Nous allons travailler avec le SCR WGS 84, sélectionnez-le donc :
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• Cliquez sur Suivant

• Maintenant, sélectionnez la région Afrique du Sud depuis la liste déroulante et cliquez sur Définir :
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• Cliquez sur Suivant

• Créez un jeu de donnée, qui est le fichier sur lequel vous allez travailler.
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Une fois cela fait, une boite de dialogue vous demandera de confirmer que les paramètres sont corrects.

• Cliquez sur Terminer.

• Cliquez sur OK dans la fenêtre de succès.

13.1.2 Follow Along: Chargement des données vecteur dans GRASS

Vous devriez désormais avoir une carte vide. Pour charger les données dans GRASS, vous allez avoir besoin de
suivre deux étapes.

• Charger les données dans QGIS comme d’habitude. Utilisez pour l’instant le jeu de donnée roads.shp
(que vous trouverez dans exercise_data/epsg/4326/).

• Une fois chargées, cliquez sur le bouton :guilabel:‘ Outils GRASS‘ :
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• Dans la nouvelle boite de dialogue, sélectionnez Liste des modules.

• Cherchez l’outil d’import de vecteur en saisissant le terme v.in.ogr.qgis dans le champ filtre.

Le v signifie “vecteur”, in est une fonction pour importer les données dans la base de GRASS, ogr est la librairie
utilisée pour lire les données vectorielles, et qgis signifie que l’outil va chercher un vecteur parmi les vecteurs
déjà chargés dans QGIS.

• Une fois l’outil trouvé, cliquez dessus pour l’utiliser :

• Nommez la couche chargée auparavant :guilabel:roads‘ et la version de GRASS g_roads pour éviter les
erreurs.

308 Chapter 13. Module: GRASS



QGIS Training Manual, Version 2.18

Note: Notez les options supplémentaires d’import fournies dans Options avancées. Cela inclut la possi-
bilité d’ajouter une clause WHERE pour la requête SQL utilisée lors de l’import de donnée.

• Cliquez sur Exécuter pour commencer l’import.

• Une fois fait, cliquez sur le bouton Voir le résultat pour voir la nouvelle couche GRASS importée dans la
carte.

• Fermez d’abord l’outil d’import (cliquez sur le bouton Fermer juste à droite de Voir le résultat), puis fermez
la fenêtre Outils GRASS.

• Enlevez la couche originel roads.

Vous ne disposez désormais plus que de la couche GRASS affichée dans la carte QGIS.

13.1.3 Follow Along: Chargement des données Raster dans GRASS

N’oubliez pas que notre MNE est dans le SCR Projeté UTM 33S / WGS 84, alors que notre projet GRASS est
dans le SCR Géographique WGS 84. Donc reprojetons d’abord notre MNE.

• Chargez le srtm_41_19.tif jeu de donnée (trouvé dans exercise_data/raster/SRTM/) dans
QGIS comme d’habitude, en utilisant l’outil QGIS Ajouter une couche raster.
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• Re-projetez le avec l’outil GDAL Warp (Raster → Projections → Déformation (Reprojeter)), défini comme
tel :

• Sauvegardez le raster dans le même dossier que l’original, mais avec le nom MNE_WGS84.tif. Une fois
qu’il apparaît sur votre carte, supprimez le jeu de donné srtm_41_19.tif de votre liste de couches.

Maintenant qu’il est reprojeté, vous pouvez l’ajouter dans votre base de données GRASS.

310 Chapter 13. Module: GRASS



QGIS Training Manual, Version 2.18

• Ouvrez à nouveau les Outils GRASS.

• Cliquez sur l’onglet Liste des modules.

• Cherchez r.in.gdal.qgis et double-cliquez dessus pour ouvrir ses propriétés.

• Paramétrez-le pour que la couche d’entrée soit MNE_WGS84 et que celle de sortie soit g_dem.

• Cliquez sur Exécuter.

• Une fois l’opération réussie, cliquez sur Voir le résultat.

• Vous pouvez Fermer l’onglet actuel puis cliquez dans la boîte de dialogue suivante sur Fermer.
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• Vous pouvez maintenant enlever la couche MNE_WGS84.

13.1.4 In Conclusion

La méthode de travail de GRASS pour la gestion des données est quelque peu différente de celle de QGIS car
GRASS les charge dans une base de donnée à structure spatiale. Toutefois, en utilisant QGIS comme interface,
vous pouvez rendre plus facile la création d’un jeu de donnée GRASS grâce aux couches QGIS comme sources
de données pour GRASS.

13.1.5 What’s Next?

Maintenant que les données sont importées dans GRASS, nous pouvons nous intéresser aux opérations d’analyses
plus évoluées que nous permet GRASS.

13.2 Lesson: Outils GRASS

Dans cette leçon, nous vous présenterons une sélection d’outils afin de vous donner une idée des potentialités de
GRASS.

13.2.1 Follow Along: Paramétrer les couleurs des rasters

• Ouvrez la fenêtre Outils GRASS.

• Cherchez le module r.colors.table dans le champ Filtre de l’onglet Liste des Modules.

• Ouvrez l’outil et paramétrez-le de la manière suivante:
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Quand vous lancez cet outil, il va recolorer le raster :
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13.2.2 Follow Along: Visualiser des données en 3D

GRASS vous permet d’utiliser un MEN pour visualiser vos données en trois dimensions. L’outil que vous allez
utiliser travaillera sur la Région GRASS qui, pour le moment, est paramétrée sur l’emprise totale de l’Afrique du
Sud comme configuré précédemment.

• Pour redéfinir l’emprise de manière à ne couvrir que les données du raster, cliquez sur ce bouton:

Lorsque cet outil est activé, votre curseur se transformera en croix lorsque vous survolerez le canevas de carte
QGIS.

• A l’aide de cet outil, dessinez un rectangle autour des limites du raster GRASS.

• Lorsque vous avez terminé, cliquez sur OK dans la boîte de dialogue Paramètres de la Région GRASS.

• Cherchez l’outil nviz:
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• Configurez-le comme ce qui est montré :
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• Souvenez-vous d’activer les boutons Utiliser la région de cette carte à la droite des menus déroulants des
deux rasters. Cela permettra à NVIZ de configurer correctement la résolution des rasters.

• Cliquer sur le bouton Run.

NVIZ créera un environnement 3D en utilisant le raster et le vecteur utilisés. Cette opération peut prendre du
temps, en fonction de la puissance de votre machine. Lorsque les calculs sont terminés, vous pouvez visualiser la
carte rendue en 3D dans une nouvelle fenêtre:
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Jouez avec les paramètres hauteur, z-exag, et Méthode de visualisation pour modifier la représentation des don-
nées. Les méthodes de navigation demandent un peu de manipulations pour pouvoir être maîtrisées.

Après avoir expérimenté, fermez la fenêtre NVIZ.

13.2.3 Follow Along: Outil Mapcalc

• Ouvrez l’onglet Liste des Modules de la boîte de dialogue Outils GRASS et cherchez calc.

• Depuis la liste des modules, sélectionnez r.mapcalc (et non r.mapcalculator qui est plus basique).

• Lancez l’outil.

La boîte de dialogue Mapcalc vous permet de construire une séquence d’analyses à effectuer sur un raster ou une
collection de rasters. Vous pouvez utiliser ces outils pour y parvenir:

Dans l’ordre:

• Ajouter une carte: Ajouter un fichier raster depuis votre jeu de données GRASS.

• Ajouter une valeur constante: Ajouter une valeur constante à utiliser dans les fonctions.

• Ajouter un opérateur ou une fonction: Ajoute un opérateur ou une fonction à connecter aux
entrées et aux sorties.

• Ajouter une connexion: Connecte les éléments. En utilisant cet outil, glissez-déposez depuis le
point rouge d’un objet vers le point rouge d’un autre. Les points qui sont correctement connectés à une ligne
de connexion deviendront gris. Si la ligne ou le point est rouge, il/elle n’est pas correctement connecté(e).

• Selectionner élément: Sélectionner un objet et déplacer les objets sélectionnés.
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• Supprimer l’objet sélectionné: Supprime l’objet sélectionné depuis la feuille mapcalc mais
pas depuis le jeu de données (s’il s’agit d’un raster existant).

En utilisant ces outils:

• Construisez l’algorithme suivant:

• Lorsque vous cliquez sur Lancer, votre sortie devrait ressembler à ce qui suit:
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• Cliquez sur Visualiser la sortie pour afficher la sortie dans votre carte:

Elle montre les surfaces où le terrain est inférieur à 500 mètres ou supérieur à 1000 mètres.
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13.2.4 In Conclusion

Dans cette leçon, nous avons abordé seulement quelques-uns des outils que GRASS propose. Pour explorer les
fonctionnalités de GRASS par vous-même, ouvrez la boîte de dialogue Outils GRASS et déroulez la Liste des
Modules. Pour une approche plus structurée, consultez l’onglet Arbre des Modules qui organise les outils par
type.
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Module: Évaluation

Utilisez vos propres données dans cette section. Vous aurez besoin de:

• un jeu de données vectorielles de points représentant des points d’intérêt, avec le nom des points et des
catégories multiples

• un jeu de données vectorielles de lignes représentant des routes

• un jeu de données vectorielles de polygones représentant l’utilisation du sol (utilisant les propriétés de
contour)

• une image de spectre visuel (une photographie aérienne par exemple)

• un MNT (téléchargeable depuis ce lien si vous n’en avez pas)

14.1 Créer une carte de base

Avant de faire une analyse de données, vous aurez besoin d’une carte de base, qui fournira le résultat de votre
analyse du contexte.

14.1.1 Ajout de la couche de points

• Ajoutez la couche de points. Selon le niveau de cours que vous avez suivi, faites seulement ce qui est listé
dans la section appropriée ci-dessous :

• Étiquetez les points selon un attribut unique, comme les noms de lieux par exemple. Utilisez une petite
police et gardez des étiquettes discrètes. L’information doit être disponible, mais ne doit pas être une entité
principale de la carte.

• Classez les points entre eux avec différentes couleurs basées sur une catégorie. Par exemple, des catégories
peuvent représenter “destination touristique”, “poste de police”, et “centre-ville”.

• Faites la même chose que dans la section .

• Classez la taille des points par importance : plus une entité est importante, plus son point sera grand.
Cependant, ne dépassez pas une taille de point de 2.00.
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• Pour les entités qui ne sont pas localisées en un point unique (par exemple, les noms des provinces/régions,
ou les noms des villes à grande échelle), ne leur affectez aucun point du tout.

• N’utilisez pas les symboles en point pour symboliser la couche. À la place, utilisez les étiquettes centrées
sur les points ; les symboles en point ne doivent avoir aucune taille.

• Utilisez la :guilabel:Source de définition des paramètres‘ pour styliser les étiquettes en des catégories signi-
ficatives.

• Ajoutez des colonnes appropriées aux données attributaires si nécessaire. Quand vous faites cela, ne créez
pas de données fictives - utilisez plutôt la Calculatrice de champ pour remplir les nouvelles colonnes, qui
se base sur des valeurs existantes appropriées du jeu de données.

14.1.2 Ajout de la couche de lignes

• Ajoutez la couche des routes et ensuite changez sa symbologie. N’étiquetez pas les routes.

• Changez la symbologie des routes pour obtenir une couleur claire avec une large ligne. Ajoutez un peu de
transparence à cela.

• Créez un symbole avec plusieurs couches de symbole. Le symbole final devrait ressemble à une véritable
route. Vous pouvez utiliser un symbole simple pour cela ; par exemple, une ligne noire avec une fine ligne
continue blanche qui passe en son centre. Il peut être élaboré ainsi, mais la carte finale ne doit pas paraître
trop chargée.

• Si votre jeu de données a une grande densité de routes à l’échelle à laquelle vous voulez montrer la carte,
vous pouvez avoir deux couches de routes : celle avec le symbole ressemblant à une route, et celle avec
un symbole plus simple pour une échelle plus petite. (Utilisez la visibilité selon l’échelle pour faire le
changement entre les deux couches aux échelles appropriées.)

• Tous les symboles devraient avoir des couches multiples de symbole. Utilisez des symboles pour les afficher
correctement.

• Faites la même chose que dans la section d’en haut.

• En outre, les routes doivent être classées. En utilisant les symboles ressemblant à une route, chaque type de
route devrait avoir son propre symbole ; par exemple, une autoroute devrait apparaître avec deux voies dans
chaque direction.

14.1.3 Ajout de la couche de polygones

• Ajoutez la couche de l’utilisation du sol et changez sa symbologie.
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• Classez la couche selon l’utilisation du sol. Utilisez des couleurs continues.

• Classez la couche selon l’utilisation du sol. Où c’est approprié, incorporez des couches de symbole, dif-
férents types de symbole, etc. Gardez cependant des résultats qui semblent modérés et uniformes. Gardez
en tête que cela fera partie d’une toile de fond !

• Utilisez une classification basée sur un ensemble de règles pour classer l’utilisation du sol en catégories
générales, telles que “urbain”, “rural”, “réserve naturelle”, etc.

14.1.4 Création de la toile de fond raster

• Créez un ombrage à partir du MNE, et utilisez-le comme un revêtement pour une version classifiée du MNE
lui-même. Vous pourriez aussi utiliser l’extension Relief (comme montré dans la leçon sur les extensions).

14.1.5 Finalisation de la carte de base

• En utilisant les ressources ci-dessous, créez une carte de base en utilisant quelques unes ou toutes les
couches. Cette carte devrait inclure toutes les informations de base nécessaire pour orienter l’utilisateur,
ainsi qu’être visuellement unifiée / “simple”.

14.2 Analyse de données

• Vous recherchez une propriété qui satisfasse certains critères.

• Vous pouvez décider de vos propres critères, que vous devez documenter.

• Il y a des lignes directrices pour ces critères :

– la propriété-cible doit être d’un certain(s) type(s) d’utilisation du sol

– elle doit être à une distance donnée des routes, ou croiser une route

– elle doit être à une distance donnée des différentes catégories de points, comme un hôpital par exemple.

14.2.1 /

• Ajouter une analyse raster à vos résultats. Considérez au moins une propriété dérivée du rater, comme son
aspect ou sa pente.
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14.3 Carte finale

• Utilisez le Composeur de carte pour créer une carte finale, qui inclue vos résultats d’analyse.

• Insérez cette carte dans un document avec vos critères documentés. Si la carte est devenue visuellement
trop chargée en raison de la(des) couche(s) ajoutée(s), désélectionnez les couches que vous jugez le moins
nécessaire.

• Votre carte doit inclure un titre et une légende.
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CHAPTER 15

Module: Application forestière

Dans les modules 1 à 13, vous avez déjà appris beaucoup à propos de QGIS et comment travailler avec. Si vous
êtes intéressé à en apprendre sur certaines applications forestières de base des SIG, suivre ce module vous donnera
la possibilité d’appliquer ce que vous avez appris et vous montrera quelques nouveaux outils utiles.

Le développement de ce module a été sponsorisé par l’Union Européenne.

15.1 Lesson: Présentation du module forestier

Suivre ce module sur une application forestière requière la connaissance que vous avez acquise à travers les
modules 1 à 11 de ce manuel d’entraînement. Les exercices dans les leçons suivantes supposent que vous êtes déjà
capable de faire beaucoup d’opérations basiques dans QGIS et seuls les outils qui n’ont pas été utilisés avant sont
présentés en détail.

Néanmoins, le module suit un niveau basique tout au long des leçons de telle sorte que si vous avez une expérience
précédente avec QGIS, vous pouvez probablement suivre les instructions sans problèmes.

Notez que vous avez besoin de télécharger un paquet de données supplémentaire pour ce module.

15.1.1 Échantillon de données forestières

Note: Les données d’exemple utilisées dans ce module font parties du jeu de données du manuel d’exercices
et peuvent être téléchargées ici. Téléchargez le fichier zip et décompressez le dossier forestry\ dans votre
dossier exercise_data\.

Les données forestières ont été fournies par l’école forestière EVO-HAMK. Les jeux de données ont été modifiés
pour s’adapter aux besoins de la leçon.

Les données générales (images aériennes, données LiDAR, cartes basiques) ont été fournies par le service open
data du National Land Survey of Finland et adaptées aux besoins des exercices. Le fichier de données ouvertes
peut être téléchargé en anglais ici.

Warning: Comme pour le reste de ce manuel d’exercices, ce cours comprend des instructions sur l’ajout,
la suppression et la modification des jeux de données SIG. Nous avons fourni des ensembles de données de
formation à cet effet. Avant d’utiliser les techniques décrites ici sur vos propres données, assurez vous toujours
de disposer des sauvegardes appropriées !
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15.2 Lesson: Géoréférencer une carte

Une tâche usuelle en forêt est la mise à jour des informations pour une zone forestière. Il est possible que les
informations précédentes pour cette zone datent de plusieurs années et ont été collectées en analogique (c’est à
dire sur papier) ou peut-être qu’elles ont été digitalisées mais que vous avez seulement une version papier de ces
données d’inventaire.

Il est probable que vous souhaitiez utiliser cette information dans votre SIG pour, par exemple, comparer les
nouveaux inventaires avec des anciens. Cela signifie que vous allez avoir besoin de numériser l’information
obtenue manuellement en utilisant votre logiciel de SIG. Mais dans un premier temps, vous allez devoir scanner
et géo-référencer votre carte papier.

Objectif de cette leçon : Apprendre à utiliser l’outil Géoréférencer dans QGIS.

15.2.1 Scanner la carte

La première tâche que vous devrez faire est de scanner votre carte. Si votre carte est trop grande, alors vous
pouvez la scanner en différentes parties mais gardez en tête que vous devrez répéter les tâches de prétraitement et
de géoréférencement pour chaque partie. Donc si cela est possible, scannez la carte en le moins de parties possible.

Si vous utilisez une carte différente de celle fournie avec ce manuel, scannez donc la carte en tant que fichier
image, avec une résolution de 300 DPI. Si votre carte est en couleur, scannez l’image en couleur pour que vous
puissiez plus tard utiliser ces couleurs pour séparer les informations de votre carte dans différentes couches (par
ex, massifs forestiers, lignes de contour, routes...).

Pour cet exercice, vous utiliserez une carte précédemment scannée. Il est disponible sous le nom de
rautjarvi_map.tif dans le dossier de données exercise_data/forestry.

15.2.2 Follow Along: Géoréférencer la carte scannée

Ouvrez QGIS et configurez le SCR du projet comme kbd:ETRS89 / ETRS-TM35FIN dans Project → Propriétés
du projet → SCR, qui est le SCR couramment utilisé en Finlande. Assurez-vous que l’option Activer la projection
‘à la volée’ est cochée, puisque nous travaillerons avec des anciennes données qui ont un autre SCR.
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Sauvegardez le projet QGIS sous map_digitizing.qgs.

Vous utiliserez l’extension géoréférencement de QGIS. L’extension est déjà installée dans QGIS. Activez
l’extension en utilisant le gestionnaire d’extensions comme vous l’avez fait dans des modules précédents.
L’extension est appelée Géoréférenceur GDAL.

Pour géoréférencer la carte :

• Ouvrez l’outil de géoréférence, Raster → Géoréférencer → Géoréférencer.

• Ajoutez le fichier image rautjarvi_map.tif comme image à géo-référencer via Fichier → Ouvrir
raster.

• Quand demandé, trouvez et sélectionnez le SCR KKJ / Finland zone 2, c’est le SCR qui a été utilisé
en Finlande en 1994 lorsque cette carte a été créée.

• Cliquez sur OK.

Ensuite, vous devez définir les paramètres de transformation pour le géoréférencement de la carte :

• Ouvrez Paramètres → Paramètres de transformation.

• Cliquez sur l’icône à côté de la boîte Raster de sortie, allez dans le dossier et créez le dossier
exercise_data\forestry\digitizing et nommez le fichier rautjarvi_georef.tif.

• Mettez le reste des paramètres comme montré ci-dessous.
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• Cliquez sur OK.

La carte contient plusieurs croix marquant les coordonnées dans la carte, nous les utiliserons pour géoréférencer
cette carte. Vous pouvez utiliser les outils de zoom et de déplacement comme vous le faites habituellement dans
QGIS pour inspecter l’image dans la fenêtre du Georeferencer.

• Zommez sur le coin inférieur gauche de la carte et notez qu’il y a une croix avec une paire de coordonnées, x
et y, qui sont, comme mentionné auparavant, dans le SCR KKJ / Finland zone 2. Vous allez utiliser
ce point comme premier point de contrôle terrain pour référencer votre carte.

• Sélectionnez l’outil Ajouter un point et cliquez sur l’intersection de la croix (déplacez-vous et zoomez au
besoin).

• Dans la boîte de dialogue Enter les coordonnées de la carte écrivez les coordonnées qui apparaissent dans
la carte (X: 2557000 et Y: 6786000).

• Cliquez sur OK.

La première coordonnée pour le géoréférencement est maintenant prête.
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Recherchez d’autres réticules dans l’image faite de lignes noires, ils sont séparés de 1000 mètres dans les deux
directions Nord et Est. Vous devriez être capable de calculer les coordonnées de ces points par comparaison au
premier.

Dézoomez l’image et bougez sur la droite jusqu’à ce que vous trouviez une autre croix, et estimez de combien de
kilomètres vous avez bougé. Essayez d’obtenir des points de contrôle aussi loin que possible les uns des autres.
Numérisez au moins trois points de contrôle supplémentaires de la même manière que vous avez fait pour le
premier. Vous devriez arriver à quelque chose comme ceci :

Dès que vous aurez trois points de contrôle, vous allez pouvoir évaluer l’erreur de géo-référencement sous la
forme d’une ligne rouge à l’extérieur des points. Les pixels d’erreur sont visibles aussi dans la Table des points
de contrôle dans les colonnes dX[pixels] et dY[pixels]. L’erreur en pixel ne doit pas être supérieure à 10 pixels,
si c’est le cas vous devez vérifier les coordonnées que vous avez saisies pour trouver le problème. Vous pouvez
utiliser l’image ci-dessus comme un guide.

Une fois que vous êtes satisfait de vos points de contrôle, sauvegardez vos points de contrôle, au cas où vous en
auriez besoin plus tard, et vous pourrez :
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• Fichier → Enregistrer les points de contrôle sous....

• Dans le répertoire exercise_data\forestry\digitizing, nommez le fichier
rautjarvi_map.tif.points.

Enfin, géoréférencez votre carte :

• Fichier → Commencer le géoréférencement.

• Notez que vous avez déjà nommé le fichier rautjarvi_georef.tif quand vous avez configuré les
paramètres du Géoréférenceur.

Vous pouvez maintenant voir la carte dans le projet QGIS comme un raster géoréférencé. Notez que le raster
semble être légèrement tourné, mais c’est simplement à cause du fait que les données sont dans KKJ / Finland
zone 2 et votre projet dans ETRS89 / ETRS-TM35FIN.

Pour vérifier que vos données sont correctement géo-référencées, vous pouvez ouvrir l’image aérienne dans le
répertoire exercise_data\forestry, nommée rautjarvi_aerial.tif. Votre carte et cette image
devraient correspondre assez bien. Mettez la transparence de la carte à 50% et comparez-la à l’image aérienne.

330 Chapter 15. Module: Application forestière



QGIS Training Manual, Version 2.18

Sauvegardez les changements dans votre projet QGIS, vous continuerez à partir de ce point pour la prochaine
leçon.

15.2.3 In Conclusion

Comme vous l’avez vu, géoréférencer une carte papier est une opération relativement simple.

15.2.4 What’s Next?

Dans la prochaine leçon, vous numériserez les massifs forestiers de votre carte sous forme de polygones et leur
ajouterez dles données d’inventaire.
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15.3 Lesson: Numériser les massifs forestiers

À moins que vous n’utilisiez votre carte géoréférencée comme une simple image d’arrière-plan, la prochaine
étape logique est de numériser des éléments de la carte. Vous l’avez déjà fait dans les exercices sur la création
de données vectorielles dans Lesson: Création d’un Nouveau Jeu de Données Vectorielles, lorsque vous avez
numérisé les terrains scolaires. Dans cette leçon, vous allez numériser les bordures des massifs forestiers qui sont
représentés sur la carte avec des lignes vertes, mais à la place d’utiliser une image aérienne, vous utiliserez votre
carte géoréférencée.

Objectif de cette leçon : Apprendre une technique d’aide à la tâche de numérisation, en numérisant des massifs
forestiers et en leur ajoutant finalement les données d’inventaire.

15.3.1 Follow Along: Extraction des bordures des massifs forestiers

Ouvrez dans QGIS votre projet map_digitizing.qgs, que vous aviez sauvegardé dans la leçon précédente.

Une fois que vous avez scanné et géoréférencé votre carte, vous pouvez directement commencer la numérisation
en regardant l’image comme un guide. Cela sera probablement la façon avec laquelle vous procéderez si l’image
que vous avez numérisé est, par exemple, une photographie aérienne.

Si vous utilisez une bonne carte pour réaliser la numérisation, comme c’est notre cas, il est probable que
l’information soit clairement affichée sous forme de lignes avec des couleurs différentes pour chaque type
d’élément. Ces couleurs peuvent être relativement faciles à extraire sous forme d’images individuelles en util-
isant un logiciel de traitement d’image comme GIMP. Ces images séparées peuvent être utilisée pour faciliter la
numérisation comme vous allez pouvoir le constater plus loin.

La première étape sera d’utiliser GIMP pour obtenir une image qui ne contienne que les massifs forestiers, c’est-
à-dire toutes ces lignes verdâtres que vous pouvez voir sur la carte scannée d’origine :

• Ouvrez GIMP (si vous ne l’avez pas déjà installé, téléchargez-le depuis internet ou demandez à votre pro-
fesseur).

• Ouvrez l’image originale de la carte, Fichier → Ouvrir, rautjarvi_map.tif dans le répertoire
exercise_data/forestry. Notez que les massifs forestiers sont représentés par des lignes vertes
(avec le numéro du massif également en vert à l’intérieur de chaque polygone).
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Vous pouvez maintenant sélectionner les pixels dans l’image qui coïncident avec les bordures des massifs forestiers
(les pixels verdâtres):

• Ouvrez l’outil Sélection → Par couleur.

• Avec l’outil activé, zoomez sur l’image (Ctrl + molette de la souris) afin qu’une ligne de massif forestier
soit suffisamment proche pour différencier les pixels formant la ligne. Voyez l’image de gauche ci-dessous.

• Cliquez et faites glisser le curseur de la souris au milieu de la ligne afin que l’outil collecte plusieurs valeurs
de couleur de pixels.

• Relâchez le clic de la souris et attendez quelques secondes. Les pixels aux couleurs récupérées par l’outil
seront sélectionnés à travers toute l’image.

• Dézoomez pour voir comment les pixels verdâtres ont été sélectionnés sur toute l’image.

• Si vous n’êtes pas content du résultat, répétez l’opération de cliquer et glisser la souris.

• Votre sélection de pixels devrait ressembler à ce qu’on voit dans l’image de droite ci-dessous.
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Une fois que vous en avez terminé avec la sélection, vous devez copier cette sélection comme nouvelle couche et
ensuite la sauvegarder séparément comme fichier image :

• Copiez (Ctr+C) les pixels sélectionnés.

• Et collez directement les pixels (Ctr+V), GIMP affichera les pixels collés comme une nouvelle couche
temporaire dans l’onglet Couches - Remplissage en tant que Sélection flottante (Couche collée).

• Faites un clic-droit sur la couche temporaire et sélectionnez Vers une nouvelle couche.

• Cliquez sur l’icône “oeil” à côté de la couche de l’image d’origine pour la désactiver, afin que seule la
Couche collée soit visible :
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• Finalement, sélectionnez Fichier → Exporter..., mettez une image TIFF à Sélectionner le type de fichier
(par extension), sélectionnez le dossier digitizing et nommez-la rautjarvi_map_green.tif.
Sélectionnez pas de compression lorsqu’on vous le demande.

Vous pouvez faire le même processus avec d’autres éléments de l’image, par exemple extraire les lignes noires
représentant les routes, ou les brunes qui représentent les lignes de contour du terrain. Mais pour nous, les massifs
forestiers sont suffisants.

15.3.2 Try Yourself Géoréférencer l’image de pixels verts

Comme vous l’avez fait dans la leçon précédente, vous devez géoréférencer cette nouvelle image pour pouvoir
l’utiliser avec le reste de vos données.

Notez que vous n’avez pas besoin de numériser plus les points de contrôle car cette image est en fait la même
image que l’image d’origine de la carte, dans la mesure où l’outil Géoréférencer est concerné. Voici quelques
choses que vous devriez vous rappelez :

• Cette image est aussi, évidemment, dans le SCR KKJ / Finland zone 2.

• Vous devriez utiliser les points de contrôle que vous avez sauvegardé, Fichier → Charger des points de
contrôle (GCP).

• Souvenez-vous de modifier les Préférences de transformation.

• Nommez le raster de sortie rautjarvi_green_georef.tif dans le dossier digitizing.

Vérifiez que le nouveau raster se superpose parfaitement avec la carte d’origine.

15.3.3 Follow Along: Création de points d’appui pour la numérisation

Si vous avez en-tête les outils de numérisation de QGIS, vous pouvez penser qu’il serait utile de s’accrocher à ces
pixels verts lors de la numérisation. C’est précisément ce que nous allons faire en créant des points à partir de ces
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pixels pour les utiliser plus tard pour nous aider à suivre les bordures des forêts lors de la numérisation en utilisant
les outils d’accrochage disponible dans QGIS.

• Utilisez l’outil Raster → Conversion → Polygoniser (Raster à Vecteur) pour vectoriser vos lignes vertes en
polygones. Si vous ne vous souvenez plus comment faire, vous pouvez le revoir dans Lesson: Conversion
Raster vers Vecteur.

• Sauvegardez en tant que rautjarvi_green_polygon.shp dans le dossier digitizing.

Zoomez et voyez à quoi ressemblent les polygones. Vous obtiendrez quelque chose comme ça :

La prochaine option pour extraire les points à partir des polygones est de récupérer leur centroïde:

• Ouvrez Vecteur → Outils géométriques → Centroïdes de polygones.

• Paramétrez la couche de polygone que vous venez de récupérer comme fichier d’entrée de l’outil.

• Nommez la sortie green_centroids.shp dans le dossier the digitizing.

• Cochez Ajouter le résultat au canevas.

• Lancez l’outil pour calculer les centroïdes des polygones.
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Vous pouvez maintenant enlever la couche rautjarvi_green_polygon de la Légende la carte.

Changez la symbologie de la couche des centroïdes comme suit :

• Ouvrez les Propriétés de la couche pour green_centroids.

• Rendez-vous à l’onglet Style.

• Configurez l’Unité avec Unité de la carte.

• Mettez la Taille à 1.

Il n’est pas nécessaire de différencier les points les uns des autres, vous avez seulement besoin de les avoir pour
que les outils d’accrochage puissent les utiliser. Vous pouvez maintenant utiliser ces points pour suivre les lignes
d’origine plus facilement que sans eux.

15.3.4 Follow Along: Numériser les massifs forestiers

Maintenant, vous êtes prêt à lancer le travail de numérisation. Créez un fichier vecteur du type polygone mais pour
cet exercice, il existe déjà un fichier Shape sur les emprises d’intérêt. Il vous reste à terminer la numérisation de
la moitié des forêts qui restent entre les routes principales (lignes roses larges) et le lac:
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• Rendez-vous au dossier digitizing en utilisant votre navigateur de gestion de fichier.

• Faites glisser et déposez le fichier vecteur forest_stands.shp dans votre carte.

Changez la symbologie de la nouvelle couche afin qu’il soit plus facile de voir quel polygone a déjà été numérisé
:

• Le remplissage du polygone en vert.

• Les bordures des polygones à 1 mm.

• Et mettez la transparence à 50%.

Maintenant, si vous vous souvenez des modules passés, nous devons définir et activer les options d’accrochage :
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• Rendez-vous aux Préférences → Options d’accrochage....

• Activez l’accrochage pour les couches green_centroids et forest_stands.

• Fixez leur Tolérance à 5 unités de carte.

• Cochez la case Éviter les intersections pour la couche forest_stands.

• Cochez Activer l’édition topologique.

• Cliquez sur Appliquer.

Avec ces paramètres d’accrochage, lorsque vous numérisez et que vous vous approcher de l’un des points de la
couche de centroïdes ou d’un segment de vos polygones déjà numérisés, une croix rose apparaît sur le point sur
lequel la numérisation s’accrochera.

Finalement, désactivez la visibilité de toutes les couches sauf de forest_stands et rautjarvi_georef.
Assurez-vous que l’image de la carte n’a plus de transparence.

Quelques choses importantes à noter avec que vous démarriez la numérisation :

• N’essayez pas d’être trop précis avec la numérisation des bordures.

• Si une bordure est une ligne droite, numérisez-la avec seulement deux noeuds. En général, la numérisation
utilise aussi peu de noeuds que possible.

• Zoomez pour fermer les plages seulement si vous pensez que vous devez être précis, par exemple, à un coin
ou lorsque vous voulez connecter un polygone avec un autre polygone à un certain noeud.

• Utilisez le bouton du milieu de la souris pour zoomer/dézoomer et vous déplacer lors de la numérisation.

• Numérisez seulement un polygone à la fois.

• Après avoir numérisé un polygone, écrivez l’id du massif forestier que vous pouvez voir sur la carte.

Vous pouvez maintenant commencer la numérisation :

• Localisez le massif forestier numéro 357 dans la fenêtre de la carte.

• Activez l’édition pour la couche forest_stands.shp.

• Sélectionner l’outil Ajouter une entité.

• Commencez la numérisation de la place 357 en connectant certains des points.

• Notez que les croix roses indiquent l’accrochage.
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• Quand vous avez terminé, faites un clic-droit pour terminer la numérisation du polygone.

• Entrez l’id de la plage forestière (dans ce cas 357).

• Cliquez sur OK.

Si on ne vous a pas demandé l’id du polygone lorsque vous avez terminé sa numérisation, rendez-vous aux
Paramètres → Options → Numérisation et assurez-vous que Supprimer les avertissements de formulaire d’attribut
lors de la création d’entité n’est pas coché.

Votre polygone numérisé ressemblera à cela :
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Pour le second polygone, récupérez l’ilot 358. Assurez-vous que l’option Éviter les intersections est cochée pour
la couche forest_stands. Cette option permet aux polygones numérisés de ne pas se superposer du tout. Si
vous numérisez au dessus d’un polygone déjà existant, le nouveau polygone sera coupé à la bordure des polygones
déjà existants. Vous pouvez utiliser cette fonctionnalité pour obtenir une bordure commune.

• Commencez à numériser le massif 358 à un des angles communs avec le massif 357.

• Puis continuez normalement jusqu’à ce que vous arriviez à l’autre coin commun aux deux massifs.

• Finalement, numérisez quelques points dans le polygone 357 en s’assurant que la bordure commune n’est
pas intersectée. Observez l’image de gauche ci-dessous.

• Faites un clic-droit pour terminer la modification du massif forestier 358.

• Entrez 358 comme id.

• Cliquez sur OK, votre nouveau polygone devrait montrer une bordure commune avec la plage 357, comme
vous pouvez le voir sur l’image de droite.
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La partie du polygone qui chevauchait le polygone existant a été automatiquement découpée et vous avez obtenu
une bordure commune, comme on pouvait s’y attendre.

15.3.5 Try Yourself Finir la numérisation des massifs forestiers

Vous avez maintenant deux plages de forêts prêtes. Et une bonne idée de comment procéder. Continuez à
numériser de vous-même jusqu’à ce que vous ayez numérisé toutes les plages de forêt qui sont limitées par la
route principale et le lac.

Cela peut sembler être beaucoup de travail, mais vous serez bientôt habitué à la numérisation des massifs forestiers.
Cela devrait vous prendre environ 15 minutes.

Lors de la numérisation, vous pourriez avoir besoin de modifier ou de supprimer des nœuds, de séparer ou de
fusionner des polygones. Vous avez appris les outils nécessaires à cela dans Lesson: Topologie des données, c’est
probablement un bon moment pour relire à nouveau ce chapitre.

Souvenez-vous qu’en ayant coché Activer l’édition topologique, cela vous permet de déplacer des noeuds com-
muns à deux polygones afin que la bordure commune soit modifiée en même temps pour les deux polygones.

Votre résultat devra ressembler à cela :
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15.3.6 Follow Along: Jointure des données du massif forestier

Il est possible que les données d’inventaire des forêts que vous avez pour votre carte soit aussi écrites sur papier.
Dans ce cas, vous devrez tout d’abord écrire ces données dans un fichier texte ou un tableur. Pour cet exercice, les
informations de l’inventaire de 1994 (le même inventaire que la carte) sont prêtes dans un fichier texte séparé par
des virgule (fichier csv).

Ouvrez le fichier rautjarvi_1994.csv depuis le répertoire exercise_data\forestry dans un éditeur
de texte et notez que le fichier de données d’inventaire possède un attribut nommé ID qui contient les numéros
des massifs de forêts. Ces numéros sont les mêmes que les ids des massifs de forêts que vous avez entrés pour
vos polygones et peuvent être utilisés pour lier les données du fichier texte au fichier vectoriel. Vous pouvez voir
les métadonnées pour ces données d’inventaire dans le fichier rautjarvi_1994_legend.txt dans le même
dossier.

• Ouvrez le .csv dans QGIS avec l’outil Couche → Ajouter une couche de texte délimité.... Dans la boîte de
dialogue, faites la configuration comme suit :
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Pour ajouter les données depuis un fichier .csv :

• Ouvrez les Propriétés de la couche pour la couche forest_stands.

• Rendez-vous à l’onglet Jointure.

• Cliquez sur le signe plus en bas de la boîte de dialogue.

• Sélectionnez rautjarvi_1994.csv pour la Couche de jointure et ID pour le champ Jointure.

• Assurez-vous que le champ Cible est aussi mis sur id.

• Cliquez sur OK deux fois.

Les données du fichier texte devraient être maintenant liées à votre fichier vectoriel. Pour voir ce qu’il s’est passé,
ouvrez la table attributaire pour la couche forest_stands. Vous pouvez voir que tous les attributs du fichier
de données d’inventaire sont maintenant liées à votre couche vectorielle numérisée.

15.3.7 Try Yourself Changement du nom des attributs et ajout de l’aire et
du périmètre

Les données du fichier .csv sont juste liées à votre fichier vectoriel. Pour rendre ce lien permanent, afin
que les données soient effectivement enregistrées dans le fichier vectoriel, vous devez sauvegarder la couche
forest_stands comme un nouveau fichier vectoriel. Fermez la table attributaire et faites un clic droit sur la
couche forest_stands pour la sauvegarder en tant que forest_stands_1994.shp.

Ouvrez votre nouveau forest_stands_1994.shp dans votre carte si vous ne l’avez pas encore ajouté. Puis,
ouvrez la table attributaire. Vous remarquerez que le noms des colonnes que vous venez d’ajouter ne sont pas très
utiles. Pour résoudre ceci :
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• Ajoutez l’extension Table Manager comme vous l’avez fait avec d’autres extensions précédemment.

• Assurez-vous que l’extension est activée.

• Dans la Légende de la carte, sélectionnez la couche forest_stands_1994.shp.

• Puis, rendez-vous à Vecteur → Table Manager → Gestionnaire de table.

• Utilisez la boîte de dialogue pour modifier les noms des colonnes correspondants à ceux du fichier .csv.

• Cliquez sur Sauvegarder.

• Sélectionnez Oui pour garder le style de la couche.

• Fermez la boîte de dialogue Table Manager.

Pour terminer sur l’information relative à ces lots forestiers, vous pourriez calculer la surface et le périmètre des
lots. Vous avez calculé les surfaces des polygones dans Lesson: Exercice Supplémentaire. Retournez consulter
cette leçon si vous en avez besoin et calculer les surfaces des lots forestiers, nommez le nouvel attribut Area et
assurez-vous que les valeurs soient calculées en hectares.

Maintenant votre couche forest_stands_1994.shp est prête et contient toute l’information disponible.

Sauvegardez votre projet pour garder la présentation de la carte actuelle au cas où vous auriez besoin d’y revenir
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plus tard.

15.3.8 In Conclusion

Cela a pris plusieurs clics de souris mais vous avez désormais vos anciennes données d’inventaire dans un format
numérique et prêtes à être utilisées dans QGIS.

15.3.9 What’s Next?

Vous pouvez lancer d’autres analyses sur votre nouveau jeu de données mais il est plus intéressant de les faire
sur un jeu de données plus récentes. Le sujet de la prochaine leçon concerne la création des massifs forestiers en
utilisant les dernières photos aériennes et l’ajout d’information plus précises à votre jeu de données.

15.4 Lesson: Mise à jour des massifs forestiers

Maintenant que vous avez numérisé les informations depuis les anciennes cartes d’inventaire et ajouté
l’information correspondant aux massifs de forêt, la prochaine étape sera de créer l’inventaire de l’état actuel
de la forêt.

Vous numériserez les nouveaux massifs de forêt à partir de zéro en suivant une photo aérienne de cette aire
forestière. La carte forestière que vous avez numérisée dans la leçon précédente a été crée depuis une pho-
tographique aérienne infrarouge couleur (CIR). Ce type d’imagerie, où la lumière infrarouge est enregistrée à la
place de la lumière bleue, est largement utilisé pour étudier les zones de végétation. Vous utiliserez aussi une
photographie CIR dans cette leçon.

Après la numérisation des massifs de forêt, vous ajouterez des informations telles que les nouvelles contraintes
données par les réglementations de conservation.

Objectif de cette leçon : Numériser un nouveau jeu de données des massifs de forêt depuis des photographies
aériennes CIR et ajouter de l’information depuis d’autres jeux de données.

15.4.1 Comparaison des anciens massifs de forêt avec des photographies
aériennes actuelles

Le National Land Survey of Finland a une politique des données libres qui vous permet de télécharger une variété
de données géographiques comme de l’imagerie aérienne, des cartes topographiques traditionnelles, des MNE,
des données LiDAR, etc. Le service est aussi disponible en anglais ici. L’image aérienne utilisée dans cet exercice
a été créée à partir de deux images CIR orthorectifiées téléchargeables depuis ce service (M4134F_21062012 et
M4143E_21062012).

• Ouvrez QGIS et mettez le SCR du projet à ETRS89 / ETRS-TM35FIN depuis Projet → Propriétés du
project → SCR.

• Assurez-vous que l’option Activer la projection ‘à la volée’ est cochée.

• Depuis le dossier exercise_data\forestry\, ajoutez l’image CIR rautjarvi_aerial.tif
contenant les lacs numérisés.

• Puis sauvegardez le projet QGIS sous digitizing_2012.qgs.

Les images CIR sont de 2012. Vous pouvez comparer les massifs qui ont été créés en 1994 avec la situation d’il y
a environ 20 ans.

• Ajoutez votre couche forest_stands_1994.shp.

• Modifiez son style afin que vous puissiez voir à travers vos polygones.
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• Étudiez comment les anciens massifs de forêt suivent (ou non) ce que vous pouvez visuellement interpréter
comme de la forêt homogène.

Zoomez et bouger autour de la zone. Vous remarquerez probablement que certains des anciens massifs de forêt
pourraient correspondre à l’image alors que d’autres non.

Ceci est une situation ordinaire, étant donné que 20 ans se sont écoulés et différentes exploitations forestières ont
été menées (récolte, éclaircissage,...). Il est également possible que les massifs de forêt aient semblé homogène à
la personne qui les a numérisés en 1992 mais avec le temps les forêts se sont développées de différentes façons.
Ou simplement les priorités de l’inventaire des forêts étaient différentes que celles d’aujourd’hui.

Ensuite, vous créerez de nouveaux massifs de forêt pour cette image sans utiliser les anciens. Plus tard, vous
pourrez les comparer pour voir les différences.

15.4.2 Interprétation de l’image CIR

Numérisons la même zone qui était couverte par l’ancien inventaire, limitée par les routes et par le lac. Vous
n’avez pas besoin de numériser l’entier de la zone, comme dans l’exercice précédent, vous pouvez commencer
avec un fichier vectoriel qui contient déjà la plupart des massifs de forêt.

• Enlevez la couche forest_stands_1994.shp.

• Ajoutez la couche forest_stands_2012.shp, située dans le dossier
exercise_data\forestry\.

• Configurez le style de cette couche de sorte que les polygones n’aient pas de remplissage et que les bordures
soient visibles.
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Vous pouvez voir qu’une région au Nord de la zone d’inventaire est toujours manquante. Cela sera votre tâche,
numériser les massifs de forêts manquants.

Mais avant de commencer, passez un peu de temps à revoir les massifs de forêt déjà numérisé et la forêt corre-
spondant à l’image. Essayez de vous faire une idée sur la façon dont les bords des massifs sont décidés, cela aide
si vous avez quelques connaissances forestières.

Quelques idées de ce que vous pourriez identifier sur les images :

• Quelles forêts ont des espèces à feuilles caduques (en Finlande surtout des forêts de bouleau) et lesquelles
ont des conifères (dans cette région, pin ou épicéa). Dans les images de CIR, les espèces à feuilles caduques
seront souvent de couleur rouge vif alors que les conifères présentent des couleurs vert foncé.

• Quand un massif de forêt change d’âge, en regardant les tailles des couronnes des arbres qui peuvent être
identifiées grâce à l’imagerie.

• Les différentes densités des massifs de forêt, par exemple des massifs de forêt qui ont récemment subi un
amincissement, montreront clairement des espaces entre les couronnes d’arbres et pourraient être faciles à
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différencier des autres massifs de forêt autour d’eux.

• Des zones bleutées indiquent des terrains stériles, routes et zones urbaines, les cultures qui ne sont pas
ouvertes à croître, etc.

• N’utilisez pas de zoom trop proche de l’image quand vous essayez d’identifier les massifs de forêt, entre 1:
3 000 et 1: 5 000 devrait être suffisant pour cette imagerie. Regardez l’image entre les deux (échelle à 1: 4
000).

15.4.3 Try Yourself Numérisation des massifs de forêts depuis l’imagerie
CIR

Lors de la numérisation des massifs de forêts, vous devez essayer de trouver des zones forestières qui sont aussi
homogènes que possible en termes d’espèces d’arbres, d’âge de la forêt, de densité... Ne soyez pas trop pointilleux
cependant, sinon vous finirez par faire des centaines de petits massifs de forêt qui ne seront pas du tout utiles. Vous
devrez essayer de trouver des massifs qui ont un sens dans le contexte de la foresterie, pas trop petite (au moins
0.5 ha) mais pas trop grand non plus (pas plus de 3 ha).

En gardant ces indications en tête, vous pouvez maintenant numériser les massifs de forêt manquants.

• Activez l’édition pour forest_stands_2012.shp.

• Configurez les options d’accrochage et de topologie comme sur l’image.

• Souvenez-vous de cliquer sur Appliquer ou OK.
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Commencez la numérisation comme vous l’avez fait dans la leçon précédente, avec la seule différence que vous
n’avez pas de couche de point sur laquelle vous vous accrochez. Pour cette zone, vous devriez obtenir environ
14 nouveaux massifs de forêt. Lors de la numérisation, remplissez le champ Stand_id avec des numéros
commençant à 901.

Quand vous avez terminé, votre couche devrait ressembler à quelque chose comme ça :

Vous avez maintenant un nouveau jeu de polygones qui définissent les différents massifs de forêt pour la situation
actuelle comme elle peut être interprétée depuis les images CIR. Mais il vous manque encore évidemment les don-
nées d’inventaire de forêt, n’est-ce pas ? Pour cela, vous devrez toujours visiter la forêt et récolter des échantillons
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de données que vous utiliserez pour estimer les attributs forestiers de chacun des massifs de forêt. Vous verrez
comment faire cela dans la prochaine leçon.

Pour le moment, vous pouvez toujours améliorer votre couche vectorielle avec quelques informations supplémen-
taires que vous avez sur la réglementation de protection qui pourraient être prises en compte pour cette zone.

15.4.4 Follow Along: Mise à jour des massifs de forêt avec l’information de
conservation

Pour la zone sur laquelle vous travaillez, les études ont montré que les règles de conservation suivantes doivent
être prises en compte lors de la planification forestière :

• Deux emplacements d’une espèce protégée d’écureuil volant de Sibérie (Pteromys volans) ont été identifiés.
Selon le règlement, une zone de 15 mètres autours des lieux devrait restée intacte.

• Une forêt riveraine d’un intérêt particulier grandissant le long d’un cours d’eau dans la zone doit être pro-
tégée. Lors d’une visite sur le terrain, il a été découvert que 20 mètres de part et d’autre du cours d’eau
doivent être protégés.

Vous avez un fichier vectoriel contenant les informations à propos des emplacements des écureuils et
un autre contenant le cours d’eau numérisé dans la région du Nord près du lac. Depuis le dossier
exercise_data\forestry\, ajoutez les fichiers vectoriels squirrel.shp et stream.shp.

Pour la protection des emplacements des écureuils, vous allez ajouter un nouvel attribut (colonne) à vos nouveaux
massifs de forêt qui contiendront l’information sur l’emplacement des points qui doivent être protégés. Cette
information sera disponible plus tard chaque fois qu’une opération forestière est planifiée, et l’équipe de terrain
pourra marquer les zones qui doivent rester intactes avant que les travaux ne commencent.

• Ouvrez la table attributaire pour la couche squirrel.

• Vous pouvez voir qu’il y a deux emplacements qui sont définis comme écureuil volant de Sibérie, et que la
zone à protéger est indiquée par une distance de 15 mètres des emplacements.

Pour joindre l’information sur les écureuils à nos massifs de forêt, vous pouvez utiliser Joindre les attributs par
localisation :

• Ouvrez Vecteur → Outils de gestion de données → Joindre les attributs par localisation.

• Mettez la couche forest_stands_2012.shp comme Couche vecteur cible.

• Comme Couche vecteur jointe sélectionnez la couche point squirrel.shp.

• Nommez le fichier de sortie stands_squirrel.shp.

• Dans la Table de sortie sélectionnez Conserver tous les enregistrements (même ceux sans correspondance).
Ainsi vous gardez tous les massifs de forêt dans la couche à la place de ne garder que ceux qui sont spa-
tialement associés à des emplacements d’écureuils.

• Cliquez sur OK.

• Sélectionnez Oui quand on vous demande d’ajouter la couche à la Légende de la carte.

• Fermez la boîte de dialogue.
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Vous avez désormais une nouvelle couche de massifs de forêt, stands_squirrel dans laquelle il y a des
nouveaux attributs qui correspondent à l’information de protection liée à l’écureuil volant de Sibérie.

Ouvrez la table de la nouvelle couche et ordonnez-la selon les massifs de forêt avec l’information de l’attribut
Protection. Vous devriez maintenant avoir deux massifs de forêt où l’écureuil a été localisé :
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Bien que cette information pourrait être suffisante, regardez quelle zone liée aux écureuils doit être protégée. Vous
savez que vous devez laisser un tampon de 15 mètres autour de l’emplacement des écureuils :

• Ouvrez Vecteur → Outils de géotraitement → Tampon.

• Faites un tampon de 15 mètres pour la couche squirrel.

• Nommez le résultat squirrel_15m.shp.
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Vous remarquerez que si vous zoomez sur l’emplacement dans la partie Nord de la zone, la zone tampon
s’étend jusqu’au massif voisin. Cela signifie que chaque fois qu’une opération forestière a lieu dans ce massif,
l’emplacement protégé devrait également être pris en compte.
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Lors de notre précédente analyse, nous n’avons pas enregistré l’information sur l’état de la protection. Voici
comment régler le problème:

• Lancez à nouveau l’outil Joindre les attributs par localisation.

• Mais cette fois, utilisez la couche squirrel_15m comme couche jointe.

• Nommez le fichier de sortie stands_squirrel_15m.shp.
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Ouvrez la table attributaire de cette nouvelle couche et notez que maintenant vous avez trois massifs de forêt qui
possèdent des informations sur les emplacements de protection. Les informations dans les données des massifs
de forêt indiqueront au gestionnaire forestier qu’il y a des considérations de protection à prendre en compte.
Puis il ou elle peut obtenir l’emplacement du jeu de données squirrel, et visiter la zone pour marquer le
tampon correspondant autour de l’emplacement afin que les opérateurs de terrain puissent éviter de déranger
l’environnement des écureuils.
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15.4.5 Try Yourself Mise à jour des massifs de forêt avec la distance au
cours d’eau

En suivant la même approche qu’indiquée pour les emplacements protégés d’écureuils, vous pouvez maintenant
mettre à jour vos massifs de forêt avec l’information de protection liée au cours d’eau identifié sur le terrain :

• Souvenez-vous que le tampon dans ce cas est de 20 mètres.

• Vous voulez avoir toutes les informations de protection dans le même fichier vecteur, alors utilisez la couche
stands_squirrel_15m comme cible.

• Nommez votre sortie forest_stands_2012_protect.shp.

Ouvrez la table attributaire de la nouvelle couche vecteur et vérifier que vous avez maintenant toutes les informa-
tions de protection pour les massifs qui sont touchés par les mesures de protection pour protéger la forêt riveraine
liée à ce cours d’eau.

Sauvegardez votre projet QGIS.

15.4.6 In Conclusion

Vous avez vu comment interprétez des images CIR pour numériser des massifs forestiers. Bien sûr cela deman-
derait plus de pratique pour faire des massifs plus précis et le plus souvent avec d’autres informations, comme des
cartes pédologiques donneraient de meilleurs résultats, mais vous savez désormais les bases pour ce type de tâche.
Et l’ajout d’informations à partir de jeux de données s’est révélé être une tâche tout à fait banale.

15.4.7 What’s Next?

Les massifs de forêt que vous avez numérisés seront utilisés pour la planification des opérations forestières dans
l’avenir, mais vous avez besoin d’obtenir toujours plus d’informations sur la forêt. Dans la prochaine leçon, vous
verrez comment planifier un ensemble de parcelles d’échantillonnage pour inventorier la zone forestière que vous
venez de numériser, et obtenir l’estimation globale des paramètres de la forêt.

15.5 Lesson: Conception d’un échantillonnage systématique

Vous avez déjà numérisé un jeu de polygones qui représentent les massifs de forêt, mais vous n’avez pas eu
d’informations sur la forêt jusqu’à maintenant. Pour cela, vous pouvez concevoir une enquête pour inventorier la
zone forestière entière et ensuite estimer ses paramètres. Dans cette leçon, vous créerez un ensemble d’échantillons
de parcelles.

Lorsque vous commencez à planifier votre inventaire forestier, il est important de définir clairement les objectifs,
les types de parcelles d’échantillon qui seront utilisées, et les données qui seront collectées pour réaliser ces
objectifs. Pour chaque cas individuel, ceux-ci dépendront du type de forêt et des fins de gestion ; et devront
être soigneusement planifiés par quelqu’un qui possède des connaissances forestières. Dans cette leçon, vous
implémenterez un inventaire théorique basé sur une conception d’un échantillonnage systématique de parcelles.

Objectif de cette leçon : Créer un échantillonnage systématique de parcelles pour étudier la zone forestière.

15.5.1 Inventaire de la forêt

Il existe plusieurs méthodes pour inventorier des forêts, chacune d’elles convenant à différentes fins et conditions.
Par exemple, une façon très précise d’inventorier une forêt (si vous considérez seulement trois espèces) serait de
visiter la forêt et de faire une liste de chaque arbre et de ses caractéristiques. Comme vous pouvez l’imaginer,
cette méthode n’est pas vraiment applicable, sauf pour de petites zones ou pour des situations particulières.

La manière la plus courante d’apprendre d’une forêt est de l’échantillonner, c’est-à-dire en prenant des mesures à
différents endroits de la forêt et en généralisant cette information à l’entier de la forêt. Ces mesures sont souvent
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faites dans des parcelles d’échantillon qui sont des zones forestières plus petites qui peuvent être facilement
mesurées. Les parcelles d’échantillon peuvent être de n’importe quelle taille (par exemple de 50 m2, 0.5 ha) et de
n’importe quelle forme (par exemple circulaire, rectangulaire, de taille variable), et peuvent être localisées dans
la forêt de différentes façons (par exemple aléatoirement, systématiquement, le long de lignes). La taille, la forme
et l’emplacement des parcelles d’échantillon sont habituellement décidés selon des considérations statistiques,
économiques et pratiques. Si vous n’avez pas de connaissances forestières, vous serez intéressé par lire cet article
Wikipedia.

15.5.2 Follow Along: Implémentation d’une conception d’un échantillon-
nage systématique de parcelle

Pour la forêt sur laquelle vous travaillez, le gestionnaire a décidé qu’une conception d’un échantillonnage systé-
matique est la méthode la plus appropriée pour cette forêt et a décidé qu’une distance fixe de 80 mètres entres
les parcelles d’échantillon et les lignes d’échantillonnage donnera des résultats fiables (dans ce cas, une erreur
moyenne de +- 5% pour une probabilité de 68%). Des parcelles de taille variables ont été sélectionnées comme
étant la méthode la plus efficace pour cet inventaire, pour des massifs matures et en croissance, mais les parcelles
à un rayon fixe de 4 mètres seront utilisées pour des massifs de semis.

Dans la pratique, vous devez simplement représenter les parcelles d’échantillon par des points qui seront utilisés
plus tard par les équipes de terrain :

• Ouvrez votre projet digitizing_2012.qgs de la leçon précédente.

• Enlevez toutes les couches, sauf forest_stands_2012.

• Sauvegardez maintenant votre projet sous forest_inventory.qgs

Vous devez maintenant créer une grille rectangulaire de points séparés de 80 mètres les uns des autres :

• Ouvrez Vecteur → Outils de recherche → Points réguliers.

• Dans les définitions Area sélectionnez Couche des limites en entrée.

• Et comme couche d’entrée choisissez la couche forest_stands_2012.

• Dans les paramètres d’Espacement de la grille, sélectionnez Utiliser cet écart entre les points et fixez-le à
80.

• Sauvegardez la sortie sous systematic_plots.shp dans le dossier forestry\sampling\.

• Cochez Ajouter le résultat au canevas.

• Cliquez sur OK.

Note: Les Points réguliers suggérés créent les points systématiques commençant dans le coin supérieur gauche de
l’étendue de la couche de polygone sélectionnée. Si vous vouliez ajouter un peu de hasard à ces points réguliers,
vous pourriez utiliser un nombre calculé de façon aléatoire compris entre 0 et 80 (80 est la distance entre nos
points), et inscrivez-le ensuite comme le paramètre Distance depuis le coin supérieur gauche dans la boîte de
dialogue de l’outil.

Vous remarquez que l’outil a utilisé toute l’étendue de votre couche des massifs pour générer une grille rectan-
gulaire de points. Mais vous êtes seulement intéressé par ces points qui sont actuellement dans la zone forestière
(voyez l’image ci-dessous) :

358 Chapter 15. Module: Application forestière

http://en.wikipedia.org/wiki/Forest_inventory
http://en.wikipedia.org/wiki/Forest_inventory


QGIS Training Manual, Version 2.18

• Ouvrez Vecteur → Outils de géotraitement → Découper.

• Sélectionnez systematic_plots comme Couche vectorielle de saisie.

• Mettez forest_stands_2012 comme Couche de découpage.

• Sauvegardez le résultat sous systematic_plots_clip.shp.

• Cochez Ajouter le résultat au canevas.

• Cliquez sur OK.

Vous avez maintenant les points que les équipes de terrain utiliseront pour naviguer aux endroits de conception
d’échantillon de parcelles. Vous pouvez toujours préparer ces points afin qu’ils soient plus utiles pour le travail
de terrain. Au minimum, vous devrez ajouter des noms significatifs pour les points et les exportez dans un format
qui puisse être utilisé avec leurs appareils GPS.

Commençons avec le nommage de ces parcelles d’échantillon. Si vous vérifiez la Table attributaire pour les par-
celles à l’intérieur de la zone forestière, vous verrez que vous avez le champ id par défaut généré automatiquement
par l’outil Regular points. Étiquetez les points pour les voir dans la carte et réfléchissez si vous pouvez utiliser ces
nombres comme part de votre appellation de parcelle d’échantillon :

• Ouvrez les Propriétés de la couche –> Étiquettes pour votre systematic_plots_clip.

• Cochez Étiqueter cette couche avec et sélectionnez le champ ID.

• Rendez-vous aux options du Tampon et cochez Afficher un tampon, mettez 1 pour la Taille.

• Cliquez sur OK.

Regardez maintenant les étiquettes sur votre carte. Vous pouvez voir que les points ont été créés et numérotés
d’abord d’Ouest en Est puis de Nord au Sud. Si vous regardez à nouveau la table attributaire, vous remarquerez
que l’ordre dans la table suit aussi ce modèle. À moins que vous n’ayez une raison de nommer les parcelles
d’échantillon d’une autre façon, les nommer de la manière Ouest-Est/Nord-Sud suit un ordre logique et est une
bonne option.
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Note: Si vous voulez les ordonner ou les nommer d’une autre manière, vous pouvez utiliser un tableur pour
pouvoir ordonner et combiner des lignes et des colonnes de différentes façons.

Néanmoins, les valeurs des nombres dans le champ id ne sont pas si bonnes. Ce serait mieux que le nom-
mage soit quelque chose comme p_1, p_2.... Vous pouvez créer une nouvelle colonne pour la couche
systematic_plots_clip.

• Rendez-vous à la Table attributaire de systematic_plots_clip.

• Activez le mode d’édition

• Ouvrez la Calculatrice de champ et nommez la nouvelle colonne Plot_id.

• Mettez le Type de champ en sortie à Texte (chaîne de caractères).

• Dans le champ Expression, écrivez, copiez ou construisez cette formule concat(’P_’, $rownum ).
Souvenez-vous que vous pouvez aussi double-cliquer sur les éléments dans la Liste des fonctions. La fonc-
tion concat peut être trouvée sous Chaîne et le paramètre $rownum peut être trouvé sous Enregistrement.

• Cliquez sur OK.

• Désactivez le mode d’édition et sauvegardez vos modifications.

Vous avez désormais une nouvelle colonne avec des noms de parcelles qui ont du sens pour vous. Pour la couche
systematic_plots_clip, changez le champ utilisé pour l’étiquetage avec votre nouveau champ Plot_id.
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15.5.3 Follow Along: Exportation des parcelles d’échantillon au format
GPX

Les équipes de terrain utiliseront probablement un appareil GPS pour localiser les parcelles d’échantillon que
vous avez planifiées. La prochaine étape est d’exporter les points que vous avez créés en un format que votre
GPS peut lire. QGIS vous permet de sauvegarder vos données vectorielles en poins et lignes dans un Format GPS
eXchange (GPX)<http://en.wikipedia.org/wiki/GPS_Exchange_Format>, qui est un format standard de données
GPS qui peut être lu par la plupart des logiciels spécialisés. Vous devez être attentif au SCR sélectionné lorsque
vous sauvegardez vos données :
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• Faites un clic droit sur systematic_plots_clip et sélectionnez Sauvegardez sous.

• Dans Format, sélectionnez GPS eXchange Format [GPX].

• Sauvegardez la sortie sous kbd:plots_wgs84.gpx.

• Dans le SCR, sélectionnez SCR sélectionné.

• Parcourez-les jusqu’à trouver WGS 84 (EPSG:4326).

..note :: Le format GPX accepte seulement ce SCR, si vous en sélectionnez un différent, QGIS ne donnera pas
d’erreur mais vous obtiendrez un fichier vide.

• Cliquez sur OK.

• Dans la boîte de dialogue qui s’ouvre, sélectionnez seulement la couche waypoints (le reste des couches
sont vides).

Les emplacement des échantillons d’inventaire sont maintenant dans un format standard géré par la plupart
des logiciels de GPS. Les équipes de terrain peuvent maintenant décharger les emplacements des échantil-
lons dans leurs équipements. Cela peut être réalisé en utilisant le logiciel spécifique des GPS et le fichier
plots_wgs84.gpx que vous venez de créer. L’autre option est d’utiliser l’extension GPS Tools mais elle
impose de paramétrer l’outil pour fonctionner avec un GPS spécifique. Si vous travaillez avec vos propres don-
nées et que vous voulez savoir comment les outils GPS fonctionnent, vous pouvez lire la section Travailler avec
des données GPS du Manuel de l’utilisateur QGIS.
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Sauvegardez maintenant votre projet QGIS.

15.5.4 In Conclusion

Vous venez de voir comment vous pouvez facilement créer une conception d’échantillonnage systématique utilisée
dans un inventaire de forêt. La création d’autres types de conceptions d’échantillonnage impliquera l’utilisation
de différents outils dans QGIS, tableurs ou scripts pour calculer les coordonnées des parcelles d’échantillon, mais
l’idée générale reste la même.

15.5.5 What’s Next?

Dans la prochaine leçon, vous verrez comment utiliser les capacités de l’Atlas dans QGIS pour générer automa-
tiquement des cartes détaillées que les équipes de terrain utiliseront pour naviguer dans les parcelles d’échantillon
qui leur sont attribuées.

15.6 Lesson: Création de cartes détaillées avec l’outil Atlas

La conception d’un échantillonnage systématique est prête et les équipes de terrain ont chargé les coordonnées
GPS dans leurs appareils de navigation. Elles ont aussi un formulaire de données de terrain dans lequel elles vont
collecter les informations mesurées sur chaque parcelle d’échantillon. Pour trouver plus facilement leur chemin
vers chaque parcelle d’échantillon, elles auront recours à un certain nombre de cartes détaillées sur lesquelles
des informations de terrain sont clairement visibles avec un petit sous-ensemble de parcelles d’échantillon et des
informations sur la zone de la carte. Vous pouvez utiliser l’outil Atlas pour générer automatiquement un nombre
de cartes avec un format commun.

Objectif de cette leçon : Apprendre à utiliser l’outil Atlas dans QGIS pour générer des cartes détaillées im-
primables pour assister le travail d’inventaire sur le terrain.

15.6.1 Follow Along: Préparation du composeur de carte

Avant que nous ne puissions automatiser les cartes détaillées de la zone forestière et de nos parcelles d’échantillon,
nous devons créer un modèle de carte avec tous les éléments que nous considérons comme utiles pour le travail
de terrain. Bien sûr, le plus important sera d’avoir un bon style mais, comme vous l’avez vu plus tôt, vous devrez
aussi ajouter beaucoup d’autres éléments qui complètent la carte imprimée.

Ouvrez le projet QGIS de la leçon précédente forest_inventory.qgs. Vous devriez au moins avoir les
couches suivantes :

• forest_stands_2012 (avec une transparence à 50%, un remplissage vert et une bordure verte plus
foncée).

• systematic_plots_clip.

• rautjarvi_aerial.

Sauvegardez le projet sous un nouveau nom, map_creation.qgs.

Pour créer une carte imprimable, souvenez-vous que vous utilisez le Gestionnaire de composition :

• Ouvrez Project → Gestionnaire de composition....

• Dans la boîte de dialogue Gestionnaire de composition.

• Cliquez sur le bouton Ajouter et nommez votre composeur forest_map.

• Cliquez sur OK.

• Cliquez sur le bouton Montrer.
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Configurez les options d’impression afin que vos cartes soient adaptées à votre papier et vos marges, pour un
feuille A4 :

• Ouvrez Composeur → Paramètres de la page.

• La Taille est A4 (217 x 297 mm).

• L’Orientation est Paysage.

• Les Marges (millimètres) sont toutes fixées à 5.

Dans la fenêtre Composeur d’impression, rendez-vous à l’onglet Composition (sur le panneau de droite) et soyez
sûr que ces paramètres pour les Options du papier sont les mêmes que celles que vous avez définies pour
l’imprimante :

• Taille : A4 (210x297mm).

• Orientation : Paysage.

• Qualité : 300dpi.

La composition d’une carte est plus facile si vous utilisez la grille du canevas pour positionner les différentes
éléments. Revoyez les paramètres pour la grille du composeur :

• Dans l’onglet Composition étendez la région de la Grille.

• Vérifiez que l’Espacement est fixé à 10 mm.

• Et que la Tolérance est fixée à 2 mm.

Vous avez besoin d’activer l’utilisation de la grille :

• Ouvrez le menu Vue.

• Cochez Afficher la grille.

• Cochez Accrochage à la grille.

• Notez que les options pour l’utilisation des guides est cochée par défaut, ce qui vous permet de voir des
lignes rouges de guidage lorsque vous déplacez des éléments dans le composeur.

Vous pouvez maintenant commencer à ajouter des éléments à votre canevas de carte. Ajoutez d’abord un élément
de carte afin que vous puissiez vérifier à quoi ça ressemble lorsque vous serez en train de faire des changements
dans la symbologie des couches :

• Cliquez sur le bouton Ajouter une nouvelle carte : .

• Cliquez et faites glisser une zone sur le canevas de sorte que la carte occupe la majeure partie de celui-ci.
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Notez comment le curseur de la souris s’accroche à la grille du canevas. Utilisez cette fonction lorsque vous
ajoutez d’autres éléments. Si vous voulez avoir plus de précision, changer le paramètre d’Espacement de la grille.
Si pour quelque raison vous ne voulez pas accrocher à la grille à certains points, vous pouvez toujours cocher ou
décocher l’option dans le menu Vue.

15.6.2 Follow Along: Ajout d’une carte de fond

Laissez le composeur ouvert mais retournez à la carte. Ajoutons des données d’arrière-plan et créons un style de
sorte que le contenu de la carte soit aussi clair que possible.

• Ajoutez le raster de fond basic_map.tif que vous pouvez trouver dans le dossier
exercise_data\forestry\.

• Lorsque demandé, sélectionnez le SCR ETRS89 / ETRS-TM35FIN pour le raster.

Comme vous pouvez voir, la carte de fond a déjà un style. Ce type de raster cartographique prêt à l’emploi est très
courant. Il est créé à partir de données vectorielles, de style dans un format standard et enregistré comme raster,
de sorte que vous ne deviez pas créer plusieurs couches vectorielles et vous souciez d’obtenir un bon résultat.

• Zoomez maintenant sur vos parcelles d’échantillon, afin que vous puissiez voir seulement quatre ou cinq
lignes de parcelles.

Le style courant des parcelles d’échantillon n’est pas le meilleur, mais comment donne-t-il dans le composeur de
cartes ? :
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Alors que dans l’exercice précédent, le tampon blanc était OK sur l’image aérienne, mais maintenant que l’image
de fond est blanche, vous pouvez à peine voir les étiquettes. Vous pouvez aussi vérifier ce que cela donne dans le
composeur :

• Rendez-vous à la fenêtre Composeur d’impression.

• Utilisez le bouton pour sélectionner l’élément de carte dans le composeur.

• Rendez-vous à l’onglet Propriétés de l’objet.

• Sous Emprise, cliquez sur Fixer sur l’emprise courante de la carte.

• Si vous devez rafraîchir l’élément, sous Propriétés principales cliquez sur Mise à jour de l’aperçu.

Ce n’est de toute évidence pas suffisamment bon, vous voulez avoir des numéros de parcelle aussi visible que
possible pour les équipes de terrain.

15.6.3 Try Yourself Changement de la symbologie des couches

Vous avez travaillé la symbologie dans Module: Création d’une carte de base et l’étiquetage dans Module: Classer
des données vectorielles. Retournez à ces modules si vous avez besoin de quelques rappels sur certaines options
et les outils disponibles. Votre but est d’obtenir la localisation des parcelles et que leur nom soit visible aussi
clairement que possible, mais permettant toujours de voir les éléments de carte en arrière-plan. Vous pouvez
prendre une certaine direction de cette image :

366 Chapter 15. Module: Application forestière



QGIS Training Manual, Version 2.18

Vous utiliserez plus tard le style vert de la couche forest_stands_2012. Pour le garder, et pour avoir une
visualisation de ce qui ne montre que les bordures du massif :

• Faites un clic droit sur forest_stands_2012 et sélectionnez Dupliquer.

• vous avez une nouvelle couche nommée forest_stands_2012 copy que vous pouvez utiliser pour
définir un style différent, par exemple avec pas de remplissage et des bords rouges.

Vous avez maintenant deux visualisations différentes des massifs de forêt et vous pouvez décider lequel afficher
pour votre carte détaillée.

Retournez souvent à la fenêtre du Composeur d’impression pour voir à quoi la carte ressemble. Pour des fins de
création de cartes détaillées, vous cherchez une symbologie qui ne soit pas bonne à l’échelle de l’ensemble de la
zone forestière (image de gauche ci-dessous) mais à une échelle proche (image de droite ci-dessous). Souvenez-
vous d’utiliser Mise à jour de l’aperçu et Fixer sur l’emprise courante de la carte chaque fois que vous changez
le zoom dans votre carte ou dans le composeur.
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15.6.4 Try Yourself Créer un modèle de carte de base

Une fois que vous avez une symbologie avec laquelle vous êtes content, vous êtes prêt à ajouter plus d’informations
à votre carte imprimée. Ajoutez au moins les éléments suivants :

• Titre.

• Une barre d’échelle

• Cadre de la grille de votre carte.

• Coordonnées au niveau des côtés de la grille.

Vous avez déjà créé une composition similaire dans Module: Création de Cartes. Revenez à ce module autant que
vous en avez besoin. Vous pouvez regarder cet exemple d’image à titre de référence :

Exportez votre carte en tant qu’image et observez-la.

• Composeur → Exporter comme image.

• Utilisez par exemple le Format JPG.

C’est ce à quoi elle doit ressembler lorsqu’elle est imprimée.

15.6.5 Follow Along: Ajouter plus d’éléments au composeur

Comme vous l’avez probablement remarqué dans les images du modèle de carte suggéré, il y a beaucoup de place
sur le côté droit du canevas. Voyons ce qu’il pourrait encore aller là-bas. Pour les fins de notre carte, une légende
n’est pas vraiment nécessaire, mais un aperçu de la carte et des zones de textes pourraient être ajoutés à la carte.

L’aperçu de la carte aidera les équipes de terrain à placer la carte détaillée dans la zone forestière générale :

• Ajoutez un autre élément de carte au canevas, juste sous le texte du titre.

• Dans l’onglet Propriétés de l’objet, ouvrez le menu déroulant Aperçu.
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• Mettez le Cadre d’aperçu à Carte 0. Cela crée un rectangle d’ombre sur la plus petite carte représentant
l’étendue visible dans la plus grande carte.

• Vérifiez également l’option Cadre avec une couleur blanche et une Épaisseur de 0.30.

Notez que votre aperçu de carte ne donne pas vraiment un aperçu de la zone forestière qui est ce que vous voulez.
Vous voulez que cette carte représente l’entier de la zone forestière et vous voulez qu’elle ne montre que le fond
de la carte et la couche forest_stands_2012, et n’affiche pas les parcelles d’échantillon. Et vous voulez
également verrouiller sa vue afin que celle-ci ne change pas chaque fois que vous modifiez la visibilité ou l’ordre
des couches.

• Retournez à la carte, mais ne fermez pas le Composeur d’impression.

• Faites un clic-droit sur la couche forest_stands_2012 et cliquez sur Zoomer sur l’emprise de la
couche.

• Désactivez toutes les couches exceptées basic_map et forest_stands_2012.

• Retournez au Composeur d’impression.

• Avec la petite carte sélectionnée, cliquez sur Fixez sur l’emprise courante de la carte pour fixer son étendue
à ce que vous pouvez voir dans la fenêtre de la carte.

• Verrouillez la vue pour la carte d’aperçu en cochant Verrouiller les couches pour cette carte sous Propriétés
principales.

Votre carte d’aperçu est maintenant comme vous vous y attendiez et sa vue ne changera plus. Mais, bien sûr, votre
carte détaillée ne montre maintenant plus ni les bordures du massif ni les parcelles d’échantillon. Fixons-les :

• Rendez-vous à nouveau à la fenêtre de la carte et sélectionnez les couches que vous voulez visibles
(systematic_plots_clip, forest_stands_2012 copy et Basic_map).

• Zoomez à nouveau pour avoir seulement quelques lignes de parcelles d’échantillon visibles.

• Retournez à la fenêtre du Composeur d’impression.

• Sélectionnez la plus grande carte dans votre composeur ( ).
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• Dans les Propriétés de l’objet, cliquez sur Mise à jour de l’aperçu et :guilabel:‘Fixer sur l’emprise de la
carte.

Notez que seule la grande carte affiche la vue actuelle de la carte, et le petit aperçu conserve la même vue que
vous aviez lorsque vous l’avez verrouillé.

Notez également que l’aperçu montre un cadre ombragé pour le contenu affiché dans la carte détaillée.

Votre modèle de carte est presque prêt. Ajoutez maintenant deux zones de textes en-dessous de la carte, une
contenant le texte ‘Zone de la carte détaillée : ‘ et l’autre ‘Remarques : ‘. Placez-les comme vous pouvez le voir
dans l’image ci-dessous.

Vous pouvez également ajouter une flèche nord à la carte générale :

• Utilisez l’outil Ajouter une image, .

• Cliquez au niveau du coin supérieur droit de la carte générale.

• Dans les Propriétés de l’objet, ouvrez Rechercher dans les répertoires et recherchez une image de flèche.

• Sous Rotation de l’image, cochez Synchroniser avec la carte et sélectionnez Map 1 (la carte d’aperçu).

• Décochez Fond.

• Redimensionnez l’image de la flèche en une taille qui semble bien avec la petite carte.

Le composeur de la carte de base est prêt, vous voulez maintenant utiliser l’outil Atlas pour générer autant de
cartes détaillées dans ce format que vous jugez nécessaires.
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15.6.6 Follow Along: Création d’une couverture d’Atlas

La couverture d’Atlas est juste une couche vectorielle qui sera utilisée pour générer des cartes détaillées; une carte
pour chaque entité dans la couverture. Pour avoir une idée de ce que vous ferez par la suite, voici un ensemble
entier de cartes détaillées pour la zone forestière :

La couverture pourrait être n’importe quelle couche existante, mais il est en général plus logique d’en créer une
dans ce but spécifique. Créons une grille de polygones couvrant la zone forestière :

• Dans l’affichage de la carte de QGIS, ouvrez Vecteur → Outils de recherche → Grille vectorielle.

• Configurez l’outil comme montrée dans cette image :
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• Sauvegardez la sortie sous atlas_coverage.shp.

• Mettez un style à la nouvelle couche atlas_coverage afin que les polygones n’aient pas de remplissage.

Les nouveaux polygones recouvrent l’étendue de la forêt et ils vous donnent une idée du contenu de chaque carte
(créée à partir de chaque polygone).
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15.6.7 Follow Along: Configuration de l’outil Atlas

La dernière étape est la configuration de l’outil Atlas :

• Retournez au Composeur d’impression.

• Dans le panneau sur la droite, rendez-vous à l’onglet Génération d’Atlas.

• Mettez les options comme suit :
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Cela dit à l’outil Atlas d’utiliser les entités (polygones) dans atlas_coverage comme le foyer de chaque carte
détaillée. Cela va créer une carte pour chaque entité dans la couche. La Couche de couverture cachée dit à l’Atlas
de ne pas montrer les polygones dans les cartes de sortie.

Une chose doit encore être faite. Vous devez dire à l’outil Atlas quel élément de carte doit être mis à jour pour
chaque carte de sortie. À présent, vous pouvez probablement deviner que la carte qui doit changer pour chaque
entité est celle que vous avez préparé pour contenir les vues détaillées des parcelles d’échantillon, qui est la plus
grande carte dans votre canevas :

• Sélectionnez la plus grande carte.

• Rendez-vous à l’onglet Propriétés de l’objet.

• Dans la liste, cochez Contrôlé par l’atlas.

• Et mettez les Marges autour des entités à 10%. L’étendue de la vue sera 10% plus grande que les polygones,
ce qui signifie que vos cartes détaillées auront un chevauchement de 10%.
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Vous pouvez maintenant utiliser l’outil de prévisualisation pour les cartes d’Atlas pour voir à quoi vos cartes
ressembleront :

• Activez les prévisualisations de l’Atlas en utilisant le bouton ou si votre barre d’outil Atlas n’est pas
visible, via Atlas → Aperçu de l’Atlas.

• Vous pouvez utiliser les flèches dans la barre d’outils Atlas ou dans le menu Atlas pour se déplacer à travers
les cartes qui seront créées.

Notez que certaines d’entre elles couvrent des zones qui ne sont pas intéressantes. Faisons quelque chose par
rapport à ça et sauvegardons quelques arbres en n’imprimant pas ces cartes inutiles.

15.6.8 Follow Along: Édition de la couche de couverture

Outre la suppression des polygones pour ces zones qui ne sont pas intéressantes, vous pouvez aussi personnaliser
les étiquettes de texte dans votre carte à générer avec le contenu de la Table attributaire de votre couche de
couverture :
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• Retournez à l’affichage de la carte.

• Activez l’édition pour la couche atlas_coverage.

• Sélectionnez les polygones qui sont sélectionnés (en jaune) dans l’image ci-dessous.

• Retirez les polygones sélectionnés.

• Désactivez l’édition et sauvegardez les modifications.

Vous pouvez retourner au Composeur d’impression et vérifiez que les aperçus de l’Atlas n’utilisent que les poly-
gones que vous avez laissés dans la couche.

La couche de couverture que vous utilisez ne dispose pas encore d’informations utiles que vous pouvez utiliser
pour personnaliser le contenu des étiquettes de votre carte. La première étape est de les créer, vous pouvez ajouter
par exemple un code de zone pour les aires de polygones et un champ avec quelques remarques pour les équipes
de terrain à prendre en compte.

• Ouvrez la Table attributaire pour la couche atlas_coverage.

• Activez l’édition.

• Utilisez la calculatrice pour créer et compléter les deux champs suivants.

• Créez un champ nommé Zone et de type Nombre entier (entier).
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• Dans la boîte Expression écrivez/copiez/construisez $rownum.

• Créez un autre champ nommé Remarques, de type Texte (chaîne de caractères) et d’une
largeur de 255.

• Dans la boîte Expression écrivez ’Pas de remarque.’. Cela va mettre cette valeur par défaut pour
tous les polygones.

Le gestionnaire de forêt aura des informations sur les zones qui peuvent être utiles lors des visites des
zones. Par exemple, l’existence d’un point, d’un marais ou l’emplacement d’espèces protégées. La couche
atlas_coverage est probablement encore en mode d’édition, ajoutez le texte suivant dans le champ
Remarques aux polygones correspondants (double-cliquez sur les cellules pour les modifier) :

• Pour la Zone 2:, Pont vers la Nord de la parcelle 19. Écureuils de Sibérie
entre p_13 et p_14..

• Pour la Zone 6:, Difficultés de transit dans les marais au Nord du lac..

• Pour la Zone 7:, Écureuils de Sibérie au Sud-Est de p_94..

• Désactivez l’édition et sauvegardez vos modifications.

Presque prêt, vous devez maintenant dire à l’outil Atlas que vous voulez que certaines des étiquettes de texte
utilisent les informations de la table attributaire de la couche atlas_coverage.

• Retournez au Composeur d’impression.

• Sélectionnez l’étiquette de texte contenant Carte détaillée....

• Mettez la taille de Police à 12.

• Mettez le curseur à la fin du texte dans l’étiquette.

• Dans l’onglet Propriétés de l’objet, dans les Propriétés principales, cliquez sur Insérer une expression.

• Dans la Liste des fonctions, double-cliquez sur le champ Zone sous Champ et Valeurs.

• Cliquez sur OK.

• Le texte à l’intérieur de la boîte dans les Propriétés de l’objet devrait montrer Carte détaillée de
la zone d’inventaire : [% "Zone" %]. Notez que [% "Zone" %] sera remplacé par la
valeur du champ Zone pour l’entité correspondante de atlas_coverage.

Testez les contenus des étiquettes en regardant les différents aperçus des cartes de l’Atlas.

Faites de même pour les étiquettes avec le texte Remarques : utilisant le champ avec l’information de zone.
Vous pouvez laisser une ligne vide avant d’entrer l’expression. Vous pouvez voir le résultat avec l’aperçu de la
zone 2 dans l’image ci-dessous :
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Utilisez l’aperçu de l’Atlas pour naviguer à travers toutes les cartes que vous créerez bientôt et appréciez !

15.6.9 Follow Along: Impression de cartes

Enfin et surtout, imprimer ou exporter vos carte en fichiers image ou PDF. Vous pouvez utiliser Atlas → Exporter
l’Atlas en tant qu’image... ou Atlas → Exporter l’Atlas au format PDF.... Actuellement, le format d’exportation
SVG ne fonctionne pas correctement et donnera un mauvais résultat.

Imprimons les cartes dans un seul PDF que vous pouvez envoyer au bureau des équipes de terrain pour impression
:

• Rendez-vous à l’onglet Génération d’Atlas sur le panneau de droite.

• Sous la Sortie, cochez Export d’un seul fichier, si possible. Cela mettra toutes les cartes ensemble dans un
fichier PDF, si cette option n’est pas cochée, vous aurez un fichier pour chaque carte.

• Ouvrez Composeur → Exporter au format PDF....

• Sauvegardez le fichier PDF comme inventory_2012_maps.pdf dans votre dossier
exercise_data\forestry\samplig\map_creation\.

Ouvrez le fichier PDF pour vérifier que tout est conforme à ce à que vous vous attendiez.

Vous pourriez tout aussi facilement créer des images séparées pour chaque carte (souvenez-vous de décochez la
création de fichier unique), ici vous pouvez voir les miniatures des images qui seront créées.
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Dans le Composeur d’impression, sauvegardez votre carte comme un modèle de composition sous
forestry_atlas.qpt dans votre dossier exercise_data\forestry\map_creation\. Utilisez
Composeur → Sauvegarder le modèle. Vous pourrez utiliser ce modèle encore et encore.

Fermez le Composeur d’impression et sauvegardez votre projet QGIS.

15.6.10 In Conclusion

Vous avez réussi à créer un modèle de carte qui peut être utilisé pour générer automatiquement des cartes détaillées
qui seront utilisées sur le terrain comme aide à la navigation vers les différentes parcelles. Comme vous l’avez
remarqué, ce n’était pas une tâche facile, mais le bénéfice viendra lorsque vous aurez besoin de créer des cartes
similaires pour d’autres régions et vous pourrez utiliser le modèle que vous venez de sauvegarder.

15.6.11 What’s Next?

Dans la prochaine leçon, vous verrez comment vous pouvez utiliser des données LiDAR pour créer un MNE et
ensuite l’utiliser pour améliorer vos données et la visibilité de vos cartes.

15.7 Lesson: Calcul des paramètres forestiers

L’estimation des paramètres de la forêt est le but de l’inventaire de la forêt. En continuant l’exemple de la
leçon précédente, vous utiliserez les informations d’inventaire récoltées sur le terrain pour calculer les paramètres
forestiers, d’abord pour l’entier de la forêt, et ensuite pour les parcelles que vous avez précédemment numérisées.

Objectif de cette leçon : Calculer des paramètres forestiers à un niveau général et à un niveau de massif forestier.

15.7.1 Follow Along: Ajout des résultats de l’inventaire

Les équipes de terrain ont visité la forêt et, avec l’aide des informations fournies, récolté des informations sur la
forêt à chaque parcelle d’échantillon.

Le plus souvent, l’information sera recueillie dans des formulaires papiers sur le terrain, puis reportée dans un
tableur. L’information des parcelles d’échantillon a été condensée dans un fichier .csv qui peut facilement être
ouvert dans QGIS.

Continuez avec le projet QGIS de la leçon sur la conception de l’inventaire, vous l’avez probablement nommé
forest_inventory.qgs.

Premièrement, ajoutez les mesures des parcelles d’échantillon à votre projet QGIS :
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• Rendez-vous à Couche → Ajouter une couche de texte délimité....

• Naviguez jusqu’au fichier systematic_inventory_results.csv situé dans
exercise_data\forestry\results\.

• Soyez sûr que l’option Coordonnées de point est cochée.

• Définissez les champs pour les coordonnées avec les champs X and Y.

• Cliquez sur OK.

• Quand demandé, sélectionnez ETRS89 / ETRS-TM35FIN comme SCR.

• Ouvrez la Table attributaire de la nouvelle couche et regardez les données.

Vous pouvez lire le type de données qui est contenu dans les mesures des parcelles d’échantillon dans le fichier
texte legend_2012_inventorydata.txt dans le dossier exercise_data\forestry\results\.

La couche systematic_inventory_results que vous venez d’ajouter est actuellement juste une représen-
tation virtuelle de l’information de texte dans le fichier .csv. Avant que vous ne continuiez, convertissez les
résultats de l’inventaire en un véritable shapefile :

• Faites un clic-droit sur la couche systematic_inventory_results.

• Naviguez jusqu’au dossier exercise_data\forestry\results\.

• Nommez le fichier sample_plots_results.shp.

• Cochez Ajouter les fichiers sauvegardés à la carte.

• Enlevez la couche systematic_inventory_results de votre projet.

15.7.2 Follow Along: Estimation des paramètres de la forêt entière

Vous pouvez calculer les moyennes pour l’ensemble de cette zone forestière à partir des résultats de l’inventaire
pour les quelques paramètres intéressants, comme le volume et le nombre de troncs par hectares. Comme les par-
celles d’échantillon systématiques représentent des aires égales, vous pouvez directement calculer les moyennes
des volumes et nombres de troncs par hectares de la couche sample_plots_results.

Vous pouvez calculer la moyenne d’un champ dans une couche vectorielle en utilisant l’outil Statistiques basiques
:

• Ouvrez Vecteur → Outils d’analyse → Statistiques basiques.

• Sélectionnez sample_plots_results comme Couche vectorielle de saisie.

• Sélectionnez Vol come Champ ciblé.

• Cliquez sur OK.

Le volume moyen dans la forêt est de 135.2 m3/ha.

Vous pouvez calculer la moyenne pour le nombre de troncs de la même façon, 2745 troncs/ha.

380 Chapter 15. Module: Application forestière



QGIS Training Manual, Version 2.18

15.7.3 Follow Along: Estimation des paramètres d’un massif

Vous pouvez faire usage de ces mêmes parcelles d’échantillon systématiques pour calculer des estimations pour
les différentes parcelles de forêt que vous avez numérisées précédemment. Certains des massifs forestiers n’ont
pas reçu de parcelles d’échantillon et pour ceux-ci, vous ne recevrez pas d’information. Vous pourriez avoir
planifié des parcelles d’échantillon supplémentaires lorsque vous avez panifié l’inventaire systématique, de sorte
que les équipes de terrain auront mesuré quelques parcelles d’échantillon supplémentaires à cette fin. Ou vous
pourriez envoyer une équipe de terrain plus tard pour obtenir des estimations des massifs de forêt manquants pour
compléter l’inventaire du massif. Néanmoins, vous obtiendrez des informations pour un bon nombre de massifs
juste en utilisant les parcelles planifiées.

Ce dont vous avez besoin est d’obtenir les moyennes des parcelles d’échantillon qui tombent dans chacun des
massifs de forêt. Si vous souhaitez combiner de l’information basée sur leurs emplacements relatifs, vous effectuez
une jointure spatiale :

• Ouvrez l’outil Vecteur → Gestion de données → Joindre les attributs par localisation.

• Mettez forest_stands_2012 sous Indiquer une couche vecteur. La couche pour laquelle vous voulez
les résultats.

• Mettez sample_plots_results sous Joindre la couche vecteur. La couche depuis laquelle vous
voulez calculer des estimations.

• Cochez Prendre un résumé des entités intersectées.

• Vérifiez que vous ne calculez que la Moyenne.

• Nommez le résultat forest_stands_2012_results.shp et sauvegardez-le dans le dossier
exercise_data\forestry\results\.

• Finalement, sélectionnez Conservez tous les enregistrements..., afin que vous puissiez vérifier plus tard quels
massifs n’a pas reçu d’information.

• Cliquez sur OK.

• Accepter d’ajouter la nouvelle couche à votre projet quand demandé.

• Fermez l’outil Joindre les attributs par localisation.

Ouvrez la Table attributaire pour forest_stands_2012_results et examinez les résultats que vous avez
obtenus. Notez qu’un certain nombre de massifs de forêt ont NULL comme valeur de calcul, ce sont ceux qui
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n’ont pas de parcelles d’échantillon. Sélectionnez-les tous et examinez-les dans la carte, ce sont quelques uns des
plus petits stands :

Calculons maintenant les même moyennes pour l’ensemble de la forêt comme vous l’avez fait avant, seulement
cette fois vous utiliserez les moyennes que vous avez obtenues pour les massifs comme base pour le calcul.
Souvenez-vous que dans la situation précédente, chaque parcelle d’échantillon représentait un massif théorique de
80x80 m. Maintenant, vous devez à la place considérer individuellement l’aire de chacun des massifs. De cette
façon, encore une fois, les valeurs moyennes des paramètres qui sont par exemple en m3/ha pour les volumes sont
converties en volumes totaux pour les massifs.

Vous devez d’abord calculer les aires pour les massifs et ensuite calculez les volumes totaux et les nombres de
troncs pour chacun d’entre eux :

• Dans la Table d’attributs, activez l’édition.
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• Ouvrez la Calculatrice de champ.

• Créez un nouveau champ appelé area.

• Laissez le Type à Nombre décimal (réel).

• Mettez la Précision à 2.

• Dans la boîte Expression, écrivez write $area / 10000. Cela va calculer l’aire des massifs de forêt en
ha.

• Cliquez sur OK.

Maintenant calculez un champ avec les volumes totaux et les nombres de troncs estimés pour chaque massif :

• Nommez les champs s_vol et s_stem.

• Les champs peuvent être des nombres entiers ou vous pouvez aussi utiliser des nombres décimaux.

• Utilisez les expressions "area" * "MEANVol" et "area" * "MEANStems" respectivement pour
les volumes totaux et le nombre de troncs

• Sauvegardez les modifications lorsque vous avez fini.

• Désactivez l’édition.

Dans la situation précédente, les aires représentées par chaque parcelles d’échantillon étaient les mêmes, ainsi il
était suffisant de calculer la moyenne des parcelles d’échantillon. Maintenant, pour calculer les estimations, vous
devez divisez la somme des volumes de massifs ou nombre de troncs par la somme des aires des massifs contenant
l’information.

• Sélectionnez tous les éléments contenant de l’information dans la Table d’attributs de la couche
forest_stands_2012_results.

• Ouvrez Vecteur → Outils d’analyse → Statistiques basiques.

• Sélectionnez forest_stands_2012_results comme Couche vectorielle de saisie.

• Sélectionnez area comme Champ ciblé.

• Cochez Utiliser uniquement les valeur sélectionnées.

• Cliquez sur OK.
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Comme vous pouvez le voir, la somme totale des aires des massifs est de 66.04 ha. Notez que l’aire des massifs
de forêt manquants est seulement d’environ 7 ha.

De la même façon, vous pouvez calculer que le volume total pour ces massifs est de 8908 m3/ha et le nombre
total de troncs est de 179594 troncs.

L’utilisation d’information provenant des massifs de forêt, plutôt que celle provenant directement des parcelles
d’échantillon, donne les estimations suivantes de moyenne :

• 184.9 m3/ha et

• 2719 troncs/ha.

Sauvegardez votre projet QGIS, forest_inventory.qgs.

15.7.4 In Conclusion

Vous avez réussi à calculer des estimations de forêt pour l’ensemble de la forêt en utilisant l’information de vos
parcelles d’échantillonnage systématique, premièrement sans considérer les caractéristiques forestières et aussi en
utilisant l’interprétation de l’image aérienne des massifs de forêt. Et vous avez également obtenu de l’information
précieuse sur les massifs particuliers, qui pourrait être utilisée pour planifier la gestion de la forêt dans les années
à venir.
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15.7.5 What’s Next?

Dans la leçon suivante, vous allez d’abord créer un fond ombragé depuis un jeu de données LiDAR que vous
utiliserez pour préparer une carte de présentation avec les résultats de la forêt que vous venez de calculer.

15.8 Lesson: MNE à partir de données LiDAR

Vous pouvez améliorer l’allure de vos cartes en utilisant différentes images de fond. Vous pourriez utiliser la carte
de base ou l’image aérienne que vous avez utilisées avant, mais un raster d’ombrage du terrain sera plus joli dans
certaines situations.

Vous utiliserez LAStools pour extraire un MNE depuis un jeu de données LiDAR et ensuite créerez un raster
d’ombrage pour l’utiliser dans votre carte de présentation plus tard.

Objectif de cette leçon : Installer LAStools et calculer un MNE depuis des données LiDAR et un raster
d’ombrage.

15.8.1 Follow Along: Installation de Lastools

La gestion de données LiDAR dans QGIS est possible en utilisant le Module de Traitements et les algorithmes
fournis par LAStools.

Vous pouvez obtenir un modèle numérique d’élévation (MNE) à partir d’un nuage de points LiDAR et ensuite
créer un raster d’ombrage qui est visuellement plus intuitif à des fins de présentation. Premièrement, vous devrez
configurez les paramètres du Traitements pour fonctionner correctement avec LAStools :

• Fermez QGIS, si vous l’aviez déjà démarré.

• Une ancienne extension lidar devrait être installée par défaut sur votre système dans le dossier
C:/Program Files/QGIS Valmiera/apps/qgis/python/plugins/processing/.

• Si vous avez un dossier nommé lidar, supprimez-le. Ceci est valable pour les installations de QGIS 2.2
et 2.4.
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• Rendez-vous au dossier exercise_data\forestry\lidar\, vous pouvez y trouver le fichier
QGIS_2_2_toolbox.zip. Ouvrez-le et extrayez le dossier lidar pour remplacer celui que vous venez
de supprimer.

• Si vous utilisez une autre version de QGIS, vous pouvez avoir plus d’informations et d’instructions dans ce
tutorial.

Vous devez maintenant installer LAStools sur votre ordinateur. Obtenez la nouvelle version ici et extrayez le
contenu du fichier lastools.zip dans un dossier dans votre système, par exemple, c:\lastools\. Le
chemin vers le dossier lastools ne doit pas avoir d’espace ou de caractères spéciaux.

Note: Lisez le fichier LICENSE.txt dans le dossier lastools. Certains des LAStools sont open-source
et d’autres sont à code source fermé et nécessitent une licence pour la plupart des utilisations commerciales et
gouvernementales. À des fins d’éducation et d’évaluation, vous pouvez utiliser et tester autant de LAStools que
vous en avez besoin.

L’extension et les algorithmes actuels sont maintenant installés sur votre ordinateur et bien que prêt à être utilisés,
vous devez juste configurez le Module de Traitements pour commencer à les utiliser :

• Ouvrez un nouveau projet dans QGIS.

• Mettez le SCR du projet en ETRS89 / ETRS-TM35FIN.

• Sauvegardez le projet sous forest_lidar.qgs.

To setup the LAStools in QGIS:

• Rendez-vous à Traitements → Options et configuration.

• Dans la boîte de dialogue Options de traitements, rendez-vous à Prestataires et ensuite à Outils pour don-
nées LiDAR.
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• Cochez Activer.

• Pour le dossier LAStools, mettez c:\lastools\ (ou le dossier que vous avez extrait de LAStools).

15.8.2 Follow Along: Calcul d’un MNE avec LAStools

Vous avez déjà utilisé la boîte à outils Traitements dans Lesson: Statistiques Spatiales pour faire tourner des
algorithmes SAGA. Vous allez maintenant l’utiliser pour faire tourner des programmes LAStools :

• Ouvrez Traitement → Boîte à outils.

• En haut dans le menu déroulant, sélectionnez Interface avancée.

• Vous devriez voir la catégorie Outils pour données LiDAR.

15.8. Lesson: MNE à partir de données LiDAR 387



QGIS Training Manual, Version 2.18

• Déroulez-le pour voir les outils disponibles, et déroulez aussi la catégorie LAStools (le nombre des algo-
rithmes peut varier).

• Faites défiler jusqu’à ce que vous trouviez l’algorithme lasview, double-cliquez dessus pour l’ouvrir.

• Dans le fichier source LAS/LAZ, parcourez jusqu’à exercise_data\forestry\lidar\ et sélection-
nez le fichier rautjarvi_lidar.laz.
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• Cliquez sur Exécuter.

Vous pouvez maintenant visualiser les données LiDAR dans la fenêtre de dialogue Visualisateur LAS et LAZ:

De nombreuses choses peuvent être faîtes dans ce visualiseur mais pour le moment, vous pouvez cliquer et vous
déplacer sur le nuage de points LiDAR pour voir à quoi il ressemble.

Note: Si vous voulez savoir plus en détail comment les LAStools fonctionnent, vous pouvez lire les fichiers texte
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README sur chacun de ces outils, dans le dossier C:\lastools\bin\. Des tutoriels et autres matériels sont
disponibles sur la page internet Rapidlasso.

• Fermez le visualiseur lorsque vous avez fini.

La création d’un MNE avec LAStools peut être faite en deux étapes, premièrement en classant le nuage de points
en points de contrôle et pas de contrôle et ensuite en calculant un MNE en utilisant seulement les
points de contrôle.

• Retournez vers la Boîte à outils de traitements.

• Remarquez la boîte Recherche..., écrivez lasground.

• Double-cliquez pour ouvrir l’outil lasground et configurez-le comme montré dans cette image :

• Le fichier de sortie est sauvegardé dans le même dossier où se trouve rautjarvi_lidar.laz et il se
nomme rautjarvi_lidar_1.las.

Vous pouvez l’ouvrir avec lasview si vous voulez le contrôler.
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Les points bruns sont les points classés comme de contrôle et les gris représentent le reste, vous pouvez cliquez
sur la lettre g pour ne visualiser que les points de contrôle ou la lettre u pour voir seulement les points non classés.
Cliquez sur la lettre a pour voir à nouveau tous les points. Consultez le fichier lasview_README.txt pour
plus de commandes. Si vous êtes intéressées, ce tutoriel vous montrera également différentes opérations dans le
visualiseur.

• Fermez à nouveau le visualiseur.

• Dans la Boîte à outils de traitements, cherchez las2dem.

• Ouvrez l’outil las2dem et configurez-le comme montré dans cette image :
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Le résultat MNE est ajouté à votre carte avec le nom générique Fichier raster de sortie.

Note: Les outils lasground et las2dem nécessitent une licence. Vous pouvez utiliser l’outil sans licence, comme
indiqué dans le fichier de licence, mais vous obtiendrez les diagonales que vous pouvez observer dans l’image des
résultats.

15.8.3 Follow Along: Création d’un ombrage de terrain

À des fins de visualisation, un ombrage généré à partir d’un MNE donne une meilleure visualisation du terrain :

• Ouvrez Raster → Analyse de terrain → Ombrage.

• Comme Couche de sortie, naviguez jusqu’à exercise_data\forestry\lidar\ et nommez le
fichier hillshade.tif.

• Laissez la configuration par défaut pour le reste des paramètres.
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• Sélectionnez ETRS89 / ETRS-TM35FIN comme SCR quand demandé.

Malgré les lignes diagonales qui restent dans le résultat raster d’ombrage, vous pouvez voir clairement un relief
précis de la zone. Vous pouvez même voir les différentes canalisations du sol qui ont été creusées dans les forêts.
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15.8.4 In Conclusion

L’utilisation de données LiDAR pour obtenir un MNE, spécialement dans les zones forestières, donne de bons
résultats sans beaucoup d’efforts. Vous pourriez aussi utiliser des MNE déjà prêts dérivés de LiDAR ou d’autres
sources comme les résolutions SRTM 9m MNE. Quoi qu’il en soit, vous pouvez les utiliser pour créer un raster
d’ombrage à utiliser dans vos cartes de présentation.

15.8.5 What’s Next?

Dans la prochaine leçon, et dernière étape de ce module, vous utiliserez le raster d’ombrage et les résultats de
l’inventaire forestier pour créer une carte de présentation des résultats.

15.9 Lesson: Carte de présentation

Dans la leçon précédente, vous avez importé un ancien inventaire forestier comme projet SIG, l’avez mis à jour
avec la situation actuelle, conçu un inventaire forestier, créé des cartes pour l’équipe de terrain et calculé des
paramètres forestiers à partir des mesures de terrain.

Il est souvent important de créer des cartes avec les résultats d’un projet SIG. Une carte présentant les résultats de
l’inventaire de forêt sera plus facilement créée si l’auteur a une bonne idée de ce que les résultats représentent en
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jetant un rapide coup d’oeil, sans devoir regarder les chiffres précis.

Objectif de cette leçon : Créer une carte présentant les résultats de l’inventaire en utilisant un raster d’ombrage
comme fond.

15.9.1 Follow Along: Préparation des données de la carte

Ouvrez le projet QGIS de la leçon sur les paramètres de calcul, forest_inventory.qgs. Gardez au moins
les couches suivantes :

• forest_stands_2012_results.

• basic_map.

• rautjarvi_aerial.

• lakes (si vous ne l’avez pas, ajoutez-la depuis le dossier exercise_data\forestry\).

Vous allez présenter les volumes moyens de vos massifs de forêts dans une carte. Si vous ouvrez la Table attribu-
taire pour la couche forest_stands_2012_results, vous pouvez voir les valeurs NULL pour les massifs
sans information. Pour pouvoir aussi obtenir ces massifs dans votre style, vous devez changer les valeurs NULL
en, par exemple, -999, sachant que ces nombres négatifs signifient qu’il n’y a pas de données pour ces polygones.

Pour la couche forest_stands_2012_results :

• Ouvrez la Table attributaire et activez l’édition.

• Sélectionnez les polygones avec les valeurs NULL.

• Utilisez la calculatrice pour mettre à jour les valeurs du champ MEANVol à -999 seulement pour les entités
sélectionnées.

• Désactivez l’édition et sauvegardez les modifications.

Vous pouvez maintenant utiliser un style sauvegardé pour cette couche :

• Rendez-vous à l’onglet Style.

• Cliquez sur Charger le Style.

• Sélectionnez forest_stands_2012_results.qml depuis le dossier
exercise_data\forestry\results\.

• Cliquez sur OK.
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Votre carte ressemblera à quelque chose comme ça :
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15.9.2 Try Yourself Essayer différents modes de fusion

Le style que vous avez chargé :
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utilise le mode Hard light de l’option Mode de mélange des couches. Veuillez noter que les différents modes
appliquent des filtres différents combinant les couches en dessous et au dessus. Dans notre cas, le raster d’ombrage
et les emplacements forestiers sont utilisés. Vous pouvez en lire davantage sur ces modes dans le Guide Utilisateur.

Essayez avec différents modes et voyez les différences dans votre carte. Puis choisissez celui que vous préférez
pour votre carte finale.

15.9.3 Try Yourself Utilisation d’un modèle de composition pour créer la
carte de résultat

Utilisez un modèle préparé à l’avance pour présenter les résultats. Le modèle forest_map.qpt se trouve dans
le dossier exercise_data\forestry\results\. Chargez-le en utilisant la boîte de dialogue Projet →
Gestionnaire de composition....
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Ouvrez le gestionnaire de carte et modifiez la carte finale pour obtenir un résultat qui vous satisfasse.

Le modèle de carte que vous utilisez vous donnera une carte similaire à celle-là :
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Sauvegardez votre projet QGIS pour des références futures.
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15.9.4 In Conclusion

Dans ce module, vous avez vu comment un inventaire forestier de base peut être planifié et présenté avec QGIS.
Beaucoup d’autres analyses forestières sont possibles avec la variété d’outils auxquels vous avez accès, mais nous
espérons que ce manuel vous a donné un bon point de départ pour explorer la façon dont vous pouvez obtenir les
résultats que vous voulez.
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CHAPTER 16

Module: Concepts de bases de données avec PostgreSQL

Les bases de données relationnelles sont une part importante de tout système d’information géographique. Dans
ce module, vous aborderez les concepts de Système de Gestion de Bases de Données Relationnelles (SGBDR) et
utiliserez PostgreSQL pour créer une nouvelle base de données afin de stocker de la donnée mais aussi d’apprendre
les fonctions spécifiques du SGBDR.

16.1 Lesson: Introduction aux Bases de Données

Avant d’utiliser PostgreSQL, assurons-nous de consolider nos fondations en abordant la théorie générale de bases
de données. Vous n’aurez besoin d’entrer aucun des codes en exemple; ils ne servent qu’à des fins d’illustration.

Objectif de cette leçon: Comprendre les concepts fondamentaux des Bases de Données

16.1.1 Qu’est-ce qu’une Base de Données?

Une base de données consiste en un ensemble organisé de données destinées à une ou plusieurs utilisations,
généralement sous format numérique. - Wikipedia

Un Système de Gestion de Base de Données (SGBD) se compose d’un logiciel qui exploite des bases de données,
gère le stockage, l’accès, la sécurité, la sauvegarde/restauration et autres fonctionnalités. - Wikipedia

16.1.2 Tables

Dans les bases de données relationnelles et à plat, une table est un jeu de données (valeurs) qui est organisé
en utilisant un modèle de colonnes verticales (qui sont identifiées par leur nom) et de lignes horizontales. Une
table contient un nombre spécifique de colonnes mais elle peut avoir autant de lignes qu’il faut. Chaque ligne
est identifiée par des valeurs qui apparaissent dans un colonne particulière qui est identifiée comme une clef. -
Wikipedia

id | name | age
----+-------+-----

1 | Tim | 20
2 | Horst | 88

(2 rows)

Dans une base de données SQL, une table est aussi appelée relation.

16.1.3 Colonnes / Champs

Une colonne est un jeu de valeur d’un type particulier, pour une valeur par ligne. Les colonnes fournissent la
structure qui permet de composer les lignes. Le terme champ est souvent utilisé pour nommer la colonne même
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si certains considère qu’il est plus correct d’employer le mot champ (ou valeur de champ) pour se référer à un
élément spécifique qui est présent à l’intersection entre une ligne et une colonne. - Wikipedia

Une colonne:

| name |
+-------+
| Tim |
| Horst |

Un champ:

| Horst |

16.1.4 Enregistrements

Un enregistrement est une information stockée dans une ligne d’une table. Chaque enregistrement aura un champ
pour chacune des colonnes de la table.

2 | Horst | 88 <-- one record

16.1.5 Types de Données

Les Types de données restreignent le genre d’informations pouvant être stockées dans une colonne. - Tim and
Horst

Il existe différents type de données. Voyons les plus fréquents:

• String - to store free-form text data

• Integer - to store whole numbers

• Real - to store decimal numbers

• Date - pour stocker l’anniversaire de Horst afin que personne n’oublie

• Boolean - to store simple true/false values

You can tell the database to allow you to also store nothing in a field. If there is nothing in a field, then the field
content is referred to as a ‘null’ value:

insert into person (age) values (40);

select * from person;

Result:

id | name | age
---+-------+-----
1 | Tim | 20
2 | Horst | 88
4 | | 40 <-- null for name

(3 rows)

Il existe beaucoup plus de types de données utilisables - Lisez le manuel de PostgreSQL!

16.1.6 Modéliser une base de données adresse

Etudions un cas simple pour voir comment est construite une base de données. Nous allons créer une base de
données adresse.
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Try Yourself

Ecrivez les propriétés qui composent une adresse et que vous voulez stocker dans la base.

Vérifiez vos résultats

Structure d’une adresse

Les propriétés qui décrivent une adresse sont les colonnes. Le type d’information stockée dans chaque colonne est
un type de données. Dans la section qui suit, nous analyserons notre table d’adresse pour voir comment l’améliorer
!

16.1.7 Théorie de base de données

Le processus de création d’une base de données implique la création d’un modèle basé sur le monde réel: prendre
les concepts du monde réel et les représenter dans une base de données en tant qu’entités.

16.1.8 Normalisation

Une des idées principales dans une base de données consiste à éviter la duplication/redondance de données. Le
processus de suppression de la redondance dans une base de données s’appelle Normalisation.

La normalisation est une méthode systémique qui permet de s’assurer que la structure de base de données est
adaptée aux requêtes génériques et qu’elle est débarassée de certaines caractéristiques non désirées liées aux
anomalies lors d’insertion, de mise à jour ou de suppression qui peuvent engendrer une perte d’intégrité des
données. - Wikipedia

Il existe différents types de normalisation.

Let’s take a look at a simple example:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
---+---------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Imaginez que vous avez beaucoup d’amis avec le même nom de rue ou de ville. Chaque fois que ces données sont
dupliquées, elles consomment de l’espace. Pire encore, si un nom de ville change, vous devrez effectuer beaucoup
de travail pour mettre à jour votre base de données.
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16.1.9 Try Yourself

Reconstruisez la structure théorique de la table people ci-dessus pour réduire la duplication d’information et
normaliser la structure de données.

Vous pouvez en lire plus sur la normalisation des bases de données ici

Vérifiez vos résultats

16.1.10 Index

Un index de base de données est un lot de données destiné à accélérer les opérations de recherche de données. -
Wikipedia

Imagine you are reading a textbook and looking for the explanation of a concept - and the textbook has no index!
You will have to start reading at one cover and work your way through the entire book until you find the information
you need. The index at the back of a book helps you to jump quickly to the page with the relevant information:

create index person_name_idx on people (name);

Now searches on name will be faster:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

16.1.11 Séquences

Une séquence est un générateur de nombre unique. Il est normalement utilisé pour créer un identifiant unique pour
une colonne d’une table.

In this example, id is a sequence - the number is incremented each time a record is added to the table:

id | name | address | phone_no
---+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

16.1.12 Diagramme Entité-Relation

In a normalised database, you typically have many relations (tables). The entity-relationship diagram (ER Dia-
gram) is used to design the logical dependencies between the relations. Consider our non-normalised people table
from earlier in the lesson:

select * from people;

id | name | address | phone_no
----+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
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2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122
(2 rows)

With a little work we can split it into two tables, removing the need to repeat the street name for individuals who
live in the same street:

select * from streets;

id | name
----+--------------
1 | Plein Street

(1 row)

and:

select * from people;

id | name | house_no | street_id | phone_no
----+--------------+----------+-----------+-------------

1 | Horst Duster | 4 | 1 | 072 121 122
(1 row)

Nous pouvons ensuite lier les deux tables en utilisant les clefs ‘keys’ streets.id et people.streets_id.

Si nous dessinons un Diagramme entité-association pour ces tables, il devrait ressembler à ce qui suit:

Le diagramme entité-association nous aide à exprimer les relations ‘un à plusieurs’. Dans ce cas, le symbole de
flèche nous montre qu’une rue peut avoir plusieurs personnes qui vivent dedans.

Try Yourself

Notre modèle de table people a encore des problèmes de normalisation. Essayez de les identifier et de les corriger
à l’aide d’un diagramme entité-association.

Vérifiez vos résultats

16.1.13 Contraintes, Clés Primaires et Clés Etrangères

Une contrainte de base de données est utilisée pour s’assurer que les données d’une relation correspondent à la
vision du modélisateur sur le stockage de l’information. Par exemple, un contrainte sur le code postal permet de
s’assurer que le nombre sera bien compris entre 1000 et 9999.

Une clef primaire est une ou plusieurs valeurs de champ qui identifie un enregistrement unique. En générale, la
clef primaire est appelé identifiant et elle correspond à une séquence.

Une clef étrangère est utilisée pour se référer à un enregistrement unique d’une autre table (en utilisant la clef
primaire de l’autre table).

Dans le diagramme entité-association, le lien entre les tables est basé sur la liaison entre les clefs étrangères et les
clefs primaires.

If we look at our people example, the table definition shows that the street column is a foreign key that references
the primary key on the streets table:

16.1. Lesson: Introduction aux Bases de Données 407



QGIS Training Manual, Version 2.18

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

16.1.14 Transactions

Lorsque vous ajoutez, modifiez ou supprimez une donnée dans une base de données, il est toujours important de
laisser la base de données dans un état consistant si quelquechose tourne mal. La plupart des bases de données
fournissent un mécanisme de transaction. Les transactions vous permettent de créer une position de retour sur
laquelle on peut revenir si les modifications ne se sont pas déroulées comme prévu.

Prenons un scénario ou vous avez mis en place un système de comptabilité. Vous devez transférer des fonds d’un
compte à l’autre. Les étapes se dérouleront de la manière suivante:

• Supprimer R20 du compte Joe.

• Ajouter R20 au compte Anne.

Si quelquechose se passe mal lors du processus (ex: une panne de courant), la transaction sera annulée.

16.1.15 In Conclusion

Les bases de données vous permettent de gérer vos données de manière structurée en utilisant des structures de
code simple.

16.1.16 What’s Next?

Maintenant que nous avons jeté un coup d’oeil sur le fonctionnement des bases de données, créons une nouvelle
base pour mettre en pratique ce que nous avons appris.

16.2 Lesson: Implémenter le modèle de données

Maintenant que toutes les notions théoriques ont été abordées, passons à l’étape de la création d’une base de
donnés. Cette base de données servira à tous les exercices de toutes les leçons à venir.

Le but de cette leçon: Installer les logiciels requis et les utiliser pour mettre en place notre base de données
exemple.

16.2.1 Installer PostgreSQL

Note: Bien qu’en marge de ce document, les utilisateurs de Mac peuvent installer PostgreSQL en util-
isant Homebrew. Les utilisateurs de Windows peuvent passer par un installateur graphique disponible ici :
http://www.postgresql.org/download/windows/. Merci de noter que la documentation concernera les utilisateurs
disposant de la version de QGIS sous Ubuntu.

408 Chapter 16. Module: Concepts de bases de données avec PostgreSQL

http://russbrooks.com/2010/11/25/install-postgresql-9-on-os-x
http://www.postgresql.org/download/windows/


QGIS Training Manual, Version 2.18

Avec Ubuntu :

sudo apt-get install postgresql-9.1

You should get a message like this:

[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:
oidentd ident-server postgresql-doc-9.1
The following NEW packages will be installed:
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Appuyez sur Y et sur Entrée et patientez jusqu’à ce que le téléchargement et l’installation soit terminés.

16.2.2 Aide

PostgreSQL dispose d’une excellente documentation en ligne : <http://www.postgresql.org/docs/9.1/static/index.html>‘_.

16.2.3 Créer une base de données utilisateur

Avec Ubuntu :

After the installation is complete, run this command to become the postgres user and then create a new database
user:

sudo su - postgres

Saisissez votre mot de passe normalement lorsqu’il vous ait demandé (vous aurez besoin des droits sudo).

Now, at the postgres user’s bash prompt, create the database user. Make sure the user name matches your unix
login name: it will make your life much easier, as postgres will automatically authenticate you when you are
logged in as that user:

createuser -d -E -i -l -P -r -s qgis

Saisissez un mot de passe lorsque c’est demandé. Il est conseillé d’utiliser un mot de passe différent de celui de
votre session.

Que signifient ces options?

-d, --createdb role can create new databases
-E, --encrypted encrypt stored password
-i, --inherit role inherits privileges of roles it is a member of (default)
-l, --login role can login (default)
-P, --pwprompt assign a password to new role
-r, --createrole role can create new roles
-s, --superuser role will be superuser

Now you should leave the postgres user’s bash shell environment by typing:

exit
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16.2.4 Vérifier le nouveau compte

psql -l

devrait renvoyer quelque chose comme ceci:

Name | Owner | Encoding | Collation | Ctype |
----------+----------+----------+------------+------------+
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)

Tapez q pour quitter.

16.2.5 Créer une base de données

The createdb command is used to create a new database. It should be run from the bash shell prompt:

createdb address -O qgis

You can verify the existence of your new database by using this command:

psql -l

Which should return something like this:

Name | Owner | Encoding | Collation | Ctype | Access privileges
----------+----------+----------+------------+------------+-----------------------
address | qgis | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres: postgres=CTc/postgres
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres: postgres=CTc/postgres
(4 rows)

Tapez q pour quitter.

16.2.6 Lancer une session de shell de base de données

Vous pouvez facilement vous connecter à votre base de données comme cela

psql address

Pour quitter la base de données de l’environnement psql, saisissez

\q

Pour obtenir de l’aide dans l’interface système, saisissez

\?

Pour obtenir de l’aide sur les commandes sql, saisissez

\help

Pour obtenir de l’aide spécifique sur une commande, saisissez (par exemple)

\help create table

Voir aussi Psql cheat sheet - disponible en ligne ici.
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16.2.7 Créer des tables en SQL

Let’s start making some tables! We will use our ER Diagram as a guide. First, connect to the address db:

psql address

Then create a streets table:

create table streets (id serial not null primary key, name varchar(50));

serial et varchar sont des types de données. serial indique à PostgreSQL de démarrer une séquence
d’entier (numérotation automatique) pour remplir le champ id automatiquement à chaque enregistrement.
varchar(50) indique à PostgreSQL de créer un champ de caractère de 50 caractères de long.

You will notice that the command ends with a ; - all SQL commands should be terminated this way. When you
press Enter, psql will report something like this:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq"
for serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index
"streets_pkey" for table "streets"

CREATE TABLE

Ça signifie que votre table a été créée avec succès et possède une clé primaire streets_pkey basée sur
streets.id.

Note: si vous avez appuyé sur Entrée sans avoir saisi un ; alors vous aurez un prompt de la forme address-#.
PG s’attend à ce que vous terminiez votre commande. Entrez ; avant de la lancer.

To view your table schema, you can do this:

\d streets

Which should show something like this:

Table "public.streets"
Column | Type | Modifiers
--------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval(’streets_id_seq’::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

To view your table contents, you can do this:

select * from streets;

Which should show something like this:

id | name
---+------
(0 rows)

Comme vous pouvez le voir, notre table est actuellement vide.

Try Yourself

Utilisez l’approche présentée ci-dessus pour créer une table des personnes appelées:

Ajouter des champs tels que le numéro de téléphone, l’adresse résidentielle, le nom, etc. (ces noms ne sont pas
valides, arrangez-le pour qu’ils le soient). Assurez-vous de donner une colonne d’identifiant à la table avec le
même type de données que plus haut.

Vérifiez vos résultats
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16.2.8 Créer des clefs en SQL

Le problème de notre précédente solution est que la base de données ne connais pas les relations logiques entre les
personnes et les rues. Pour l’exprimer de manière formelle, nous devons définir des clefs étrangères qui pointent
vers la clef primaire de la table des rues.

Il y a deux manières de le faire:

• Ajouter la clef après que la table ait été créée.

• Définir la clef lors de la création de la table.

Our table has already been created, so let’s do it the first way:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

Cela indique à la table people que le champ street_id doit être un id valide de la table streets.

The more usual way to create a constraint is to do it when you create the table:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int references streets(id) not null,
phone_no varchar null);

\d people

After adding the constraint, our table schema looks like this now:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+---------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

16.2.9 Créer des index en SQL

We want lightning fast searches on peoples names. To provide for this, we can create an index on the name column
of our people table:

create index people_name_idx on people(name);

\d people

Which results in:
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Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-----------------------------------
id | integer | not null default nextval

| | (’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name) <-- new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

16.2.10 Supprimer des tables en SQL

If you want to get rid of a table you can use the drop command:

drop table streets;

Note: Dans l’exemple en cours, la commande ci-dessus ne fonctionnera pas. Pourquoi? Voir la raison

If you used the same drop table command on the people table, it would be successful:

drop table people;

Note: Si vous avez entré cette commande et supprimé la table people, il sera bon de la recréer car vous en
aurez besoin pour les prochains exercices.

16.2.11 Un mot sur pgAdmin III

Nous vous avons montré des commandes SQL lancées depuis le prompt psql car c’est un moyen très efficace
d’apprendre à utiliser des bases de données. Néanmoins, il existe des moyens plus rapides et plus simples pour
le faire. Installez pgAdmin III et vous pourrez créer, supprimer, modifier les tables en cliquant dans une interface
graphique.

Under Ubuntu, you can install it like this:

sudo apt-get install pgadmin3

PgAdmin III sera détaillé dans un prochain module.

16.2.12 In Conclusion

Vous avez étudié comment créer une nouvelle base de données à partir de rien.

16.2.13 What’s Next?

Dans le prochain chapitre, nous allons étudier comment utiliser une base de données spatiale pour ajouter de
nouvelles données.
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16.3 Lesson: Ajouter des données au modèle

Les modèles que nous avons créés nécessitent maintenant d’être remplis avec les données qu’ils sont censés
contenir.

Objectif de cette leçon: Apprendre à intégrer de nouvelles données dans des modèles de bases de données.

16.3.1 Insérer une déclaration

How do you add data to a table? The sql INSERT statement provides the functionality for this:

insert into streets (name) values (’High street’);

Un certain nombre de choses à noter :

• Après le nom de la table (streets), vous listez les noms des colonnes que vous peuplerez (dans ce cas-là
seulement la colonne name).

• Après le mot clé valeurs, placez la liste des valeurs de champ.

• Des chaînes de caractères devraient être citées en utilisant des guillemets simples.

• Notez que nous n’avons pas inséré une valeur pour la colonne id ; c’est parce que c’est une séquence et
qu’elle sera auto-générée.

• Si vous remplissez manuellement le id, vous pouvez avoir de sérieux problèmes avec l’entier de votre base
de données.

Vous pourrez voir INSERT 0 1 si cela a fonctionné.

You can see the result of your insert action by selecting all the data in the table:

select * from streets;

Result:

select * from streets;
id | name

----+-------------
1 | High street

(1 row)

Try Yourself

Utiliser la commande INSERT pour ajouter une nouvelle rue à la table streets.

Vérifiez vos résultats

16.3.2 Séquençage d’ajout de données en fonction des contraintes

16.3.3 Try Yourself

Essayez d’ajouter un objet personne à la table people avec les détails suivants

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21
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Note: Rappelez-vous que dans cet exemple, nous avons défini les numéros de téléphone comme chaînes de
caractères, et non comme entiers.

À cette étape, vous devriez avoir un rapport d’erreur si vous essayez de faire cela sans d’abord créer un enreg-
istrement pour Main Street dans la table streets.

Vous devriez aussi avoir remarqué ceci :

• Vous ne pouvez pas ajouter la rue en utilisant son nom

• Vous ne pouvez pas ajouter une rue en utilisant un id de rue avant d’avoir d’abord créé l’enregistrement de
la rue dans la table des rues.

Souvenez-vous que nos deux tables sont liées via une paire de Clé Primaire / Clé Étrangère. Cela signifie
qu’aucune personne valide ne peut être créée sans qu’il y ait également un enregistrement valide de la rue corre-
spondante.

En utilisant les connaissances ci-dessus, ajoutez une nouvelle personne à la base de données.

Vérifiez vos résultats

16.3.4 Sélectionner les données

Nous vous avons déjà montré la syntaxe pour sélectionner des enregistrements. Regardons quelques exemples de
plus :

select name from streets;

select * from streets;

select * from streets where name=’Main Road’;

Dans les sessions suivantes, nous irons plus en détail sur la façon de sélectionner et de filtrer des données.

16.3.5 Mise à jour des données

What if you want to make a change to some existing data? For example, a street name is changed:

update streets set name=’New Main Road’ where name=’Main Road’;

Soyez très prudent en utilisant ces déclarations de mise à jour - si plus d’un enregistrement correspond à votre
clause WHERE, ils seront tous mis à jour !

A better solution is to use the primary key of the table to reference the record to be changed:

update streets set name=’New Main Road’ where id=2;

Il devrait être retourné UPDATE 1.

Note: Les critères de déclaration WHERE sont sensibles aux majuscules et minuscules : Main Road n’est pas
la même chose que Main road.

16.3.6 Supprimer les données

In order to delete an object from a table, use the DELETE command:

delete from people where name = ’Joe Smith’;

Let’s look at our people table now:
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address=# select * from people;

id | name | house_no | street_id | phone_no
----+------+----------+-----------+----------

(0 rows)

16.3.7 Try Yourself

Use the skills you have learned to add some new friends to your database:

name | house_no | street_id | phone_no
-----------------+----------+-----------+--------------
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

16.3.8 In Conclusion

Vous savez maintenant comment ajouter de nouvelles données aux modèles existants que vous avez précédemment
créés. Souvenez-vous que si vous voulez ajouter de nouveaux types de données, vous pouvez modifier et/ou créer
de nouveaux modèles pour contenir ces données.

16.3.9 What’s Next?

Maintenant que vous avez ajouté des données, vous allez apprendre comment utiliser des requêtes pour accéder à
ces données de différentes façons.

16.4 Lesson: Requêtes

Lorsque vous écrivez une commande SELECT ..., cela est communément connu comme une requête - vous
interrogez la base de données pour une information.

Objectif de cette leçon : Apprendre comment créer des requêtes qui retourneront des informations utiles.

Note: Si vous ne l’avez pas fait dans la leçon précédente, ajoutez les objets personnes suivants dans votre table
people. Si vous recevez des erreurs liées à des contraintes de clé étrangère, vous devez d’abord ajouter l’objet
‘Main Road’ à votre table des rues.

insert into people (name,house_no, street_id, phone_no)
values (’Joe Bloggs’,3,2,’072 887 23 45’);

insert into people (name,house_no, street_id, phone_no)
values (’Jane Smith’,55,3,’072 837 33 35’);

insert into people (name,house_no, street_id, phone_no)
values (’Roger Jones’,33,1,’072 832 31 38’);

insert into people (name,house_no, street_id, phone_no)
values (’Sally Norman’,83,1,’072 932 31 32’);

16.4.1 Ordonner les résultats

Let’s retrieve a list of people ordered by their house numbers:
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select name, house_no from people order by house_no;

Result:

name | house_no
--------------+----------
Joe Bloggs | 3
Roger Jones | 33
Jane Smith | 55
Sally Norman | 83

(4 rows)

You can sort the results by the values of more than one column:

select name, house_no from people order by name, house_no;

Result:

name | house_no
--------------+----------
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83

(4 rows)

16.4.2 Filtrage

Souvent, vous ne voudrez pas voir chaque enregistrement individuel dans la base de données - en particulier s’il y
a des milliers d’enregistrements et que vous êtes seulement intéressés à en voir un ou deux.

Here is an example of a numerical filter which only returns objects whose house_no is less than 50:

select name, house_no from people where house_no < 50;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

You can combine filters (defined using the WHERE clause) with sorting (defined using the ORDER BY clause):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

You can also filter based on text data:

select name, house_no from people where name like ’%s%’;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Ici nous utilisons la cause LIKE pour trouver tous les noms qui contiennent un s. Vous noterez que cette requête
est sensible aux majuscules et minuscules, ainsi l’entrée Sally Norman ne sera pas retournée.
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If you want to search for a string of letters regardless of case, you can do a case in-sensitive search using the
ILIKE clause:

select name, house_no from people where name ilike ’%r%’;

name | house_no
--------------+----------
Roger Jones | 33
Sally Norman | 83
(2 rows)

That query returned every people object with an r or R in their name.

16.4.3 Jointure

What if you want to see the person’s details and their street’s name instead of the ID? In order to do that, you need
to join the two tables together in a single query. Lets look at an example:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Note: Avec les jointures, vous devez toujours définir les deux tables d’où proviennent les informations, dans
notre cas personnes et rues. Vous devez également spécifier quelle clé sert à la correspondance (clé étrangère et
clé primaire). Si vous ne spécifiez pas cela, vous allez obtenir une liste de toutes les combinaisons possibles de
personnes et de rues, mais il ne sera pas possible de savoir qui habite dans quelle rue!

Here is what the correct output will look like:

name | house_no | name
--------------+----------+-------------
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

Nous reverrons des jointures plus tard lorsque nous créerons des requêtes plus complexes. Souvenez-vous juste
qu’elles permettent de combiner d’une façon simple l’information de deux ou plusieurs tables.

16.4.4 Sous-sélection

Des sous-sélections vous permettent de sélectionner des objets d’une table sur la base des données d’une autre
table qui est liée via une relation de clé étrangère. Dans notre cas, nous voulons trouver des personnes qui vivent
dans une rue spécifique.

First, let’s do a little tweaking of our data:

insert into streets (name) values(’QGIS Road’);
insert into streets (name) values(’OGR Corner’);
insert into streets (name) values(’Goodle Square’);
update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;

Let’s take a quick look at our data after those changes: we can reuse our query from the previous section:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Result:
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name | house_no | name
--------------+----------+-------------
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street

(4 rows)

Now let’s show you a sub-selection on this data. We want to show only people who live in street_id number
1:

select people.name
from people, (

select *
from streets
where id=1

) as streets_subset
where people.street_id = streets_subset.id;

Result:

name
--------------
Roger Jones
Sally Norman

(2 rows)

Bien que ce soit un exemple très simple et inutile avec nos petits jeux de données, il illustre à quel point les
sous-sélections peuvent être utiles et importantes lors de requêtes sur des jeux de données grands et complexes.

16.4.5 Requêtes agrégées

One of the powerful features of a database is its ability to summarise the data in its tables. These summaries are
called aggregate queries. Here is a typical example which tells us how many people objects are in our people
table:

select count(*) from people;

Result:

count
-------

4
(1 row)

Si nous voulons les totaux agrégés par nom de rue nous pouvons procéder ainsi:

select count(name), street_id
from people
group by street_id;

Result:

count | street_id
-------+-----------

2 | 1
1 | 3
1 | 2

(3 rows)

Note: Comment nous n’avons pas utilisé la clause ORDER BY, l’ordre de vos résultats peut ne pas correspondre
avec ce qui est montré ici.
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Try Yourself

Résumez les personnes par nom de rue et montrez les noms de rue actuel à la place de street_ids.

Vérifiez vos résultats

16.4.6 In Conclusion

Vous avez vu comment utiliser des requêtes pour retourner les données dans votre base de données d’une façon
qui vous permet d’y extraire de l’information utile.

16.4.7 What’s Next?

Ensuite vous verrez comment créer des vues depuis les requêtes que vous avez écrites.

16.5 Lesson: Vues

Lorsque vous créez une requête, vous devez fournir un effort non négligeable pour la formuler. Avec les vues,
vous pouvez sauvegarder votre définition dans une requête SQL sous la forme d’une ‘table virtuelle’ réutilisable.

Objectif de cette leçon : Sauvegarder des requêtes en vues.

16.5.1 Créer une vue

You can treat a view just like a table, but its data is sourced from a query. Let’s make a simple view based on the
above:

create view roads_count_v as
select count(people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;

As you can see the only change is the create view roads_count_v as part at the beginning. We can
now select data from that view:

select * from roads_count_v;

Result:

count | name
-------+-------------

1 | Main Road
2 | High street
1 | Low Street

(3 rows)

16.5.2 Modifier une vue

A view is not fixed, and it contains no ‘real data’. This means you can easily change it without impacting on any
data in your database:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count(people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;
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(Cet exemple montre également la convention de bonne pratique d’utiliser les caractères MAJUSCULES pour les
mot-clefs du SQL.)

You will see that we have added an ORDER BY clause so that our view rows are nicely sorted:

select * from roads_count_v;

count | name
-------+-------------

2 | High street
1 | Low Street
1 | Main Road

(3 rows)

16.5.3 Supprimer une vue

If you no longer need a view, you can delete it like this:

drop view roads_count_v;

16.5.4 In Conclusion

En utilisant des vues, vous pouvez sauvegarder une requête et accéder à ses résultats comme s’il s’agissait d’une
table.

16.5.5 What’s Next?

Parfois, lorsque vous changez une donnée, vous voulez que ces modifications entraînent des effets ailleurs dans la
base de données. La prochaine leçon nous permettra de voir comment on peut y parvenir.

16.6 Lesson: Règles

Les règles permettent à “l’arbre de requête” d’une requête entrante d’être réécrit. Une utilisation courante est
l’implémentation de vues, y compris des vues pouvant être mises à jour. -Wikipedia

Objectif de cette leçon: Apprendre à intégrer de nouvelles règles pour la base de données.

16.6.1 Vues matérialisées (vues basées sur des règles)

Say you want to log every change of phone_no in your people table in to a people_log table. So you set up a new
table:

create table people_log (name text, time timestamp default NOW());

In the next step, create a rule that logs every change of a phone_no in the people table into the people_log table:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

To test that the rule works, let’s modify a phone number:

update people set phone_no = ’082 555 1234’ where id = 2;

Check that the people table was updated correctly:
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select * from people where id=2;

id | name | house_no | street_id | phone_no
----+------------+----------+-----------+--------------

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)

Now, thanks to the rule we created, the people_log table will look like this:

select * from people_log;

name | time
------------+----------------------------
Joe Bloggs | 2014-01-11 14:15:11.953141

(1 row)

Note: La valeur du champ time dépendra de la date et de l’heure courante.

16.6.2 In Conclusion

Les règles permettent d’ajouter ou de modifier automatiquement les données dans votre base de données pour
refléter des changements survenus ailleurs.

16.6.3 What’s Next?

Le prochain module introduira les bases de données spatiales avec PostGIS, reprenant ainsi les concepts de bases
de données et les appliquant aux données SIG.
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Module: Concepts de bases de données spatiales avec PostGIS

Les Bases de Données Spatiales permettent le stockage de la géométrie de dossiers au sein d’une Base de Données
et fournissent également une fonctionnalité pour interroger et retourner les dossiers utilisant ces Géométries. Dans
ce module, nous utiliserons PostGIS, une extension de PostgreSQL, pour apprendre à configurer une base de
données spatiales, importer des données depuis des shapefiles dans une base de données et utiliser les fonctions
géographiques qu’offre PostGIS.

While working through this section, you may want to keep a copy of the PostGIS cheat sheet available from
Boston GIS user group. Another useful resource is the online PostGIS documentation.

Il existe également des tutoriels plus détaillés sur PostGIS et les bases de données spatiales sur le site de Boundless
Geo :

• Introduction à PostGIS

• Trucs et Astuces des Bases de données Spatiales

Voir aussi PostGIS online.

17.1 Lesson: Configuration de PostGIS

Configurer les fonctions PostGIS vous permettra d’accéder à des fonctions spatiales depuis PostgreSQL.

Objectif de cette leçon : Installer des fonctions spatiales et démontrer brièvement leurs effets.

Note: Nous assumerons que vous utilisez PostGIS version 2.1 dans cet exercice. L’installation et la configuration
de la base de données sont différentes pour les versions plus anciennes. Néanmoins, le reste du module devrait
fonctionner. Consultez la documentation pour votre plate-forme pour vous aider à installer et configurer votre base
de données.

17.1.1 Installation sous Ubuntu

Postgis s’installe facilement avec apt

$ sudo apt-get install postgis
$ sudo apt-get install postgresql-9.1-postgis

C’est aussi simple que ça...

Note: En fonction de la version d’Ubuntu que vous utilisez et des dépôts que vous avez configurés, les commandes
qui suivent installeront PostGIS 1.5 ou 2.x. Vous pouvez trouver la version installée en lançant la requête select
PostGIS_full_version(); sous psql ou un autre outil.

Pour installer la dernière version de PostGIS, vous pouvez utiliser les commandes suivantes.
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$ sudo apt-add-repository ppa:sharpie/for-science
$ sudo apt-add-repository ppa:sharpie/postgis-nightly
$ sudo apt-get update
$ sudo apt-get install postgresql-9.1-postgis-nightly

17.1.2 Installation sous windows

L’installation sous Windows est un peu plus compliquée, sans être difficile. Notez que vous devez être en ligne
pour installer le pack postgis.

Visiter en premier lieu la page de téléchargements.

Puis suivez ce guide.

Vous pouvez trouver plus d’information sur l’installation sous Windows sur le site web PostGIS.

17.1.3 Installation sur les autres plate-formes

The PostGIS website download has information about installing on other platforms including macOS and on other
linux distributions

17.1.4 Configurer les bases de données pour utiliser postgis

Lorsque PostGis est installé, vous allez devoir configurer votre base de données pour utiliser les extensions. Si
vous avez installé PostGis en version > 2.0, il suffit d’envoyer la commande suivante avec psql en utilisant l’adresse
de la base de donnée de l’exercice précédant.

$ psql -d address -c "CREATE EXTENSION postgis;"

Note: Si vous utilisez PostGIS 1.5 et une version de PostgreSQL inférieure à la 9.1, vous devrez utiliser d’autres
étapes pour installer les extensions PostGIS à la base de données. Consultez la documentation PostGIS pour plus
d’information sur ce sujet. Il existe également quelques instructions supplémentaires dans la version précédente
de ce manuel.

17.1.5 Quelles-sont les fonctions installées par PostGIS ?

PostGIS peut être considéré comme une collection de fonctions internes à la baes de données qui étendent les
fonctionnalités de base de PostgreSQL de manière à ce qu’il puisse gérer des données spatiales. par ‘gérer’, on
entend stocker, récupérer, requêter et manipuler. Pour y parvenir, un certain nombre de fonctions sont installées
dans la base de données.

Our PostgreSQL address database is now geospatially enabled, thanks to PostGIS. We are going to delve a lot
deeper into this in the coming sections, but let’s give you a quick little taster. Let’s say we want to create a point
from text. First we use the psql command to find functions relating to point. If you are not already connected to
the address database, do so now. Then run:

\df *point*

This is the command we’re looking for: st_pointfromtext. To page through the list, use the down arrow,
then press q to quit back to the psql shell.

Essayez d’exécuter cette commande:

select st_pointfromtext(’POINT(1 1)’);

Result:
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st_pointfromtext
--------------------------------------------
0101000000000000000000F03F000000000000F03F
(1 row)

Trois choses à noter:

• Nous avons défini un point à la position 1,1 (dans le SRID EPSG:4326) en utilisant POINT(1 1),

• Nous avons lancé une commande sql non pas sur une table mais uniquement sur des données insérées depuis
le prompt SQL,

• La ligne de résultat n’est pas très significative.

La ligne de résultat est au format OGC dénommé ‘Well Known Binary’ (WKB). Ce format sera détaillé dans la
prochaine section.

To get the results back as text, we can do a quick scan through the function list for something that returns text:

\df *text

The query we’re looking for now is st_astext. Let’s combine it with the previous query:

select st_astext(st_pointfromtext(’POINT(1 1)’));

Result:

st_astext
------------

POINT(1 1)
(1 row)

Ici nous avons inséré la chaîne POINT(1,1), nous l’avons transformée en point en utilisant la fonc-
tion st_pointfromtext() et nous l’avons reconvertie sous forme lisible par l’humain avec la fonction
st_astext() qui nous redonne notre chaîne originelle.

One last example before we really get into the detail of using PostGIS:

select st_astext(st_buffer(st_pointfromtext(’POINT(1 1)’),1.0));

Qu’avons-nous fait ? Nous avons créé un tampon de 1 degré autour de notre point et nous avons renvoyé le résultat
sous forme de texte.

17.1.6 Système de référence spatiale

En plus des fonctions PostGIS, l’extension contient une collection de définitions de systèmes de référence spatiale
(SRS) telles que définies par l’European Petroleum Survey Group (EPSG). Ces définitions sont utilisées pour les
opérations qui impliquent des conversion de systèmes de coordonnées de référence (SCR).

Nous pouvons inspecter ces définitions de SRS dans notre base de données car elles sont stockées dans des tables
normales.

First, let’s look at the schema of the table by entering the following command in the psql prompt:

\d spatial_ref_sys

The result should be this:

Table "public.spatial_ref_sys"
Column | Type | Modifiers

-----------+-------------------------+-----------
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |
proj4text | character varying(2048) |
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Indexes:
"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)

Vous pouvez utiliser les requêtes SQL standards (que nous avons étudiées dans les sections d’introduction) pour
visualiser et manipuler la table même si ce n’est pas une bonne idée de mettre à jour ou de supprimer des enreg-
istrements sans comprendre ce qu’on fait.

One SRID you may be interested in is EPSG:4326 - the geographic / lat lon reference system using the WGS 84
ellipsoid. Let’s take a look at it:

select * from spatial_ref_sys where srid=4326;

Result:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS
84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

Le champ srtext correspond à la définition de la projection au format Well Known Text (c’est le même qui est
utilisés dans les fichiers .prj des fichiers Shape).

17.1.7 In Conclusion

Les fonctions PostGIS sont maintenant installées dans votre copie de PostgreSQL. Nous pouvez maintenant
utiliser les fonctions spatiales de PostGIS.

17.1.8 What’s Next?

Dans la prochaine leçon, nous allons étudier comment les entités spatiales sont représentées dans la base de
données.

17.2 Lesson: Modèle d’Entité Simple

Comment pouvons-nous stocker et représenter des entités géographique dans une base de données ? Dans cette
leçon nous aborderons une seule approche: le Modèle d’Entité Simple défini par l’OGC.

Objectif de cette leçon: Apprendre à connaître et à utiliser le modèle SFS

17.2.1 Qu’est-ce-que l’OGC ?

L’OGC (Open Geospatial Consortium) est une organisation internationale bénévole d’élaboration de standards qui
a été fondée en 1994. Au sein de l’OGC, plus de 370 organisations commerciales, gouvernementales, associatives
et laboratoires de recherche à travers le monde participent au développement et à l’implémentation de standards
pour les services et le contenu géospatial, le traitement de données SIG et les formats d’échange. - Wikipedia

17.2.2 Quel est le modèle SFS ?

Le Modèle Simple Feature for SQL et une méthode non topologique pour stocker de l’information spatiale dans
une base de données. Il définit des fonctions pour accéder, faire des calculs et construire ces données.
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Le modèle définit les données spatiales à partir des types Points, Linestring (polylignes) et Polygon (ainsi que leur
aggrégation sous forme d’objets multiples).

Pour plus di’nformations, consultez le standard OGC Simple Feature for SQL.

17.2.3 Ajoutez un champ géométrique à la table

Let’s add a point field to our people table:

alter table people add column the_geom geometry;

17.2.4 Ajoutez une contrainte basée sur le type de géométrie.

You will notice that the geometry field type does not implicitly specify what type of geometry for the field - for
that we need a constraint:

alter table people
add constraint people_geom_point_chk

check(st_geometrytype(the_geom) = ’ST_Point’::text
OR the_geom IS NULL);

Ce code ajoute une contrainte à la table de manière à ce qu’elle n’accepte que les géométries de points ou les
valeurs vides.

17.2.5 Try Yourself

Créez une nouvelle table appelée cities et donnez-lui des colonnes appropriées, incluant un champ de géométrie
pour stocker des polygones (les limites administratives). Assurez-vous d’avoir une contrainte géométrique sur les
polygones.

Vérifiez vos résultats

17.2.6 Remplissez la table geometry_columns.

At this point you should also add an entry into the geometry_columns table:
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insert into geometry_columns values
(’’,’public’,’people’,’the_geom’,2,4326,’POINT’);

Pourquoi ? La colonne geometry_columns est utilisée par certaines applications pour savoir quelles sont les
tables de la base de données qui contiennent des données géométriques.

Note: If the above INSERT statement causes an error, run this query first:

select * from geometry_columns;

If the column f_table_name contains the value people, then this table has already been registered and you
don’t need to do anything more.

La valeur 2 indique le nombre de dimensions; dans notre cas: deux: x et y.

La valeur 4326 indique que la table utilise une projection WGS 84 qui est référencée par le numéro 4326 (référez-
vous à la discussion précédente à propos des codes EPSG).

Try Yourself

Ajoutez une entrée dans la table geometry_columns pour la couche cities.

Vérifiez vos résultats

17.2.7 Ajouter un enregistrement géométrique à la table en utilisant SQL

Now that our tables are geo-enabled, we can store geometries in them:

insert into people (name,house_no, street_id, phone_no, the_geom)
values (’Fault Towers’,

34,
3,
’072 812 31 28’,
’SRID=4326;POINT(33 -33)’);

Note: Dans la nouvelle entrée ci-dessus, vous devez indiquer quelle projection (SRID) utiliser. Cette indication
est obligatoire lorsqu’on enregistre un point à l’aide d’une chaîne de caractères qui n’ajoute pas automatiquement
l’information de projection. Bien entendu, le nouveau point doit utiliser le même SRID que le jeu de données dans
lequel il est ajouté et vous devez le spécifier.

Si à ce stade vous utilisez une interface graphique, l’indication de la projection de chaque point se ferait automa-
tiquement. En d’autres termes, il n’y a généralement pas besoin d’ajouter la bonne projection à chaque point que
vous voulez ajouter si vous avez déjà indiqué le SRID pour le jeu de données utilisé, comme nous l’avons fait
auparavant.

C’est le bon moment pour ouvrir QGIS et tenter de visualiser la table people. De plus, nous pouvons essayer
d’éditer/ajouter/supprimer des enregistrements et réaliser des requêtes sur la base de données pour visualiser com-
ment la donnée est modifiée.

Pour charger une couche PostGIS dans QGIS, utilisez l’entrée de menu Couche → Ajouter une couche PostGIS
ou la barre d’outils:

Ce qui ouvrira la boîte de dialogue suivante:
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Cliquez sur le bouton New pour ouvrir la boîte de dialogue suivante:
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Définissez alors une nouvelle connexion, par exemple:

Name: myPG
Service:
Host: localhost
Port: 5432
Database: address
User:
Password:

Pour vérifier que QGIS trouve bien la base de données address et que votre compte/mot de passe sont corrects,
cliquez sur Tester la connexion. Si ça fonctionne, cochez les cases après Enregistrer le nom de l’utilisateur et
Enregistrer le mot de passe . Cliquez alors sur OK pour créer cette connexion.
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Retournez dans la boîte de dialogue Ajouter une ou plusieurs tables PostGIS , cliquez sur Connecter et ajoutez les
couches à votre projet comme d’habitude.

Try Yourself

Elaborez une requête qui montre le nom de la personne, le nom de lrue et la position (depuis la colonne the_geom)
au format texte.

Vérifiez vos résultats

17.2.8 In Conclusion

Vous avez vu comment ajouter des objets spatiaux à votre base de données et comment les visualiser dans un
logiciel de SIG.

17.2.9 What’s Next?

Dans la prochaine leçon, nous verrons comment importer et exporter des données de la base de données.

17.3 Lesson: Importer et Exporter

Bien évidemment, une base de données sans un moyen facile de migrer des données dans et hors d’elle serait sans
grand intérêt. Heureusement, il existe de nombreux outils permettant de facilement déplacer les données vers et
hors de PostGIS.

17.3.1 shp2pgsql

shp2pgsql is a commandline tool to import ESRI shapefiles to the database. Under Unix, you can use the following
command for importing a new PostGIS table:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psql -d <databasename> -h <hostname> -U <username>

Under Windows, you have to perform the import process in two steps:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql

You may encounter this error:

ERROR: operator class "gist_geometry_ops" does not exist for access method
"gist"

C’est un problème connu lié à la création in situ d’un index spatial sur la couche en cours d’importation. Pour
éviter l’erreur, excluez le paramètre -I. Cela signifie qu’aucun index spatial ne sera directement créé sur la table,
et que vous aurez besoin de le créer une fois la donnée importée dans la base de données. (La création d’un index
spatial sera abordée dans la prochaine leçon.)

17.3.2 pgsql2shp

pgsql2shp is a commandline tool to export PostGIS Tables, Views or SQL select queries. To do this under Unix:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>
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To export the data using a query:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> "<query>"

17.3.3 ogr2ogr

ogr2ogr is a very powerful tool to convert data into and from postgis to many data formats. ogr2ogr is part of the
GDAL/OGR Software and has to be installed separately. To export a table from PostGIS to GML, you can use
this command:

ogr2ogr -f GML export.gml PG:’dbname=<databasename> user=<username>
host=<hostname>’ <Name of PostGIS-Table>

17.3.4 DB Manager

You may have noticed another option in the Database menu labeled DB Manager. This is a tool that provides a
unified interface for interacting with spatial databases including PostGIS. It also allows you to import and export
from databases to other formats. Since the next module is largely devoted to using this tool, we will only briefly
mention it here.

17.3.5 In Conclusion

Importer et exporter vers et depuis une base de données peut être fait de diverses manières. Vous utiliserez
probablement ces fonctions (ou des similaires) si vous utilisez des données de sources disparates.

17.3.6 What’s Next?

Prochainement, nous verrons comment interroger les données que nous avons créées auparavant.

17.4 Lesson: Requêtes Spatiales

Les requêtes spatiales ne sont pas différentes des autres requêtes de base de données. Vous pouvez utiliser la
colonne de géométrie comme n’importe quelle colonne de base de données. Avec l’installation de PostGIS dans
notre base de données, vous avons ajouté des fonctions additionnelles pour requêter la base.

Objectif de cette leçon: Etudier comment les fonctions spatiales sont implémentées de manière similaire aux
autres fonctions non spatiales.

17.4.1 Opérateurs spatiaux

Lorsque vous souhaitez connaître quels sont les points distants de 2 degrés par rapport à un point (X,Y), vous
pouvez le faire ainsi:

select *
from people
where st_distance(the_geom,’SRID=4326;POINT(33 -34)’) < 2;

Résultat:

id | name | house_no | street_id | phone_no | the_geom
----+--------------+----------+-----------+---------------+---------------

6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)
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Note: La valeur the_geom a été tronquée pour des questions d’affichage sur cette page. Si vous voulez voir le
point exprimé dans des coordonnées lisibles par l’être humain, utilisez quelquechose de similaire à ce que vous
avez vu dans la section précédente “Voir un point en WKT”.

Comment savons-nous que la requête précédente retourne tous les points situés à moins de 2 degrés ? Pourquoi
pas 2 mètres ? Ou dans une autre unité ?

Vérifiez vos résultats

17.4.2 Index spatiaux

We also can define spatial indexes. A spatial index makes your spatial queries much faster. To create a spatial
index on the geometry column use:

CREATE INDEX people_geo_idx
ON people
USING gist
(the_geom);

\d people

Résultat:

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+----------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (the_geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) = ’ST_Point’::text
OR the_geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

17.4.3 Try Yourself

Modifiez la table des villes de manière à ce que la colonne de géométrie utilise un index spatial.

Vérifiez vos résultats

17.4.4 Démonstration des fonctions spatiales de PostGIS

Pour faire une démonstration des fonctions spatiales de PostGIS, nous allons créer une base de données contenant
des données (fictives).

To start, create a new database (exit the psql shell first):

createdb postgis_demo
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Remember to install the postgis extensions:

psql -d postgis_demo -c "CREATE EXTENSION postgis;"

Next, import the data provided in the exercise_data/postgis/ directory. Refer back to the previous lesson
for instructions, but remember that you’ll need to create a new PostGIS connection to the new database. You can
import from the terminal or via DB Manager. Import the files into the following database tables:

• points.shp dans building

• lines.shp dans road

• polygons.shp dans region

Chargez ces trois couches dans QGIS via la boîte de dialogue Ajouter des couches PostGIS, comme d’habitude.
Lorsque vous ouvrez les tables d’attributs, vous pouvez remarquer qu’elles ont un champ id et un autre gid,
créés lors de l’import PostGIS.

Maintenant que les tables sont importées, nous pouvons utiliser PostGIS pour requêter les données. Retournez
dans votre terminal (ligne de commande) et entrez le prompt psql en lançant:

psql postgis_demo

Nous allons présenter quelques-uns des traitements SQL en créant des vues avec eux pour que vous puissiez les
ouvrir dans QGIS pour visualiser les résultats.

Sélection par localisation

Récupérer tous les bâtiments de la région KwaZulu:

SELECT a.id, a.name, st_astext(a.the_geom) as point
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’KwaZulu’;

Résultat:

id | name | point
----+------+------------------------------------------
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)

(5 rows)

Or, if we create a view from it:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.the_geom
FROM building a, region b

WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’KwaZulu’;

Ajoutez la vue comme couche dans QGIS:
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Sélection des voisins

Show a list of all the names of regions adjoining the Hokkaido region:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.the_geom, b.the_geom)
AND a.name = ’Hokkaido’;

Résultat:

name
--------------
Missouri
Saskatchewan
Wales

(3 rows)

As a view:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE TOUCHES(a.the_geom, b.the_geom)
AND a.name = ’Hokkaido’;

Dans QGIS:
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Note the missing region (Queensland). This may be due to a topology error. Artifacts such as this can alert us to
potential problems in the data. To solve this enigma without getting caught up in the anomalies the data may have,
we could use a buffer intersect instead:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(the_geom, 100) as the_geom
FROM region

WHERE name = ’Hokkaido’;

Cette requête créé un tampon de 100 mètres autour de la région d’Hokkaido.

La surface la plus sombre est le tampon:
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Select using the buffer:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.the_geom
FROM
(

SELECT * FROM
vw_hokkaido_buffer

) a,
region b
WHERE ST_INTERSECTS(a.the_geom, b.the_geom)
AND b.name != ’Hokkaido’;

Dans cette requête, la vue originelle du tampon est utilisée comme n’importe quelle autre table. Elle dispose
d’un alias a et son champ de géométrie, a.the_geom, est utilisé pour sélectionner un polygone dans la table
region (alias b) qui l’intersecte. Néanmoins, Hokkaido est exclue de cette sélection car nous n’en voulons pas,
nous voulons seulement les régions qui la touche.

Dans QGIS:
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It is also possible to select all objects within a given distance, without the extra step of creating a buffer:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE ST_DISTANCE (a.the_geom, b.the_geom) < 100
AND a.name = ’Hokkaido’
AND b.name != ’Hokkaido’;

Cela permet le même résultat sans avoir besoin de l’étape du tampon:
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Sélection de valeurs uniques

Show a list of unique town names for all buildings in the Queensland region:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’Queensland’;

Résultat:

name
---------
Beijing
Berlin
Atlanta

(3 rows)

Autres exemples...

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_SHORTESTLINE(a.the_geom, b.the_geom)) as text,
ST_SHORTESTLINE(a.the_geom, b.the_geom) AS the_geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_LONGESTLINE(a.the_geom, b.the_geom)) as text,
ST_LONGESTLINE(a.the_geom, b.the_geom) AS the_geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM road a

WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM region a

WHERE a.name = ’Saskatchewan’;

SELECT ST_PERIMETER(a.the_geom)
FROM region a
WHERE a.name=’Queensland’;

SELECT ST_AREA(a.the_geom)
FROM region a
WHERE a.name=’Queensland’;

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(the_geom, 20) AS the_geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(the_geom, 50) AS the_geom
FROM road;

CREATE VIEW vw_convex_hull AS
SELECT
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ROW_NUMBER() over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL(ST_COLLECT(a.the_geom)) AS the_geom
FROM building a
GROUP BY a.name;

17.4.5 In Conclusion

Vous avez observer comment faire des requêtes spatiales sur des objets en utilisant les nouvelles fonctions ap-
portées par PostGIS.

17.4.6 What’s Next?

Dans le prochain chapitre, nous allons étudier des structures de géométries plus complexes et voir comment les
créer en utilisant PostGIS.

17.5 Lesson: Construction de géométrie

Dans cette section nous allons creuser un peu plus profondément comment les géométries simples sont construites
en SQL. En réalité, vous utiliserez probablement un SIG comme QGIS pour créer des géométries complexes en
utilisant leurs outils de numérisation ; cependant, comprendre comment ils sont formulés peut être pratique pour
écrire des requêtes et comprendre comment la base de données est assemblée.

Objectif de cette leçon : Mieux comprendre comment créer des entités spatiales directement dans Post-
greSQL/PostGIS.

17.5.1 Création de polylignes

Retournons à notre base de données address et faisons en sorte que la table des rues corresponde à celles
précédemment étudiées, c’est-à-dire qu’il existe une contrainte géométrique, un index et en entrée dans la table de
métadonnées geometry_columns.

17.5.2 Try Yourself

• Modifiez la table streets de sorte à ce qu’il y ait une colonne géométrie de type ST_PolyLigne.

• N’oubliez pas de faire la mise à jour d’accompagnement à la table des colonnes géométriques !

• Ajoutez également une contrainte pour empêcher toutes géométries ajoutées qui ne sont pas des
POLYLIGNES ou nulles.

• Créez un index spatial sur la nouvelle colonne géométrique

Vérifiez vos résultats

Now let’s insert a linestring into our streets table. In this case we will update an existing street record:

update streets
set the_geom = ’SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)’
where streets.id=2;

Jetez un coup d’œil aux résultats dans QGIS. (Vous pouvez devoir faire un clic droit sur la couches streets dans la
‘Légende’ des couches, et choisissez ‘Zoomer sur l’emprise de la couche’.)

Créez maintenant plus d’entrées streets - certaines dans QGIS et d’autres depuis la ligne de commande.
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17.5.3 Création de Polygones

Creating polygons is just as easy. One thing to remember is that by definition, polygons have at least four vertices,
with the last and first being co-located:

insert into cities (name, the_geom)
values (’Tokyo’, ’SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))’);

Note: Un polygone requière des doubles parenthèses autour de sa liste de coordonnées ; c’est pour vous permettre
d’ajouter des polygones complexes avec de multiples aires non connectées. Par exemple

insert into cities (name, the_geom)
values (’Tokyo Outer Wards’,

’SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),
(-10 -30, -5 0, -15 -15, -10 -30))’

);

Si vous suivez cette étape, vous pouvez vérifier ce qui a été fait en chargeant le jeu de données villes dans QGIS, en
ouvrant sa table attributaire, et en sélectionnant la nouvelle entrée. Notez comment les deux nouveaux polygones
se comportent comme un polygone.

17.5.4 Exercice : Lier les Villes aux Personnes

Pour cet exercice, vous devriez faire comme suit :

• Supprimez toutes les données depuis votre table personne.

• Ajoutez une colonne clé étrangère aux personnes qui font référence à la clé primaire de la table des villes.

• Utilisez QGIS pour capturer quelques villes.

• Utilisez SQL pour insérer quelques nouveaux enregistrements de personnes, en vous assurant que chacun a
une rue et une ville associées.

Your updated people schema should look something like this:

\d people

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+--------------------------------------------
id | integer | not null

| | default nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |
city_id | integer | not null

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) =

’ST_Point’::text OR the_geom IS NULL)
Foreign-key constraints:

"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

Vérifiez vos résultats
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17.5.5 Regarder notre Schéma

Notre schéma devrait désormais ressembler à ça :

17.5.6 Try Yourself

Créez des contours de ville en calculant l’enveloppe convexe minimum de toutes les adresses pour cette ville et en
calculant un tampon autour de cette zone.

17.5.7 Accès aux sous-objets

Avec les fonctions du Modèle-SFS, vous avez une large variété d’options pour accéder aux sous-objets des
Géométries SFS. Lorsque vous voulez sélectionner le premier point du sommet de chaque géométrie de poly-
gone dans la table myPolygonTable, vous devez faire cela de cette manière :

• Transform the polygon boundary to a linestring:

select st_boundary(geometry) from myPolygonTable;

• Select the first vertex point of the resultant linestring:

select st_startpoint(myGeometry)
from (

select st_boundary(geometry) as myGeometry
from myPolygonTable) as foo;

17.5.8 Traitement de données

PostGIS supporte toutes les fonctions conformes à la norme OGC SFS/MM. Toutes ces fonctions commencent
avec ST_.

17.5.9 Découper

To clip a subpart of your data you can use the ST_INTERSECT() function. To avoid empty geometries, use:

where not st_isempty(st_intersection(a.the_geom, b.the_geom))
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select st_intersection(a.the_geom, b.the_geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.the_geom,32734),

b.the_geom));
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17.5.10 Construction de géométries à partir d’autres géométries

À partir d’une table d’un point donné, vous voulez générer une polyligne. L’ordre des points est défini par leur
id. Une autre méthode d’ordre pourrait être un horodatage, comme celui que vous obtenez lorsque vous capturez
des points de navigation avec un récepteur GPS.

To create a linestring from a new point layer called ‘points’, you can run the following command:

select ST_LineFromMultiPoint(st_collect(the_geom)), 1 as id
from (

select the_geom
from points
order by id

) as foo;

Pour voir comme cela fonctionne sans créer une nouvelle couche, vous pourriez aussi lancer cette commande sur
la couche ‘people’, même si faire cela dans le monde réel aurait peu de sens.
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17.5.11 Nettoyage de géométrie

Vous trouverez plus d’informations à ce sujet dans ce blog.

17.5.12 Différences entre les tables

To detect the difference between two tables with the same structure, you can use the PostgreSQL keyword
EXCEPT:

select * from table_a
except
select * from table_b;

Comme résultat, vous obtiendrez tous les enregistrements de la table_a qui ne sont pas stockés dans la table_b.

17.5.13 Espaces de table

You can define where postgres should store its data on disk by creating tablespaces:

CREATE TABLESPACE homespace LOCATION ’/home/pg’;

Lorsque vous créez une base de données, vous pouvez indiquer quel espace de table utiliser, ex:
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createdb --tablespace=homespace t4a

17.5.14 In Conclusion

Vous avez appris comment créer des géométries complexes en utilisant les déclarations PostGIS. Gardez à l’esprit
que vous avez amélioré votre connaissance globale sur les bases de données spatiales, à travers un outil SIG.
Vous n’avez généralement pas besoin d’utiliser ces déclarations manuellement mais disposer de compétences sur
leur utilisation et leur structure vous aidera à utiliser un SIG, particulièrement si vous rencontrez des erreurs qui
pourraient apparaître comme incompréhensibles autrement.
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CHAPTER 18

Le Guide du module Traitements de QGIS

Ce module est une contribution de Victor Olaya et Paolo Cavallini.

Contenus:

18.1 Introduction

Ce guide décrit comment utiliser le module Traitements de QGIS. Il n’exige aucune connaissance préalable tant
sur le module Traitements que sur les applications qui y sont reliées. Il suppose une connaissance basique de
QGIS. Les chapitres concernant les scripts supposent que vous avez une connaissance basique de Python, voire de
l’API Python de QGIS.

Ce guide est conçu pour un auto-apprentissage ou pour diriger un atelier sur le traitement.

Les exemples de ce guide utilisent QGIS 2.0 mais sont partiellement mis à jour pour 2.10. Ils pourraient ne pas
fonctionner ou ne plus être disponibles dans d’autres versions que celles-là.

Ce guide est composé de petits exercices à complexité croissante. Si vous n’avez jamais utilisé le module Traite-
ments, vous devriez commencer par le tout début. Si vous avez quelque petite expérience, vous pouvez ignorer
des leçons. Elles sont plus ou moins indépendantes les unes des autres, et chacune présente quelque nouveau
concept ou élément signalé dans le titre de chapitre et la courte introduction en début de chapitre. Cela devrait
donc faciliter la recherche des leçons relatives à un sujet particulier.

Pour une description plus systématique de tous les composants du module et leur utilisation, il est recommandé
de vérifier le chapitre correspondant dans le manuel QGIS. Utilisez-le comme un texte de support en complément
de ce guide.

Tous les exercices de ce guide utilisent des jeux de données libres Qui peuvent être téléchargés depuis le site web
de QGIS. Le fichier zip à télécharger contient de nombreux répertoires correspondants à chacune des leçons de ce
guide. vous trouverez dans chacun d’eux un fichier projet QGIS. Ouvrez-le et vous êtes prêts à démarrer la leçon.

Savourez!

18.2 Une importante mise en garde avant de commencer

De la même manière que le manuel d’un traitement de texte ne vous apprend pas à écrire une nouvelle ou un
poème ou qu’un tutoriel de CAO ne vous montre pas comment calculer la taille d’une poutre pour un bâtiment, ce
guide ne vous apprendra rien sur l’analyse spatiale. A la place, il vous montrera comment utiliser l’environnement
des Traitements QGIS qui est un outil puissant pour réaliser des analyses spatiales. Il est de votre responsabilité
d’apprendre les concepts qui seront indispensables à la compréhension de ce type d’analyses. Sans eux, vous
n’arriverez pas à utiliser l’environnement et ses algorithmes même si vous pouvez être tenté de le faire.

Voyons cela plus clairement avec un exemple.

A partir d’un jeu de points et de la valeur d’une variable de chaque point, vous pouvez calculer une couche raster
en utilisant le géo-traitement Krigeage. Les paramètres de la boîte de dialogue de ce module sont les suivants:
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Cela semble complexe, non?

En lisant ce manuel, vous apprendrez à utiliser ce module, comment le lancer dans un traitement par lots pour
créer des couches rasters à partir de centaines de couches ponctuelles en une seule passe, ou bien ce qui résulte si
la couche d’entrée a certains points sélectionnés. Néanmoins les paramètres en eux-même ne sont pas expliqués.
Un analyste expérimenté disposant d’une bonne connaissance de géo-statistique n’aura aucun problème à les
comprendre. Si vous n’en êtes pas et que les termes seuil, plage ou Nugget se vous sont pas familiers alors vous
ne pourrez pas utiliser le module Krigeage. Ce qui est d’autant plus le cas que ce module requiert de connaître les
concepts de l’auto-correlation spatiale ou les semi-variogrammes, ce dont vous n’avez sans doute jamais entendu
parler ou que vous n’avez sans doute pas étudié. Vous devez donc étudier et comprendre ces éléments avant de
revenir à QGIS pour les utiliser et réaliser des analyses. Les ignorer vous conduira a des résultats faussés et à des
analyses de piètre qualité (et souvent inutiles).

Bien que tous les algorithmes ne soient pas aussi complexes que le krigeage (même si certains sont quand même
plus complexes), la plupart d’entre eux requièrent la compréhension des concepts fondamentaux sur lesquels ils
sont basés. Sans cette connaissance, leur utilisation mènera très probablement à des résultats médiocres.
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Utiliser des géoalgorithmes sans avoir une bonne base en analyse spatiale revient à essayer d’écrire un roman sans
connaitre les règles de grammaire ou de syntaxe ni de narration. Vous obtiendrez un résultat, mais qui pourrait
n’avoir aucune valeur. De grâce, n’allez donc pas croire qu’une fois que vous aurez lu ce guide, vous serez capable
de réaliser des analyses spatiales et obtenir des résultats exacts. Il vous faudra tout de même étudier les analyses
spatiales.

Voici une bonne référence que vous pourrez lire au sujet de l’analyse de données spatiales.

Geospatial Analysis (3rd Edition): A Comprehensive Guide to Principles, Techniques and Software Tools Michael
John De Smith, Michael F. Goodchild, Paul A. Longley

C’est disponible en ligne ici

18.3 Installation du module de traitements

La première chose à faire avant d’utiliser le module de traitements est de le configurer. Il n’y a pas beaucoup à
mettre en place, c’est une tâche facile.

Plus tard, nous montrerons comment configurer les applications externes qui sont utilisées pour étendre la liste des
algorithmes disponibles, mais pour l’instant, nous allons nous contenter de travailler avec le module lui-même.

Le module de traitements est une extension principale de QGIS, ce qui signifie que, si vous utilisez QGIS 2.0 ou
suivant, il devrait déjà être installé sur votre système, car il est inclus avec QGIS. Dans le cas où il est activé, vous
devriez voir un menu appelé Traitements dans votre barre de menu. Vous y trouverez un accès à tous les éléments
du module.

Si vous ne pouvez pas trouver ce menu, vous devez activer l’extension en vous rendant dans le gestionnaire
d’extensions et en l’activant.

L’élément principal avec lequel nous allons travailler est la barre d’outils. Cliquez sur l’entrée du menu corre-
spondant et vous verrez la barre d’outils épinglée sur le côté droit de la fenêtre QGIS.
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The toolbox contains a list of all the available algorithms, divided in groups so called Providers. Providers can
be (de)activated in the settings dialog. A label in the bottom part of the toolbox will remind you of that whenever
there are inactive providers. Use the link in the label to open the settings window and set up providers. We will
discuss the settings dialog later in this manual.

By default, only providers that do not rely on third-party applications (that is, those that only require QGIS
elements to be run) are active. Algorithms requiring external applications might need additional configuration.
Configuring providers is explained in a later chapter in this manual.

Si vous avez atteint ce point, vous êtes maintenant prêt à utiliser des géoalgorithmes. Il n’y a pas besoin de
configurer autre chose pour le moment. Nous pouvons déjà faire tourner notre premier algorithme, ce que nous
ferons dans la prochaine leçon.

18.4 Lancement de notre premier algorithme. La boîte à outils

Note: Dans cette leçon, nous allons lancer notre premier algorithme, et obtenir notre premier résultat de cela.

Comme nous l’avons déjà mentionné, le module de traitement peut lancer les algorithmes d’autres applications,
mais il contient également des algorithmes natifs qui ne nécessitent pas un logiciel externe pour être exécutés. Pour
commencer l’exploration du module de traitement nous allons lancer un de ces algorithmes natifs. En particulier,
nous allons calculer les centroïdes d’un jeu de polygones.

Ouvrez tout d’abord le projet QGIS correspondant à cette leçon. Il contient seulement une seule couche avec deux
polygones.
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Now go to the text box at the top of the toolbox. That is the search box, and if you type text in it, it will filter the
list of algorithms so just those ones containing the entered text are shown. If there are algorithms that match your
search but belong to a provider that is not active, an additional label will be shown in the lower part of the toolbox.

Type centroids and you should see something like this.

The search box is a very practical way of finding the algorithm you are looking for. At the bottom of the dialog, an
additional label shows that there are algorithms that match your search but belong to a provider that is not active.
If you click on the link in that label, the list of algorithms will also include results from those inactive providers,
which will be shown in light gray. A link to activate each inactive provider is also shown. We’ll see later how to
activate other providers.
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To execute an algorithm, you just have to double-click on its name in the toolbox. When you double-click on the
Polygon centroids algorithm, you will see the following dialog.

Tous les algorithmes ont une interface similaire qui contient essentiellement des paramètres d’entrée que vous avez
à remplir, et de sortie dont vous devez choisir l’emplacement de stockage. Dans le cas présent, la seule donnée en
entrée que nous avons est une couche vectorielle de polygones.

Sélectionnez la couche de Polygones en entrée. L’algorithme a une seule sortie, qui est la couche des centroïdes. Il
y a deux options pour définir où la sortie de données est sauvegardée : entrez un chemin de fichier ou sauvegardez-
la dans un fichier temporaire

In case you want to set a destination and not save the result in a temporary file, the format of the output is defined by
the filename extension. To select a format, just select the corresponding file extension (or add it if you are directly
typing the filepath instead). If the extension of the filepath you entered does not match any of the supported ones,
a default extension (usually .dbf for tables, .tif for raster layers and .shp for vector ones) will be appended
to the filepath and the file format corresponding to that extension will be used to save the layer or table.

Dans tous les exercices de ce guide, nous sauvegarderons les résultats dans un fichier temporaire, tant qu’il n’y
a pas besoin de les sauvegarder pour une utilisation ultérieure. Sentez-vous libre de les sauvegarder à un endroit
permanent si vous le voulez.

Warning: Notez que les fichiers temporaires sont supprimés une fois que vous fermez QGIS. Si vous créez
un projet avec une sortie qui a été sauvegardée en tant que fichier temporaire, QGIS se plaindra lorsque vous
essayerez de rouvrir le projet plus tard, car le fichier de sortie n’existera plus.

452 Chapter 18. Le Guide du module Traitements de QGIS



QGIS Training Manual, Version 2.18

Once you have configured the algorithm dialog, press [Run] to run the algorithm.

Vous obtiendrez le fichier de sortie suivant.

Le fichier de sortie a le même SCR que celui d’entrée. Les géoalgorithmes supposent que toutes les couches
d’entrée partagent le même SCR et ne font aucune reprojection. Sauf dans le cas de certains algorithmes spéciaux
(par exemple ceux de reprojection), les fichiers de sortie auront aussi ce même SCR. Nous en verrons plus à propos
de cela bientôt.

Try yourself saving it using different file formats (use, for instance, shp and geojson as extensions). Also, if
you do not want the layer to be loaded in QGIS after it is generated, you can check off the checkbox that is found
below the output path box.

18.5 Plus d’algorithmes et types de données

Note: Dans cette leçon, nous lancerons trois algorithmes supplémentaires, apprendrons à utiliser d’autres types
d’entrées, et configurerons des sorties pour qu’elles soient sauvegardées dans un dossier donné automatiquement.

Pour cette leçon, nous aurons besoin d’une table et d’une couche de polygones. Nous allons créer une couche
de points basée sur des coordonnées dans la table, et ensuite compter le nombre de points dans chaque polygone.
Si vous ouvrez le projet QGIS correspondant à cette leçon, vous trouverez une table avec des coordonnées X et
Y, mais vous ne trouverez pas de couche de polygones. Ne vous inquiétez pas, nous la créerons en utilisant un
géoalgorithme de traitement.

La première chose que nous allons faire est de créer une couche de points à partir des coordonnées de la table, en
utilisant l’algorithme Convertir la table en points. Vous savez maintenant comment utiliser le champ de recherche,
et il ne devrait donc pas être trop difficile pour vous de le trouver. Double-cliquez dessus pour le lancer et accéder
à la boîte de dialogue suivante.

Cet algorithme, comme celui de la leçon précédente, génère qu’une seule sortie, et a trois entrées :

• Table: la table avec les coordonnées. Vous devrez sélectionner ici la table à partir des données de la leçon.

• Les champs X et Y: ces deux paramètres sont liés au premier. Le sélecteur correspondant montrera le nom
de ces champs qui sont disponibles dans la table sélectionnée. Sélectionnez le champ XCOORD pour le
paramètre X, et le champ YYCOORD pour le paramètre Y.
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• SCR : Comme cet algorithme ne prend pas de couche en entrée, il ne peut donc pas assigner un SCR à la
couche de sortie. À la place, il vous est demandé de sélectionner manuellement le SCR que les coordonnées
dans la table utilisent. Cliquez sur le bouton sur le côté gauche pour ouvrir le sélecteur du SCR de QGIS,
et sélectionnez EPSG:4326 comme SCR de sortie. Nous utilisons ce SCR car les coordonnées dans la table
sont dans ce SCR.

Votre boîte de dialogue devrait ressembler à cela.

Cliquez maintenant sur le bouton Exécuter pour obtenir la couche suivante (vous aurez peut être besoin de faire
un zoom arrière pour revenir sur les points nouvellement créés de la carte) :
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La prochaine chose dont nous avons besoin est la couche de polygone. Nous allons créer une grille régulière de
polygones en utilisant l’algorithme Créer une grille, qui a les paramètres suivants dans la boîte de dialogue.
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Warning: Les options sont plus simples dans les versions récentes de QGIS; vous devez juste rentrer les
valeurs min et max pour X et Y (suggestion de valeurs: -5.696226,-5.695122,40.24742,40.248171)

Les entrées requises pour créer une grille sont toutes des nombres. Lorsque vous devez entrer une valeur
numérique, vous avez deux options : la taper directement dans le champ correspondant, ou cliquer sur le bou-
ton sur le côté droit pour obtenir une boîte de dialogue comme celle montrée après.
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La boîte de dialogue contient une simple calculatrice, donc vous pouvez taper des expressions telles que 11 *
34.7 + 4.6, et le résultat sera calculé et inséré dans le champ de texte correspondant dans la boîte de dialogue
des paramètres. En outre, elle contient des constantes que vous pouvez utiliser, et des valeurs d’autres couches
disponibles.

Dans ce cas, nous voulons créer une grille qui couvre l’étendue de la couche de points d’entrée, de manière à
pouvoir utiliser les coordonnées pour calculer la coordonnée du centre de la grille ainsi que sa largeur et sa hauteur,
puisque ce sont les paramètres que l’algorithme prend pour créer la grille. Avec un peu de mathématiques, essayez
de faire ça par vous-même en utilisant la boîte de dialogue et les constantes de la couche de point d’entrée.

Sélectionnez Rectangles (polygones) dans le champ Type.

Comme dans le cas du dernier algorithme, nous devons entrer le SCR ici. Sélectionnez EPSG:4326 comme le
SCR cible, comme nous l’avons fait avant.

À la fin, vous devriez avoir une boîte de dialogue de paramètres comme ceci :

18.5. Plus d’algorithmes et types de données 457



QGIS Training Manual, Version 2.18

(Il est plus sage d’ajouter un espacement sur la largeur et la hauteur: Espacement horizontal: 0.0001, Espacement
vertical: 0.0001, Largeur: 0.001004, Hauteur: 0.000651, X Centre: -5.695674, Y Centre: 40.2477955). Le cas du
centre X est un peu compliqué: -5.696126+(( -5.695222+ 5.696126)/2)

Cliquez sur Exécuter et vous obtiendrez la couche du graticule.
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La dernière étape consiste à compter les points dans chacun des rectangles de ce graticule. Nous utiliserons
l’algorithme Compter les points dans les polygones.

Nous avons maintenant le résultat que nous cherchions.

Avant de terminer cette leçon, voici un rapide astuce pour vous simplifier la vie dans le cas où vous voulez
sauvegarder vos données de manière persistante. Si vous voulez sauvegarder tous vos fichiers de sortie dans un
dossier donnée, vous n’avez pas besoin de taper le nom du dossier à chaque fois. À la place, rendez-vous dans
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le menu de traitement et sélectionnez l’élément Options et configuration. Cela va ouvrir la boîte de dialogue de
configuration.

Dans l’entrée Dossier de sortie que vous trouverez dans le groupe Général, tapez le chemin de votre dossier de
destination.
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Désormais, quand vous lancez un algorithme, utilisez seulement le nom du fichier à la place de tout
le chemin. Par exemple, avec la configuration montrée ci-dessous, si vous entrez graticule.shp
comme chemin de sortie pour l’algorithme que nous venons d’utiliser, le résultat sera sauvegardé dans
D:\processing_output\graticule.shp. Vous pouvez toujours entrer un chemin entier au cas où vous
voulez sauvegarder un résultat dans un dossier différent.

Essayez vous-même l’algorithme Créer une grille avec différentes tailles de grille, et aussi avec différents types
de grille.

18.6 SCR. Reprojection

Note: Dans cette leçon, nous discuterons de comment les Traitements utilisent les SCR. Nous verrons également
un algorithme très utile : la reprojection.

Les SCR sont une grande source de confusion pour les utilisateurs de Traitements QGIS, alors voici quelques
règles générales sur la façon dont ils sont traités par les géoalgorithmes lors de la création d’une nouvelle couche.

• S’il y a des couches d’entrée, le SCR de la première couche sera utilisé. Celui-ci est supposé être le SCR de
toutes les couches d’entrée, car ils devraient avoir le même. Si vous utilisez des couches avec des SCR non
correspondants, QGIS vous en avertira. Notez que le SCR des couches d’entrées est affiché avec son nom
dans la boîte de dialogue des paramètres.

• S’il n’y a pas de couche d’entrée, ce sera le SCR du projet qui sera utilisé, à moins que l’algorithme
contienne un champ spécifique au SCR (comme cela s’est passé dans la dernière leçon avec l’algorithme
graticule)
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Ouvrez le projet correspondant à cette leçon et vous verrez deux couches nommées 23030 et 4326. Elles con-
tiennent toutes les deux les mêmes points, mais dans des SCR différents (EPSG:23030 and EPSG:4326). Elles
apparaissent à la même place parce que QGIS reprojecte à la volée le SCR du projet (EPSG:4326), mais elles ne
sont pas réellement la même couche.

Ouvrez l’algorithme Exporter/ajouter des colonnes de géométrie.

Cet algorithme ajoute des nouvelles colonnes aux tables attributaires d’une couche vectorielle. Le contenu des
colonnes dépend du type de géométrie de la couche. Dans le cas des points, de nouvelles colonnes avec les
coordonnées X et Y de chaque point sont ajoutées.

Dans la liste des couches disponibles que vous pouvez trouver dans le champ de couche d’entrée, vous verrez
chacune avec son SCR. Cela signifie que, bien qu’elles apparaissent à la même place dans votre canevas, elles
seront traitées différemment. Sélectionnez la couche 4326.

L’autre paramètre de l’algorithme permet de définir la manière dont l’algorithme utilise des coordonnées pour
calculer la nouvelle valeur qu’il ajoute aux couches résultantes. La plupart des algorithmes n’ont pas d’option
comme celle-ci, et il suffit d’utiliser directement les coordonnées. Sélectionnez l’option SCR de la couche pour
simplement utiliser des coordonnées telles qu’elles sont. Voilà comment presque tous les géoalgorithmes sont.

Vous devriez obtenir une nouvelle couche avec exactement les mêmes points comme les deux autres couches. Si
c’est le cas, cliquez sur le nom de la couche et ouvrez ses propriétés, vous verrez qu’elle partage le même SCR que
la couche d’entrée, qui est EPSG:4326. Lorsque la couche est chargée dans QGIS, il ne vous sera pas demandé
d’entrer le SCR de la couche, dès lors que QGIS sait déjà lequel c’est.

Si vous ouvrez la table attributaire de la nouvelle couche, vous verrez qu’elle contient deux nouveaux champs
avec les coordonnées X et Y de chaque point.
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Ces valeurs de coordonnées sont données dans le SCR de la couche, comme nous avons choisi cette option.
Cependant, même si vous choisissez une autre option, le SCR de la couche de sortie sera le même, comme le SCR
d’entrée est utilisé pour définir le SCR de la couche de sortie. Le choix d’une autre option donnera des valeurs
différentes, mais ne changerait pas le point ou le SCR de la couche de sortie par rapport au SCR de la couche
d’entrée.

Faites maintenant le même calcul en utilisant l’autre couche. Vous devriez trouver la couche résultante exactement
à la même place que les autres, et elle aura le SCR EPSG:23030, dès lors que c’était celui de la couche d’entrée.

Si vous vous rendez à sa table attributaire, vous verrez des valeurs qui sont différentes de celles dans la première
couche que nous avons créée.

Cela est dû au fait que les données originales sont différentes (elles utilisent un SCR différent), et ces coordonnées
sont prises de lui.

Que devons-nous en tirer ? L’idée principale derrière ces exemples est que les géoalgorithmes utilisent la couche
telle qu’elle est dans sa source originale de données, et ignorent complètement les reprojections que QGIS pourrait
faire avant le rendu. En d’autres termes, ne vous fiez pas à ce que vous voyez dans le canevas, mais gardez toujours
en tête que les données originales seront utilisées. Ce n’est pas si important dans ce cas, car nous n’utilisons qu’une
seule couche à la fois, mais dans un algorithme qui a besoin de plusieurs d’entre elles (comme un algorithme de
découpage), des couches qui semblent correspondre ou se superposer pourraient être très loin l’une de l’autre, car
elles pourraient avoir des SCR différents.

Les algorithmes n’effectuent aucune reprojection (excepté dans l’algorithme de reprojection que nous verrons plus
tard), c’est donc à vous de vous assurez que les couches ont des SCR correspondants.
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Un module intéressant qui travaille avec les SCR est celui de reprojection. Il représente un cas particulier, car il a
une couche d’entrée (celle à reprojeter), mais il n’utilise pas son SCR pour la couche de sortie.

Ouvrez l’algorithme Reprojection de couche.

Sélectionnez une des couches en entrée, et sélectionnez EPSG:23029 comme le SCR de destination. Lancez
l’algorithme et vous obtiendrez une nouvelle couche, identique à celle d’entrée, mais avec un SCR différent. Elle
apparaîtra dans la même région du canevas, comme les autres, tant que QGIS reprojette à la volée, mais ses coor-
données originales sont différentes. Vous pouvez voir cela en lançant l’algorithme Exporter/Ajouter des colonnes
géométriques en utilisant cette nouvelle couche comme entrée, et en vérifiant que les coordonnées ajoutées sont
différentes que celles dans les tables des attributs des deux couches que nous avons calculées avant.

18.7 Sélection

Note: Dans cette leçon, nous verrons comment les algorithmes de traitement gèrent les sélections dans les
couches vectorielles qui sont utilisées comme couches d’entrée, et comment créer une sélection en utilisant un
type particulier d’algorithme.

Contrairement à d’autres extensions d’analyse dans QGIS, vous ne trouverez pas de case à cocher “Utiliser unique-
ment les valeurs sélectionnées” ou autre case similaire dans les géoalgorithmes de traitement. Le comportement
concernant la sélection est défini pour l’ensemble de l’extension et tous ses algorithmes, et non pour chaque exé-
cution de l’algorithme. Les algorithmes suivent les règles simples suivantes lors de l’utilisation d’une couche
vecteur.

• Si la couche possède une sélection, seules les entités sélectionnées sont utilisées.

• S’il n’y a pas de sélection, toutes les entités sont utilisées.

Veuillez noter que ce comportement peut être modifié via le menu Traitement → Options → Général.

Vous pouvez vérifier par vous-même en sélectionnant quelques points dans une des couches que nous avons
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utilisées dans le chapitre précédent, et lancer sur eux l’algorithme de reprojection. La couche reprojetée que vous
obtiendrez contiendra seulement ces points qui ont été sélectionnés, à moins qu’il n’y ait pas de sélection préalable
auquel cas, la couche résultante contiendra tous les points de la couche d’origine.

Pour faire une sélection, vous pouvez utiliser une des méthodes ou un des outils disponibles dans QGIS. Cepen-
dant, vous pouvez également utiliser un géoalgorithme pour le faire. Les algorithmes pour créer une sélection se
trouvent dans la boîte à outils sous Vecteur/Sélection

Ouvrez l’algorithme Sélection aléatoire.

En laissant les valeurs par défaut, cela va sélectionner 10 points à partir de la couche actuelle.
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Vous remarquerez que cet algorithme ne produit pas de sortie, mais modifie la couche d’entrée (pas la couche
elle-même, mais sa sélection). C’est un comportement inhabituel, puisque tous les autres algorithmes produiront
de nouvelles couches et n’altérerons pas les couches d’entrée.

Étant donné que la sélection ne fait pas partie des données elles-mêmes, mais est quelque chose qui n’existe que
dans QGIS, ces algorithmes de sélection doivent seulement être utilisés pour la sélection dans une couche déjà
ouverte dans QGIS, et non une couche ajoutée avec l’option de sélection de fichier que vous pouvez trouver dans
la boîte de valeur du paramètre correspondant.

La sélection que nous venons de faire, comme la plupart de celles créées par les autres algorithmes de sélection,
peut également être faite manuellement depuis QGIS, donc vous pourriez peut-être vous demander à quoi ça sert
d’utiliser un algorithme pour cela. Bien que cela pourrait actuellement ne pas avoir beaucoup de sens pour vous,
nous verrons plus tard comment créer des modèles et des scripts. Si vous voulez faire une sélection au milieu
d’un modèle (qui définit un flux de traitement), seul un géoalgorithme peut être ajouté à un modèle. Les autres
éléments et opérations de QGIS ne peuvent y être ajoutés. C’est la raison pour laquelle certains algorithmes de
traitement dupliquent la fonctionnalité déjà disponible dans d’autres éléments QGIS.

Pour l’instant, souvenez-vous simplement que des sélections peuvent être faites en utilisant des géoalgorithmes,
et que les algorithmes utiliseront seulement les entités sélectionnées si une sélection existe, ou toutes les entités
autrement.

18.8 Lancement d’un algorithme externe

Note: Dans cette leçon, nous verrons comment utiliser des algorithmes qui dépendent d’une tierce application,
en particulier SAGA, qui est l’un des principaux fournisseurs d’algorithmes.

Tous les algorithmes que nous avons exécutés jusqu’à présent font partie du module de traitement. C’est à dire
que ceux sont des algorithmes natifs implémentés dans l’extension et exécutés par QGIS de la même façon que
l’extension elle-même est exécutée. Cependant, une des plus importantes caractéristiques du module de traitement
est qu’il peut utiliser des algorithmes provenant d’applications externes et étendre les possibilités de ces applica-
tions. De tels algorithmes sont enveloppés et placés dans la boîte d’outils, pour que vous puissiez les utiliser dans
QGIS et utiliser les données de QGIS pour les exécuter.

Certains des algorithmes que vous voyez dans la vue simplifiée ont besoin d’applications tierces qui ont besoin
d’être installées sur votre système. Un fournisseur d’algorithmes ayant un intérêt particulier est SAGA (Système
pour l’Analyse Géospatiale Automatisée). Nous devons d’abord tout configurer pour que QGIS puisse correcte-
ment appeler SAGA. Cela n’est pas compliqué, mais il est important de comprendre comment cela fonctionne.
Chaque application externe a sa propre configuration et, plus tard dans ce manuel, nous parlerons de certaines
autres, mais SAGA va devenir notre support principal et nous allons maintenant en discuter.

Si vous utilisez Windows, la meilleure façon de travailler avec des algorithmes externes est d’utiliser l’installateur
indépendant de QGIS. Il fera en sorte d’installer toutes les dépendances requises, y compris SAGA, ainsi si vous
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l’avez utilisé, il n’y a rien à faire. Vous pouvez ouvrir la boîte de dialogue des paramètres et aller au groupe
Pilotes/SAGA.

Le chemin SAGA devrait déjà être configuré et pointer vers le dossier où SAGA est installé.

Si vous avez installé QGIS sans utiliser l’installateur indépendant vous devez alors indiquer le chemin d’accès à
votre installation de SAGA (que vous devrez avoir installé indépendamment).

Dans le cas où vous utilisez Linux, vous n’avez pas besoin de mettre le chemin de votre installation SAGA
dans la configuration du de l’outil Traitement. À la place, vous devez installer SAGA et être sûr que le dossier
SAGA est dans le PATH, de sorte qu’il puisse être appelé depuis la console (ouvrez simplement une console et
tapez saga_cmd pour le vérifier). Sous Linux, la version ciblée pour SAGA est aussi 2.1, mais dans certaines
installations (comme par exemple le OSGeo Live DVD) vous ne pourriez avoir que la version 2.0.8 de disponible.
Il y a des compilations 2.1 disponibles, mais elles ne sont généralement pas installées et peuvent avoir quelques
problèmes, donc si vous préférez utiliser la version 2.0.8 plus courante et plus stable, vous pouvez le faire en
activant la compatibilité 2.0.8 dans la boîte de dialogue de configuration, sous le groupe SAGA.
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Une fois que SAGA est installé, vous pouvez lancer un algorithme SAGA en double-cliquant sur son nom, comme
avec n’importe quel autre algorithme. Étant donné que nous utilisons l’interface simplifiée, vous ne savez pas
quels algorithmes sont basés sur SAGA ou dans une autre application externe, mais si vous arrivez à double–
cliquer sur un des algorithmes et que l’application correspondante n’est pas installée, vous verrez quelque chose
comme ceci.

Dans notre cas, et en supposant que SAGA est correctement installé et configuré, vous ne devriez pas voir cette
fenêtre, et vous obtiendrez à la place la boîte de dialogue des paramètres.
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Essayons avec un algorithme SAGA de base, celui nommé Séparer une couche de formes aléatoirement.

Utilisez la couche de points dans le projet correspondant à cette leçon comme entrée, et les valeurs de paramètre
par défaut, et vous obtiendrez quelque chose comme ceci (la séparation est aléatoire, donc votre résultat pourrait
être différent).

La couche en entrée a été séparée en deux couches, chacune avec le même nombre de points. Ce résultat a été
calculé par SAGA, récupéré ensuite par QGIS et ajouté au projet QGIS.

Si tout va bien, vous ne remarquerez aucune différence entre cet algorithme SAGA de base et un des autres
algorithmes que nous avons précédemment lancé. Cependant, SAGA peut, pour une raison quelconque, ne pas
être capable de produire un résultat et ne pas pouvoir générer le fichier que QGIS attend. Dans ce cas, il y aura
des problèmes en ajoutant le résultat au projet QGIS, et un message d’erreur comme celui ci-dessous.
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Ce type de problème peut se passer, même si SAGA (ou n’importe quelle autre application que nous avons appelé
à partir du module de traitements) est correctement installé, et il est important de savoir comment gérer ces erreurs.
Produisons un de ces messages d’erreur.

Ouvrez l’algorithme Créer un graticule et utilisez les valeurs ci-dessous.

Nous utilisons les valeurs de largeur et de hauteur qui sont plus grandes que l’emprise indiquée, donc SAGA
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ne peut pas produire de sortie. En d’autres mots, les valeurs des paramètres sont fausses, mais elles ne sont pas
vérifiées jusqu’à ce que SAGA les obtienne et essaie de créer la grille. Tant qu’il ne peut pas la créer, il ne produira
pas la couche attendue, et vous verrez un message d’erreur comme montré ci-dessus.

Note: Avec SAGA >=2.2.3, la commande ajustera automatiquement les valeurs erronées en entrée et vous
n’obtiendrez donc pas d’erreur. Afin de provoquer une erreur, indiquez des valeurs négatives pour la division.

La compréhension de ce type de problèmes vous aidera à les résoudre et à trouver une explication à ce qu’il se
passe. Comme vous pouvez le voir dans le message d’erreur, un test est effectué pour vérifier que la connexion
avec SAGA fonctionne correctement, vous indiquant qu’il peut y avoir un problème dans comment l’algorithme a
été exécuté. Cela s’applique non seulement à SAGA, mais aussi à d’autres applications externes.

Dans la prochaine leçon, nous introduirons le journal de progression, où l’information à propos des commandes
lancées par les géoalgorithmes est gardée, et vous verrez comment obtenir plus de détail lorsque des problèmes
comme ceci apparaissent.

18.9 Le journal de progression

Note: Cette leçon décrit le journal du traitement.

Toutes les analyses effectuées avec le module de traitements sont enregistrées dans le système de suivi du journal
de QGIS. Cela vous permet d’en savoir plus à propos de ce qui a été fait avec les outils de traitement, pour résoudre
des problèmes quand ils surviennent, et aussi de re-exécuter les opérations précédentes, puisque le système de suivi
du journal met également en oeuvre une certaine interactivité.

Pour ouvrir le journal, cliquez sur la bulle en bas à droite, sur la barre d’état de la fenêtre QGIS. Certains algo-
rithmes peuvent laisser ici des informations sur leur exécution. Par exemple, ces algorithmes qui appellent une
application externe enregistrent habituellement la sortie de la console de l’application dans cette entrée. Si vous
jetez un œil à celle-ci, vous verrez que la sortie de l’algorithme SAGA que nous venons de faire tourner (et qui
n’est pas parvenu à s’exécuter car les données d’entrée n’étaient pas corrects) est stockée ici.

Ceci est utile pour comprendre ce qui se passe. Les utilisateurs avancés seront capables d’analyser cette sortie
pour trouver pourquoi l’algorithme n’a pas pu s’exécuter. Si vous n’êtes pas un utilisateur avancé, ceci permettra
aux autres personnes de vous aider à diagnostiquer le problème, qui peut être un problème dans l’installation du
logiciel externe ou un problème avec les données que vous avez fournies.

Même si l’algorithme peut être exécuté, certains algorithmes peuvent laisser des messages d’avertissements
lorsque le résultat peut ne pas être correct. Par exemple, lors de l’exécution d’un algorithme d’interpolation avec
un très petit nombre de points, l’algorithme peut tourner et produira un résultat, mais il est probable qu’il ne sera
pas correct, car plus de points auraient du être utilisés. Il est utile de vérifier régulièrement ce type d’avertissements
si vous n’êtes pas sûr de certains aspects d’un algorithme donné.

Vous trouverez un dossier Algorithmes dans le menu Traitements, sous la section Historique. Tous les algorithmes
qui sont exécutés, même s’ils sont lancés depuis l’interface graphique et non depuis la console (dont on parlera
plus tard dans ce manuel), sont stockés dans cette partie du journal comme un appel de console. Cela signifie
que chaque fois que vous lancez un algorithme, une commande de console est ajoutée au journal et vous avez
l’historique entier de votre session de travail. Voici à quoi ressemble cet historique de travail :
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Il peut être très utile lorsque l’on commence à travailler avec la console, d’apprendre la syntaxe des algorithmes.
Nous l’utiliserons lorsque nous discuterons de comment lancer des commandes d’analyses depuis la console.

L’historique est aussi interactif, et vous pouvez re-exécuter chaque algorithme précédent simplement en double–
cliquant sur son entrée. C’est une façon simple de répéter le travailler que nous avons déjà fait avant.

Par exemple, essayez ce qui suit. Ouvrez les données correspondantes au premier chapitre de ce manuel et exé-
cuter l’algorithme expliqué ici. Rendez-vous maintenant à la boîte de dialogue du journal et localisez le dernier
algorithme dans la liste, qui correspond à l’algorithme que nous venons d’exécuter. Double–cliquez dessus et un
nouveau résultat devrait être produit, simplement comme lorsque vous l’avez lancé en utilisant la boîte de dialogue
normale et en l’appelant depuis la boîte à outils.

18.9.1 Avancé

Vous pouvez également modifier l’algorithme. Simplement copiez-le, ouvrez Extensions → Con-
sole Python, cliquez sur Importer une classe → Importer une classe de traitement, puis collez-
le pour relancer l’analyse ; modifiez le texte à volonté. Pour afficher le fichier obtenu, tapez
iface.addVectorLayer(’/chemin/nomdufichier.shp’, ’Nom de la couche dans
la légende’, ’ogr’). Autrement, vous pouvez utiliser processing.runandload.

18.10 La calculatrice raster. Valeurs No-data

Note: Dans cette leçon, nous verrons comment utiliser la calculatrice raster pour effectuer des opérations sur des
couches raster. Nous expliquerons également qu’est-ce que sont les valeurs no–data et comment la calculatrice et
les autres algorithmes réagissent avec elles.
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La calculatrice rester est un des plus puissants algorithmes que vous trouverez. C’est un algorithme très flexible
et souple qui peut être utilisé pour beaucoup de calculs différents, et il deviendra bientôt une partie importante de
votre boîte à outils.

Dans cette leçon, nous allons réaliser quelques calculs, plutôt simples, à l’aide de la calculatrice raster. Cela
nous permettra de voir comment l’utiliser et comment gérer certaines situations particulières que nous pourrons
rencontrer. Comprendre est une étape importante pour obtenir à l’avenir des résultats adaptés en utilisant la
calculatrice et également pour maîtriser certaines techniques qui sont courramment employées avec.

Ouvrez le projet QGIS correspondant à cette leçon et vous verrez qu’il contient plusieurs couches raster.

Ouvrez maintenant la boîte à outils et ouvrez la boîte de dialogue correspondant à la calculatrice raster.

Note: L’interface est différente dans les versions récentes.

La boîte de dialogue contient 2 paramètres.

• Les couches à utiliser pour l’analyse. C’est une entrée multiple, ce qui signifie que vous pouvez sélectionner
autant de couches que vous voulez. Cliquez sur le bouton sur le côté droit et sélectionnez ensuite les couches
que vous voulez utiliser dans la boîte de dialogue qui apparaît.

• La formule à appliquer. La formule utilise les couches sélectionnées dans le paramètre du haut, qui sont
nommées en utilisant les lettres de l’alphabet (a, b, c...) ou g1, g2, g3... comme nom de
variable. Autrement dit, la formule a + 2 * b est la même que g1 + 2 * g2 et calculera la somme
des valeurs dans la première couche plus deux fois la valeur dans la seconde couche. L’ordre des couches
est le même ordre que vous voyez dans la boîte de dialogue de sélection.

Warning: La calculatrice est sensible à la casse.

Pour commencer, nous changerons les unités du MNE des mètres aux pieds. La formule dont nous avons besoin
est la suivante :
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h’ = h * 3.28084

Sélectionnez le MNE dans le champ des couches et tapez a * 3.28084 dans le champ de formule.

Warning: Pour les utilisateurs non anglophones : utilisez toujours ”.”, et non ”,”.

Cliquez sur Exécuter pour lancer l’algorithme. Vous obtiendrez une couche qui a la même apparence que la couche
d’entrée, mais avec des valeurs différentes. La couche d’entrée que nous avons utilisée possède des valeurs valides
dans toutes ses cellules, donc le dernier paramètre n’a pas du tout d’effet.

Effectuons maintenant un autre calcul, cette fois sur la couche accflow. Cette couche contient des valeurs de flux
cumulés, un paramètre hydrologique. Elle contient des valeurs seulement dans la zone d’un bassin hydrographique
donné, avec des valeurs no–data en dehors de celui-ci. Comme vous pouvez le voir, le rendu n’est pas très instruc-
tif, en raison de la façon dont les valeurs sont distribuées. L’utilisation du logarithme de cette accumulation de
flux donnera une représentation beaucoup plus instructive. Nous pouvons calculer cela en utilisant la calculatrice
raster.

Ouvrez à nouveau la boîte de dialogue de l’algorithme, sélectionnez la couche accflow comme la seule couche
d’entrée, et entrez la formule suivante : log(a)‘.

Voici la couche que vous obtiendrez.

Si vous sélectionnez l’outil Identifier pour connaître la valeur d’une couche à un point donné, sélectionnez la
couche que nous venons juste de créer, et cliquez sur un point en dehors du bassin, vous verrez qu’il contient une
valeur no–data.
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Pour l’exercice suivant, nous allons utiliser deux couches à la place d’une, et nous allons obtenir un MNE avec des
valeurs d’élévation valides seulement dans le bassin défini dans la seconde couche. Ouvrez la boîte de dialogue de
la calculatrice et sélectionnez les deux couches du projet dans le champ des couches d’entrée. Entrez la formule
suivant dans le champ correspondant :

a/a * b

a fait référence à la couche de flux cumulé (car il est la premier à apparaître dans la liste) et b fait référence au
MNE. Ce que nous allons faire dans la première partie de cette formule ici est de diviser la couche de flux cumulé
par elle-même, ce qui donnera une valeur de 1 dans le bassin, et une valeur no–data à l’extérieur. Puis nous
multiplions par le MNE, pour obtenir la valeur d’élévation dans les cellules dans le bassin (MNE * 1 = MNE) et
des valeurs no–data à l’extérieur (MNE * no_data = no_data)

Voici la couche de résultat.

Cette technique est fréquemment utilisée pour masquer des valeurs dans une couche raster, et est utile toute les fois
que vous voulez effectuer des calculs pour une région autre que la région rectangulaire arbitraire qui est utilisée
par une couche raster. Par exemple, un histogramme des élévations d’une couche raster n’a pas beaucoup de sens.
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S’il est à la place calculé en utilisant seulement des valeurs qui correspondent à un bassin (comme dans le cas
ci-dessus), le résultat que nous obtenons a un sens et donne effectivement des informations sur la configuration du
bassin.

Il y a d’autres choses intéressantes sur cet algorithme que nous venons juste d’exécuter en dehors des valeurs
sans-donnée et comment elles sont traitées. Si vous regardez l’emprise des couches que nous avons multipliées
(vous pouvez le faire en double-cliquant sur le nom des couches dans la table des matières et en inspectant leurs
propriétés), vous verrez que ce ne sont pas les mêmes, car l’emprise couverte par la couche d’accumulation de
flux est plus petite que l’emprise du MNE complet.

Cela signifie que ces couches ne correspondent pas et qu’elles ne peuvent pas être multipliées directement sans
homogénéiser leur tailles et leur emprises en ré-échantillonnant une ou les deux couches. Cependant, nous n’avons
rien fait. QGIS prend soin de cette situation et ré-échantillonne automatiquement les couches d’entrée lorsque
nécessaire. L’emprise de sortie est la couverture de l’emprise minimum calculée à partir des couches d’entrée et
la taille de cellule minimum de leurs tailles de cellule.

Dans ce cas (et dans la plupart des cas), cela produit les résultats souhaités, mais vous devriez toujours être
conscient des opérations supplémentaires qui ont lieu, car elles pourraient influencer sur le résultat. Dans les cas
où ce comportement ne devrait pas être désiré, un ré-échantillonnage manuel doit être appliqué à l’avance. Dans
les chapitres suivants, nous en verrons plus sur le comportement des algorithmes lors de l’utilisation de plusieurs
couches raster.

Finissons cette leçon avec un autre exercice de masquage. Nous allons calculer la pente dans toutes les aires ayant
une élévation entre 1000 et 1500 mètres.

Dans ce cas, nous n’avons pas de couche à utiliser comme masque, mais nous pouvons en créer une en utilisant la
calculatrice.

Lancez la calculatrice en utilisant le MNE comme seule couche d’entrée et la formule suivante

ifelse(abs(a-1250) < 250, 1, 0/0)

Comme vous pouvez le voir, nous pouvons utiliser la calculatrice non seulement pour faire de simples opérations
algébriques, mais aussi pour exécuter des calculs plus complexes impliquant des propositions conditionnelles,
comme celui ci-dessus.

Le résultat a une valeur de 1 dans la plage avec laquelle nous voulons travailler, et no–data dans les cellules à
l’extérieur de celle-ci.

La valeur no–data vient de l’expression 0/0. Comme c’est une valeur indéterminée, SAGA ajoutera une valeur
NaN (Not a Numbre, pas un nombre en anglais), qui est en fait traitée comme une valeur no–data. Avec ce petit
truc, vous pouvez mettre une valeur no–data sans avoir besoin de savoir qu’est-ce que la valeur no–data de la
cellule.
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Vous n’avez plus qu’à maintenant la multiplier avec la couche de pente intégrée au projet, et vous obtiendrez le
résultat désiré.

Tout cela peut être fait en une simple opération avec la calculatrice. Nous laissons cela comme exercice au lecteur.

18.11 Calculatrice Vecteur

Note: Dans cette leçon, nous verrons comment ajouter de nouveaux attributs à une couche vectorielle en se basant
sur une expression mathématique, en utilisant la calculatrice vecteur.

Nous savons déjà comme utiliser la calculatrice raster pour créer de nouvelles couches raster en utilisant des
expressions mathématiques. Un algorithme semblable est disponible pour la couche vectorielle, et génère une
nouvelle couche avec les mêmes attributs que la couche d’entrée, plus un attribut supplémentaire avec le résultat
de l’expression entrée. L’algorithme est appelé Calculatrice de champ et offre les paramètres suivants.

Note: Les récentes versions de Traitement ont considérablement fait évoluer l’interface, devenant plus robuste et
plus facile à utiliser.

Voici quelques exemples d’utilisation de cet algorithme.

Tout d’abord, calculons la densité de population des personnes blanches dans chaque polygone, qui représente
un recensement. Nous avons deux champs dans la table attributaire que nous pouvons utiliser pour cela, à savoir
WHITE et SHAPE_AREA. Nous avons juste à les diviser et les multiplier par un million (pour avoir la densité par
km carré), nous pouvons donc utiliser la formulaire suivante dans le champ correspondant :

( "WHITE" / "SHAPE_AREA" ) * 1000000

La boîte de dialogue des paramètres devrait être remplie comme montré ci-dessous :

Cela va générer un nouveau champ appelé WHITE_DENS
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Calculons maintenant dans un nouveau champ le ratio entre les champs MALES‘ et FEMALES pour voir si la
population masculine est numériquement prédominante sur la population féminine.

Entrez la formule suivante

"MALES" / "FEMALES"

Cette fois, la fenêtre des paramètres devrait ressembler à cela avant de cliquer sur le bouton OK.
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Dans la version précédente, les deux champs étant de type entier, le résultat sera tronqué en un entier. Pour indiquer
que le résultat souhaiter doit être à virgule flottante, la formule devrait être: 1.0 * "MALES" / "FEMALES".

Nous pouvons utiliser des fonctions conditionnelles pour avoir un nouveau champ avec comme chaîne de carac-
tères mâle ou femelle à la place de ces valeurs de rapport, en utilisant la formule suivante:

CASE WHEN "MALES" > "FEMALES" THEN ’male’ ELSE ’female’ END

La fenêtre des paramètres devrait ressembler à ceci.
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Une calculatrice de champ python est disponible dans la Calculatrice de champ avancée Python qui ne sera pas
détaillée ici
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18.12 Définition des étendues

Note: Dans cette leçon, nous verrons comment définir les emprises qui sont nécessaires pour certains algorithmes,
en particulier ceux avec des rasters.

Certains algorithmes nécessitent une étendue pour définir l’aire à couvrir par l’analyse qu’ils effectuent, et
habituellement, définir l’étendue de la couche de résultat.

Lorsqu’une emprise est nécessaire, elle peut être définie manuellement en entrant les quatre valeurs qui la définis-
sent (X min, Y min, X max, Y max), mais il y a aussi d’autres façons plus pratiques et plus intéressantes de le
faire. Nous les verrons toutes dans cette leçon.

Premièrement, ouvrons un algorithme qui requière une étendue comme paramètre. Ouvrez l’algorithme Rasteri-
sation, qui crée une couche raster à partir d’une couche vectorielle.
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Tous les paramètres, excepté les deux derniers, sont utilisés pour définir quelle couche doit être numérisée et
configurer comment le processus de numérisation devrait fonctionner. Les deux derniers paramètres, d’autre part,
définissent les caractéristiques de la couche de sortie. Cela signifie qu’ils définissent la zone qui est couverte
(qui n’est pas nécessairement la même zone couverte par la couche vectorielle d’entrée), et la résolution/taille de
cellules (qui ne peut pas être déduite de la couche vectorielle, étant donné que les couches vectorielles n’ont pas
de taille de cellules).

La première chose que vous pouvez faire est de taper les 4 valeurs définies expliquées plus tôt, séparées par des
virgules.

Cela ne nécessite pas d’explication supplémentaire. Bien que ce soit l’option la plus flexible, c’est aussi la moins
pratique dans certains cas, et c’est pourquoi d’autres options sont mises en oeuvre. Pour y accéder, vous devez
cliquer sur le bouton sur le côté droit de la zone de texte étendue.

Voyons ce que fait chacune d’entre elles.

La première option est Utiliser l’emprise de la couche/du canevas, qui montrera la boîte de dialogue de sélection
montrée ci-dessous.
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Ici vous pouvez sélectionner l’étendue du canevas (dans la mesure prévue par le zoom en cours), ou l’extension de
n’importe quelles couches disponibles. Sélectionnez-la et cliquez sur OK, et la zone de texte sera automatiquement
remplie avec les valeurs correspondantes.

La seconde option est Sélectionner l’emprise depuis le canevas. Dans ce cas, la boîte de dialogue de l’algorithme
disparaît et vous pouvez cliquer et faire glisser sur le canevas QGIS pour définir l’étendue désirée.

Une fois que vous relâchez le bouton de la souris, la boîte de dialogue réapparaîtra et la zone de texte aura déjà les
valeurs correspondantes à l’emprise définie.

La dernière option est Utiliser l’étendue de couverture minimale depuis les couches d’entrée, qui est l’option
par défaut. Cette fonction calcule l’étendue de couverture minimale de toutes les couches utilisées pour exécuter
l’algorithme, et il n’y a pas besoin d’entrer de valeur dans la zone de texte. Dans le cas d’une seule couche
d’entrée, comme dans l’algorithme que nous avons lancé, la même étendue peut être obtenue en sélectionnant
cette même couche d’entrée dans Utiliser l’emprise de la couche/du canevas que nous avons déjà vu. Cependant,
quand il y a plusieurs couches d’entrée, l’étendue de couverture minimale ne doit correspondre à aucune étendue
d’une des couches d’entrée, car elle est calculée à partir de toutes les couches mises ensemble.

Nous utiliserons cette dernière méthode pour exécuter notre algorithme de mise en raster.

Remplissez la boîte de dialogue des paramètres comme montré par la suite et cliquez sur OK.
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Note: Dans ce cas, utilisez plutôt un entier (1 octet) au lieu d’un réel (4 octets), car NAME est un entier ayant
une valeur maximum=64. Une taille de fichier plus petite et des calculs plus rapides en résulteront.

Vous obtiendrez une couche de numérisation qui couvre exactement la zone couverte par la couche vecteur origi-
nale.
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Dans certains cas, la dernière option, Utiliser l’emprise de couverture minimale depuis les couches d’entrée,
pourrait ne pas être disponible. C’est le cas avec les algorithmes qui n’ont pas de couches d’entrée, mais seulement
des paramètres d’autres types. Dans ce cas, vous devrez entrer la valeur manuellement ou utiliser une des autres
options.

Notez que, lorsqu’une sélection existe, l’emprise de la couche est celle de l’ensemble des entités et la sélection
n’est pas utilisée pour calculer l’emprise, même si la mise en raster ne se fait que sur les éléments sélectionnés.
Dans ce cas, vous pouvez alors vouloir créer une nouvelle couche à partir de la sélection et ensuite l’utiliser comme
entrée.

18.13 Sorties HTML

Note: Dans cette leçon, nous apprenons comment QGIS gère les sorties en format HTML, qui sont utilisées pour
produire des sorties texte et graphiques.

Toutes les sorties que nous avons produites jusqu’à maintenant étaient des couches (soit raster soit vecteur).
Cependant, certains algorithmes génèrent des sorties sous forme de textes et de graphiques. Toutes ces sorties
sont intégrées dans des fichiers HTML et affichées dans un Affichage des résultats, comme appelé, qui est un autre
élément du module de traitement.

Voyons un de ces algorithmes pour comprendre comment ils fonctionnent.

Ouvrez le projet avec les données à utiliser dans cette leçon et ensuite ouvrez l’algorithme Statistiques basiques
pour champs numériques.

18.13. Sorties HTML 485



QGIS Training Manual, Version 2.18

L’algorithme est assez simple, et vous avez juste à sélectionner la couche à utiliser et un de ses champs (un
numérique). La sortie est de type HTML, mais le champ correspondant fonctionne exactement comme celui
que vous pouvez trouver dans le cas d’une sortie raster ou vecteur. Vous pouvez entrer un chemin de fichier ou
le laisser blanc pour sauvegarder en tant que fichier temporaire. Dans ce cas, cependant, seul le html et les
extensions html sont autorisés, il n’y a donc aucun moyen de modifier le format de sortie en utilisant un autre
format.

Lancez l’algorithme en sélectionnant la seule couche dans le projet comme entrée, et le champ POP2000, et une
nouvelle boîte de dialogue comme celle montrée après apparaîtra une fois l’algorithme exécuté et la boîte de
dialogue des paramètres fermée.
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Voici le Visualiseur de résultats. Il conserve tous les résultats HTML générés durant la session actuelle, et il est
facilement accessible. Vous pouvez donc les vérifier rapidement chaque fois que vous en avez besoin. Comme
pour les couches, si vous avez sauvegardé la sortie dans un fichier temporaire, il s’effacera une fois que vous
fermerez QGIS. Si vous avez sauvegardé sous un chemin non temporaire, le fichier restera, mais il n’apparaîtra
pas dans le Visualiseur de résultats la prochaine fois que vous ouvrirez QGIS.

Certains algorithmes génèrent du texte qui ne peut pas être divisé en d’autres sorties plus détaillées. C’est le cas,
par exemple, si l’algorithme saisit la sortie de texte à partir d’un processus externe. Dans d’autres cas, la sortie se
présente sous forme de texte, mais est divisée à l’intérieur en plusieurs petites sorties, habituellement sous forme
de valeurs numériques. L’algorithme que nous venons d’exécuter est l’un de ceux-ci. Chacune de ses valeurs est
traitée comme une sortie unique, et stockée dans une variable. Cela n’a pas du tout d’importance pour l’instant,
mais une fois que nous passerons au modeleur graphique, vous verrez que cela nous permet d’utiliser ces valeurs
comme entrées numériques pour des autres algorithmes.

18.14 Premier exemple d’analyse

Note: Dans cette leçon, nous effectuerons une véritable analyse en utilisant uniquement la boîte à outils, afin que
vous puissiez vous familiariser avec les éléments du module de traitements.

Maintenant que tout est configuré et que nous pouvons utiliser des algorithmes externes, nous avons un outil très
puissant pour effectuer une analyse spatiale. Il est temps de réaliser un exercice plus important avec des données
du monde réel.

Nous utiliserons le fameux set de données que John Snow utilisa en 1854 dans son œuvre révolution-
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naire (http://en.wikipedia.org/wiki/John_Snow_%28physician%29), et nous obtiendrons des résultats intéressants.
L’analyse de ce set de données est presque triviale et les techniques sophistiquées de SIG ne sont pas nécessaires
pour obtenir de bons résultats et conclusions, mais c’est une bonne façon de montrer comment ces problèmes
spatiaux peuvent être analysés et résolus par l’utilisation d’outils de traitement différents.

Le jeu de données contient des fichiers Shape qui référencent les décès dus au choléra, les emplacements des
pompes à eau ainsi qu’une carte raster issue d’OSM au format TIFF. Ouvrez le projet QGIS correspondant à cette
leçon.

La première chose à faire est de calculer le diagramme de Voronoï (aussi connu sous le nom des polygones
de Thyessen) de la couche des pompes, pour obtenir la zone d’influence pour chaque pompe. L’algorithme du
Diagramme de Voronoï peut être utilisé pour cela.
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C’est assez facile, mais cela nous donne déjà des informations intéressantes.
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Il est clair que la plupart des cas soient dans un des polygones.

Pour obtenir un résultat plus quantitatif, nous pouvons compter le nombre de décès dans chaque polygones.
Comme chaque point représente un bâtiment où il y a eu un ou des décès, et que le nombre de décès est stocké
dans un attribut, nous ne pouvons pas simplement compter les points. Nous avons besoin d’un nombre pondéré,
donc nous utiliserons l’outil Compter les points dans les polygones (pondérés).
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Le nouveau champ sera appelé DEATHS, et nous utiliserons le champ COUNT comme champ de pondération. La
table de résultats reflète clairement que le nombre de décès dans le polygone correspondant à la première pompe
est beaucoup plus grand que celui des autres.
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Une autre bonne façon de visualiser la dépendance de chaque point dans la couche Cholera_deaths avec un
point dans la couche Pumps est de dessiner une ligne vers le plus proche. Cela peut être fait avec l’outil Distance
au nœud le plus proche, et en utilisant la configuration montrée ci-après.
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Le résultat ressemble à cela :
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Bien que le nombre de lignes soit plus grand dans le cas de la pompe centrale, n’oubliez pas que cela ne représente
par le nombre de décès, mais le nombre de lieux où des cas de choléra ont été détecté. C’est un paramètre
représentatif, mais il ne considère pas que certains emplacements puissent représenter plus de cas qu’un autre.

Une couche de densité nous donnera aussi une vision très claire de ce qu’il se passe. Nous pouvons la créer avec
l’algorithme Densité par noyau. En utilisant la couche Cholera_deaths et son champ COUNT comme champ de
pondération, avec un rayon de 100 ainsi que l’emprise et la taille des cellule de la couche raster des rues, nous
obtenons quelque chose comme ça.
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Souvenez-vous que pour obtenir l’emprise de sortie, vous ne devez pas la taper. Cliquez sur le bouton sur le côté
droit et sélectionnez Utiliser l’emprise de la couche/du canevas.
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Sélectionnez la couche raster des routes et son étendue sera automatiquement ajoutée au champ de texte. Vous
devez faire de même avec la taille de cellule, en sélectionnant la taille de cellule de cette couche.

En combinant la couche des pompes, nous voyons qu’il y a une pompe qui se trouve clairement dans le point
chaud où la densité maximale de cas de décès a été trouvée.

18.15 Découpage et fusion de couches raster

Note: Dans cette leçon, nous verrons un autre exemple de préparation de données spatiales, pour continuer à
utiliser des géoalgorithmes dans des scénarios du monde réel.

Pour cette leçon, nous allons calculer une couche de pente pour une zone entourant une zone de ville, qui est
donnée dans une couche vecteur avec un seul polygone. Le MNT de base est divisé en deux couches raster
qui, ensemble, couvrent une zone beaucoup plus grande que celle autour de la ville avec laquelle nous voulons
travailler. Si vous ouvrez le projet correspondant à cette leçon, vous verrez quelque chose comme ça.
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Ces couches ont deux problèmes :

• Elles couvrent une aire qui est trop grande pour ce que l’on veut (nous nous intéressons à une plus petite
région autour du centre ville)

• Elles sont dans deux fichiers différents (les limites de la ville tombent dans une seule couche raster, mais,
comme cela a été dit, nous voulons des zones supplémentaires autour d’elle).

Ces deux problèmes sont facilement résolvables avec les géoalgorithmes appropriés.

Premièrement, nous créons un rectangle définissant la zone que nous voulons. Pour faire cela, nous créons une
couche contenant l’emprise rectangulaire de la couche avec les limites de la zone de la ville, et ensuite nous lui
ajoutons un tampon, afin d’obtenir une couche raster qui couvre un peu plus que le strict nécessaire.

Pour calculer l’emprise rectangulaire, nous pouvons utiliser l’algorithme Créer un polygone à partir de l’emprise
d’une couche.
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Pour lui ajouter un tampon, nous utilisons l’algorithme Tampon à distance fixe, avec les valeurs de paramètres
suivantes.
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Warning: La syntaxe a changé dans les récentes versions; définissez la Distance et l’Arc de vertex à .25

Voici l’emprise résultante obtenue en utilisant les paramètres montrés au-dessus.

Il s’agit d’un rectangle arrondi, mais nous pouvons facilement obtenir l’emprise équivalente avec des angles droits,
en lançant sur elle l’algorithme Créer un polygone à partir de l’emprise de la couche. Nous aurions pu créer un
tampon sur les limites de la ville d’abord et ensuite calculer l’emprise rectangulaire, ce qui nous aurait économisé
une étape.

Vous remarquerez que les rasters ont une projection différente de celle du vecteur. Nous devons donc les reprojeter
avant de poursuivre, en utilisant l’outil Projection (reprojection).
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Note: Les versions récentes ont des interfaces plus complexes. Sélectionnez au moins une méthode de compres-
sion.

Avec cette couche qui contient l’emprise rectangulaire de la couche raster que nous voulons obtenir, nous pouvons
recadrer les deux couches rasters, en utilisant l’algorithme Découper un raster selon une couche de masque.
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Une fois que les couches ont été recadrées, elles peuvent être fusionnées en utilisant l’algorithme Fusionner de
GDAL.

18.15. Découpage et fusion de couches raster 501



QGIS Training Manual, Version 2.18

Note: Vous pouvez gagner du temps en fusionnant d’abord et en recadrant ensuite, et vous éviterez d’appeler
deux fois l’algorithme de découpage. Cependant, s’il y a plusieurs couches à fusionner et qu’elles ont une assez
grande taille, vous finirez avec une grande couche qui pourra être difficile à traiter plus tard. Dans ce cas, vous
devriez appeler l’algorithme de découpage plusieurs fois, ce qui peut prendre beaucoup de temps, mais ne vous
inquiétez pas, nous verrons bientôt qu’il existe des outils supplémentaires pour automatiser cette opération. Dans
cet exemple, nous n’avons que deux couches, donc vous n’aurez pas besoin de vous soucier de cela maintenant.

Avec cela, nous obtenons le MNT final que nous voulons.

Il est maintenant temps de calculer la couche de pente.

Une couche de pente peut être calculée avec l’algorithme Pente, Aspect, Courbes, mais le MNT obtenu dans
la dernière étape n’est pas approprié comme entrée, puisque les valeurs d’élévation sont en mètre mais la taille
de cellule n’est pas exprimée en mètre (la couche utilise un SCR avec des coordonnées géographiques). Une
reprojection est nécessaire. Pour reprojeter une couche raster, l’algorithme Projection (reprojection) peut encore
être utilisé. Nous reprojetons dans un SCR avec des mètres comme unités (par exemple 3857), donc nous pouvons
ensuite calculer correctement la pente, avec soit SAGA soit GDAL.

Avec ce nouveau MNT, la pente peut maintenant être calculée.
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Et voici la couche de pente de résultat.
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La pente produite par l’algorithme Pente, Aspect, Courbes peut être exprimée en radians, mais les degrés sont une
unité plus pratique et plus commune. L’algorithme Conversions métriques nous aidera à faire la conversion (mais
dans le cas où vous ne sauriez pas que cet algorithme existe, vous pouvez toujours utiliser la calculatrice raster
que nous avons déjà manipulée).
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En reprojetant la couche de pente reconvertie avec la Reprojection de couche raster, nous obtenons la couche
finale que nous souhaitons.

Warning: A faire : Ajouter une image

Les processus de reprojection ont peut-être généré une couche finale qui contient des données en dehors de
l’emprise que nous avons calculée dans une des premières étapes. Cela peut être résolu en la découpant à nouveau,
comme nous l’avons fait pour obtenir le MNT de base.

18.16 Analyse hydrologique

Note: Dans cette leçon nous allons réaliser une analyse hydrographique. Cette analyse sera utilisée dans certaines
des leçons suivantes, car elle constitue un très bon exemple d’un flux de travail d’analyse, et nous l’utiliserons pour
démontrer certaines fonctionnalités avancées.

Dans cette leçon, nous allons faire une analyse hydrographique. En commençant avec un MNE, nous allons
extraire un réseau de canaux, délimiter des bassins versants et calculer des statistiques.

La première chose à faire est de charger le projet avec les données de la leçon qui contient uniquement un MNE.
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Le premier module qui s’exécute est Catchment area (dans certaines versions de SAGA il s’appelle Flow accu-
mulation (Top Down)). Vous pouvez utiliser n’importe lequel des autres qui sont appelés Catchment area. Ils
utilisent différents algorithmes, mais les résultats sont pratiquement les mêmes.

Sélectionnez le MNE dans le champ Élévation, et laissez les valeurs par défaut pour le reste des paramètres.
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Certains algorithmes calculent plusieurs couchent, mais celui de la Surface de bassin versant est le seul que nous
utiliserons.

Vous pouvez vous débarrasser des autres si vous voulez.

Le rendu de la couche n’est pas très instructif.

Pour savoir pourquoi, vous pouvez regarder l’histogramme et vous verrez que des valeurs ne sont pas dis-
tribuées uniformément (il y a quelques cellules avec une très grande valeur, celles qui correspondent au réseau
de canaux). Le calcul du logarithme de la valeur du bassin versant produit une couche qui transmet beaucoup plus
d’information (vous pouvez le faire en utilisant la calculatrice raster).
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Le basin versant (aussi connu comme l’accumulation de flux) peut être utilisé pour mettre une limite pour
l’initiation de canaux. Voici comment vous devez le mettre en place (notez le Seuil d’initiation Plus grand que
10.000.000).
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Utilisez la couche originale bassin versant, pas celle du logarithme. Celle-ci était juste à des fins de rendu.

Si vous augmentez la valeur Seuil d’initiation, vous obtiendrez un réseau de canaux plus clairsemé. Si vous le
diminuez, vous obtiendrez un réseau dense. Avec la valeur proposée, c’est ce que vous obtenez.
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L’image ci-dessus montre simplement la couche vectorielle de résultat et le MNE, mais il devrait aussi y avoir un
raster avec le même réseau de canaux. Ce raster-là sera en fait celui que nous utiliserons.

Maintenant, nous utiliserons l’algorithme Basins versants pour délimiter les sous-bassins correspondant à ce
réseau de canaux, en utilisant comme points de sortie toutes les jonctions. Voici comment vous devez config-
urer la boîte de dialogue des paramètres correspondants.
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Et voici ce que vous obtiendrez.

Il en résulte un raster. Vous pouvez le vectoriser en utilisant l’algorithme Vectoriser les classes de grille.
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Maintenant, essayons de calculer des statistiques sur les valeurs d’élévation dans un des sous-bassins. L’idée est
d’avoir une couche qui représente uniquement l’élévation au sein de ce sous-bassin et ensuite de la passer au
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module qui calcule ces statistiques.

Commençons par découper le MNE original avec le polygone représentant un sous-bassin. Nous utiliseront
l’algorithme Découper une raster avec un polygone. Si nous sélectionnons un seul polygone de sous-bassin et
exécutons ensuite l’algorithme de découpage, nous pouvons découper la zone du MNE couverte par ce polygone
puisque l’algorithme prend en compte la sélection.

Sélectionnez un polygone,

et appelez l’algorithme de découpage avec les paramètres suivants :

18.16. Analyse hydrologique 513



QGIS Training Manual, Version 2.18

L’élément sélectionné dans le champ d’entrée est, bien sûr, le MNE que nous voulons découper.

Vous obtiendrez quelque chose comme ça.
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Cette couche est prête à être utilisée dans l’algorithme Statistiques de la couche raster.

Les résultats des statistiques sont les suivants.

Nous utiliserons tant la procédure de calculs de bassin que le calcul statistique dans d’autres leçons pour découvrir
comment d’autres éléments peuvent nous aider à les automatiser les deux et à travailler plus efficacement.
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18.17 Commencer avec le modeleur graphique

Note: Dans cette leçon nous utiliserons le modeleur graphique, un élément puissant que nous pouvons utiliser
pour définir un flux de traitements et exécuter une chaîne d’algorithmes.

Une session normale avec les outils de traitement comprend plus que l’exécution d’un algorithme unique.
Habituellement, plusieurs d’entre eux sont exécutés pour obtenir un résultat et les sorties de certains de ces algo-
rithmes sont utilisées comme entrée pour d’autres.

En utilisant le modeleur graphique, ce flux de traitement peut être mis dans un modèle, qui exécutera tous les
algorithmes nécessaires en une unique exécution, en simplifiant ainsi le processus entier et en l’automatisant.

Pour commencer cette leçon, nous allons calculer un paramètre nommé Indice d’Humidité Topographique.
L’algorithme qui le calcule est appelé Indice d’Humidité Topographique (twi)

Comme vous pouvez le voir, il y a deux entrées obligatoires : Pente et Bassin versant. Il y a aussi une entrée
optionnelle, mais nous ne l’utiliserons pas, donc nous pouvons l’ignorer.

Les données pour cette leçon comprennent juste un MNE, donc nous n’avons aucune des entrées requises. Cepen-
dant, nous savons comment les calculer les deux avec ce MNE, étant donné que nous avons déjà vu les algorithmes
pour calculer une pente et un bassin versant. Donc nous pouvons d’abord calculer ces couches et ensuite les utiliser
pour l’algorithme TWI.

Voici les boîtes de dialogue des paramètres que vous devriez utiliser pour calculer les 2 couches intermédiaires.

Note: La pente doit être calculée en radians, et non en degrés.
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Et c’est comme ça que vous devez configurer la boîte de dialogue des paramètres de l’algorithme TWI.
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C’est le résultat que vous obtiendrez (la palette par défaut de pseudo-couleurs inversées de bande unique a été
utilisée pour le rendu). Vous pouvez utiliser le style twi.qml fourni.

Ce que nous essayerons de faire maintenant est de créer un algorithme qui calcule le TWI depuis un MNE en
seulement une seule étape. Cela nous facilitera la tâche si nous avons, par la suite, à calculer une couche TWI à
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partir d’un autre MNE, car nous n’aurons besoin que d’une seule étape pour le faire à la place des 3 ci-dessus.
Tous les traitements dont nous avons besoin se trouvent dans la boîte à outils, donc ce que nous avons à faire est
de définir le flux de traitements pour les assembler. C’est ici que le modeleur graphique entre en jeu.

Ouvrez le modeleur en sélectionnant son entrée dans le menu du traitement.

Deux choses sont nécessaires pour créer un modèle : configurer les entrées qu’il faudra, et définir l’algorithme
qu’il contient. Tous les deux sont faits en ajoutant des éléments depuis les deux onglets sur la partie gauche de la
fenêtre du modeleur : Entrées et Algorithmes

Commençons avec les entrées. Dans ce cas nous ne devons pas en ajouter plus. Nous avons juste besoin d’une
couche raster avec un MNE, et ceci sera notre seule entrée de données.

Double-cliquez sur l’entrée Couche raster et vous verrez la boîte de dialogue suivante.

Ici nous devons définir l’entrée que nous voulons. Puisque nous nous attendons à ce que cette couche raster soit
un MNE, nous l’appellerons MNE. C’est le nom que l’utilisateur du modèle verra lorsqu’il l’exécutera. Comme
nous avons besoin de cette couche pour que ça fonctionne, nous la définirons comme une couche obligatoire.

Voici comment la boîte de dialogue devrait être configurée.
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Cliquez sur OK et l’entrée apparaîtra dans le canevas du modeleur.

Rendons-nous maintenant à l’onglet Algorithmes. Le premier algorithme que nous devons exécuter est
l’algorithme Pente, aspect, courbature. Localisez-le dans la liste des algorithmes, double-cliquez dessus et vous
verrez la boîte de dialogue montrée ci-dessous.
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Cette boîte de dialogue est très semblable à celle que vous pouvez trouver lors de l’exécution de l’algorithme
depuis la boîte à outils, mais les éléments que vous pouvez utiliser comme valeurs de paramètre ne viennent pas
du projet QGIS courant, mais du modèle lui-même. Cela signifie que, dans ce cas, nous n’aurons pas toutes les
couches raster de notre projet disponibles pour le champ Élévation, mais uniquement pour ceux définis dans notre
modèle. Comme nous avons ajouté seulement un seul raster d’entrée nommé MNE, ce sera la seule couche raster
que nous verrons dans la liste correspondant au paramètre d’Élévation.

Les sorties générées par un algorithme sont gérées un peu différemment lorsque l’algorithme est utilisé comme
une partie du modèle. À la place de sélectionner le chemin du fichier où vous voulez sauvegarder chaque sortie,
vous devez simplement spécifier si cette sortie est une couche intermédiaire (et vous ne voulez pas la garder après
l’exécution du modèle), ou si c’est une couche finale. Dans ce cas, toutes les couches produites par cet algorithme
sont intermédiaires. Nous utiliserons seulement l’une d’entre elles (la couche de pente), mais nous ne voulons pas
la garder, puisque nous avons juste besoin d’elle pour calculer la couche TWI, qui est le résultat final que nous
voulons obtenir.

Lorsque des couches ne sont pas un résultat final, vous devriez juste laisser le champ correspondant. Autrement,
vous devez entrer un nom qui sera utilisé pour identifier la couche dans la boîte de dialogue des paramètres qui
apparaîtra lorsque vous exécuterez plus tard le modèle.

Il n’y a plus grand-chose d’autre à sélectionner dans cette première boîte de dialogue étant donné que nous n’avons
qu’une seule couche d’entrée dans notre modèle (le MNE que nous avons créé). En fait la configuration par défaut
de la boîte de dialogue est correcte et vous pouvez simplement cliquer sur Ok. Voici ce que vous aurez maintenant
dans le canevas du modeleur.
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Le second algorithme que nous devons ajouter à notre modèle est l’algorithme de bassin versant. Nous utiliserons
l’algorithme nommé Bassin versant (Parallèle). Nous utiliserons à nouveau la couche MNE comme entrée, et
aucune des sorties produites seront des sorties finales, donc voici comment vous devez remplir la boîte de dialogue
correspondante.
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Votre modèle devrait maintenant ressembler à cela.

524 Chapter 18. Le Guide du module Traitements de QGIS



QGIS Training Manual, Version 2.18

La dernière étape est l’ajout de l’algorithme Indice d’Humidité Topographique, avec la configuration suivante.

Dans ce cas, nous n’utiliserons pas le MNE comme entrée, mais à la place, nous utiliserons les couches de
pente et de surface du bassin versant qui sont calculées par les algorithmes que nous avons précédemment ajoutés.
Lorsque vous ajoutez de nouveaux algorithmes, les sorties qu’ils produisent deviennent disponibles pour les autres
algorithmes, et en les utilisant vous reliez les algorithmes, créant le flux de traitement.
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Dans ce cas, la couche de sortie TWI est une couche finale, donc nous devons l’indiquer. Dans le champ corre-
spondant, entrez le nom que vous voulez qu’il soit montré pour cette sortie.

Notre modèle est maintenant terminé et il devrait ressembler à cela.

Entrez un nom et un nom de groupe dans la partie du haut de la fenêtre du modèle, et ensuite sauvegardez-le en
cliquant sur le bouton Sauvegarder.

Vous pouvez le sauvegarder n’importe où où vous voulez et l’ouvrir plus tard, mais si vous le sauvegardez dans
le répertoire des modèles (qui est le répertoire que vous verrez lorsque la boîte de dialogue de sauvegarde du
fichier apparaîtra), votre modèle sera également disponible dans la boîte à outils. Donc restez dans ce répertoire
et sauvegardez le modèle avec le nom de fichier que vous désirez.

Fermez maintenant la boîte de dialogue du modeleur et rendez-vous dans la boîte à outils. Sous l’entrée Modèles,
vous trouverez votre modèle.

Vous pouvez l’exécuter simplement comme n’importe quel algorithme normal, en double-cliquant dessus.
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Comme vous pouvez le voir, la boîte de dialogue des paramètres contient l’entrée que vous avez ajoutée au modèle,
de même que les sorties que vous avez configurées comme finales lors de l’ajout des algorithmes correspondants.

Exécutez-le en utilisant le MNE comme entrée et vous obtiendrez la couche TWI en seulement une seule étape.

18.18 Des modèles plus complexes

Note: Dans cette leçon nous travaillerons avec un modèle plus complexe dans le modeleur graphique.

Le premier modèle que nous avons créé dans le chapitre précédent était très simple, avec seulement une entrée et
3 algorithmes. Des modèles plus complexes peuvent être créés, avec différents types d’entrée et contenant plus
d’étapes. Dans ce chapitre nous travaillerons avec un modèle qui crée une couche vectorielle avec des bassins
versants basés sur un MNE et une valeur de seuil. Cela sera très utile pour calculer plusieurs couches vecteur
correspondant à différents bassins versants, sans avoir à répéter chacune des étapes à chaque fois.

Cette leçon ne contient pas d’instructions sur comment créer votre modèle. Vous connaissez déjà les étapes
nécessaires (nous les avons vues dans une leçon précédente) et vous avez déjà vu les idées de base sur le modeleur,
donc vous devrez essayer de le faire vous-même. Passez quelques minutes à essayer de créer votre modèle,
et n’ayez crainte de faire des fautes. Souvenez-vous : premièrement, ajoutez les entrées et ensuite ajoutez les
algorithmes qui les utilisent pour créer le flux de traitements.

Dans le cas où vous ne pourriez pas créer le modèle complet vous-même et que vous avez besoin d’aide sup-
plémentaire, le dossier de données correspondant à cette leçon contient la version ‘presque’ terminée de celui-ci.
Ouvrez le modeleur et ensuite ouvrez le fichier modèle que vous trouverez dans le dossier de données. Vous
devriez voir quelque chose comme cela.
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Ce modèle contient toutes les étapes nécessaires pour compléter le calcul, mais il n’a seulement qu’une entrée : le
MNE. Cela signifie que le seuil pour la définition du canal utilise une valeur fixe, ce qui rend le modèle pas aussi
utile qu’il aurait pu l’être. Ce n’est pas un problème, étant donné que nous pouvons modifier le modèle, et c’est
exactement ce que nous allons faire.

Premièrement, ajoutons une entrée numérique. Cela demandera à l’utilisateur une entrée numérique que nous
pouvons utiliser lorsqu’une telle valeur est nécessaire dans un des algorithmes inclus dans notre modèle. Cliquez
sur l’entrée Nombre dans l’arbre de saisie, et vous verrez la boîte de dialogue correspondante. Remplissez-la avec
les valeurs montrées ensuite.

Votre modèle devrait maintenant ressembler à cela.
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L’entrée que nous venons juste d’ajouter n’est pas utilisée, donc le modèle n’a pas réellement changé. Nous devons
lier cette entrée à l’algorithme qui l’utilise, dans ce cas, le Réseau de canaux. Pour modifier un algorithme qui
existe déjà dans le modeleur, cliquez simplement sur l’icône crayon de la boîte correspondante dans le canevas.
Si vous cliquez sur l’algorithme Réseau de canaux, vous verrez quelque chose comme ça.

La boîte de dialogue est remplie avec les valeurs actuelles utilisées par l’algorithme. Vous pouvez voir que le
paramètre de seuil a une valeur fixe de 1,000,000 (c’est également la valeur par défaut de cet algorithme, mais
toute autre valeur pourrait être mise ici). Cependant, vous remarquerez peut-être que le paramètre n’est pas entré
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dans une zone de texte commune, mais dans un menu d’options. Si vous le déroulez, vous verrez quelque chose
comme ça.

L’entrée que nous avons ajoutée est là et nous pouvons la sélectionner. Chaque fois qu’un algorithme dans un
modèle requière une valeur numérique, vous pouvez la coder en dur et directement la taper, ou vous pouvez utiliser
l’une des entrées et valeurs disponibles (souvenez-vous que certains algorithmes génèrent des valeurs numériques
individuelles. Nous en verrons bientôt plus là-dessus). Dans le cas d’un paramètre de chaîne de caractères, vous
verrez également des entrées de chaînes de caractères et vous pourrez sélectionner l’une d’entre elles ou taper la
valeur fixe souhaitée.

Sélectionnez l’entrée Seuil dans le paramètre Seuil et cliquez sur OK pour appliquer les changements à votre
modèle. La conception du modèle devrait maintenant ressembler à cela.
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Le modèle est maintenant complet. Essayer de le lancer en utilisant le MNE que nous avons utilisé dans les leçons
précédentes, et avec différentes valeurs de seuil. Ici vous avez un échantillon des résultats obtenus pour différentes
valeurs. Vous pouvez comparer avec le résultat pour la valeur par défaut, qui est celui que nous avons obtenu dans
la leçon d’analyse hydrologique.

Seuil = 100,000
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Seuil = 1,0000,000

18.19 Calculs numériques dans le modeleur

Warning: Prenez garde, ce chapitre n’est pas bien testé, s’il vous plaît rapporter tous problèmes ; les images
sont manquantes

Note: Dans cette leçon nous verrons comment utiliser des sorties numériques dans le modeleur

Pour cette leçon, nous allons modifier le modèle hydrologique que nous avons créé dans le dernier chapitre
(ouvrez-le dans le modeleur avant de commencer), de sorte que nous puissions automatiser le calcul d’une valeur
de seuil valide et que nous n’ayons pas besoin de demander à l’utilisateur de l’entrer. Comme cette valeur fait
référence à la variable dans la couche raster de seuil, nous l’extrairons de cette couche, basée sur une analyse
statistique simple.

En commençant avec le modèle précédemment mentionné, faisons les modifications suivantes :

Premièrement, calculons les statistiques de la couche d’accumulation de flux en utilisant l’algorithme Statistiques
de la couche raster.
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Cela va générer un ensemble de valeurs statistiques qui seront maintenant disponibles pour tous les champs
numériques dans les autres algorithmes.

Si vous éditez l’algorithme Réseau de canaux comme nous l’avons fait dans la dernière leçon, vous verrez que
vous avez maintenant d’autres options en dehors de l’entrée numérique que vous avez ajoutée.
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Cependant, aucune de ces valeurs n’est apte à être utilisée comme un seuil valable, étant donné qu’elles auront
comme résultat des réseaux de canaux qui ne seront pas très réalistes. Nous pouvons, à la place, tirer quelques
nouveaux paramètres à partir d’elles, pour obtenir un meilleur résultat. Par exemple, nous pouvons utiliser la
moyenne plus 2 fois l’écart-type.

Pour ajouter cette opération arithmétique, nous pouvons utiliser la calculatrice que vous trouverez dans le groupe
Géoalgorithmes/modeleur/outils du modeleur. Ce groupe contient des algorithmes qui ne sont pas très utiles en
dehors de ce modeleur, mais qui fournissent des fonctionnalités utiles lors de la création d’un modèle.

La boîte de dialogue des paramètres de l’algorithme de la calculatrice ressemble à ça :
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Comme vous pouvez le voir, la boîte de dialogue est différente des autres que nous avons vues, mais vous avez ici
les mêmes variables qui étaient disponibles dans le champ Seuil dans l’algorithme Réseau de canaux. Entrez la
formule ci-dessous et cliquez sur OK pour ajouter l’algorithme.

Si vous étendez l’entrée des sorties, comme montré ci-dessus, vous verrez que le modèle est relié à deux des
valeurs, à savoir la moyenne et l’écart-type, qui sont celles que nous avons utilisées dans la formule.

L’ajout de ce nouvel algorithme va ajouter une nouvelle valeur numérique. Si vous ouvrez de nouveau l’algorithme
Réseau de canaux, vous pouvez maintenant sélectionner cette valeur dans le paramètre Seuil.
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Cliquez sur OK et votre modèle devrait ressembler à cela.

Nous n’utilisons pas l’entrée numérique que nous avons ajoutée au modèle, donc elle peut être supprimée. Faites
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un clic–droit dessus et sélectionnez Supprimer.

Warning: A faire : Ajouter une image

Notre nouveau modèle est maintenant terminé.

18.20 Un modèle dans un modèle

Warning: Prenez garde, ce chapitre n’est pas bien testé, s’il vous plaît rapporter tous problèmes ; les images
sont manquantes

Note: Dans cette leçon nous verrons comment utiliser un modèle dans un modèle plus grand.

Nous avons déjà créé quelques modèles, et dans cette leçon nous allons voir comment nous pouvons les combiner
dans un seul plus grand modèle. Un modèle se comporte comme n’importe quel autre algorithme, ce qui signifie
que vous pouvez ajouter un modèle que vous avez déjà créé dans le cadre d’un autre modèle que vous créerez par
la suite.

Dans ce cas, nous allons étendre notre modèle hydrologique en ajoutant la valeur moyenne TWI dans chacun
des bassins qu’il génère comme résultat. Pour ce faire, nous devons calculer le TWI et calculer les statistiques.
Comme nous avons déjà créé un modèle pour calculer le TWI depuis un MNE, c’est une bonne idée de réutiliser
ce modèle au lieu d’ajouter les algorithmes qu’il contient individuellement.

Commençons avec le modèle que nous avons utilisé comme point de départ pour la dernière leçon.

Warning: todo: Ajouter image

Premièrement, nous ajouterons le modèle TWI. Pour qu’il soit disponible, il aurait dû être enregistré dans le
dossier des modèles, autrement il ne sera pas affiché dans la boîte à outils ou dans la liste des algorithmes dans le
modeleur. Assurez-vous que vous l’avez rendu disponible.

Ajoutez-le au modèle actuel et utilisez le MNE d’entrée comme son entrée. La sortie est temporaire, car nous
voulons juste la couche TWI pour calculer les statistiques. L’unique sortie de ce modèle que nous avons créé sera
toujours la couche vectorielle avec les bassins versants.

Voici la boîte de dialogue des paramètres correspondants :

Warning: todo: Ajouter image

Nous avons maintenant une couche TWI que nous pouvons utiliser avec la couche vectorielle des bassins versants
pour générer une nouvelle couche qui contienne les valeurs du TWI correspondant à chaque bassin versant.

Ce calcul est fait en utilisant l’algorithme Statistiques de la grille en polygones. Utilisez les couches mentionnées
ci-dessus comme entrée pour créer le résultat final.

Warning: todo: Ajouter image

La sortie de l’algorithme Classes des grilles vectorisées était à l’origine notre sortie finale, mais maintenant nous
la voulons simplement comme un résultat intermédiaire. Pour changer cela, nous devons modifier l’algorithme.
Double–cliquez simplement dessus pour voir la boîte de dialogue de ses paramètres, et supprimez le nom de la
sortie. Cela va faire une sortie temporaire, comme c’est le cas par défaut.

Warning: todo: Ajouter image

Voici à quoi le modèle final devrait ressembler :
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Warning: todo: Ajouter image

Comme vous le voyez, utiliser un modèle dans un autre modèle n’est rien de spécial, et vous pouvez l’ajouter
simplement comme vous ajoutez un autre algorithme, tant que le modèle est sauvegardé dans le dossier des
modèles et est disponible dans la boîte à outils.

18.21 Using modeler-only tools for creating a model

Note: This lesson shows how to use some algorithms that are only available in the modeler, to provide additional
functionality to models.

The goal of this lesson is to use the modeler to create an interpolation algorithm that takes into account the current
selection, not just to use only selected features, but to use the extent of that selection to create the interpolated
raster layer.

The interpolation process involves two steps, as it has been already explained in previous lessons: rasterizing the
points layer and fill the no-data values that appear in the rasterized layer. In case the points layer has a selection,
only selected points will be used, but if the output extent is set to be automatically adjusted, the full extent of the
layer will be used. That is, the extent of the layer is always considered to be the full extent of all features, not the
one computed from just the selected ones. We will try to fix that by using some additional tools into our model.

Open the modeler and start the model by adding the required inputs. In this case we need a vector layer (restricted
to points) and an attribute from it, with the values that we will use for rasterizing.

The next step is to compute the extent of the selected features. That’s where we can use the model-only tool called
Vector layer bounds. First, we will have to create a layer that has the extent of those selected features. Then, we
can use this tool on that layer.

An easy way of creating a layer with the extent of the selected features is to compute a convex hull of the input
points layer. It will use only the selected point, so the convex hull will have the same bounding box as the selection.
Then we can add the Vector layer bounds algorithm, and use the convex hull layer as input. It should look this in
the modeler canvas:
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The result from the Vector layer bounds is a set of four numeric values and a extent object. We will use both the
numeric outputs and the extent for this exercise.

We can now add the algorithm that rasterizes the vector layer, using the extent from the Vector layer bounds
algorithm as input.

Fill the parameters of the algorithm as shown next:
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The canvas should now look like.

Finally, fill the no-data values of the raster layer using the Close gaps algorithm.
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The algorithm is now ready to be saved and added to the toolbox. You can run it and it will generate a raster layer
from interpolating the selected points in the input layer, and the layer will have the same extent as the selection.

Here’s an improvement to the algorithm. We have used a harcoded value for the cellsize when rasterizing. This
value is fine for our test input layer, but might not be for other cases. We could add a new parameter, so the user
enters the desired value, but a much better approach would be to have that value automatically computed.

We can use the modeler-only calculator, and compute that value from the extent coordinates. For instance, to
create a layer with a fixed width of 100 pixels, we can use the following formula in the calculator.
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Now we have to edit the rasterize algorithm, so it uses the output of the calculator instead of the hardcoded value.

The final algorithm should look like this:

18.22 Interpolation

Note: Ce chapitre explique comment interpoler des données points et présente un autre exemple concret
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d’utilisation de l’analyse spatiale.

Dans cette leçon, nous allons interpoler des points afin d’obtenir une couche raster. Avant de le faire, nous
devons préparer les données. Nous modifierons également la couche obtenue après l’interpolation afin de couvrir
l’intégralité du processus d’analyse.

Ouvrez les données de l’exemple fourni pour cette leçon. Cela devrait ressembler à cela :

Ces données correspondent à des rendements agricoles tels qu’une moissonneuse moderne peut fournir, et nous
les utiliserons afin d’obtenir une couche raster. Nous ne prévoyons pas d’analyser cette couche davantage par la
suite. Nous allons juste l’utiliser comme fond de plan afin d’identifier facilement les zones les plus productives et
celles où la production pourrait être optimisée.

La première chose à faire est de nettoyer la couche car certains points sont redondants. Cela est dû à la conduite
de la moissonneuse : pour une raison ou une autre elle a dû tourner ou changer de vitesse à certains endroits.
L’algorithme Filtrer points sera utile pour ceci. Nous l’utiliserons deux fois afin de supprimer à la fois les points
qui peuvent être considérés comme aberrants car sortant de la norme par le haut ou par le bas.

Pour la première exécution, utilisez les valeurs suivantes des paramètres.
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Pour le second filtrage, utilisez les paramètres suivants :
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Notez que vous n’utilisez pas la couche de départ comme entrée, mais la sortie de la précédente itération.

La couche “filtrée” finale devrait ressembler à la couche originelle avec pour seule différence un nombre réduit de
points. Vous pouvez vérifier cela en comparant leurs tables d’attributs.

Transformons maintenant la couche en raster au moyen de l’algorithme “rasterize”.
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La couche Filtered points réfère à celle résultant de l’application du second filtre. Attention, étant donné que le
nom est assigné par l’algorithme, elle a le même nom que celle produite suite à l’application du premier filtre. Il
faut utiliser la seconde couche produite. Afin d’éviter toute confusion et étant donné que nous n’allons pas utiliser
la première couche produite, vous pouvez la supprimer de votre projet et ne garder que la dernière couche.

La couche raster résultante devrait ressembler à ceci :
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Il s’agit déjà une couche raster, mais certaines de ses cellules manquent de données. Elle ne contient des données
que dans les cellules où se trouvait un point. Toutes les autres cellules ont été attribuées la valeur “pas de donnée”.
Afin de compléter les valeurs manquantes, nous pouvons utiliser l’algorithme Close gaps.
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La couche complétée ressemble à ceci :
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Afin de restreindre la couche uniquement à la zone où les rendements agricoles ont été effectivement mesurés,
nous pouvons ne garder de la couche raster que ce qui correspond à la couche “limits” fournie.
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Et pour un résultat plus lissé (moins précis mais plus adéquat pour être utilisé comme couche de fond) nous
pouvons y appliquer un filtre Gaussien.
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Avec les paramètres précédents, vous obtiendrez le résultat suivant :

18.23 Plus d’interpolation

Note: Ce chapitre montre un autre cas pratique où les algorithmes d’interpolation sont utilisés.

L’interpolation est une technique commune, et elle peut être utilisée pour démontrer plusieurs techniques qui
peuvent être appliquées en utilisant le module de traitements QGIS. Cette leçon utilise certains algorithmes
d’interpolation qui ont déjà été introduits, mais utilise une approche différente.

Les données pour cette leçon contiennent également une couche de points, dans ce cas avec des données
d’élévation. Nous allons les interpoler principalement de la même façon que nous l’avons fait dans la leçon
précédente, mais cette fois nous sauvegarderons une partie des données originales pour les utiliser pour évaluer la
qualité du processus d’interpolation.

Premièrement, nous devons pixeliser la couche de points et remplir les cellules no–data résultantes, mais en util-
isant seulement une fraction des points dans la couche. Nous sauvegarderons 10% des points pour une prochaine
vérification, donc nous avons besoin de 90% des points prêts pour l’interpolation. Pour se faire, nous pourrions
utiliser l’algorithme Séparer une couche de formes aléatoirement, que nous avons déjà utilisé dans une précédente
leçon, mais il y a une meilleure manière de faire cela, sans avoir à créer une nouvelle couche intermédiaire. À la
place de cela, nous pouvons simplement sélectionner les points que nous voulons utiliser pour l’interpolation (la
fraction de 90%), puis exécuter l’algorithme. Comme nous l’avons déjà vu, l’algorithme de pixelisation utilisera
seulement les points sélectionnés et ignorera le reste. La sélection peut être faite en utilisant l’algorithme Sélection
aléatoire. Lancez-le avec les paramètres suivants.
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Cela va sélectionner 90% des points dans la couche à pixeliser

La sélection est aléatoire, donc votre sélection devrait différer de la sélection montrée dans l’image ci-dessus.

Exécutez maintenant l’algorithme Rastériser pour obtenir la première couche raster, et ensuite exécutez
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l’algorithme Combler les lacunes pour remplir les cellules sans–données [Résolution de cellule : 100 m].

Pour vérifier la qualité de l’interpolation, nous pouvons maintenant utiliser les points qui n’ont pas été sélectionnés.
Nous connaissons, en ce point, l’élévation réelle (la valeur dans la couche de points) ainsi que l’élévation interpolée
(la valeur présente dans la couche raster interpolée). Nous pouvons comparer les deux en calculant leur différence.

Comme nous allons d’abord utiliser les points qui ne sont pas sélectionné, inversons la sélection.

Les points contiennent la valeur originale, mais pas celles de l’interpolation. Pour les ajouter dans un nouveau
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champ, nous pouvons utiliser l’algorithme Ajouter des valeurs de raster aux points.

La couche raster à sélectionner (l’algorithme supporte plusieurs rasters, mais nous n’en avons besoin que d’un)
est celle qui résulte de l’interpolation. Nous l’avons renommée interpolation et ce nom de couche est celui qui
sera utilisé pour le nom du champ à ajouter.

Nous avons maintenant une couche vecteur qui contient ces deux valeurs, avec des points qui n’étaient pas utilisé
pour l’interpolation.
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Maintenant, nous utiliserons la calculatrice de champs pour cette tâche. Ouvrez l’algorithme Calculatrice de
champs et exécutez-le avec les paramètres suivants.
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Si votre champ avec les valeurs de la couche raster a un nom différent, vous devrez modifier la formule ci-dessus
en conséquence. En exécutant cet algorithme, vous obtiendrez une nouvelle couche avec uniquement les points
que nous n’avons pas utilisé pour l’interpolation, chacun d’eux contenant la différence entre les deux valeurs
d’élévation.

Représenter cette couche selon cette valeur nous donnera une première idée d’où se trouvent les grands écarts.

Interpoler cette couche vous donnera une couche raster avec l’erreur estimée dans tous les points de la zone
interpolée.
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Vous pouvez aussi obtenir la même information (différence entre les valeurs des points d’origine et ceux interpolés)
directement avec GRASS → v.échantillon.

Vos résultats devrait différer de ceux-ci, car il y a une composante aléatoire introduite lors de l’exécution de la
sélection aléatoire, au début de cette leçon.

18.24 Exécution itérative d’algorithmes

Note: Cette leçon montre une manière différente d’exécuter des algorithmes qui utilisent des couches vectorielles,
en les exécutant de manière répétitive, en itérant sur les caractéristiques dans une couche vecteur d’entrée.

Nous avons déjà vu le modeleur graphique qui est l’une des façons d’automatiser les tâches de traitement. Cepen-
dant, dans certains cas, le modeleur n’est peut être pas ce dont nous avons besoin pour automatiser une tâche
donnée. Voyons l’une de ces situations et comment la résoudre facilement en utilisant une fonctionnalité dif-
férente : l’exécution itérative des algorithmes.

Ouvrez les données correspondantes à ce chapitre. Cela devrait ressembler à cela.
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Vous reconnaîtrez notre bien connu MNE des précédents chapitres et un ensemble de bassins versants extrait de
celui-ci. Imaginez que vous avez besoin de séparer le MNE en plusieurs couches plus petites, chacune d’elles
contenant uniquement les données d’élévation correspondant à un même bassin versant. Cela sera utile si vous
voulez par la suite calculer certains paramètres liés à chaque bassin versant, comme son élévation moyenne ou sa
courbe hypsographique.

Cela peut être une tâche longue et fastidieuse, spécialement si le nombre de bassins versants est grand. Cependant,
c’est une tâche qui peut facilement être automatisée, comme nous le verrons.

L’algorithme à utiliser pour couper une couche raster avec une couche polygone est appelé Découper le raster
avec des polygones, et possède la boîte de dialogue des paramètres suivante.
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Vous pouvez l’exécuter en utilisant la couche “watersheds” et le MNE en entrées et vous obtiendrez le résultat
suivant.

Comme vous pouvez le voir, la zone couverte par tous les polygones des bassins versants est utilisée.
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Vous pouvez avoir le MNE coupé avec un seul bassin versant en sélectionnant le bassin versant souhaité, puis en
exécutant l’algorithme comme nous l’avons fait avant.

Tant que seules les fonctionnalités sélectionnées sont utilisées, seul le polygone sélectionné sera utilisé pour
découper la couche raster.

Faire ainsi pour tous les bassins versants produira le résultat que nous cherchons, mais cela ne semble pas être une
manière très pratique de procéder. À la place, voyons comment automatiser cette routine sélectionner et découper.
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Avant toute chose, effaçons la sélection précédente, afin que tous les polygones soient à nouveau utilisables.
Ouvrez maintenant l’algorithme Découper la grille avec des polygones et sélectionnez les mêmes entrées qu’avant,
mais cette fois cliquez sur le bouton que vous trouverez sur le côté droit de la couche vecteur d’entrée où vous
avez sélectionné la couche des bassins versants.

Ce bouton permettra à la couche d’entrée sélectionnée d’être séparée en autant de couches qu’elle a de caractéris-
tiques, chacune d’entre elles contenant un simple polygone. Sur ce, l’algorithme sera appelé de manière répétitive,
une fois pour chacune des couches de polygone unique. Le résultat, à la place d’une seule couche raster dans le cas
de cet algorithme, sera un ensemble de couches raster, chacune d’entre elles correspondant à une des exécutions
de l’algorithme.

Voici le résultat que vous obtiendrez si vous exécutez l’algorithme de découpage comme expliqué.
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Pour chaque couche, la palette de couleur noire et blanche (ou n’importe quelle palette que vous utilisez) est réglée
différemment, de ses valeurs minimum à ses valeurs maximum. C’est la raison pour laquelle vous pouvez voir
les différentes pièces et que les couleurs ne semblent pas correspondre à la frontière des couches. Cependant, les
valeurs coïncident.

Si vous entrez un nom de fichier de sortie, les fichiers résultants seront nommés avec ce nom de fichier et un
numéro correspondant à chaque itération comme suffixe.

18.25 Plus d’exécution itérative d’algorithme

Note: Cette leçon montre comment combiner l’exécution itérative des algorithmes avec le modeleur pour obtenir
plus d’automation.

L’exécution itérative des algorithmes est disponible non seulement pour les algorithmes intégrés mais aussi pour
les algorithmes que vous pouvez écrire vous-même, tels que les modèles. Nous allons voir comment combiner un
modèle avec l’exécution itérative d’algorithmes pour pouvoir facilement obtenir des résultats plus complexes.

Les données que nous allons utiliser pour cette leçon sont les mêmes que celles que nous avons déjà utilisés à la
dernière leçon. Dans ce cas, à la place de simplement couper le MNE avec chaque polygone de bassin versant,
nous ajouterons quelques étapes supplémentaires et calculerons une courbe hypsométrique pour chacun d’entre
eux, afin d’étudier comment l’élévation est distribué au sein du bassin versant.

Tant que nous avons un flux de traitements qui implique plusieurs étapes (découpage + calcul de la courbe hyp-
sométrique), nous devrions aller dans le modeleur et créer le modèle correspondant pour ce flux de traitements.

Vous pouvez trouver le modèle déjà créé dans le dossier de données pour cette leçon, mais il serait bien que vous
essayiez d’abord de le créer vous-même. La couche découpée n’est pas un résultat final dans ce cas, puisque nous
nous intéressons seulement aux courbes, donc ce modèle ne générera aucune couche, mais uniquement une table
avec les données de la courbe.

Le modèle devrait ressembler à cela :
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Ajoutez le modèle à votre dossier de modèles afin qu’il soit disponible dans la boîte à outils, et exécutez-le
maintenant.

Sélectionnez le MNE et les bassins versants, et n’oubliez pas d’utiliser le bouton qui indique que l’algorithme doit
être exécuté itérativement.

L’algorithme sera exécuté plusieurs fois, et les tables correspondantes seront créées et ouvertes dans votre projet
QGIS.
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Nous pouvons compliquer cet exemple en élargissant le modèle et en calculant des statistiques de pente. Ajoutez
l’algorithme Pente, aspect, courbature au modèle et puis l’algorithme Statistiques raster, qui devrait utiliser la
donnée de sortie pente comme sa seule entrée.

Si vous exécutez maintenant le modèle, en dehors des tables, vous obtiendrez un ensemble de pages avec des
statistiques. Ces pages seront disponibles dans la boîte de dialogue des résultats.

18.26 L’interface de traitements par lots

Note: Cette leçon introduit l’interface de traitements par lots, qui permet d’exécuter un seul algorithme avec un
ensemble de valeurs d’entrée différentes.

Parfois un algorithme donné doit être exécuté de manière répétitive avec différentes entrées. Ceci est par exemple
le cas lorsqu’un ensemble de fichiers d’entrée doivent être convertis d’un format à un autre, ou lorsque plusieurs
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couches dans une projection donnée doivent être converties dans une autre projection.

Dans ce cas, appeler l’algorithme de manière répétitive dans la boîte à outils n’est pas la meilleure option. À
la place, l’interface de traitements par lots devrait être utilisée, ce qui simplifie grandement la réalisation d’une
exécution multiple d’un algorithme donné. Pour exécuter un algorithme en tant que traitement par lots, trouvez-le
dans la boîte à outils, et à la place de double–cliquer dessus, faites un clic droit et sélectionnez Exécuter en tant
que traitement par lots.

Pour cet exemple, nous utiliserons l’algorithme Reprojection, alors trouvez-le et suivez la description ci-dessus.
Vous obtiendrez la boîte de dialogue suivante.

Si vous regardez les données pour cette leçon, vous verrez qu’elles contiennent un ensemble de trois shapefiles,
mais aucun fichier de projet QGIS. C’est parce que lorsqu’un algorithme est exécuté en tant que traitement par
lots, les couches en entrée peuvent être sélectionnées soit à partir du projet QGIS courant, soit à partir de fichiers.
Cela permet de traiter plus facilement de grandes quantités de couches, telles que par exemple toutes les couches
dans un dossier donné.

Chaque ligne dans la table de la boîte de dialogue de traitement par lots représente une seule exécution de
l’algorithme. Les cellules sur une ligne correspondent aux paramètres nécessaires pour l’algorithme, qui ne sont
pas disposés l’un en dessus de l’autre, comme dans la boîte de dialogue d’une exécution unique normale, mais
horizontalement sur la même ligne.

Définir les traitements par lots à lancer se fait en remplissant la table avec les valeurs correspondantes. La boîte
de dialogue contient plusieurs outils qui peuvent faciliter cette tâche.

Commençons par remplir les champs un par un. La première colonne à remplir est celle de la Couche d’entrée. À
la place d’entrer les noms de chacune des couches que nous voulons traiter, vous pouvez toutes les sélectionner et
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laisser la boîte de dialogue en mettre une par ligne. Cliquez sur le bouton dans la cellule supérieure gauche, et dans
la boîte de dialogue de sélection de fichier qui apparaîtra, sélectionnez les trois fichiers à reprojeter. Comme un
seul d’entre eux est nécessaire pour chaque ligne, ceux restants seront utilisés pour remplir les lignes ci-dessous.

Le nombre par défaut de lignes est 3, ce qui est exactement le nombre de couches que nous devons convertir, mais
si vous sélectionnez plus de couches, de nouvelles lignes seront ajoutées automatiquement. Si vous voulez remplir
les entrées manuellement, vous pouvez ajouter plus de lignes en utilisant le bouton Ajouter une ligne.

Nous allons convertir toutes ces couches en EPSG:23029, donc nous devons sélectionner ce SCR dans le second
champ. Nous voulons le même pour toutes les lignes, mais nous ne devons pas le faire pour chaque ligne in-
dividuellement. Configurez ce SCR pour la première ligne (celle du haut) en utilisant le bouton dans la cellule
correspondante, et ensuite double-cliquez sur l’en-tête de la colonne. Cela va permettre à toutes les cellules de la
colonne d’être remplies avec la valeur de la cellule du haut.
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Finalement, nous devons sélectionner un fichier de sortie pour chaque exécution, qui contiendra la couche repro-
jetée correspondante. Une fois encore, faisons-le uniquement pour la première rangée. Cliquez sur le bouton dans
la cellule supérieure et, dans un dossier où vous voulez mettre vos fichiers de sortie, entrez un nom de fichier (par
exemple reprojected.shp).

Maintenant, lorsque vous cliquez sur OK sur la boîte de dialogue de sélection de fichier, le fichier ne s’écrit pas
automatiquement dans la cellule, mais une zone de saisie comme celle qui suit s’affiche à la place.

Si vous sélectionnez la première option, seule la cellule courante sera remplie. Si vous sélectionnez n’importe
quelles autres options, toutes les lignes en-dessous seront remplies avec un modèle donné. Dans ce cas, nous
allons sélectionner l’option Remplir avec la valeur de paramètre, et ensuite la valeur Couche d’entrée dans le
menu déroulant dessous. Cela ajoutera la valeur dans la Couche d’entrée (c’est-à-dire le nom de la couche) au
nom de fichier que nous avons ajouté, rendant chaque fichier de sortie différent. La table de traitement par lots
devait maintenant ressembler à ça.
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La dernière colonne indique s’il faut ou non ajouter les couches résultantes au projet courant QGIS. Laissez
l’option par défaut Oui, de sorte que vous puissiez voir vos résultats dans ce cas.

Cliquez sur OK et le traitement par lots sera exécuté. Si tout s’est bien passé, toutes vos couches auront été traitées,
et 3 nouvelles couches auront été créées.

18.27 Modèles dans l’interface de traitements par lots

Warning: Prenez garde, ce chapitre n’est pas bien testé, s’il vous plaît rapporter tous problèmes ; les images
sont manquantes

Note: Cette leçon montre un autre exemple de l’interface de traitements par lots, mais cette fois en utilisant un
modèle à la place d’un algorithme intégré.

Les modèles sont simplement comme tout autre algorithme, et ils peuvent être utilisés dans l’interface de traite-
ments par lots. Pour démontrer cela, voici un exemple simple que nous pouvons faire en utilisant notre modèle
hydrologique bien connu.

Soyez sûr que vous avez ajouté le modèle à votre boîte à outils, et ensuite exécutez-le dans un mode lot. Voici à
quoi la boîte de dialogue du traitement par lots devrait ressembler.

Warning: todo: Ajouter image

Ajoutez des lignes jusqu’à avoir un total de 5. Sélectionnez le fichier MNE correspondant à cette leçon comme
l’entrée pour tous. Ensuite, entrez 5 valeurs de seuil différentes comme montré après.

Warning: todo: Ajouter image

Comme vous le voyez, l’interface de traitements par lots peut être exécutée non seulement pour exécuter le même
processus sur différents jeux de données, mais également sur le même jeu de données avec différents paramètres.
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Cliquez sur OK et vous devriez obtenir 5 nouvelles couches avec les bassins versants correspondant aux valeurs
spécifiques aux 5 bassins versants.

18.28 Pre- and post-execution script hooks

Note: This lesson shows how to use pre- and post-execution hooks, which allow to perform additional operations
before and after actual processing.

Pre- and post-execution hooks are Processing scripts that run before and after actual data processing is performed.
This can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax of the hooks is identical to the syntax of Processing scripts, see the corresponding chapter in the QGIS
User Guide for more details.

In addition to all scripts features, in hooks you can use a special global variable named alg, which represents the
algorithm that has just been (or is about to be) executed.

Here is an example post-execution script. By default, Processing stores analysis results in temporary files. This
script will copy outputs to a specific directory, so they won’t be deleted after closing QGIS.

import os
import shutil
from processing.core.outputs import OutputVector, OutputRaster, OutputFile

MY_DIRECTORY = ’/home/alex/outputs’

for output in alg.outputs:
if isinstance(output, (OutputVector, OutputRaster, OutputFile)):

dirname = os.path.split(output.value)[0]
shutil.copytree(dirname, MY_DIRECTORY)

In the first two lines we import the required Python packages: os — for path manipulations, e.g. extracting file
name, and shutil — for various filesystem operations like copying files. In the third line we import Processing
outputs. This will be explained in more detail later in this lesson.

Then we define a MY_DIRECTORY constant, which is the path to the directory where we want to copy analysis
results.

At the end of the script, we have the main hook code. In the loop we iterate over all algorithm outputs and check
if this output is a file-based output and can be copied. If so, we determine top-level directory in which output files
are located and then copy all files to our directory.

To activate this hook we neeed to open the Processing options, find the entry named Post-execution script file in
the General group, and specify the filename of the hook script there. the specified hook will be executed after
each Processing algorithm.

In a similar way, we can implement pre-execution hooks. For example, let’s create a hook to check input vectors
for geometry errors.

from qgis.core import QgsGeometry, QgsFeatureRequest
from processing.core.parameters import ParameterVector

for param in alg.parameters:
if isinstance(param, ParameterVector):

layer = processing.getObject(param.value)
for f in layer.getFeatures(QgsFeatureRequest().setSubsetOfAttributes([])):

errors = f.geometry().validateGeometry()
if len(errors) > 0:

progress.setInfo(’One of the input vectors contains invalid geometries!’)

As in the previous example, first we import required QGIS and Processing packages.
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Then we iterate over all the algorithm parameters and if a ParameterVector parameter is found, we get the cor-
responding vector layer object from it. We loop over all the features of the layer and check them for geometry
errors. If at least one feature contains an invalid geometry, we print a warning message.

To activate this hook we need enter its filename in the Pre-execution script file option in the Processing configura-
tion dialog. The hook will be executed before running any Processing algorithm.

18.29 Autres programmes

Module développé par Paolo Cavallini - Faunalia

Note: Ce chapitre montre comment utiliser des programmes supplémentaires à l’intérieur du module Traite-
ment. Pour le compléter, vous devez avoir installé, avec les outils pour votre système d’exploitation, les paquets
concernés.

18.29.1 GRASS

GRASS est une suite de logiciels libres et open-source de SIG pour la gestion des données géospatiales et
l’analyse, le traitement d’images, la production de graphiques et de cartes, la modélisation spatiale, et la visu-
alisation.

Elle est installée par défaut sur Windows via l’installeur indépendant OSGeo4W (32 et 64 bit), et il existe des
compilations pour toutes les distributions importantes de Linux.

18.29.2 R

R est un environnement logiciel libre et open-source pour le calcul statistiques et les graphiques.

Il doit être installé séparément, avec quelques librairies nécessaires (LIST).

La beauté de l’implémentation du module de Traitement est qu’elle vous permet d’ajouter vos propres scripts,
simples ou complexes, qui pourront être utilisés comme n’importe quel module, relié à des flux de traitements
plus complexes, etc.

Testez quelque uns des exemples pré-installés, si vous avez déjà installé R (souvenez-vous d’activer les modules
R depuis la configuration Générale du Module de Traitement).

18.29.3 OTB

OTB (aussi connu comme Orfeo ToolBox) est une librairie d’algorithmes de traitement d’images libre et open-
source. Il est installé par défaut sur Windows via l’installeur indépendant OSGeo4W (NB: 32 bits seulement).
Les chemins devraient être configurés dans le Module de Traitement.

Dans une installation standard OSGeo4W de Windows, les chemins seront:

OTB application folder C:\OSGeo4W\apps\orfeotoolbox\applications
OTB command line tools folder C:\OSGeo4W\bin

Sur Debian et dérivés, ce sera /usr/bin

18.29.4 Autres

TauDEM est une suite d’outils de Modèle Numérique d’Élévation (MNE) pour l’extraction et l’analyse
d’information hydrologique. La disponibilité dans les différents systèmes d’exploitation varie.

LASTools est un ensemble mixte, libre et propriétaire de commandes pour traiter et analyser des données LiDAR.
La disponibilité dans les différents systèmes d’exploitation varie.
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D’autres outils sont disponibles via des extensions supplémentaires, par exemple :

• LecoS : une suite pour les statistiques de la couverture du sol et de l’écologie du paysage

• lwgeom : faisant autrefois partie de PostGIS, cette librairie apporte quelques outils utiles pour le nettoyage
de la géométrie.

• Animove: Outils pour analyser l’étendu du territoire d’animaux.

D’autres viendront.

18.29.5 Comparaison entre les backends

Tampons et distances

Chargeons points.shp et le type buf dans le filtre de la Boîte à outils, puis double-cliquons dessus :

• Distance tampon fixe : Distance de 10000

• Variable distance tampon : Champ de distance SIZE

• v.buffer.distance: distance de 10000

• v.buffer.column: bufcolumn TAILLE

• Formes de Tampon: 10000 de valeur fixe (dissoudre et pas), champ d’attribut (avec mise à l’échelle)

Voyez comme la vitesse est tout à fait différentes, et différentes options sont disponibles.

Exercice pour le lecteur : trouver les différences dans la sortie géométrique entre les différentes méthodes.

Maintenant, les tampons raster et les distances :

• premièrement, chargez et pixelliser le vecteur rivers.shp avec GRASS → v.to.rast.value; Attention : la
taille des cellules doit être fixée à 100 m, autrement le temps de calcul sera énorme ; la carte résultante aura
1 et NULLs

• Faîtes de même avec SAGA → Shapes to Grid → COUNT (carte résultante: 6 = 60).

• puis proximité (valeur = 1 pour GRASS, une liste d’identifiants de rivières pour SAGA), r.buffer avec les
paramètres 1000,2000,3000, r.grow.distance (la première des deux cartes ; la seconde affichera les zones
pertinentes de chaque rivière, si calculée avec le raster SAGA).

Décomposer

Décomposer des entités basées sur un attribut commun :

• GRASS → v.dissolve municipalities.shp dans PROVINCIA

• QGIS → Dissolve municipalities.shp dans PROVINCIA

• OGR → Dissoudre municipalities.shp sur PROVINCIA

• SAGA → Dissolve Polygone municipalities.shp dans PROVINCIA (NB : Garder les frontières
internes ne doit pas être sélectionné)

Note: Le dernier est cassé dans SAGA <= 2.10

Exercice pour le lecteur : trouvez les différences (géométriques et d’attributs) entre différentes méthodes.
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18.30 Interpolation et contour

Module développé par Paolo Cavallini - Faunalia

Note: Ce chapitre montre comment utiliser différents backends pour calculer différentes interpolations.

18.30.1 Interpolation

Le projet montre un gradient dans les précipitations, du sud au nord. Utilisons différentes méthodes pour
l’interpolation, toutes basées sur un vecteur points.shp, paramètre RAIN :

Warning: Entrez une taille de cellule de 500 pour les analyses.

• GRASS → v.surf.rst

• SAGA → Interpolation de B-spline multi-niveaux

• SAGA → Distance inverse pondérée [distance inverse à une puissance ; Puissance : 4 ; Rayon de recherche
: Global ; Gamme de recherche : tous les points]

• GDAL → Grille (Distance inverse à une puissance) [Puissance : 4]

• GDAL → Grille (Moyenne de déplacement) [Rayon1&2 : 50000]

Puis mesurez la variation entre les méthodes et corrélez-les avec la distance aux points :

• GRASS → r.series [Désélectionner la propagation des NULLs, Opération d’agrégation : stddev]

• GRASS → v.to.rast.value sur points.shp

• GDAL → Proximité

• GRASS → r.covar pour montrer la matrice de corrélation ; vérifiez la validité de la corrélation, par exemple
avec http://vassarstats.net/rsig.html.

Ainsi, les zones loin des points auront une interpolation moins précise.

18.30.2 Contour

Diverses méthodes pour dessiner des lignes de contours [toujours étapes = 10] sur le raster stddev :

• GRASS → r.contour.step

• GDAL → Contour

• SAGA → Lignes de contour depuis la grille [NB: la sortie shp n’est pas valide sur certaines anciennes
versions de SAGA, bogue connu]

18.31 Simplification vectorielle et lissage

Module développé par Paolo Cavallini - Faunalia

Note: Ce chapitre montre comment simplifier des vecteurs, et lisser les coins pointus.

Parfois nous avons besoin d’une version simplifiée d’un vecteur, pour avoir une plus petite taille de fichier et
se débarrasser des détails inutiles. Beaucoup d’outils font ça d’une manière très approximative, et oublient
l’adjacence et parfois l’exactitude topologique des polygones. GRASS est l’outil idéal pour cela : étant un SIG
topologique, l’adjacence et l’exactitude sont préservées même à des niveaux de simplification très grande. Dans
notre cas, nous avons un vecteur résultant d’un raster, montrant ainsi un motif de “scie” aux bords. Appliquer une
simplification résulte dans les grandes lignes :
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• GRASS → v.generalize [Valeur de tolérance maximale : 30 m]

Nous pouvons aussi faire l’inverse, et faire une couche plus complexe, en lissant les coins pointus.

• GRASS → v.generalize [méthode : chaiken]

Essayez d’appliquer cette deuxième commande sur le vecteur original et aussi sur celui résultant de la première
analyse, et voyez la différence. Notez que l’adjacence n’est pas perdue.

Cette seconde option peut être appliquée par exemple aux lignes de contour résultant d’un raster grossier, à des
pistes GPS avec de rares sommets , etc.

18.32 Prévoir une ferme solaire

Module développé par Paolo Cavallini - Faunalia <http://www.faunalia.eu>

Note: Ce chapitre montre comment utiliser plusieurs critères pour localiser les zones adaptées à l’installation
d’une centrale photovoltaique

Pour commencer, créer une carte d’aspect à partir du MNT :

• GRASS → r.aspect [Type de données : int ; taille de cellule : 100]

Dans GRASS, l’aspect est calculé en degrés, dans le sens horaire inverse à partir de l’Est. Pour extraire seulement
les pentes du versant Sud (270 degrés +- 45), nous pouvons le reclasser :

• GRASS → r.reclass

avec les règles suivantes:

225 thru 315 = 1 south

* = NULL

Vous pouvez utiliser le fichier texte reclass_south.txt fourni. Notez qu’avec ces simples fichiers texte
nous pouvons aussi créer de très complexes reclassifications.

Nous souhaitons construire une grande ferme, donc nous ne sélectionnons que les grands espaces contiguës (>
100 ha) :

• GRASS → r.reclass.greater

Finalement, nous convertissons en vecteur :

• GRASS → r.to.vect [Type d’entité: surface ; Lisser les angles : oui]

Exercice pour le lecteur : répétez l’analyse, en replaçant les commandes GRASS par analogie avec d’autres
programmes.

18.33 Utilisation de scripts R avec Processing

Module réalisé par Matteo Ghetta - financé par Scuola Superiore Sant’Anna

Processing permet d’écrire et de faire tourner des scripts dans QGIS.

Warning: R doit être installé sur votre ordinateur et la variable PATH doit être correctement configurée. De
plus, Processing ne fait qu’utiliser les progiciels de R, et ne peut donc pas les installer. Soyez donc certain
d’installer les progiciels externes directement dans R. Voir aussi le chapitre correspondant dans le manuel de
formation.

Note: Si vous avez des problèmes avec certains progiciels, c’est peut être lié à l’absence de progiciels obligatoires
requis par Processing, comme “sp”, “rgdal” et “raster”.
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18.33.1 Ajout de scripts

Ajouter un script est très simple. Ouvrez la boîte d’outils de Processing et cliquez simplement sur R → Outils →
Créer un nouveau script R.

Note: Si vous ne pouvez pas voir R dans Processing, vous devez l’activer dans Processing → Options → Pilotes

Il ouvre une fenêtre d’édition de script dans laquelle vous devez fournir quelques paramètres avant de pouvoir
ajouter le corps du script.

18.33.2 Création de graphiques

Dans ce tutoriel nous allons créer une boîte à moustaches à partir d’un champ d’une couche vertorielle.

Open the r_intro.qgs QGIS project under the exercise_data/processing/r_intro/ folder.
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Paramètres du script

Ouvrez l’éditeur et commencez l’écriture au début.

Vous devez définir certains paramètres avant le corps du script :

1. le nom du groupe auquel votre script appartiendra

##plots=group

de sorte que vous trouverez votre script dans le groupe graphiques de la boîte d’outils de Processing.

2. vous devez dire à Processing que vous voulez afficher un graphique (comme dans cet exemple)

##showplots

De cette façon vous verrez le graphique dans le Visualiseur de Résultats de Processing.

3. Vous devez aussi dire à Processing le type de données que vous allez utiliser. Dans cet exemple nous voulons
créer un graphique à partir d’un champ d’une couche vectorielle.

##Layer=vector

Processing sait maintenant que l’entrée est un vecteur. Le nom * Couche* n’est pas important, ce qui compte
c’est le paramètre vectorielle.

4. Enfin, vous devez fournir le champ en entrée de la couche vectorielle que vous voulez afficher

##X=Field Layer

Donc Processing sait que vous avez appelé X le Champ de la Couche.

Corps du script

Maintenant que vous avez établi l’en-tête du script vous pouvez ajouter la fonction

boxplot(Layer[[X]])

Notez que Boîte à Moustaches est le nom de la fonction R qui appelle Couche comme jeu de données et X en
tant que champ du jeu de données.

Warning: Le paramètre X est entre double crochets [[]]

Le script complet se présente ainsi

##Vector processing=group
##showplots
##Layer=vector
##X=Field Layer
boxplot(Layer[[X]])
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Sauvez le script dans le répertoire suggéré par Processing. Le nom que vous choisissez sera celui du script que
vous trouverez dans la boîte d’outils de Processing.

Note: Vous pouvez sauver le script dans un autre répertoire, mais Processing n’est pas capable de le charger
automatiquement et vous devrez charger tous les scripts manuellement

Maintenant exécutez le en utilisant le bouton en haut de la fenêtre de l’éditeur :
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Autrement, une fois que la fenêtre de l’éditeur a été fermée, utilisez la boîte de texte de Processing pour trouver
votre script :

Vous pouvez maintenant fournir les paramètres requis dans la fenêtre de l’algorithme de Processing :

• Choisissez points tests comme Couche

• Renseignez le champ X avec le paramètre value

Cliquez sur Lancer
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La Fenêtre des résultats devrait s’ouvrir automatiquement, sinon, cliquez simplement sur Processing → Visu-
aliseur de Résultats....

C’est le dernier résultat que vous verrez :
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Note: Vous pouvez ouvrir, copier et sauver l’image avec un clic droit sur le graphique

18.33.3 Créer un vecteur

Avec un script R vous pouvez aussi créer un vecteur et l’ajouter automatiquement à QGIS.

L’exemple suivant est tiré du script Échantillonnage aléatoire de grille que vous pouvez
télécharger de la collection en ligne R → Outils → Télécharger des scripts R à partir de la collection en ligne.

Le but de l’exercice est de créer un vecteur de points aléatoires dans l’emprise d’une couche en utilisant la fonction
spsample du progiciel sp.

Paramètres du script

Comme auparavant, nous devons définir certains paramètres avant le corps du script :

1. définissez le nom du groupe dans lequel le script sera mis, par exemple Analyses de motif de points

##Point pattern analysis=group

2. définissez la couche qui contiendra les points aléatoires

##Layer=vector

3. définissez le nombre de points qui seront créés
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##Size=number 10

Note: 10 sera la valeur par défaut. Vous pouvez modifier ce chiffre ou vous pouvez laisser le paramètre
sans valeur par défaut

4. spécifie que la sortie est une couche vectorielle

##Output= output vector

Corps du script

Vous pouvez maintenant ajouter le corps de la fonction :

1. exécute la fonction spsample

pts=spsample(Layer,Size,type="random")

de cette façon la fonction récupère l’emprise de la Couche, le nombre de points est dérivé du paramètre
Taille et le type de création des points est aléatoire

2. Écrit la ligne qui contient les paramètres en sortie

Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Le script complet se présente ainsi

##Point pattern analysis=group
##Layer=vector
##Size=number 10
##Output= output vector
pts=spsample(Layer,Size,type="random")
Output=SpatialPointsDataFrame(pts, as.data.frame(pts))
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Sauvez-le et exécutez-le, en cliquant sur le bouton Lancer.

Dans la nouvelle fenêtre, entrez les bons paramètres :

et cliquez sur Lancer.

Les points en résultant seront affichés sur le canevas de carte
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18.33.4 R - syntaxe de Processing

Veuillez noter que Processing utilise une syntaxe spéciale pour obtenir les résultats de R :

• > avant votre commande, comme pour >lillie.test(Couche[[Champ]]) qui veut dire que le ré-
sultat devrait être envoyé sur la sortie de R (Visionneur de Résultat)

• + après un graphique pour permettre la superposition de graphiques. Par exemple plot(Couche[[X]],
Couche[[Y]]) + abline(h=mean(Couche[[X]]))

18.34 Syntaxe R dans les scripts des Traitements

Module réalisé par Matteo Ghetta - financé par Scuola Superiore Sant’Anna

Ecrire des scripts R dans Traitement peut être un peu difficile du fait de la syntaxe à adopter.

Chaque script commence avec Input et Output précédé de ##.

18.34.1 Entrées

Avant d’indiquer les entrées, vous pouvez également indiquer le group d’algorithme dans lequel votre script sera
intégré. Si le groupe existe déjà, l’algorithme y sera ajouté sinon un nouveau groupe sera automatiquement créé:

1. création de groupe, ##Mon groupe=group

Vous devez ensuite indiquer toutes les entrées ainsi que les paramètres supplémentaires. Vous pouvez avoir dif-
férents types d’entrées:

1. vector, ##Couche = vector

2. Champ de la couche, ##F = Field Couche‘ (où Couche est le nom de la couche en entrée)

3. raster, ##r = raster

4. table, ##t = table

5. number, ##Num = number

6. chaîne de caractères, ##Str = string

7. booléen, ##Bol = boolean

you can also have a dropdown menu with all the parameters you want; the items must be separated with semicolons
;:

8. ##type=selection point;lines;point+lines

18.34.2 Sorties

Comme pour les entrées, chaque sortie doit être définie au début du script:

1. vecteur, ##sortie= output vector

2. raster, ##sortie= output raster

3. table, ##sortie= output table

4. graphiques, ##showplot

5. R émet une sortie dans le Visualisateur de résultats, il faut juste indiquer ‘‘>‘ dans le script avant la sortie
que vous souhaitez afficher.
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18.34.3 Corps du script

Le corps du script suit le style de syntaxe de R et le panneau Journal peut vous aider à vérifier ce qui s’est mal
déroulé avec votre script.

Attention à bien charger toutes les bibliothèques additionnelles dans le script:

library(sp)

Exemple avec sortie vecteur

Prenons un algorithme de la collection de scripts en ligne qui créé des points aléatoires depuis l’emprise d’une
couche en entrée:

##Point pattern analysis=group
##Layer=vector
##Size=number 10
##Output= output vector
library(sp)
pts=spsample(Layer,Size,type="random")
Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

et analysons chacune des lignes:

1. Point pattern analysis est le groupe de l’algorithme.

2. Layer est la couche vecteur en entrée.

3. Size est le paramètres numérique avec une valeur par défaut de 10.

4. Output est la couche vecteur qui sera créée par l’algorithme.

5. library(sp) charge la bibliothèque sp (qui devrait être déjà installée sur votre machine et dont
l’installation doit être réalisée dans R).

6. Appelle la fonction spsample de la bibliothèque sp et l’utilise avec les entrées définies au-dessus.

7. créé la couche vecteur de sortie avec la fonction SpatialPointsDataFrame.

C’est tout ! Lancez l’algorithme avec une couche vecteur ouverte dans QGIS, choisissez un nombre de points
aléatoires et vous les récupérerez dans le canevas de carte.

Exemple avec sortie raster

Le script suivant effectuera un krigeage simple ordinaire et créera une couche raster des valeurs interpolées:

##Basic statistics=group
##Layer=vector
##Field=Field Layer
##Output=output raster
require("automap")
require("sp")
require("raster")
table=as.data.frame(Layer)
coordinates(table)= ~coords.x1+coords.x2
c = Layer[[Field]]
kriging_result = autoKrige(c~1, table)
prediction = raster(kriging_result$krige_output)
Output<-prediction

L’algorithme utilisera la fonction autoKrige du paquet R automap, à partir d’une couche vecteur en entrée et
d’un de ses champs et calculera d’abord le modèle de krigeage puis créera le raster.

Le raster est créé avec la fonction raster du paquetage raster R.
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Exemple avec une sortie table

Éditons l’algorithme Summary Statistics de manière à ce que la sortie soit un fichier de table (csv).

Le corps du script est le suivant:

##Basic statistics=group
##Layer=vector
##Field=Field Layer
##Stat=Output table
Summary_statistics<-data.frame(rbind(
sum(Layer[[Field]]),
length(Layer[[Field]]),
length(unique(Layer[[Field]])),
min(Layer[[Field]]),
max(Layer[[Field]]),
max(Layer[[Field]])-min(Layer[[Field]]),
mean(Layer[[Field]]),
median(Layer[[Field]]),
sd(Layer[[Field]])),row.names=c("Sum:","Count:","Unique values:","Minimum value:","Maximum value:","Range:","Mean value:","Median value:","Standard deviation:"))
colnames(Summary_statistics)<-c(Field)
Stat<-Summary_statistics

La troisième ligne indique le Champ vecteur et la quatrième ligne indique à l’algorithme que la sortie doit être
une table.

La dernière ligne utilisera l’objet Stat créé dans le script et le convertira en une table csv.

Exemple de sortie de la console d’exécution de R

Nous pouvons prendre l’exemple précédent et au lieu de créer un tableau, afficher le résultat dans l’Afficheur de
Résultat:

##Basic statistics=group
##Layer=vector
##Field=Field Layer
Summary_statistics<-data.frame(rbind(
sum(Layer[[Field]]),
length(Layer[[Field]]),
length(unique(Layer[[Field]])),
min(Layer[[Field]]),
max(Layer[[Field]]),
max(Layer[[Field]])-min(Layer[[Field]]),
mean(Layer[[Field]]),
median(Layer[[Field]]),
sd(Layer[[Field]])),row.names=c("Sum:","Count:","Unique values:","Minimum value:","Maximum value:","Range:","Mean value:","Median value:","Standard deviation:"))
colnames(Summary_statistics)<-c(Field)
>Summary_statistics

Le script est identique à celui situé ci-dessus mais avec 2 modifications:

1. Il n’y a plus de sortie indiquée (la quatrième ligne a été supprimée).

2. La dernière ligne commence avec le caractère > qui indique à Processing d’afficher l’objet dans le visual-
isateur de résultats.

Exemple avec un graphique

Créer des graphiques est très simple. Vous devez juste utiliser le paramètre ##showplots comme indiqué dans
le script qui suit:
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##Basic statistics=group
##Layer=vector
##Field=Field Layer
##showplots
qqnorm(Layer[[Field]])
qqline(Layer[[Field]])

Le script prend un champ de la couche vecteur en entrée et créé un diagramme Quantile-Quantile pour tester la
normalité d’une distribution.

La graphique est automatiquement ajouté au Visualisateur de Résultats de Processing.

18.35 Table de résumé de la syntaxe R pour Processing

Module réalisé par Matteo Ghetta - financé par Scuola Superiore Sant’Anna

Processing inclue de nombreux différents paramètres d’entrée et de sortie, utilisables dans le corps du script. Voici
une table de résumé:

18.35.1 Paramètres en entrée

Paramètre Exemple de Syntaxe Objets renvoyés
vector Couche = vector Objet SpatialDataFrame, objet par défaut du paquet rgdal.
vector
point

Couche = vector point Objet SpatialPointDataFrame, objet par défaut du paquet rgdal.

vector line Couche = vector line Objet SpatialLineDataFrame, objet par défaut du paquet rgdal.
vector
polygon

Couche = vector
polygon

Objet SpatialPolygonsDataFrame, objet par défaut du paquet
rgdal.

multiple
vector

Couches = multiple
vector

Objets SpatialDataFrame, objet par défaut du paquet rgdal.

table Couche = table Conversion des données depuis le format csv, objet par défaut de la
fonction read.csv.

field Champ = Field Layer Nom du champ sélectionné, ex: "Area".
raster Couche = raster Objet RasterBrick, objet par défaut du paquet rgdal.
multiple
raster

Couches = multiple
raster

Objets RasterBrick, objet par défaut du paquet rgdal.

number N = number Entier ou nombre à virgule flottante choisi.
string S = string Chaîne de caractères ajoutée dans la boîte.
longstring LS = longstring Chaîne de caractères ajoutée à la boîte, peut être plus longue que la

chaîne normale.
selection S = selection

first;second;third
Chaîne de caractères de l’entrée sélectionnée, choisie dans le menu
déroulant.

crs C = crs Chaîne de caractères du SCR choisi, dans le format "EPGS:4326".
extent E = extent Objet d’emprise du paquet raster, vous pouvez en extraire les

valeurs avec E@xmin.
point P = point Lorsque vous cliquez sur la carte, vous avez les coordonnées du

point.
file F = file Chemin du fichier sélectionné, par exemple “/home/matteo/file.txt”.
folder F = folder Chemin du dossier sélectionné, par exemple

“/home/matteo/Downloads”.

Toute entrée peut également être OPTIONNELLE, ce qui indique facilement au script d’ignorer le paramètre.

Pour indiquer qu’une entrée est optionnelle, il suffit d’ajouter la chaîne de caractères optional avant l’entrée,
ex:
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##Layer = vector
##Field1 = Field Layer
##Field2 = optional Field Layer

18.35.2 Paramètres de sortie

Les paramètres de sortie prennent les noms des Entrées que vous avez écrit au début du script et écrive l’objet
que vous voulez.

Paramètre Exemple de Syntaxe
vector Sortie = output vector
raster Sortie = output raster
table Sortie = output table
file Sortie = output file

Note: Pour le type de sortie graphique, vous pouvez la sauvegarder au format png directement depuis le Visual-
isateur de Résultats de Processing ou vous pouvez choisir d’enregistrer le graphique directement depuis l’interface
de l’algorithme.

18.35.3 Exemples

Pour mieux comprendre l’ensemble des paramètres d’entrée et de sortie, merci de consulter le R Syntax chapter.

18.36 Prédire les glissements de terrain

Module développé par Paolo Cavallini - Faunalia

Note: Ce chapitre montre comment créer un modèle simplifié pour prédire la probabilité des glissements de
terrain.

Premièrement, nous calculons la pente (choisir parmi les différents backends; le lecteur intéressé pourra calculer
les différences entre les sorties) :

• GRASS → r.slope

• SAGA → Slope, aspect, curvature

• GDAL Slope

Ensuite nous créons un modèle de prédiction des précipitations, basé sur une interpolation des valeurs de précipi-
tations mesurées aux stations météorologiques.

• GRASS → v.surf.rst (résolution : 500 m)

La probabilité d’un glissement de terrain est très approximativement liée à la fois à la quantité de précipitations et
à la pente (bien sûr un véritable modèle utilisera plusieurs couches et des paramètres appropriés), disons “(précip-
itations * pente) / 100”.

• SAGA → Raster calculator rain, slope: (a*b)/100 (ou : GRASS → r.mapcalc)

• then let’s calculate what are the municipalities with the greatest predicted risk of rainfall: SAGA → Raster
statistics with polygons (the parameters of interest are Maximum and Mean)
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CHAPTER 19

Module: Utiliser des bases de données spatiales dans QGIS

Dans ce module, vous apprendrez l’utilisation des bases de données spatiales avec QGIS pour gérer, afficher
et manipuler des données dans la base de données ainsi que réaliser des analyses à partir de requêtes. Nous
utiliserons principalement PostgreSQL et PostGIS (qui ont été abordés dans les sections précédentes), mais les
mêmes concepts s’appliquent aux autres implémentations de bases de données spatiales notamment spatialite.

19.1 Lesson: Travailler avec les Bases de Données dans le Navi-
gateur de QGIS

Dans les 2 précédents modules, nous avons vu les concepts de base, les entités et fonctions des bases de données
relationnelles ainsi que les extensions qui nous permettent de stocker, gérer, interroger et manipuler des données
spatiales dans une base de données relationnelle. Cette section ira plus loin, notamment dans la façon dont les
bases de données spatiales sont utilisées dans QGIS.

L’objectif de cette leçon: Apprendre comment interagir avec des bases de données spatiales en utilisant le pan-
neau Parcourir de QGIS.

19.1.1 Follow Along: Ajouter des tables de bases de données via le pan-
neau Parcourir

Nous avions déjà brièvement vu comment ajouter des tables de base de données comme couches dans QGIS;
maintenant, nous allons l’aborder un peu plus en détail et voir les différentes manières d’opérer. Commençons
donc par la nouvelle interface du panneau Parcourir.

• Démarrer un nouveau projet dans QGIS.

• Ouvrez le panneau Parcourir en cliquant sur l’onglet Parcourir en bas du Panneau Couches

• Déroulez la partie PostGIS de l’arborescence. Vous devriez y voir la connexion précédemment configurée
(il vous faudra peut-être cliquer sur le bouton Actualiser en haut de la fenêtre Parcourir).
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• Un double-clic sur une table/couche de la liste l’ajoute automatiquement à la carte.

• Un clic droit sur une table/couche vous offre des options. Cliquez sur l’élément Propriétés pour voir les
propriétés de la table/couche.
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Note: Bien entendu, vous pouvez aussi utiliser cette interface pour vous connecter à des bases de données
hébergées sur un serveur autre que votre station de travail. Un clic droit sur l’entrée PostGIS de l’arborescence
vous permet de spécifier les paramètres pour une nouvelle connexion.

19.1.2 Follow Along: Ajouter des enregistrements filtrés comme couche

Maintenant que nous avons vu comment ajouter une table entière dans QGIS, il serait intéressant d’apprendre à
ajouter un jeu de données filtrées depuis une table en utilisant les requêtes, notion abordée dans les précédentes
sections.

• Ouvrez dans QGIS un nouveau projet, vide de couches

• Click the Add PostGIS Layers button or select Layer → Add PostGIS Layers from the menu.

• Dans la fenêtre Ajouter une ou plusieurs table(s) PostGIS qui s’ouvre, connectez-vous à postgis_demo.

• Déroulez le schéma public dans lequel vous devriez trouver les trois tables que nous utilisions précédem-
ment.

• Sélectionnez la couche lines, mais au lieu de l’ajouter à la carte, cliquez sur le bouton Filtrer les fichiers
afin d’afficher la fenêtre Constructeur de requête.

• Construisez la requête suivante à l’aide des boutons ou en la saisissant directement:

"roadtype" = ’major’
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• Cliquez sur OK pour valider l’édition du filtre et sur Ajouter pour ajouter la couche filtrée à la carte.

• Renommez la couche lines dans l’arborescence en roads_primary.

Vous constaterez que seules les routes principales ont été ajoutées à votre carte et non la totalité de la couche.

19.1.3 In Conclusion

Vous savez maintenant comment interagir avec les bases de données en utilisant le panneau Parcourir et comment
ajouter des couches pré-filtrées à votre carte.

19.1.4 What’s Next?

Nous verrons ensuite comment vous pouvez accéder à des fonctions plus complètes de gestion de bases de données
via l’interface DB Manager.

19.2 Lesson: Utiliser DB Manager pour travailler avec les Bases
de données Spatiales dans QGIS

Nous avons déjà vu comment réaliser plusieurs opérations de base de données avec QGIS ainsi qu’avec d’autres
outils mais il maintenant temps d’étudier l’outil DB Manager qui fournit les mêmes fonctionnalités ainsi que des
outils plus orientés vers l’administration.

L’objectif de cette leçon: Apprendre comment interagir avec des base de données spatiales en utilisant le DB
Manager de QGIS.

19.2.1 Follow Along: Administrer une Base de Données PostGIS avec DB
Manager

Vous devez premièrement ouvrir l’interface DB Manager en sélectionnant Base de Données –> DB Manager –>
DB Manager dans le menu ou en séelectionnant l’icone DB Manager dans la barre d’outils.

Vous devriez déjà voir les connexions que nous avons configurées précédemment et vous devriez pouvoir étendre
la section myPG et son schéma public pour voir les tables que nous avons utilisées dans les sections précédentes.

La première chose que vous pouvez remarquer est que vous pouvez maintenant lire les métadonnées des schémas
contenus dans la base de données.
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Les schémas constituent un moyen de regrouper des tables de données et d’autres objets au sein d’une base de
données PostgreSQL. Ils contiennent également les permissions et les autres contraintes. Gérer des schémas
PostgreSQL dépasse la portée de ce document mais vous pouvez en apprendre plus dans la Documentation sur les
schémas PostgreSQL. Vous pouvez utiliser DB Manager pour créer de nouveaux schémas mais vous aurez sans
doute besoin d’outils comme pgAdmin III ou de la ligne de commande pour aller plus loin.

DB Manager peut également être utilisé pour gérer les tables de votre base de données. Nous avons déjà étudié
plusieurs méthodes pour créer et gérer des tables à partir de la ligne de commande mais regardons rapidement
comment on peut le faire avec DB Manager.

Il est d’abord intéressant de consulter les métadonnées de la table en cliquant sur son nom dans l’arbre et en lisant
l’onglet Info.

19.2. Lesson: Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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Dans ce panneau, vous pouvez lire les Informations Générales de la table ainsi que l’information que l’extension
PostGIS conserve sur la géométrie et le système de référence spatiale.

Si vous vous déplacez vers le bas de l’onglet Info, vous pouvez avoir plus d’information sur les Champs, les
Constraintes et les Index de la table sélectionnée.
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Vous pouvez également utiliser DB Manager pour observer le contenu de la base de données de la même manière
que vous utilisez la table des attributs d’une couche dans la Légende. Vous pouvez naviguer dans les données en
sélectionnant l’onglet Table.

19.2. Lesson: Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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Il existe également l’onglet Aperçu qui vous montrera l’aspect de la couche de données dans une carte d’aperçu.

Effectuez un clic droit sur une couche dans l’arborescence et cliquez sur Ajouter au Canevas pour ajouter cette
couche à votre carte.

Jusqu’à présent, nous avons observé la base de données par ses schémas et ses tables ainsi que leurs métadonnées
mais qu’en est-il si nous voulons modifier la table pour ajouter une colonne ? DB Manager vous permet de le faire
directement.

• Sélectionnez dans l’arborescence la table que vous souhaiter éditer.

• Sélectionnez depuis le menu Table → Éditer une table afin d’ouvrir la fenêtre Propriétés de la table.

Vous pouvez utiliser cette fenêtre pour ajouter des colonnes, ajouter des colonnes géométriques, éditer des
colonnes existantes ou supprimer complètement une colonne.

Dans l’onglet Contraintes, vous pouvez gérer quels champs sont utilisés comme clé primaire ou supprimer des
contraintes existantes.
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L’onglet Index peut être utilisé pour ajouter et supprimer des index aussi bien normaux que spatiaux.

19.2. Lesson: Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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19.2.2 Follow Along: Création d’une Nouvelle Table

Maintenant que nous avons vu comment travailler sur les tables existantes dans notre base de données, voyons
comment créer une nouvelle table avec DB Manager.

• Si elle n’est pas déjà ouverte, ouvrez la fenêtre de DB Manager et déroulez l’arborescence jusqu’à voir la
liste des tables déjà présentes dans votre base de données.

• Depuis le menu, sélectionnez Table –> Créer une table pour afficher la fenêtre de création de table.

• Utilisez le schéma par défaut Public et nommez la table places .

• Ajoutez les champs id, place_name et elevation comme montré ci-dessous

• Assurez-vous de définir le champ id comme clé primaire.

• Cochez la case Créer une colonne géométrique et assurez-vous qu’il est défini de type POINT; laissez le
nom geom et spécifiez 4326 comme SRID.

• Cochez la case Créer un index spatial et cliquez sur Créer pour créer la table.
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• Validez la fenêtre vous faisant savoir que la table a été créée et cliquez sur:guilabel:Fermer pour fermer la
fenêtre de création de table.

Vous pouvez maintenant inspecter votre table dans DB Manager et bien entendu, vous constaterez qu’elle ne
contient aucune donnée. Désormais, vous pouvez ajouter votre table au projet, la Basculer en mode édition depuis
le menu Couche et commencez à y ajouter des places.

19.2.3 Follow Along: Administration basique de base de données

DB Manager vous permet aussi de faire d’autres tâches basiques d’administration de base de données. Ce n’est
certainement pas un substitut pour un outil complet d’administration de base de données, mais il vous fournit des
fonctions de maintenance de votre base de données.

Les tables des bases de données peuvent souvent devenir volumineuses et les tables qui sont fréquemment modi-
fiées laissent des enregistrements qui n’ont plus besoin d’être conservés par PostgreSQL. La commande VACUUM
s’occupe de gérer la suppression de ces données invalidées pour compacter et analyser vos tables dans l’objectif
d’être plus performant.

Voyons comment réaliser une commande VACUUM ANALYZE à partir de DB Manager.

• Sélectionnez une de vos tables dans l’arborescence de DB Manager.

• Sélectionnez menu Table → Lancer Vacuum Analyze.

Ça y est! PostgreSQL va réaliser l’opération. Selon la taille de votre table, ceci peut prendre un certain temps.

19.2. Lesson: Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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Vous trouverez plus d’informations sur les processus de VACUUM ANALYZE dans la documentation de Post-
greSQL.

19.2.4 Follow Along: Exécution de requêtes SQL avec DB Manager

DB Manager fournit également un moyen d’écrire des requêtes de tables et de visualiser les résultats. Nous avons
déjà vu ce type de fonctionnalité dans le panneau Navigation mais observons comment le faire avec DB Manager.

• Sélectionnez la table lines dans l’arborescence.

• Sélectionnez le bouton Fenêtre SQL dans la barre d’outils de DB Manager.

• Composez la Requête SQL suivante dans l’espace disponible:

select * from lines where roadtype = ’major’;

• Cliquez sur le bouton Exécuter (F5) pour réaliser la requête.

• Vous devriez maintenant voir les enregistrements correspondants dans le panneau Résultat.

• Cochez la case Charger comme une nouvelle couche pour ajouter le résultat à votre carte.

• Sélectionnez la colonne id en tant que Colonne avec des valeurs entières et uniques et la colonne geom en
tant que Colonne de géométrie.

• Saisissez roads_primary dans le Nom de la couche.

598 Chapter 19. Module: Utiliser des bases de données spatiales dans QGIS

http://www.postgresql.org/docs/9.1/static/sql-vacuum.html
http://www.postgresql.org/docs/9.1/static/sql-vacuum.html


QGIS Training Manual, Version 2.18

• Cliquez sur Charger ! pour charger les résultats dans une nouvelle couche sur votre carte.

Les couches qui correspondent à votre requête sont maintenant affichées sur la carte. Vous pouvez bien entendu
utiliser cet outil pour lancer n’importe quelle commande SQL, incluant celles que nous avons étudiées dans les
modules et les sections précédentes.

19.2.5 Importer des données dans une base de données avec DB Manager

Nous avons déjà étudié comment importer des données dans une base de données spatiale en utilisant la ligne de
commande. Voyons comment y parvenir en utilisant le Gestionnaire de Bases de Données.

• Cliquez sur le bouton Importer une couche ou un fichier dans la barre d’outils de la boîte de dialogue de DB
Manager.

• Sélectionnez le fichier urban_33S.shp depuis exercise_data/projected_data en tant que
donnée d’entrée.

• Cliquer sur le bouton Options de mise à jour pour pré-remplir certaines valeurs du formulaire.

• Assurez-vous que l’option Créer une nouvelle table est sélectionnée.

• Paramétrer le SCR Source à 32722 et le SCR Cible à 4326.

• Cochez la case Créer un index spatial

• Cliquez sur OK pour réaliser l’import.

19.2. Lesson: Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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• Fermer la boîte de message qui vous indique que l’export s’est correctement déroulé.

• Cliquez sur le bouton Rafraîchir de la barre d’outils de DB Manager.

Vous pouvez maintenant inspecter la table dans votre base de données en cliquant dans l’arbre. Vérifiez que la
donnée a bien été reprojetée en vérifiant que Ref Spatiale: contient bien WGS 84 (4326).
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Faîtes un clic droit sur la table dans l’arbre et sélectionnez Ajouter au Canevas pour ajouter la table comme couche
dans votre carte.

19.2.6 Exporter des données d’une base de données à l’aide de DB Manager.

Bien entendu, DB Manager peut également être utilisé pour exporter des données de base de données spatiales.
Voyons comment faire.

• Sélectionnez la couche lines dans l’arbre et cliquez sur le bouton Exporter vers le fichier pour ouvrir la
boîte de dialogue Exporter vers un fichier vecteur .

• Cliquez sur le bouton ... pour sélectionner le Fichier en sortie et sauvegarder les données dans le répertoire
exercise_data sous le nom urban_4326.

• Paramétrez le SCR cible à 4326.

• Cliquez sur OK pour lancer l’export.

19.2. Lesson: Utiliser DB Manager pour travailler avec les Bases de données Spatiales dans
QGIS
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• Fermer la boîte de message vous indiquant que l’export s’est correctement déroulé et fermez DB Manager.

Vous pouvez maintenant inspecter le fichier Shape que vous avez créé en utilisant le panneau Navigation.
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19.2.7 In Conclusion

Nous avons étudié comment utiliser l’interface de DB Manager sous QGIS pour gérer des bases de données
spatiales, exécuter des requêtes et comment importer et exporter des données.

19.2.8 What’s Next?

Dans la prochaine leçon, nous étudierons comment utiliser des techniques identiques sur les bases de données
Spatialite.

19.3 Lesson: Travailler avec des Bases de Données Spatialite dans
QGIS

Alors que PostGIS est généralement utilisé sur un serveur pour fournir des fonctionnalités de bases de données
spatiales à de multiples utilisateurs en même temps, QGIS gère également l’utilisation d’un format de fichier
nommé spatialite qui est un moyen léger et portable de stocker une base de données spatiale dans un seul fichier.
Naturellement ces deux types de bases de données spatiales doivent être utilisées pour des objetcifs différents mais
les mêmes principes de bases s’appliquent aux deux. Créons une nouvelle base de données spatialite et explorons
les fonctionnalités offertes par QGIS pour travailler avec.

L’objectif de cette leçon: Apprendre à interagir avec des bases de données Spatialite dans le Navigateur de QGIS.

19.3.1 Follow Along: Créer une base de données Spatialite avec le Naviga-
teur

A l’aide du panneau Navigateur, nous pouvons créer une nouvelle base de données Spatialite et la configurer pour
un usage sous QGIS.

• Clic droit sur l’entrée Spatialite dans l’arborescence du Navigateur et sélectionnez Créer une base de don-
nées.

• Spécifiez où vous souhaitez stocker le fichier et nommez-le qgis-sl.db.

• Faites à nouveau un clic droit sur l’entrée Spatialite de l’arborescence du Navigateur et sélectionnez cette
fois Nouvelle Connexion. Trouvez et ouvrez le fichier précédemment créé.

Maintenant que vous avez configuré votre nouvelle base de données, vous pourrez remarquer que l’entrée de
l’arbre de Navigation n’a rien en dessous et que la seule chose que vous pouvez faire à ce niveau et de supprimer
la connexion. Ce comportement est présent uniquement parce que nous n’avons pas encore ajouté de tables à cette
base de données. Faisons-le.

• Trouvez le bouton pour créer une nouvelle couche et utilisez le menu déroulant pour créer une nouvelle
couche SpatiaLite ou sélectionnez Couche → Nouveau → Nouvelle couche SpatiaLite.

• Sélectionnez dans la liste déroulante la base de données créée dans les étapes précédentes.

• Nommez la couche en places.

• Cochez la case à côté de Créer une clé primaire auto-incrémentée.

• Ajoutez 2 attributs comme montré ci-dessous

• Cliquez sur OK pour créer la table.
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• Cliquez sur le bouton Actualiser en haut de la fenêtre Navigateur et vous devriez pouvoir voir la table
places dans la liste.
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Un clic droit sur la table vous permet de voir ses propriétés, comme vu dans l’exercice précédent.

A ce stade, vous pouvez commencer une session d’édition et ajouter des données directement à votre nouvelle
base de données.

Nous avons déjà appris à importer des données dans une base de données à l’aide de DB Manager. Vous pouvez
utiliser cette technique pour importer des données dans votre nouvelle base de données Spatialite.

19.3.2 In Conclusion

Vous avez vu comment créer des bases de données Spatialite, leur ajouter des tables et utiliser celles-ci comme
couches dans QGIS.
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CHAPTER 20

Annexe : Contribution à ce manuel

Pour ajouter du matériel à ce cours, vous devez suivre les recommandations dans ces annexes. Vous ne devez pas
changer les conditions dans ces annexes, à l’exception de la clarification. C’est pour s’assurer que la qualité et le
contenu de ce manuel puissent être maintenus.

20.1 Téléchargement des ressources

La source de ce document est disponible sur GitHub. Consultez GitHub.com pour les instructions d’utilisation du
système de contrôle de versionnement git.

20.2 Format du Manuel

Ce manuel est écrit en utilisant Sphinx, un générateur de documentation sous Python utilisant le langage de balise
reStructuredText. Les instructions sur l’utilisation de ces outils sont disponibles sur leur site respectif.

20.3 Ajout d’un module

• Pour ajouter un nouveau module, créez tout d’abord un nouveau répertoire (directement sous le plus haut
niveau du répertoire qgis-training-manual) avec le nom du nouveau module.

• Sous ce nouveau répertoire, créez un fichier appelé index.rst. Pour l’instant, fermez le fichier vierge.

• Ouvrez le fichier index.rst sous le plus haut niveau du répertoire. Ses premières lignes sont

.. toctree::
:maxdepth: 2

foreword/index
introduction/index

Vous remarquerez que c’est une liste de noms de répertoires, suivis par le nom index. Cela dirige le fichier index
au plus haut niveau dans chaque répertoire. L’ordre dans lequel ils sont listés détermine l’ordre dans lequel ils
apparaîtront dans le document.

• Ajoutez le nom de votre nouveau module (c’est-à-dire le nom que vous avez donné au nouveau répertoire),
suivi par /index, à cette liste, là où vous voulez que votre module apparaisse.

• Souvenez-vous de garder l’ordre des modules logique, de telle sorte que les modules suivants s’appuient sur
la connaissance présentée dans les modules précédents.

• Ouvrez votre propre index de votre nouveau module ([module name]/index.rst).

• En haut de la page, écrivez une ligne de 80 astérisques (*). Cela représente l’en-tête d’un module.
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• Poursuivez cela avec une ligne contenant la balise |MOD| (qui signifie “module”), suivie par le nom de
votre module.

• Terminez cela avec une autre ligne de 80 astérisques.

• Laissez une ligne ouverte sous ça.

• Écrivez un court paragraphe expliquant la fonction et le contenu de ce module.

• Laissez une ligne ouverte, puis ajoutez le texte suivant:

.. toctree::
:maxdepth: 2

lesson1
lesson2

... où lesson1, lesson2, etc., sont les noms de vos leçons prévues.

Le fichier index au niveau du module ressemblera à ceci :

*******************************************************************************
|MOD| Module Name

*******************************************************************************

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2

20.4 Ajout d’une leçon

Pour ajouter une leçon à un module existant ou non:

• Ouvrez le répertoire du module.

• Ouvrez le fichier index.rst (créé ci-dessus dans le cas de nouveaux modules).

• Assurez-vous que le nom de la leçon prévue est listé sous la directive toctree, comme montré ci-dessous.

• Créez un nouveau fichier sous le répertoire du module.

• Nommez ce fichier exactement de la même manière que le nom que vous avez fourni dans le fichier
index.rst du module, et ajoutez l’extension .rst.

Note: À des fins d’édition, un fichier .rst fonctionne exactement comme un fichier texte normal (.txt).

• Avant de rédiger la leçon, écrivez la balise |LS| suivie du nom de la leçon.

• À la ligne suivante, écrivez une ligne comprenant 80 signes égal (=).

• Laissez une ligne ouverte après ceci.

• Écrivez une courte description du but recherché de la leçon.

• Incluez une introduction générale au sujet. Regardez les leçons existantes dans ce manuel pour les exemples.

• Sous cela, commencez un nouveau paragraphe, débutant avec cette phrase

**The goal for this lesson:**

• Expliquez brièvement le résultat escompté à la fin de cette leçon.
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• Si vous ne pouvez pas décrire le but de la leçon en une ou deux phrases, envisagez de couper le sujet en
plusieurs leçons.

Chaque leçon sera subdivisée en plusieurs sections, qui seront traitées après.

20.5 Ajout d’une nouvelle section

Il existe deux types de sections: “Suivez le fil” et “Essayez vous-même”.

• Une section “Suivez le fil” est un ensemble détaillé d’instructions destinées à apprendre au lecteur comment
utiliser tel ou tel aspect de QGIS. Cela se fait habituellement en donnant les instructions clic-par-clic aussi
claires que possible, entrecoupées de captures d’écran.

• Une section “Essayez vous-même” assigne au lecteur une petite mission à réaliser de lui-même. Elle est
généralement associée à une entrée dans la feuille de réponses à la fin de la documentation, qui va montrer
ou expliquer comment faire cet exercice, et affichera le résultat escompté si possible.

Chaque section vient avec un niveau de difficulté. Une section facile est signalée par |basic|, une intermédiaire
par |moderate|, et une section avancée par |hard|.

20.5.1 Ajout d’une section “Suivez le fil”

• Pour commencer cette section, écrivez la balise du niveau de difficulté prévu (comme montré ci-dessus).

• Laissez un espace puis écrivez |FA| (pour “Suivez le fil”, Follow Along en anglais).

• Laissez un autre espace et écrivez le nom de la section (utilisez seulement une initiation en majuscule, ainsi
que les capitales pour les noms propres).

• À la ligne suivante, écrivez une ligne de 80 tirets/traits d’union (-). Assurez-vous que votre éditeur de texte
ne remplace pas le caractère tirets/traits d’union avec une longue ligne ou un autre caractère.

• Écrivez une courte introduction à la section, expliquant ses objectifs. Puis donnez des instructions détaillées
(clic-pa-clic) sur la procédure à être démontrée.

• Dans chaque section, incluez des liens internes, des liens externes et des captures d’écran au besoin.

• Essayez de clore toute section avec un court paragraphe qui la conclut et fait naturellement un lien vers la
section suivante, si possible.

20.5.2 Ajout d’une section “Essayez vous-même”

• Pour commencer cette section, écrivez la balise du niveau de difficulté prévu (comme montré ci-dessus).

• Laissez un espace puis écrivez |TY| (pour “Essayez vous-même” en anglais).

• À la ligne suivante, écrivez une ligne de 80 tirets/traits d’union (-). Assurez-vous que votre éditeur de texte
ne remplace pas le caractère tirets/traits d’union avec une longue ligne ou un autre caractère.

• Expliquez l’exercice que vous voulez que le lecteur fasse. Référez-vous aux sections, leçons ou modules
précédents si nécessaire.

• Incluez des captures d’écran pour clarifier les exigences si une description textuelle n’est pas claire.

Dans la plupart des cas, vous voudrez donner une réponse sur la façon de remplir la mission donnée dans cette
section. Pour faire cela, vous aurez besoin d’ajouter une entrée dans la feuille de réponse.

• Premièrement, décidez d’un nom unique pour la réponse. Idéalement, ce nom inclura le nom de la leçon et
un numéro d’incrémentation.

• Créez un lien pour cette réponse :
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:ref:‘Check your results <answer-name>‘

• Ouvrez la feuille de réponses (answers/answers.rst).

• Créez un lien vers la section “Essayez vous-même” en écrivant cette ligne:

.. _answer-name:

• Écrivez les instructions sur comment terminer les tâches, en utilisant des liens et des images où cela est
nécessaire.

• Pour finir, incluez un lien vers la section “Essayez vous-même” en écrivant cette ligne:

:ref:‘Back to text <backlink-answer-name>‘

• Pour que ce lien fonctionne, ajoutez la ligne suivante au-dessus de l’en-tête de la section “Essayez vous-
même”:

.. _backlink-answer-name:

Souvenez-vous que chacune de ces lignes montrées plus haut doivent avoir une ligne blanche en-dessus et en-
dessous d’elles-mêmes, autrement cela pourrait causer des erreurs lors de la création du document.

20.6 Ajout d’une conclusion

• Pour terminer une leçon, écrivez la phrase |IC| pour “in conclusion” (qui signifie “Pour conclure” en
anglais), suivie par une nouvelle ligne de 80 tirets/ traits d’union (-). Écrivez une conclusion pour la leçon,
expliquant quels concepts ont été abordés dans la leçon.

20.7 Ajout d’une section Pour aller plus loin

• Cette section est optionnelle.

• Écrivez une phrase FR pour “further reading” (qui signifie “Pour aller plus loin” en anglais), suivie par une
nouvelle ligne de 80 tirets/traits d’union (-).

• Incluez des liens vers des sites externes appropriés.

20.8 Ajout d’une section La suite ?

• Écrivez la phrase |WN| pour “what’s next” (qui signifie “La suite ?” en anglais), suivie par une nouvelle
ligne de 80 tirets/traits d’union (-).

• Expliquez comment cette leçon a préparé les étudiants à la prochaine leçon ou au prochain module.

• Pensez à changer la section “La suite ?” de la précédente leçon si nécessaire, afin qu’elle fasse référence à
votre leçon. Cela sera nécessaire si vous avez inséré une nouvelle leçon entre les leçons déjà existantes, ou
après une leçon existante.

20.9 Utilisation des balises

Pour adopter les standards de ce document, vous devrez ajouter des balises standards à votre texte.
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20.9.1 Nouveaux concepts

• Si vous êtes en train d’expliquer un nouveau concept, vous devrez écrire le nom du nouveau concept en
italique en l’enfermant entre des astérisques (*).

This sample text shows how to introduce a *new concept*.

20.9.2 Accentuation

• Pour accentuer un terme important qui n’est pas un concept, écrivez-le en gras en l’enfermant entre des
doubles astérisques (**).

• Utilisez cela avec modération ! Si vous l’utilisez trop, il peut sembler au lecteur que vous criez ou que vous
êtes condescendant.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma,** or at the **end of the
sentence.**

20.9.3 Images

• Quand vous ajoutez une image, sauvegardez-la dans le dossier _static/lesson_name/.

• Incluez-la dans le document comme ceci

.. image:: /static/training_manual/lesson_name/image_file.extension
:align: center

• Souvenez-vous de laisser une ligne vide en-dessus et en-dessous de la balise de l’image.

20.9.4 Liens internes

• Pour créer un point d’ancrage pour un lien, écrivez la ligne suivante au-dessus de l’endroit où vous souhaitez
que le lien pointe

.. _link-name:

• Pour créer un lien, ajoutez cette ligne:

:ref:‘Descriptive link text <link-name>‘

• Rappelez-vous de laisser une ligne vide avant et après cette ligne.

20.9.5 Liens externes

• Pour créer un lien externe, écrivez-le comme ceci:

‘Descriptive link text <link-url>‘_

• Rappelez-vous de laisser une ligne vide avant et après cette ligne.

20.9.6 Utilisant du texte mono-espacé

• Lorsque vous écrivez un texte qui indique que l’utilisateur doit saisir un emplacement de fichiers ou le
nom d’un élément de base de données tel qu’une table ou un nom de colonne, vous devez l’écrire en
monospaced text. Par exemple:
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Enter the following path in the text box: :kbd:‘path/to/file‘.

20.9.7 Étiqueter les éléments de l’interface

• Quand vous faites référence à un élément de l’interface, comme un bouton, vous devez écrire son nom dans
le format des éléments de l’interface. Par exemple :

To access this tool, click on the :guilabel:‘Tool Name‘ button.

• Cela s’applique également si vous mentionnez le nom d’un outil sans obliger l’utilisateur à cliquer sur un
bouton.

20.9.8 Sélections de menu

• Si vous guidez un utilisateur à travers les menus, vous devez utiliser le menu → sélection → format. Par
exemple

To use the :guilabel:‘Tool Name‘ tool, go to :menuselection:‘Plugins -->
Tool Type --> Tool Name‘.

20.9.9 Ajout de notes

• Vous devriez rédiger une note dans le texte qui donne plus de détails qui ne peuvent faire partie du flux
général de la leçon. C’est la balise:

[Normal paragraph.]

.. note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]

20.9.10 Ajouter une note sur l’auteur ou le sponsor

Si vous écrivez un nouveau module, une nouvelle leçon ou une section par le financement d’un sponsor, vous devez
y inclure un message de leur choix. Cela indique au lecteur le nom du sponsor et il doit apparaître en dessous de
l’entête du module, de la leçon ou de la section sponsorisé(e). Néanmoins, il ne s’agit pas d’une publicité pour
leur entreprise.

Si vous avez postulé en écrivant un module, une leçon ou une section de votre compétence et que vous n’êtes
pas patronné, vous pouvez inclure une note sur l’auteur en dessous de l’en-tête de l’élément que vous avez
créé. Cela doit prendre la forme de Ce [module/leçon/section] a été rédigé(e) par [nom
de l’auteur].. N’ajoutez pas plus de texte ni d’informations de contact, etc. Ces éléments seront ajoutés
dans la section “Contributions” de l’avant-propos, avec les noms des parties que vous avez ajoutées. Si vous avez
seulement réalisé des améliorations, des corrections ou des ajouts, vous pouvez être listé dans les éditeurs.

20.10 Merci !

Merci de votre contribution à ce projet ! En contribuant, vous rendez QGIS plus accessible aux utilisateurs et
ajoutez de la valeur au projet QGIS dans son ensemble.
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CHAPTER 21

Feuille de réponses

21.1 Results For Ajout de votre première Couche

21.1.1 Préparation

Vous devriez voir un grand nombre de lignes, symbolisant les routes. Toutes ces lignes sont dans la couche
vectorielle que vous venez de charger pour créer une carte de base.

Retour au texte

21.2 Results For Un Aperçu de l’Interface

21.2.1 Aperçu (Partie 1)

Reportez-vous à l’image montrant l’agencement de l’interface et vérifiez que vous vous souvenez des noms et
fonctions des éléments de l’écran.

Retour au texte

21.2.2 Aperçu (Partie 2)

1. Sauvegarder sous

2. Zoom sur la couche

3. Aide

4. Rendu on/off

5. Mesurer une longueur

Retour au texte

21.3 Results For Travailler avec les Données Vecteurs

21.3.1 Shapefiles

Il devrait y avoir cinq couches sur la carte:
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• places

• water

• buildings

• rivers et

• roads.

Retour au texte

21.3.2 Bases de Données

Toutes les couches vectorielles devraient être chargées dans la carte. Cela ne donnera probablement pas un joli
rendu pour le moment (nous corrigerons les couleurs laides plus tard).

Retour au texte

21.4 Results For Style

21.4.1 Couleurs

• Vérifiez que les couleurs changent telles que vous l’escomptez.

• Il suffit de changer la couche water pour l’instant. Un exemple est indiqué ci-après, mais il pourrait être
différent de ce que vous avez selon la couleur que vous avez choisie.

Note: Si vous souhaitez travailler sur une seule couche à la fois et ne pas être perturbé par d’autres couches, vous
pouvez cacher le contenu de ces couches en cliquant sur la case à cocher à côté du nom dans la liste des couches.
Si la case est vide, alors la couche ne sera pas affichée.
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Retour au texte

21.4.2 Structure des Symboles

Votre carte devrait maintenant ressembler à ça:

Si vous êtes un utilisateur débutant, vous pouvez vous arrêter ici.

• Utilisez la méthode ci-dessus pour modifier les couleurs et les styles pour toutes les couches restantes.

• Essayez d’utiliser des couleurs naturelles selon les objets. Par exemple, une route ne devrait pas être rouge
ou bleue, mais peut être en gris ou en noir.

• De même, n’hésitez pas à expérimenter différents paramètres de Style de remplissage et de Style de bordure
pour les polygones.

Retour au texte

21.4.3 Couches de Symbole

• Personnalisez votre couche buildings comme vous le voulez, mais souvenez-vous qu’il doit être facile de
distinguer les différentes couches de la carte.

Voici un exemple:
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Retour au texte

21.4.4 Niveaux de symboles

Pour obtenir le symbole requis, vous avez besoin de deux couches de symbole :
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La couche de symbole du bas est une large ligne jaune continue . Au sommet de celle-ci, il y a une ligne continue
grise et légèrement plus mince .

• Si vos couches de symboles ressemblent à celles de l’image au-dessus mais que vous n’obtenez pas les
résultats que vous voulez, vérifiez que vos niveaux de symboles ressemblent à ceci :
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• Maintenant, votre carte devrait ressembler à ça:
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Retour au texte

21.4.5 Niveaux de Symbole

• Ajustez vos niveaux de symbole avec ces valeurs :

• Essayez différentes valeurs afin d’obtenir différents résultats.

• Ouvrez à nouveau votre carte originale avant d’aborder l’exercice suivant.

Retour au texte

21.5 Results For Données Attributaires

21.5.1 Données Attributaires

Le champ NAME est le plus utile pour afficher les étiquettes. Ceci est dû au fait que toutes ses valeurs sont uniques
à chacun des objets et peu susceptibles de contenir la valeur NULL. Si vos données contiennent des valeurs NULL,
ne vous inquiétez pas du moment que la plupart de vos places ont des noms.
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Retour au texte

21.6 Results For L’outil Étiquette

21.6.1 Paramétrage des étiquettes (Partie 1)

Votre carte devrait maintenant représenter les symboles en points et les étiquettes devraient en être décalées de
2.0 mm: Le style des symboles et des étiquettes devraient être tout deux bien visibles sur la carte :

Retour au texte

21.6.2 Paramétrage des étiquettes (Partie 2)

Une solution possible aboutit à ce résultat final:
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Pour arriver à ce résultat:

• Utilisez une Taille de police de 10, une Distance de 1,5 mm, une Largeur du symbole et Hauteur du
symbole de 3.0 mm.

• En outre, cet exemple utilise l’option Retour à la ligne sur le caractère:
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• Entrez un espace dans ce champ et cliquez sur Appliquer pour avoir le même effet. Dans notre cas,
quelques-uns des noms de lieux sont très longs, étant alors mis sur plusieurs lignes, ce qui n’est pas très
agréables. Vous pourriez trouver ce paramétrage plus approprié à votre carte.

Retour au texte

21.6.3 Utiliser les Valeurs définies par des données

• Toujours en mode d’édition, mettez pour le FONT_SIZE les valeurs que vous préférez. L’exemple utilise
16 pour les villes, 14 pour les banlieues, 12 pour les localités et 10 pour les hameaux.

• Pensez à sauvegarder vos modifications et sortir du mode d’édition.

• Retournez dans les options de format du Texte de la couche places et sélectionnez FONT_SIZE dans Champ
d’attribut du menu déroulant de la taille de police.
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Vos résultats, en utilisant les valeurs ci-dessous, devraient être ceux-ci:

Retour au texte

21.6. Results For L’outil Étiquette 623



QGIS Training Manual, Version 2.18

21.7 Results For Classification

21.7.1 Affiner la Classification

• Utiliser la même méthode que dans le premier exercice de la leçon pour vous débarrasser des bordures:

Les paramètres que vous avez utilisés pourraient ne pas être les mêmes mais, avec Classes = 6 et Mode = Ruptures
Naturelles (Jenks) (et bien sûr, en utilisant les mêmes couleurs), la carte ressemblera à ça:
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Retour au texte

21.8 Results For Création d’un Nouveau Jeu de Données Vecto-
rielles

21.8.1 Numérisation

Le style importe peu, mais les résultats devraient plus ou moins ressembler à celui-ci:

Retour au texte

21.8.2 Topologie: Outil Ajouter un Anneau

La forme exacte importe peu, mais vous devriez obtenir un trou au centre de votre entité, comme sur celle-ci:
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• Annulez vos modifications avant d’entamer l’exercice du prochain outil.

Retour au texte

21.8.3 Topologie: Outil Ajouter une Partie

• Tout d’abord, sélectionner Bontebok National Park:
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• Maintenant, ajoutez votre nouvelle partie:

• Annulez vos modifications avant d’entamer l’exercice du prochain outil.

Retour au texte

21.8.4 Fusionner les entités

• Utilisez l’outil Fusionner les entités sélectionnées en vous assurant d’avoir au préalable sélectionné les deux
polygones que vous souhaitez fusionner.

• Utilisez l’entité avec le OGC_FID de 1 comme la source de vos attributs (cliquez sur son entrée dans la
boîte de dialogue, puis cliquez sur le bouton Prendre les attributs de l’entité sélectionnée) :

Note:
Si vous utilisez un jeu de données différent, il est fort probable que le OGC_FID de votre polygone d’origine

ne soit pas de 1. Choisissez simplement l’entité qui a un OGC_FID.
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Note: Utiliser l’outil Fusionner les attributs des entités sélectionnées conservera les géométries distinctes mais
leur affecte les mêmes attributs.

Retour au texte

21.8.5 Formulaires

Pour le TYPE, il y a de toute évidence un nombre maximum de types de voies, et si vous regardez la table
attributaire de cette couche, vous verrez qu’ils sont prédéfinis.

• Mettez l’outil sur Valeur de carte et cliquez sur Charger les données depuis la couche.

• Sélectionnez routes dans le menu déroulant Couche et autoroute pour les options Valeur et Description :

• Cliquez sur Ok trois fois.
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• Si vous utilisez maintenant l’outil Identifier sur une rue pendant que le mode d’édition est activé, la boîte
de dialogue que vous obtenez ressemble à ceci :

Retour au texte

21.9 Results For Analyse vectorielle

21.9.1 Extraire vos couches à partir des données OSM

Aux fins de cet exercice, les couches OSM auxquelles nous nous intéressons sont des multipolygons et des
lines. La couche multipolygons contient les données dont nous avons besoin pour produire les couches
houses, schools and restaurants. La couche lines contient les jeux de données des routes.

Le Constructeur de requêtes se trouve dans les propriétés de la couche:
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En utilisant le Constructeur de requêtes pour la couche multipolygon, créez les requêtes suivantes pour les
couches houses, schools, restaurants et residential :
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Une fois que vous avez entré chaque requête, cliquez sur OK. Vous verrez que la carte met à jour la vue unique-
ment pour les données que vous avez sélectionnées. Puisque vous aurez besoin d’utiliser à nouveau les données
multipolygon du jeu de données OSM, à ce stade, vous pouvez utiliser l’une des méthodes suivantes :

• Renommer la couche OSM filtrée et ré-importer la couche osm_data.osm, OU

• Dupliquer la couche filtrée, renommer la copie, effacer la requête et créer votre nouvelle requête dans le
Constructeur de requêtes.

Note: Bien que le champ OSM building dispose d’une valeur house, la couverture de votre aire de travail
peut ne pas être complète. Dans notre région de test il plus précis d’exclure tous les bâtiments qui n’ont pas pour
valeur house. Vous pouvez décider d’inclure simplement les bâtiments qui sont définis comme house ainsi que
toutes les autres valeurs qui n’ont pas une signification précise comme yes.

Pour créer la couche roads, construisez cette requête pour la couche OSM lines :

21.9. Results For Analyse vectorielle 633



QGIS Training Manual, Version 2.18

Vous devriez vous retrouver avec une carte qui ressemble à ce qui suit :

Retour au texte
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21.9.2 Distance des écoles secondaires

• Votre boîte de dialogue du tampon devrait ressembler à cela :

La Distance tampon est 1000 mètres (c’est-à-dire, 1 kilomètre).

• La valeur Segments pour l’approximation est fixée à 20. C’est optionnel, mais recommandé, car il rend les
contours de tampon plus lisses. Comparez ceci :
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A cela :

La première image montre le tampon avec la valeur Segments pour l’approximation fixée à 5 et la seconde montre
la valeur fixée à 20. Dans notre exemple, la différence est subtile, mais vous pouvez voir que les angles du tampon
sont plus lisses avec la plus grande valeur.

Retour au texte
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21.9.3 Distance des Restaurants

Pour créer la nouvelle couche houses_restaurants_500m, nous allons passer par un processus en deux
étapes :

• Premièrement, créez un tampon de 500m autour des restaurants et ajouter la couche à la carte.
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• Puis, sélectionnez les bâtiments dans cette zone tampon :

• Maintenant, sauvez la sélection dans notre nouvelle couche houses_restaurants_500m :
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Votre carte devrait maintenant montrer uniquement les bâtiments qui sont à 50m d’une route, 1km d’une école et
500m d’un restaurant :
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Retour au texte

21.10 Results For Analyse Raster

21.10.1 Calculer l’aspect

• Configurez votre boîte de dialogue DEM (Analyse de terrain) comme ceci :
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Votre résultat:

Retour au texte

21.10.2 Calcul de la pente (moins que 2 et 5 degrés)

• Configurez votre boîte de dialogue Calculatrice Raster comme ceci :
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• Pour la version à 5 degrés, remplacer le 2 dans l’expression et le nom du fichier avec 5.

Vos résultats:

• 2 degrés :
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• 5 degrés :
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Retour au texte

21.11 Results For Complément à l’Analyse

21.11.1 Raster vers Vecteur

• Ouvrez le Constructeur de requête en faisant un clic-droit sur la couche all_terrain dans la Légende, sélec-
tionnez l’onglet Général.

• Ensuite, créez la requête "suitable" = 1.

• Cliquez sur OK pour filtrer tous les polygones où cette condition n’est pas respectée.

Lorsqu’on regarde sur le raster d’origine, les zones doivent se chevaucher parfaitement :
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• Vous pouvez sauver cette couche en faisant un clic-droit sur la couche all_terrain dans la Légende et choisir
Sauvegarder sous..., puis continuez en suivant les instructions :

Retour au texte

21.11.2 Contrôler les résultats

Vous pouvez remarquer que certains des bâtiments dans votre couche new_solution ont été “tranché” par
l’outil Intersection. Cela montre que seule une partie du bâtiment - et donc qu’une partie de la propriété - repose
sur un terrain approprié. Nous pouvons donc sensiblement éliminer ces bâtiments de notre jeu de données.

Retour au texte

21.11.3 Affiner l’analyse

A ce stade, votre analyse devrait ressembler à peu près à ceci:
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Considérez une aire circulaire, continue sur 100 mètres dans toutes les directions.

Si elle dispose d’un rayon de plus de 100m, retirer 100m de sa taille (dans toutes les directions) résultera dans
l’apparition d’une partie restant au milieu.

21.11. Results For Complément à l’Analyse 647



QGIS Training Manual, Version 2.18

Vous pouvez donc lancer un tampon intérieur de 100m dans la couche vecteur suitable_terrain. Dans la sortie de
la fonction de tampon, tout ce qui restera de la couche originelle représentera les surfaces disposant de plus de
100m autour.

Pour le démontrer:

• Allez à Vecteur → Outils de géotraitement → Tampon(s) pour ouvrir la fenêtre Tampon(s).

• Définissez-le comme ceci:
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• Utilisez la couche suitable_terrain avec 10 segments et une distance tampon de -100. (La distance est
automatiquement en mètres car votre carte utilise une projection CRS.)

• Sauvegardez la sortie dans exercise_data/residential_development/ comme
suitable_terrain_continuous100m.shp.

• Si nécessaire, déplacez la nouvelle couche au-dessus de votre couche d’origine suitable_terrain.

Votre résultat ressemblera à peu près à ceci :
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• Maintenant, utilisez l’outil Sélection par localisation (Vecteur → Outils de recherche → Sélection par
localisation).

• Configurez comme suit :
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• Sélectionnez les entités de new_solution qui croisent les entités de suitable_terrain_continuous100m.shp.

Voici le résultat:

Les bâtiments jaunes sont sélectionnés. Bien que certains des bâtiments soient en partie à l’extérieur de la
nouvelle couche suitable_terrain_continuous100m, ils se trouvent bien dans la couche d’origine
suitable_terrain et répondent donc à toutes nos exigences.

• Sauvegardez la sélection sous exercise_data/residential_development/ comme
final_answer.shp.

Retour au texte

21.12 Results For WMS

21.12.1 Ajout d’une autre couche WMS

Votre carte devrait ressembler à ceci (vous aurez peut-être besoin de réorganiser vos couches):
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Retour au texte

21.12.2 Ajout d’un Nouveau Serveur WMS

• Utilisez la même approche qu’avant pour ajouter le nouveau serveur et la couche appropriée comme
hébergée sur ce serveur :
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• Si vous zoomez sur la zone Swellendam, vous remarquerez que ce jeu de données a une basse résolution :

Par conséquent, il est préférable de ne pas utiliser ces données pour la carte actuelle. Les données Blue Marble
sont plus adaptée à une échelle globale ou nationale.

Retour au texte

21.12.3 Trouver un serveur WMS

Vous pouvez remarquer que la plupart des serveurs WMS ne sont pas toujours disponibles.
Quelque fois cela est temporaire, d’autres fois permanent. Un exemple d’un serveur
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WMS qui fonctionne au moment de l’écriture est le World Mineral Deposits WMS sur
http://apps1.gdr.nrcan.gc.ca/cgi-bin/worldmin_en-ca_ows. Il ne nécessite pas de
frais ou n’a pas de contraintes d’accès, et il est mondial. Par conséquent, il satisfait les prérequis. Gardez
cependant à l’esprit que ce n’est qu’un exemple. Il existe beaucoup d’autres serveurs WMS possibles.

Retour au texte

21.13 Results For Concepts de bases de données

21.13.1 Propriétés de la table d’adresses

Pour notre table d’adresses théorique, nous pourrions stocker les propriétés suivantes :

House Number
Street Name
Suburb Name
City Name
Postcode
Country

Lors de la création de la table qui représentera les objets adresse, nous allons créer des colonnes qui représentent
chacune de ces propriétés et nous allons les nommer avec des noms courts conformes au SQL:

house_number
street_name
suburb
city
postcode
country

Retour au texte

21.13.2 Normalisation de la table Personne

Le problème principal avec la table people est qu’elle contient un seul champ adresse qui enregistre l’adresse
complète d’une personne. En pensant à la table address étudiée précédemment, nous savons qu’une adresse est
composée de plusieurs éléments. En stockant ces éléments dans un seul champ, il sera plus complexe de mettre à
jour et de requêter nos données. Nous devons donc séparer le champ adresse en autant d’éléments que nécessaire.
Cela nous donnera une table avec la structure suivante:

id | name | house_no | street_name | city | phone_no
--+---------------+----------+----------------+------------+-----------------
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123
2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

Note: Dans la prochaine section, vous étudierez les relations basées sur les clefs étrangères qui peuvent
s’appliquer à cet exemple pour améliorer la structure de notre base de données.

Retour au texte

21.13.3 Normalisation avancée de la table People

Notre table people ressemble actuellement à ceci:
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id | name | house_no | street_id | phone_no
---+--------------+----------+-----------+-------------
1 | Horst Duster | 4 | 1 | 072 121 122

La colonne street_id représenter une relation ‘un à plusieurs’ entre les objets people et l’objet lié street qui
est stocké dans la table streets.

Un moyen d’améliorer la normalisation de la table est de séparer le champ de nom en deux: first_name et
last_name:

id | first_name | last_name | house_no | street_id | phone_no
---+------------+------------+----------+-----------+------------
1 | Horst | Duster | 4 | 1 | 072 121 122

Nous pouvons également créer des tables séparées pour le nom des villes ou des villages et pour le nom des pays
en les liant à notre table people via une relation ‘un à plusieurs’:

id | first_name | last_name | house_no | street_id | town_id | country_id
---+------------+-----------+----------+-----------+---------+------------
1 | Horst | Duster | 4 | 1 | 2 | 1

Un diagramme ER pour représenter cela devrait ressembler à ça :

Retour au texte

21.13.4 Créer une table People

Voici la requête SQL pour créer une table de personnes correcte:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int not null,
phone_no varchar null );

Le schéma de la table (entrez \d people) ressemble à ceci
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Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

Note: Pour des questions d’affichage, nous avons délibérément omis la contrainte de clef étrangère.

Retour au texte

21.13.5 La commande DROP

La raison pour laquelle la commande DROP ne fonctionne pas dans ce cas est parce que la table people dispose
d’une contrainte de clef étrangère vers la table streets. Cela signifie que détruire (ou supprimer des enregistrements
dans) la table streets laisserait des entrées de la table people qui pointeraient vers des références non existantes de
la table streets.

Note: Il est possible de ‘forcer’ la suppression d’enregistrements dans la table streets en utilisant la commande
CASCADE. Néanmoins, cela supprimerait également des enregistrements dans la table people‘et toute autre table
qui disposerait d’une relation avec la table ‘streets. A utiliser avec précaution !

Retour au texte

21.13.6 Insérer une nouvelle rue

La commande SQL que vous devez utiliser ressemble à cela (vous pouvez remplace le nom de la rue avec un nom
de votre choix) :

insert into streets (name) values (’Low Road’);

Retour au texte

21.13.7 Ajouter une nouvelle personne avec une relation de clef étrangère

Voici la syntaxe SQL correcte à utiliser :

insert into streets (name) values(’Main Road’);
insert into people (name,house_no, street_id, phone_no)

values (’Joe Smith’,55,2,’072 882 33 21’);

Si vous regardez à nouveau dans la table des rues (en utilisant une déclaration de sélection comme avant), vous
verrez que l’id pour l’entrée Main Road est 2.

C’est pourquoi nous pouvons seulement saisir le numéro 2 ci-dessus. Même si nous ne voyons pas le terme Main
Road écrit complètement dans la requête précédente, la base de données sera capable de l’associer avec le champ
street_id ayant une valeur de 2.

Note: Si vous avez déjà ajouté un nouvel objet street, vous pourriez trouver que le nouveau Main Road a
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un identifiant à 3 et non à 2.

Retour au texte

21.13.8 Renvoyer les noms des rues

Voici la syntaxe SQL correcte à utiliser:

select count(people.name), streets.name
from people, streets
where people.street_id=streets.id
group by streets.name;

Résultat:

count | name
------+-------------

1 | Low Street
2 | High street
1 | Main Road

(3 rows)

Note: Vous avez noté que nous avons préfixé les noms des champs avec les noms des tables (ex: people.name et
streets.name). Il est nécessaire de le faire lorsque les noms des champs sont ambigus (c’est-à-dire que plusieurs
tables ont les mêmes noms de champs dans la base de données).

Retour au texte

21.14 Results For Requêtes Spatiales

21.14.1 Les Unités utilisées dans les requêtes spatiales

Les unités utilisées dans l’exemple de requête sont des degrés, car le SCR utilisé pour la couche est WGS 84.
C’est un SCR géographique, ce qui signifie que ses unités sont en degrés. Un SCR projeté, comme les projections
UTM, est en mètres.

Souvenez-vous que lorsque vous écrivez une requête, vous avez besoin de savoir quelles unités le SCR de la
couche utilise. Cela vous permettra d’écrire une requête qui retournera le résultat que vous attendez.

Retour au texte

21.14.2 Création d’un Index Spatial

CREATE INDEX cities_geo_idx
ON cities
USING gist (the_geom);

Retour au texte
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21.15 Results For Construction géométrique

21.15.1 Création de polylignes

alter table streets add column the_geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(the_geom) = ’ST_LineString’::text OR the_geom IS NULL);
insert into geometry_columns values (’’,’public’,’streets’,’the_geom’,2,4326,

’LINESTRING’);
create index streets_geo_idx

on streets
using gist
(the_geom);

Retour au texte

21.15.2 Lier des tables

delete from people;
alter table people add column city_id int not null references cities(id);

(Capturer les villes dans QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’Faulty Towers’,

34,
3,
’072 812 31 28’,
1,
’SRID=4326;POINT(33 33)’);

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’IP Knightly’,

32,
1,
’071 812 31 28’,
1,F
’SRID=4326;POINT(32 -34)’);

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’Rusty Bedsprings’,

39,
1,
’071 822 31 28’,
1,
’SRID=4326;POINT(34 -34)’);

Si vous obtenez le message d’erreur suivant:

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

cela indique que lors de votre expérimentation de création de polygones pour la table des villes, vous avez dû en
supprimer quelques-uns. Vérifiez les enregistrements de votre table de ville et utiliser un id qui existe.

Retour au texte
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21.16 Results For Modèle d’Entité Simple

21.16.1 Remplir les tables

create table cities (id serial not null primary key,
name varchar(50),
the_geom geometry not null);

alter table cities
add constraint cities_geom_point_chk
check (st_geometrytype(the_geom) = ’ST_Polygon’::text );

Retour au texte

21.16.2 Remplir la table Geometry_Columns

insert into geometry_columns values
(’’,’public’,’cities’,’the_geom’,2,4326,’POLYGON’);

Retour au texte

21.16.3 Ajouter une géométrie

select people.name,
streets.name as street_name,
st_astext(people.the_geom) as geometry

from streets, people
where people.street_id=streets.id;

Résultat:

name | street_name | geometry
--------------+-------------+---------------
Roger Jones | High street |
Sally Norman | High street |
Jane Smith | Main Road |
Joe Bloggs | Low Street |
Fault Towers | Main Road | POINT(33 -33)

(5 rows)

Comme vous pouvez le voir, notre contrainte autorise l’ajout de valeurs nulles dans la base de données.

Retour au texte
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CHAPTER 22

Index et Tables

• genindex

• modindex

• search
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